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Preface 
Thank you for choosing MAGIX Video Pro X6! Your new software offers video editing 
and postproduction on a professional level, comprehensive format support, powerful 
performance, high-end audio editing and all options for DVD authoring and export.  

The fully developed MAGIX Video Pro X6 operating concept helps you get top results 
after only a short familiarization period. This documentation offers you an overview 
and a quick start at the beginning. The sections at the end provide a detailed and 
systematic description of the numerous functions.  

Have fun with your projects and MAGIX Video Pro X6 from 

Your MAGIX Team 
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Support 
Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. To this 
end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at http://pro.magix.com 

• The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 150,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products: 
For each new MAGIX product you will automatically receive 12 months free 
customer support by email. 

• Premium Email Support: 
For priority support, or if you want the support team to help with non-MAGIX 
related hardware problems you can purchase a premium email support ticket. 
Proceed as follows: 

1. Go to the MAGIX customer support page at http://support.magix.net 
http://support.magix.net. 

2. Sign in using your login details. 

3. Click on "Purchase access code" in the navigation bar. 
Each ticket corresponds to a specific problem, it will remain valid until the 
problem has been solved. A ticket is not limited to a single email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation CD or on the 
inside of the DVD box. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a fee-
based telephone customer service. 

http://support.magix.net/�
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Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 

Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 45 699 18763 
Sweden: 46 852 500713  
Finland: 35 89 42419023 
Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  
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Before You Start 

Package Contents 
Installation & multimedia content DVD 
The MAGIX Video Pro X6 installation manager is included on the installation DVD. 
 

Printed and PDF manuals 
The printed manual contains an overview of the most important functions of MAGIX 
Video Pro X6. 

If you have further questions, please read the complete documentation and a shortcut 
pdf located in the program folder of MAGIX Video Pro X6. To read it, you will require 
the free Foxit Reader program. 
 

Installation 
Step 1: Insert the program disc into the drive. The installation program starts up 
automatically in Windows. If the disc doesn't run automatically, 

• open the Windows Explorer and click the letter of the CD/DVD drive. 
• Now double-click on "Start.exe" to start the installer. 

Step 2: To begin the installation of MAGIX Video Pro X6, click on "MAGIX Video Pro 
X6". The MAGIX Video Pro X6 installation program will appear. 

Simply follow the instructions on screen to complete the installation process, and 
then click "Continue". All files are copied onto the hard drive. 

Step 3: Once the installation is complete, confirm by pressing "Finish". You can start 
the program at any time using the Windows "Start" menu 
 

Serial number 
A serial number is included in each product. This serial number is required for the 
installation of the software and enables usage of additional bonus services. Please 
store this number in a safe place. 

What can a serial number do? 
With a serial number your MAGIX Video Pro X6 is clearly assigned to you and only 
you. This way improved and more targeted customer service is made possible. Abuse 
of the software can be prevented with a serial number, which ensures that optimum 
the price/performance ratio continues is guaranteed. 
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Where can the serial number be found? 
The serial number can be found on the reverse side of your CD/DVD case. If your 
product is packed in a DVD box, then you'll find the serial number on the inside. 

For the versions that have been especially optimized for the Internet (download 
versions), you'll get your serial number for activating the software directly after 
purchasing the product via email. 

When will you need the serial number? 
The serial number is required when you start or register MAGIX Video Pro X6 for the 
first time. 

Note: We explicitly recommend registering your product (free), since only then are 
you entitled to download updates and use MAGIX support (view page 11) services. 

 

Unlocking MAGIX Video Pro X6 
After MAGIX Video Pro X6 has been installed and the serial number has been 
entered, the software can be used for 30 days. After these 30 days have expired, 
MAGIX Video Pro X6 must be activated. 
 

System requirements 
For Microsoft Windows XP | Vista | 7 | 8 

Minimum configuration: 
• Processor: Intel Core Duo with 1.83 GHz, AMD Dual-Core with 2.0 GHz 
• RAM: 1GB 
• Graphics card: Onboard graphics card with a screen resolution of at least 1024 x 

768 
• Sound card: Internal sound card 
• Hard drive space: 1 GB (for minimum installation) 
• Optical drive: DVD drive 

Minimum requirements for HD/3D editing: 
• Processor: Intel Core 2 Quad-core processor with 2.83 GHz (Intel Core i7 

recommended), AMD Quad-core processor with 2.8 GHz 
• RAM: 4 GB 
• Graphics card: Dedicated graphics card with 512 MB VRAM or more 
• Sound card: Multi-channel sound card recommended for Surround sound editing 
• Hard drive space: 4 GB 
• Optical drive: Blu-ray burner to create Blu-ray Discs 
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Introduction 

What is MAGIX Video Pro X6? 
MAGIX Video Pro X6 is a professional video editing program for Windows PC 
systems. All standard video formats can be directly imported onto the track without 
the need for converting to a proprietary format. The editing options include realtime 
effect editing, efficient three-point and four-point editing, intelligent mouse modes for 
intuitive editing processes and a Multicam Mode with automatic synchronization on 
up to nine tracks.  

Perfect synchronization of image and audio in realtime is made possible thanks to 
technology based on the high-end audio engine in Samplitude. With effective batch 
rendering you can export your finished projects in broadcast quality formats, burn 
them to DVD, AVCHD and Blu-ray disc or upload them directly to video hosting sites 
and mobile devices. 
 

Features 
Recording 
MAGIX Video Pro X6 features the following recording options: 

• AVCHD/DVCPRO/AVC-Intra/Video-DSLRs/XDCAM/NXCAM (and other 
drives)* 

• HDV camera: HDV camcorder 
• DV camera: Mini DV camcorder or DV video recorder 
• Video: Analog TV, video input, VCR, webcam 
• Audio: Microphone, cassette recorder, MiniDisc player, record player 
• Screen:  PC monitor. 
• Single frame: Single and series images from webcams, video recorders, video 

cameras, or TV cards 

*Import of AVC-Intra and DVCPRO possible after fee-based activation (view page 
346) 

Analog capture requires capture cards compatible with DirectShow. DV capture can 
be performed through an OHCI-compatible IEEE 1394 host adapter (FireWire or 
iLink). A TV card can be used to record programs from TV or from your video 
recorder. 
 

Import and export formats 
Supported import formats:  
The following standards and formats can be imported: 
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Video: DV, HDV, AVCHD, H.264, XDCAM, NXCAM, DVCPRO, AVC-Intra, 
Stereo3D, AVI, MPEG-1, MPEG-2, MPEG-4, M2TS, MJPEG, MKV, MTS, MXV, 
QuickTime, WMV(HD), VOB, TOD, TS, DVR-MS, uncompressed video 

Audio: AAC, MIDI, MP3, OGG, WAV, WMA 

Photo: BMP, GIF, JPEG, PNG, TIF, TGA 

Supported export formats: 
Video: AVI, DV-AVI, MJPEG, MPEG-1, MPEG-2, MPEG-4, WMV 

Audio: MP3, WAV 

Photo: BMP, JPEG 

Note: This program requires an Internet connection for many of its functions. MP3 
export requires the installation of Windows Media Player version 10 or higher. 
DVCPRO and AVC Intra require a fee-based initial activation.  

A current list of all supported formats can be found at format-support.magix.com. 

 

Editing 
• Program and source monitors: To provide an optimal overview, these two 

separate preview monitors are integrated for the source material and movie 
arrangement respectively. 

• Project folder: This folder is used for storing your material. It serves as the 
preselection area for the media in your current project. Here you can store video, 
audio or title files - and even edited versions or sections of movies - and use them 
later in various places in your project. 

• Image optimization: Color improvement (RGB, saturation), sharpness (focus and 
blurring), brightness regulator (brightness, contrast), anti-flicker filter. 

• Sound optimization: The equalizer can be used to adjust the frequency spectrum, 
e. g. reducing highs, boosting lows etc. The compressor limits the dynamic of the 
signal. The Stereo FX processor controls the position of the sound within the 
stereo panorama. The Denoiser and Dehisser are professional noise reduction 
tools. 

• Video effects: For example, artistic filters, distortion, video mix (Chroma Key), 
movement effects (e. g. camera/zoom or rotation), cropping, picture-in-picture 
collages, video effect plug-in support. 

• Automatic scene recognition  
• Multicam editing (view page 111) on up to nine tracks. Different camera 

recordings can be played back in sync and edited together as a single version. 
• Slideshow Maker turns drab photo collages into spectacular multimedia shows 

automatically. 
• MAGIX Soundtrack Maker creates background music automatically. 
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Burnable disc formats 
You will find the following burning options in the "Burn" area: 

• DVD 
• Blu-Ray disc 
• AVCHD disc (on DVD and Blu-ray Discs) 

In the "File" menu you can make and burn backup copies. 
 

Multimedia editable disc menus 
Included are many disc menu templates which offer selection options for movies and 
chapters on the screen. Many of these are also available in 16:9 format. They can be 
included during burning and give the disc a professional appearance. 

Every menu template may be customized with personal photos, thematic animations, 
3D captions, sound, intro videos, etc. 
 

Notes for MAGIX Movie Edit Pro users 
If you are used to working with MAGIX Movie Edit Pro, you can change the window 
appearance to MAGIX Video deluxe "classic" view by going to "Window"> "Window 
appearance" > "Minimal". 

For all those who haven't used MAGIX Movie Edit Pro before, we recommend the 
"Standard" window appearance. You have the most options available in this mode. 

Below you will find a rough overview of the differences between MAGIX Video Pro X6 
and MAGIX Movie Edit Pro. 
 

Video monitors 
• In the "Minimal" display mode the program only has one preview monitor which 

is used for both program and source monitor similar to the one in MAGIX Movie 
Edit Pro. When the project is stopped, files in the Media Pool can be selected and 
played back using the transport console. To play back the project again you can 
simply click on the project window.  

• The "Standard" display mode in MAGIX Video Pro X6 offers two preview 
monitors. One is the program monitor for previewing the project in the project 
window and one is the source monitor for previewing files in the Media Pool. Both 
monitors have their own transport consoles so you can separately control the 
preview of the Media Pool and playback of the project. For more information 
about the preview monitors please refer to the section in the „Workspaces“ (view 
page 62) chapter. 
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Keyboard layout 
The preset keyboard shortcuts are different and can be displayed in both modes via 
"File -> Settings -> Keyboard shortcuts". MAGIX Video Pro X6 also allows familiar 
shortcuts from Movie Edit Pro to be loaded if they are easier to work with. More 
information about keyboard shortcuts can be found in the chapter "Keyboard 
shortcut" (view page 335) and in the shortcut pdf located in the program folder of 
MAGIX Video Pro X6. 
 

Load files 
• In MAGIX Video Pro X6, files are dragged and dropped to the desired position in 

the project window or loaded using the commands in the Insert menu. For more 
about this, please read the section "Insert modes" in the chapter "Workspaces". 

• In Movie Edit Pro, files can also be loaded form the Media Pool by double-clicking 
them. This inserts the video or image file on the first track at the position of the 
playback marker. If another object is already present at that position, the new 
object will be inserted after it on the first track. Titles appear on tracks 3 and 4 
and additional audio files are located on track 5. 

You can also change this behavior under "File -> Settings -> Program" in the tab 
"System" and under "Behavior on double-click". 
 

Space bar behavior 
In either program, use the space bar on your keyboard to start and stop. Pressing the 
space bar again produces different effects according to the respective program: 

• In Movie Edit Pro, the playback marker is placed at the last stop position.  
• In MAGIX Video Pro X6, the playback marker is kept at the current position. This 

corresponds with the functionality of a tape recorder when stopped.  

Playback behavior may be switched via "File -> Settings -> Program" and then the 
"Playback" tab. 
 

Project folder 
• In Movie Edit Pro, the project folder function is not available. 
• MAGIX Video Pro X6 features the project folder as a separate folder on the right 

side, which serves as an intermediate store or catch-all for all kinds of project 
material. More information about this is available in the section "Project folder 
(view page 61)" in the chapter "Workspaces". 
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Projects, movies and objects 
MAGIX Video Pro X6 works with "Projects", "Movies", and "Objects". In order to 
work quickly and intuitively, is it important to know the differences between these 
three hierarchically-ordered terms. 

Project A "Project" includes everything that you want to include on a disc. 
Normally this means one or more movies and a menu structure for 
selecting movies for playback. Projects can be saved as "MVP" files on 
your hard drive and can be loaded later to do further editing to the 
movies. 

Movie A "Movie" can be one single video clip or a combination of clips and 
photos. It can also include music, titles, transitions and much more.  
Each movie can be exported individually as a video. The "project" can be 
considered a type of drawer into which you can put multiple movies that 
will be edited together and burned to the same disc. 

Objects "Objects" are the individual units of the movie. There are different types 
of objects (view page 87): videos, photos, titles, transitions, decorative 
elements, audio (sound). 

Summary: „Projects“ contain „Movies“ and „Movies“ contain „Objects“. 

 

Project management 
The "Edit" area can be used for editing films and also for managing your projects, i. e. 
here you can sort the order of the movies, add new movies, remove existing movies 
from the project or rename the movies.  

Each film in a current project can be controlled through its own tab above the tracks. 
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To rename, sort, load or delete movies, the easiest way is to right-click on one of the 
tabs. You can then select the action you want from the context menu that appears. 
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Quick start 
This chapter explains the basic functions of MAGIX Video Pro X6 with a step-by-step 
introduction. A systematic description of all program functions can be found in the 
following chapters. 

Tip: Use the online tutorial videos that can be accessed in the "Help" menu. This 
feature requires an Internet connection. 

The program keyboard shortcuts (view page 335) for commonly used processes 
and functions are also very helpful. 

 

Program start 
When you start MAGIX Video Pro X6 for the first time, the start dialog will appear. 

This dialog allows you to either  "Load an existing project" or "Create a new project". 
You can also "Create a new project folder". All files belonging to this movie will be 
saved there. 

Additionally, you can also use movie templates (view page 286). Movie templates 
offer a structure for quickly developing certain standard projects with the help of 
included placeholders.  

If you are looking for a quick start into the basic functions of MAGIX Video Pro X6, we 
recommend switching into the "Basic mode" (view page 35), which can be found 
under "Editing mode". 
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We're still at the very beginning, so let's stick with keeping an overview of everything. 
Click "OK" to end the dialog and continue. 
 

Select, load, and play back videos 
In the beginning, it's probably best to load a video file for test purposes and to get to 
know the program functions. 

• The Media Pool appears at the top right; four tabs provide access to all important 
elements that are required for video projects. The first tab displays all usable files 
(besides movies, also photos, images, audio files, and even RTF text files for 
captions) in the current folder. 

 

• Navigation works just like in other file managers: folders can be opened with a 
double-click. Arrow buttons allow you to go one level up or down. You can also 
display a folder tree featuring the folder hierarchy and then use the search 
function (view page 56) to locate files according to different criteria. 

 

• All files opened in the file list can be loaded and used.  Find a video file, e.g.  in the 
format *.mpg, *mxv, or *.avi. 
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• In the upper left area you will see two preview monitors.  

 

• The left program monitor is responsible for playback of objects in the project 
window. The right source monitor displays a preview of files in the Media Pool.  

• To enable playback of movie files from the Media Pool in the right source 
monitor, double-click the file in the file list first. Double-clicking loads the file in 
the monitor. 

• This method enables you to select and play back different video files. Drag the 
selected file (hold down the mouse button) from the Media Pool down into the 
project window. An object appears at the location on the track where you release 
the mouse button to represent this video file. 

• Each object in the project window can be moved with the mouse either 
horizontally on a track or vertically between tracks. Drag the video object on the 
first track all the way to the left to the beginning of the track.  

 

Note: If the video also has an audio track, it will be displayed in the same track. You 
can learn how to separate image and sound in the "Objects" (view page 93) chapter. 
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• Now the first file is in the project window where it can be cut, edited and 
exported.  Now you can load additional files and videos and combine audio files 
on the tracks.   

• To play back the project, click the play button on the transport console under the 
program monitor to the left. 

Tip: An even easier way to control playback is by pressing the space bar on your 
keyboard. 

• During playback a vertical line will move across the project window. This is the 
playback marker that displays the current position. It can be set directly with a 
mouse click in order to jump to certain positions. 

• You can also define playback ranges, e.g.  to freeze a certain position independent 
of the playback marker. Clicking in the range bar above the first track lets you 
define an in-point, i.e. the starting point of the playback range. If you right-click 
further on, the end marker will appear to indicate the end point of the playback 
range. The length of the playback area is shown in the center of the section 
display. 

 

• The in and out points can be moved with the mouse: Left-clicking positions the 
in-point, and the right mouse button sets the out-point.  

 
• To play back the range, click the "Play back range" button on the transport 

control under the program monitor. 

Now you know how to load and play back media files in different ways. Would you 
like to try to make your own movie now? 

• If you want to continue with your own video footage, select the "New movie" 
option from the "File" menu and read the following chapters about video import.  

• If you want to continue working with the test file, simply skip the following import 
tutorial and begin reading the "Video editing (view page 26)" section.  

 

Import video material from memory card 
• Connect your memory medium (camera, USB stick, SD card or other) to the PC. 

You may have to first turn your camera on. 



 

Quick start 25  

 

• Click on the red button below the source monitor to open the record dialog. 

 

• In the record dialog, click on "AVCHD/DVCPRO/AVC-Intra". 
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• The AVCHD import assistant will then open. Select your connected storage 
devices as "video source". A file list will appear. 

 

• In the file list, select all the recordings that you've imported from the device. 
• You can preview all your recordings using the preview monitor in the middle of 

the dialog in order to decide if they are suitable for your movie.  
• After selecting all videos, in "Import options" you can select whether the 

recordings should be directly placed into your movie project or simply copied to 
your computer's hard drive (you can select the location in the next dialog). You 
can also automatically delete your recordings after import. 

 

Video editing 
Timeline mode 
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All editing is performed in the project window. In "Timeline Mode" your movies and 
scenes are displayed proportionally to their size, i.e. the longer the movie, the longer 
the object on the track.  

Handles: All objects can be shortened by moving the mouse to one of the lower 
corners of the object until it turns into a stretch symbol. You can now can shorten the 
object until it is the length you want. At the top corners of every object you’ll find two 
fade handles that can be adjusted to fade an object in or out. The handle at the top 
center can be used to adjust the volume of audio objects and the transparency of 
video objects. 

 

Note: Video objects with an audio track are automatically displayed on one track. 
These objects have six handles instead of five. You can find out more about this in 
the chapter „Objects“. 

Object selection: For advanced effects editing, the objects must be selected first. 
Individual objects can be selected with the mouse. Objects will change color to show 
that they have been selected. Multiple objects can be selected by holding down the 
"Shift" key. You can also click and drag out a rectangle to select multiple objects. All 
objects contained in this rectangle will be selected. 
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Effect editing: Selected objects can be edited with the effects in the Media Pool.  

 

The settings for each effect can be adjusted directly in the Media Pool. Most effects 
can be controlled using keyframe animation and effect curves. The intensity of the 
effect is controlled either dynamically with single points (keyframes) or drawn as a 
curve (effect curve). All the buttons for keyframe and effect curve animation 
corresponding to the selected effect can be found in the lower area of the Media Pool.  

Note: A keyframe must first be selected before an effect curve can be activated.  

Context menu: The context menu also offers a series of editing options for objects. 
This dialog can be opened by right-clicking on an object. It offers advanced object 
editing options, e. g. various trimming editors which enable an exact cut with different 
transition parameters. For video objects there is a different context menu than the one 
for audio and title objects. 
 

Remove unusable scenes 
One of the most important work steps during import of your footage is cutting out 
unusable scenes from the material. There are two options for this: 

• Variant 1: The complete material is loaded into your project first and the unusable 
scenes are cut out.  

• Variant 2: Cut the material prior to importing it, and then proceed to import only 
the scenes you need. This process is recommended for long movies with a lot of 
editing; it functions either via the Media Pool or the project folder.  

 



 

Quick start 29  

 

Cut videos in the project window 
Let's assume that you have already imported your film material into a project and 
would now like to edit it.  

• Play back your video by clicking the play button on the program monitor's 
transport control (or simply press the space bar on the keyboard). 

• If during playback you have reached a scene that you would like to cut out, click 
the playback button in the transport control a second time. The playback marker 
stays near the start of the scene to be removed. 

Tip: In the case of long films or to speed up searching, you can also fast forward the 
video and follow the action on the program monitor. To do this, pull the playback 
marker across the timeline (but not too fast!) while holding down the mouse key. 

• Set the playback marker exactly at the start of the unusable material. The zoom 
function is recommended to get a better view of longer videos (the +/- buttons in 
the bottom right corner of the project window). 

 

• Press "T" on the keyboard. This will split the current scene into two sections at 
the position of the playback marker. 

• Repeat these steps for the end of the unusable scene. Find the end of the 
unusable scene, place the play marker as close as possible to the end point, and 
then press the "T" key on the keyboard again. 
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• Now you have "isolated" the unusable scene and can delete it from the video by 
pressing "Del" on the keyboard. Before this, the scene must be selected by 
clicking it with the mouse. 

 

• If you didn't work accurately during cutting, then don't worry; you can use the 
object handles to stretch or shorten the remaining objects to recover or exclude 
material from the deleted section. 

 

• After deletion, a gap will appear in the film sequence where the removed material 
was. How do you remove gaps from the movie? It's easy: Simply drag the later 
scenes up to the earlier scenes until they "dock" with each other. Remember to 
drag all objects that are further behind, otherwise the gap will just be passed on 
down the line. To drag later objects, use the "All Tracks" mouse mode. This 
automatically takes the objects on all tracks found later on the timeline along 
with the object being moved. 

 

Note: If your project has an audio track in addition to the image track , it is usually 
necessary to cut audio and video tracks in synchronization. After import from the 
camera, video and audio tracks are automatically combined in one object, i.e. all 
cutting and moving actions have an effect on video and sound tracks 
simultaneously. If you have added a separate soundtrack which has not yet been 
grouped with the image sequence, you should group them before starting to edit. To 
do this, select the video object and the audio object with "Ctrl" + click, and in the 
"Edit" menu select the "Group" option (or click the Group Tool). 
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All of the cutting functions are non-destructive (as are all of the editing functions in 
MAGIX Video Pro X6).  This means that all original material will remain unchanged 
on your hard drive. 
 

Importing individual scenes from longer movies 
If you have saved a longer video as a file on your hard disk and only want to use a 
section of it for your project, then proceed as follows: 

• Double click the desired file in the Media Pool. Double-click the file to load it in 
the source monitor and play it back using the transport controls. 

• Find the range which you would like to import. Position the playback marker 
above the transport control at the start position of the range and click the "Set in 
point" button. 

 

• Next, position the playback marker at the end of the section and click the "Set out 
point" button. 

 

• The currently selected range appears highlighted in blue in the range display. You 
can playback this range separately with the "Playback range" button.  

 

• All range limits can be moved by holding down the mouse button and dragging. 
Once the range matches the section that you want to import, click on the preview 
monitor and drag the section onto the track. An object will appear featuring the 
material you wanted to import. If you're not sure where you would like to use the 
section in the project, you can drag it into the project folder instead of onto the 
track. 

Tip: You can also edit files that are located in the project folder in the same way. A 
shortened file also contains information in the project folder about in and out points 
so that you don't always need to reset these in case the video needs to be re-
imported at a later time. You can also drag each file directly from the Media Pool 
into the project folder. 
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Regroup scenes 
You will often want to move specific scenes or even groups of scenes to a different 
place within a movie. This process is completely intuitive: Simply select single scenes 
by clicking on them and move them to the desired position using drag & drop. You 
can also create scene groups which can be moved together: "Ctrl" + mouse click 
selects more than one scene, "Shift" + mouse click selects all of the scenes that lie in 
between. 

Finally, here are three tips for more extensive arranger work: 

• The mouse modes "All tracks" or "One track" (view page 44) don't just move the 
selected scene, but all objects that are located behind the object in the same 
track ("one track") or all tracks ("all tracks"). 

• The commands "Group (view page 299)" and "Ungroup (view page 299)" enable 
you to combine scenes into groups which can then be moved together as a block. 

• If cutting and moving around parts of your project has left it a little unorganized, 
try to make more use of the project folder. You can use this folder as a clipboard 
to store objects and use them in other parts of your project. You can either move 
all of the objects directly from the project window into the project folder by 
dragging them there (they will be removed from the corresponding track), or you 
can copy the objects and paste them into the project folder. To do this, press the 
Ctrl key while clicking and dragging. You can also drag files or sections of files 
directly from the Media Pool into the project folder. 

Note: Be aware that the project folder is only available for the corresponding project. 
The contents will be saved together with the project and made available the next 
time the same project is opened, but not when another project is opened. 

 

Publish videos 
Burn DVDs and Blu-ray discs with interactive menus 
You can burn your projects onto DVD or Blu-ray discs with an interactive menu.  

Note: Authoring for DVDs and Blu-ray discs is the same for both formats. 

For multiple films that are subdivided into individual chapters, the disc selection menu 
becomes even more important, allowing you to jump to each movie or chapter using 
your remote control. To make sensible chapter divisions in your movie, it should be 
split into sensible sections. Place the play marker where you'd like to have it and 
choose the option "Chapter marker" from the "Edit" menu (keyboard shortcut: Shift + 
Enter). If you select the option "Automatic chapter markers", a chapter marker is 
automatically placed at the beginning of every scene. 
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You can switch to the "Burn" screen by pressing the corresponding button at the top 
right. 

 

The "Burn" screen has two views: "Preview" and "Edit". The "Preview" screen provides 
fast loading for a menu template followed by burning. More detailed editing such as 
activation/deactivation of menu entries, creation of new menu pages, or 
individualization of templates takes place via the "Edit" screen. 

Once the menu is finished, you may burn a disc to watch via your player. 
 

Export video as file 
Besides burning the project, it may also be exported as a video file. When exporting 
the file, all of the material in the project window is combined into a single file that can 
be saved to any folder on the hard drive. The available export formats are listed in the 
menu "File -> Export movie".  

To upload a video to the Internet go to "File" > "Online" to access direct connections 
to MAGIX Online Album and the media hosting sites YouTube, Vimeo and showfy. 
 

Edit mode 
In the standard mode, MAGIX Video Pro X6 offers plenty of menus, toolbars and 
controls, which can confuse beginners.  

For simple video editing tasks, such as a rough cut or format conversion, the full range 
of function in MAGIX Video Pro X6 isn't necessary. For this reason, the MAGIX Video 
Pro X6 interface can be switched to a simplified, or basic mode. In this mode control 
elements, menus and toolbars are reduced to the basic necessities. 
 



 

34   

http://pro.magix.com 

Standard mode 
The standard mode offers all MAGIX Video Pro X6 functions for advanced project 
editing. 

 

• Program and source monitor 
• Complete Media Pool with "Fades", "Titles" and "Effects" tabs.  
• The project window which can be activated as scene overview, timeline mode 

and multicam mode. 
• Complete menus and toolbars 
• Project folder 
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Basic mode 
In basic mode all elements, menus and toolbars are reduced to a minimum. 

 

• The window layout corresponds to the arrangement in Movie Edit Pro with 
program monitor, Media Pool and project. 

• The project window is replaced by a single track Storyboard (view page 35). 
Here, imported video material can be cut and arranged. Controls and menu 
commands for effects and audio editing are hidden. 

• Only standard fades and simple titles in preset fonts are possible. 
• The Media Pool can be used solely for file import. The fades, titles and effects 

tabs are hidden. 
• Next to the buttons used for switching between the main screens Edit and Burn 

(view page 227), there is an additional button Export (view page 37). Along with 
the export dialog, the finished movie can be saved in various formats and 
uploaded to Internet platforms. 

• In the Burn screen, the control elements for menu template editing are missing. 
 

Storyboard in basic mode 
In the "Edit" screen in basic mode, the Arranger has been replaced with a Storyboard. 
Pictures and video footage (including the audio track) are displayed as scenes in the 
Storyboard. The scenes are all displayed the same way, irrespective of how long they 
really are in the movie. 

Note: With this kind of display, the playback marker moves in the movie at different 
speeds during playback. Correspondingly, it moves slower in longer scenes. 
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You can load a video or image file by dragging it into the Storyboard from the Media 
Pool using the mouse. To generate a preview of the video, drag the file into the 
program monitor. The transport console no longer applies to the Storyboard, but plays 
the video from the Media Pool. 

A loaded file is made up of a single long "scene", which can be split into several 
smaller scenes. You can do this manually using the Cut button (view page 45) in the 
lower toolbar or using the function Automatic scene detection (view page 271) 
(Shortcut Shift + Z). 

You can then re-arrange the scenes using drag & drop and delete unwanted scenes.  

 

The following buttons are found on every scene: 

 
Add titles and text: Click on the "T" button to add a title. Enter your 
text straight into the program monitor. You can also change the size 
of the title. The title is added at the beginning of the scene and is 
displayed for 5 seconds. 

 
Set volume: The volume in the soundtrack of each scene can be set 
with the loudspeaker button. 

 Effects menu: This button provides access to a menu with 
copy/paste functions, some special functions ("Scene recognition", 
Audio/video offset for videos, "Cut automatically to fit screen" and 
"Change photo length" for pictures) and Object properties. 

 
Transitions/Fades: Click on the large button between the scenes and 
select a scene transition (or "Fade"). You can choose between a 
"Crossfade" and a "Thru black" that each last one second. Selecting 
"Cut (no fade)" removes the fade. 

 
Rotate image (only with image files): If an image or photo is on its 
side or upside down, click on this button. The photo will rotate 90 
degrees. 

 

Display duration: The display duration for each scene is shown here 
in [Minutes]:[Seconds]:[Frames]. With image files, you can click the 
time display and adjust the display duration in the dialog that appears. 
This duration can be applied to all photos in the movie. 
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Export 

 
The "Export" button opens a dialog containing the most 
important export functions. With it, the finished movie can be 
saved in various formats, exported to various devices and 
uploaded to Internet platforms. 

 

 Save on computer (view page 235) 

 Place on MAGIX Online Album  (view page 243) 

 Export to device 

 Upload to Internet (view page 242) 

 Export as Media Player  (view page 244) 

 
 

Switching between standard and basic modes 
To switch MAGIX Video Pro X6 into basic mode, select "Window" > "Editing mode" 
> "Basic mode". 
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Note: If you switched into basic mode by accident and your MAGIX Video Pro X6 
project contains cut and edited audio and video material on multiple tracks, this 
arrangement will not be changed. However, it is not recommended to work in basic 
mode because the effects on other tracks during editing in Storyboard aren't 
predictable. For this reason, in this case you should switch back into standard mode. 

Tip: If you switch from basic mode back into standard mode, by going to "Window" 
> "Window arrangement" > "Resent window arrangement" you can restore the 
previous arrangement of MAGIX Video Pro X6. 
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Work screens 
This chapter will provide an overview of the the screens that available in MAGIX 
Video Pro X6. 
 

Activate main screen 

 

MAGIX Video Pro X6 contains two views where all work is executed: 

• The "Edit" screen is the main view. Load the videos here and edit them in a 
project window. 

• The "Burn" screen is a special view for burning discs. This especially involves 
design on a selection menu, for example as used by DVDs and other storage 
devices. 

The above right allows you to switch between these screens. 
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"Edit" screen 

 

1 Upper Toolbar (view page 41): These are the buttons for quick access 
to the most important commands. 

2 Menu bar: This contains important MAGIX Video Pro X6 functions. 
3 Program monitor andSource monitor (view page 62): The video and 

image objects are displayed here. 
4 Media Pool: In the four tabs you can access the folders on your hard 

drive, various transitions, titles and effects. 
5 Buttons for overview and multicam mode: Here you can switch to 

"Overview" mode. This displays all the object on the first track and 
enables fast sorting of scenes. The button on the right activates 
Multicam Mode (view page 111). 

6 Lower Toolbar: In Timeline Mode you can switch the various mouse 
modes here. 

7 Timeline: Here you can define the playback range. It is equipped with a 
time scale. 

8 Peak meter: The peak meter displays the current volume of the audio 
track in the stereo master. 

9 Project folder (view page 61):  Here you can store all of the files 
needed for the project. 

10 Project window (view page 49): All of the files in the Media Pool and 
the project folder can be added to a track using drag & drop. 

11 Scroll bars: The lower scroll bars can be dragged apart and pushed 
together for zooming with the mouse.  The right scroll bar zooms into 
the tracks vertically. Click on the edge of the scroll bars while holding 
the mouse button to change the visible part in the project window. 
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Note: Various elements of the interface are only available in the „Standard“ setting 
(„Window“ > „Window arrangement“). 

 

Toolbars 
Upper tool bar 

 

The upper tool bar can be found in the monitor to the top left. It has the following 
functions: 
 

New project 

 
A new MAGIX Video Pro X6 project is created. The Start dialog opens in this 
case 

A start dialog will open when the program is started or a new project is loaded.  Here 
you can make important presets for the project. You can change these settings at any 
time by going to "File" > "Settings". 

 

Load existing project: Here you can select and load a previously saved project. 
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View introductory video: Here you can start the introductory video with information 
about workflows in MAGIX Video Pro X6. 

Create new project: Here you can assign a name to your new project. 

Create proxy file automatically: The original material is already converted to a 
suitable target format in advance, which can (view page 267) save a lot of time when 
editing and exporting when finished. 

Project folder: Here you can set the path for the project folder where all project files 
should be saved. 

Movie settings: Here you can set the movie's target format (display norm, resolution, 
frame rate). This setting has no effect on the internal processing quality and can be 
changed at any time by going to "File > Settings > Movie". 

Audio sample rate: Here you can set the audio track's audio sample rate. 

Use movie template: Here you can choose an included movie template for a new 
project. Read the "Using movie templates" (view page 286) section for more details. 

Editing mode: You can use Standard Mode and Basic Mode (view page 35) to edit 
your movies. 

Shortcut:  Ctrl + N 
 

Load project 

 With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. MAGIX 
Video Pro X6 will search for all used sounds and video files in the folders in 
which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Save project 

 
The current movie is saved with the name displayed in the project window. If 
you have not yet specified a name for your project, a dialog will open wherein 
MAGIX Video Pro X6 asks you to do so. 

Please note: In the project file (*.MVP), all information about the used media files, 
cuts, effects, and titles are saved, but not the picture and sound material itself. This is 
found in the recorded or imported media files that remain unchanged during the 
entire MAGIX Video Pro X6 editing process. To save the full movie into a dedicated 
directory, for instance to continue editing on a different PC, please use the command 
"Copy movie and media into directory". 

Keyboard shortcut: Ctrl + S 
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Undo 

 
With this command you can undo the last changes you made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
then you can always revert to the previous state by using "Undo". 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings. In 
general: The longer the list, the more RAM is used. 

Keyboard shortcut:  Ctrl + Z 
 

Redo 

 
This function undoes the previous "Undo" function. 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings. In 
general: The longer the list, the more RAM is used. 

Keyboard shortcut:   Shift + Y 
 

MAGIX News Center 
The MAGIX News Center features links to current online tutorials and tips & tricks on 
the software application examples. The "News" is indicated by color according to 
content:  

• Green indicates practical tips & tricks for the software 
• Yellow reports the availability of new patches and updates 
• Red for special offers, contests and questionnaires 

If no new messages are present, the button will appear gray. When the MAGIX News 
Center is clicked, all of the available information will be displayed. Click the messages 
to reach the corresponding website. 
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Lower toolbar 

 

 

The lower toolbar is located just above the first track. It has the following functions: 
 

Object 

 
This is the preset mouse mode for individual objects that is used the most 
often. 

Left clicking selects an object. Holding down the mouse button moves the selected 
object. Right clicking opens the context menu. 

Shortcut:  6 
 

One track 

 
This mouse mode behaves similar to the mouse mode "All tracks". When 
moving objects, only those objects will be moved that are located on the same 
track after the selected object. 

Keyboard shortcut:   8 
 

All tracks 

 
This mouse mode behaves similar to "Object" mouse mode. However, when 
objects are moved, all of the objects behind the selected object are also 
moved. 

The complete background component of the arrangement, i.e. all objects and gaps on 
all tracks, will therefore be maintained during any movement. 

This is useful for moving a complete arrangement, e. g. to insert new opening credits 
or to close gaps. 

Keyboard shortcut:   7 
 

More mouse modes 

 
MAGIX Video Pro X6 offers more mouse modes for different kinds of editing. 
They can be opened using the small arrow next to the button. 

. 
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Stretching 

 
This special mode enables the length of objects to be adjusted. The object is 
played back completely and the playback speed is adjusted to the stretched 
object length. 

Video objects are therefore accelerated or decelerated accordingly. Audio objects are 
stretched or pinched via timestretching, but without creating any changes to the pitch 
itself.  

Attention: If the object is to be animated with effects curves, then the option 
"Connect curve length with object length (view page 149)" should also be set. 

Shortcut:  0 
 

Curve 

 
This mouse mode is used especially for drawing effects curves. 

Effects curves control the level of the effect: The higher the curve point is, the more 
intense the respective effect parameter will be at this position. These may be used for 
the video and image objects of the image tracks as well as for the audio objects of the 
sound tracks. 

More information about this can be found in the chapter "Animate objects", section 
"Editing object effects curves". 

Shortcut:  9 
 

Preview audio 

 
This mode allows you to preview audio objects (as long as the mouse button is 
held down). 

In this mode, objects cannot be moved or changed. 

Keyboard shortcut:  Alt + 6 
 

Cut button 

 
MAGIX Video Pro X6 offers various modes for video editing. They can be 
opened using the small arrow next to the button. 
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Split 

 
This command cuts a scene at the point where the playback marker is 
positioned. This way, two free-standing objects are created. 

Keyboard shortcut:   T 
 

Remove start 
This command cuts a scene at the point where the playback marker is positioned and 
removes the material before the playback marker. 

Keyboard shortcut:  Z 
 

Remove end 

 
This command cuts a selected object at the playback marker position and 
removes the material behind the playback marker. 

Shortcut:  U 

Hint: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

 

Remove scene 

 
This command allows you to completely remove selected objects. The parts 
that follow will be automatically moved to the end of the object in front of the 
object to be removed. 

Keyboard shortcut:  Ctrl + Del 
 

Split movie 

 
Splits movie at the playback marker position into two sections within one 
project. These can be individually controlled using the "Window" menu or the 
button "Select movie for editing" (see above). 

Shortcut:  Alt + Y 
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Special functions to insert new objects 

 
MAGIX Video Pro X6 has various modes for inserting new objects from the 
Media Pool. They can be opened using the small arrow next to the button. 

Before inserting new files, the insertion mode should be checked or set. There are two 
options for using the modes: 

• You can either first select one or several files in the Media Pool and then click on 
the insert button in the lower toolbar 

• Or you can hover the mouse over the file to be inserted and click on one of the 
import buttons in the window that appears. 

 

Apply automatically 

 
Pastes the file selected in the Media Pool into the project window. Video and 
image objects will always be placed behind the last object into the first track; 
audio and text objects are separated into different tracks.  

 

Single-track ripple 

 
Inserts an object from the Media Pool at the position of the playback marker 
and simultaneously moves the objects on the track following it.  

• In contrast to automatic placement, with track ripple, all objects will be placed at 
the position of the playback marker. Objects on the target track are automatically 
moved behind the inserted object. Bordering tracks are unchanged. 

• Videos and images will be loaded to the first track, as usual. If another object is 
found at the playback marker position, then it will be cut continued at the end of 
the inserted object (so that the inserted object can start exactly at the point of 
insertion). 

 

Multitrack ripple 

 
The object selected in the Media Pool will be inserted on the target track at the 
position of the playback marker. All objects found at the playback marker 
position will be split and moved down the length of the inserted object. All 
objects on the track located further on will also be moved. 

• In contrast to automatic insertion, all objects will be inserted at the position of 
the playback marker. 

• Videos and images will be loaded to the first track, as usual. If another object is 
found at the playback marker position, then it will be cut continued at the end of 
the inserted object (so that the inserted object can start exactly at the point of 
insertion). 

• If other objects are located at the playback marker position, these will also be 
separated and moved further along the track. 

• Objects lying further along on all tracks will be moved further down. 
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Replace 

 
Replaces the selected object with an object selected in the Media 
Pool. 

 
 

Overwrite 

 
Overwrites the object in the target track at the position of the start marker 
with the object selected in the Media Pool. 

Hint: In contrast to "Replace", no length adjustment takes place. With "Replace", any 
downstream objects are moved, while "Overwrite" overwrites downstream objects 
as well (sometimes only partially), depending on the length of the object being 
inserted in comparison to the object being overwritten. 

 

Title editor 

 
Opens the Title editor for the selected photo, video, or title object. 

Keyboard shortcut:  Ctrl + T 
 

Set chapter marker 

 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename". The 
new name will appear in the chapter menu (view page 211). 

Keyboard shortcut:  Shift + Enter 
 

Object grid 

 
Use this button to switch the object grid on and off. When the object grid is 
switched on, the objects snap into place beside one another so that everything 
fits in seamlessly. 

 

Form group 

 
All selected objects are assigned to a group which may then be selected and 
edited jointly by clicking the mouse. 

Shortcut:  G 
 

Ungroup objects 

 
This command splits an object group into separate objects. 

Shortcut:  Shift + G 
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Mute button 

 
This button mutes the sound output. Clicking the triangle provides access to 
settings for scrubbing (view page 209) and selection of the audio track for 
multi-audio tracks (view page 206). 

 

Mixer 
With this option you can open and close the real-time mixer. Further information can 
be found in the Mixer (view page 198) chapter. 

Shortcut:  M 
 

Arranger 

 

The arranger offers a professional editing screen for post-production. 
 

Overview mode 

 

The “Scene overview” mode is a special view that improves manageability and 
categorization of scenes. All scenes are listed one after the other (in multiple lines, 
like in a text program) and can be copied, cut, moved, deleted and inserted. 

"Overview" mode does not indicate start, playback, or end markers. The scene which 
is currently being played has a frame around it. 
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The zoom slider enables the view 
to be enlarged or reduced. 

This controller also specifies how many scenes are displayed. The smaller the preview 
pictures, the more will fit onto the overview. 

 Maximize: Use this button to maximize the scene overview to fullscreen mode. 

 

Timeline mode 
In the Timeline mode, your movies and scenes are shown in proportion to their length: 
The longer the object in the track, the longer the corresponding movie. 

You also have direct access to all media files such as titles, effects, etc. currently 
being used in the movie.  
 

Multicam mode 
The Multicam mode is an expanded timeline mode, where you can edit together 
scenes shot with different camera perspectives, a process called Multicam editing 
(view page 111). The top two tracks serve as target tracks for copying sound and video 
from two different source tracks. 
 

Tracks 
The project window is divided into tracks where the multimedia material can be 
positioned and edited. The number of displayed tracks can be set in "File" > "Settings" 
> "Movie". 

In principle, any object type can be placed on any of the tracks. Video and image 
objects can also be combined with MIDI and audio objects on any of these tracks. The 
maximum length of a movie is restricted to six hours. 

At the beginning of each track there is a track header.  
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 Lock icon: Clicking on this icon locks the entire track and all of its objects against 
editing.  

 Track number: All tracks have a number to help differentiate them in the project. 

 Maximize track: This enlarges the track. This makes it easier to edit fine details, 
e. g. cut transitions. 

 Solo: This switches the track to "solo" mode. During playback only this track will 
be seen or heard. 

 Hide video, image and title objects: All visible objects become transparent. 
Audio objects can still be heard. 

 Transparency controller: Here you can set the transparency for the entire track. 

 Mute: Shuts off the sound on all audio objects on the track. Video, image and 
title objects are still played back. 

 Volume control: Sets the volume for all audio objects on the track. 

 Track name: This is the track name. You can give the track a name by clicking on 
the name field and entering it manually. Press Enter to confirm the name. 

Right-clicking on the track header opens a context menu with the following options: 

• Multicam > Source track: Here you can activate/deactivate a track as a source 
track. 

• Multicam > Master audio track: Here you can designate the master audio track 
for Multicam editing (view page 113). 

• DVD audio track: If you are planning to burn more than one audio track (e.g. 
several languages) to a DVD or Blu-ray disc, here you can specify the position for 
the current track. This option is meant for pure audio tracks. When you select an 
option from the submenu, a dialog will open where you can give the audio track a 
name (e.g. "English"). You can find out more about this in the chapter „Audio 
editing“ (view page 206). 

• Track height: Set whether the selected track or all tracks should be displayed as 
small, large or in standard size.  
You can also adjust the size using your mouse. To do so, drag the lower border of 
a track box downward using a mouse. 
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Zoom 

 

The vertical zoom function sets the 
number of visible tracks. On many tracks 
zooming is useful for selectively editing a 
track or an object in full view. 

Use the horizontal zoom functions to set up the visible section of the project on the 
timeline. 

Clicking and dragging on the bottom border of a track allows you to adjust the height 
of the display. 
 

 Object zoom: Vertical and horizontal zoom stages are enlarged so that all of 
the selected objects are displayed at maximum size. 

 Optimize view: Displays the complete arrangement in full width. Zoom will 
be set to 100%. 

When the function is turned off, the old zoom level will be reactivated. 
 

Scroll 
The scroll bars serve to navigate in the arrangement. This enables the visible section 
of the arranger to be moved. 

 

The zoom level may be changed via the horizontal scroll bar by clicking the bar's edge 
and dragging. 

 

Tip: To zoom and scroll, it is recommended to use keyboard shortcuts (view page 
336). 

 

Snap/Grid 
The project window features a frame-exact snap grid. This ensures that video and 
image objects snap exactly to the borders of a frame. 

The step size depends on the frame rate specified in the movie settings ("File -> 
Settings -> Movie"). Choose between Europe's conventional frame rate for PAL (25 
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frames per second) and America's and Japan's conventional frame rate NTSC (29.97 
frames per second) or any other manually set frame rate. 

 

When moving an object, the position display indicates at which frame the first image 
of the object is shown. 

 

The position is displayed in the form of a 
tooltip when moving the object.  

This information is displayed in the form 
"Hours:Minutes:Seconds:Frame". 

 

Note: Audio objects can be moved by exact samples. This means that they do not 
snap to the frame grid if they are not grouped with a video object. 

In addition to the constantly active frame grid, an object grid can also be activated. 
This ensures that two consecutive objects will seamlessly snap together even if they 
are on different tracks. This avoids undesired gaps or overlaps. 

 
The object grid can be activated/deactivated using the magnet symbol in the 
lower toolbar. 

 

Preview rendering 

 

You can access the preview rendering options by pressing this button. 
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Media Pool 
The structure and functioning of the Media Pool is similar to Windows Explorer with 
the only difference being that the Media Pool only displays usable files. This is used to 
access and load multimedia files of all kinds: photos and other image files, video files, 
audio files, transitions, titles, effects, and also complete projects. 

 

Note: The Media Pool displays the files on your hard drive. If you delete files here, 
you won't be able to find them again using Windows Explorer. 

If you hover the mouse pointer over a media file, three icons for the options will 
appear: preview, range import and complete import. 

 

• Preview: All available media can be previewed using the preview function. If you 
click on the playback icon, the file will be played back in the preview monitor. 
Video and image files are displayed and audio files are played back through the 
sound card. There are previews for the templates and effects included to make it 
clear how they will function.  

• Range import: You can define an import range using buttons for setting an in- and 
out-point in the source monitor. 

• Complete import: This button will import the complete file into the project 
window. 
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When importing using the import buttons, you can set (view page 46) various 
insertion modes.  

You can also load files from the Media Pool by dragging & dropping them. You can 
even drag & drop entire folders into the project window. If you want to load several 
files simultaneously, you first have to select them in the Media Pool.  

• Click on the selected entries one after the other while holding down "Ctrl".  
• If you want to load a sequence of files, hold the "Shift" key and click on the first 

entry and then on the last. All entries in between will be selected.  
• By holding down the left mouse button you can drag out a selection box over 

multiple image files to select them. "Ctrl + A" selects every entry contained in a 
Media Pool folder. 

Tip: Improve access to your media folder by creating a link in the "Import" area of 
the Media Pool. You can do this by right-clicking on one of the entries and selecting 
"Create link". Select the media folder and click "OK" to confirm. 
Note: All links are automatically deleted if the function "Reset standard program 
settings" ("Edit" menu > "Settings") is used. 

 

Preview function 
A preview function for all of the files in the Media Pool can be started by double 
clicking or by pressing the playback button on the source monitor. 

The transport control function in the source monitor allows you to select sections 
from a longer video file in the Media Pool and load them. Read the "Add objects into 
the project" (view page 62) section. 
 

Importing 
Navigation buttons 
The navigation buttons let you navigate through your computer’s drives and folders.  

Forward/ 
back  

These buttons access the previously viewed folders.  

 

Higher 
directory  

This button accesses the next highest folder level. 

Folder tree 
 

Here you can activate a folder tree to navigate through 
your computer system. 

 

Search 
 

The search function allows you to find specific files 
quickly. You may specify your search according to file 
type, date, or certain folders. 
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Browse 
history list 
and path 
details 

 

 

The path information for the current 
folder is displayed in the center above. 
Use the arrow button to open the menu 
to find the folders you previously visited. 

 

Options All functions of the context menu (switch views, 
rename, or delete files, etc.) can also be accessed 
via the options button. 

 

Display 
options  

Settings for how detailed the entries should be listed 
may be specified here. 

Zoom 
 

A zoom slider can be used to set the number and size of 
visible symbols in the "Large symbols" view. 

 

Search 
The Media Pool has an easy search function for finding files on the computer. It may 
be activated and turned off again with the shown button. 

 
 

File name: Enter any part of the name of the file you are looking for in the "File name" 
field. The X symbol deletes the entry. A "?" may be used as a placeholder for a single 
character, and "*" for any number of characters. 
 

File type: Here you can enter a file name extension. Multiple entries are separated 
using a semicolon. Below the entry field, various presets may be selected for often-
used file name extensions. 
 

Date: Here, you can set time period limits on your search. Choose an entry from the 
list. 
 

Folder: If you don't want to search the entire computer, but only look on certain drives 
or in a single folder, you can define a certain search path. 
 

Search depth: Here you have various options that determine whether additional 
locations should be searched. 

• Search indexed locations and the selected folder 
• Search indexed locations, the selected folder and personal files.  
• Search indexed locations, the selected folder, personal files and the project file. 
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"Indexed locations" are folders, which are searched and cataloged in Windows via the 
index list. If the index list is activated, the files in the indicated folders will be indexed 
while the computer is idling, so that the user's search query may be completed faster. 

Note: In Microsoft Windows XP, the indexing service is usually deactivated by 
default. The search functions in Windows Vista® may be installed with the current 
version of "Windows Search". They make it possible to easily add to the indexing 
service. Please refer to the installation instructions from Microsoft. 

 

Computer 
The link button "Computer" displays the drives in the Media Pool. All drives will be 
listed along with their drive letters and can be opened with a double click. 
 

User directory 
The second button featuring the user's name opens their personal folder in the Media 
Pool. 
 

My media 
The "My media" button lets you select "Projects", "My videos", "My music", "My 
images", and "Recordings". 
 

Projects: Here you can switch to the folder where your projects and films are usually 
stored. 

You will find the "Show project contents" function in the context menu of a project. 
Using this function, you can display all objects of a project and copy them into the 
current project, retaining the editing and effect state of the object. This means that 
you don't have to edit the objects again to keep the status of the "old" project. But you 
can certainly continue editing the transferred object. These changes will be then 
saved in the current project. 
 

My videos: Displays all usable files found in "My documents\My videos." 
 

My music: Displays the contents of the "My Documents\My Music" folder. MAGIX 
Music Manager also suggests this folder for importing your music collection into the 
database. 
 

Slideshow music: This features the music that is included for dubbing. 
 

My pictures: Switches to the "My documents\My pictures" folder. This folder is often 
used by digital cameras and scanners to store transferred images by default. The 
included MAGIX Photo Manager program also uses this folder (e.g. during image 
import). 
 

Recordings: MAGIX Video Pro X6 specifies standards for all recordings. 
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MAGIX tools 
The "MAGIX tools" link selects links to "Downloads", "Database", "Online Album", 
and "Internet Media". 

XAR animations: Here you will find various elements, which you can design with the 
help of Xara Designer Pro and use in your projects. As soon as you drag one of the 
elements into the Timeline, Xara Designer Pro will automatically open with the 
corresponding element. You can find additional information about Xara Designer Pro 
at http://pro.magix.com. 

Downloads: This buttons gives you access to media files downloaded with Catooh. 

Data base: This button opens the program-spanning database view. Right clicking 
opens the database search. The database first has to be created using the supplied 
additional program, MAGIX Photo Manager. 

Online Album: With this button you can access MAGIX Online Album directly. This 
provides a shortcut to uploading and deleting data. To do this, you must first register 
on MAGIX Online Album.  

There are many ways to upload data: 

• While holding "Ctrl" down, select the data to be uploaded in the Media Pool, and 
select "Copy" in the context menu (opened by right clicking). Switch to the 
MAGIX Online Album screen, open the desired folder, and select "Paste" in the 
context menu. 

• In the Media Pool, click on "Online Album", and go to the desired directory. Open 
the Windows Explorer, select the desired data with "Ctrl" held down, and drag it 
into the Media Pool. 

Both options will result in your desired data being uploaded to your MAGIX Online 
Album. 

Note: This function requires Internet access. To gain access, make sure you have 
your log in information (email address and password) ready. 

Internet media: Opens the integrated browser (view page 332) from MAGIX Video 
Pro X6. It offers you the option of collecting media directly from the Internet, for 
example  for use in your current project. 
 

Transitions 
Here you can find all transitions from MAGIX Video Pro X6, sorted into various 
categories. One click on a category displays all of the transitions that are contained. 

To load a transition, drag it with a held-down mouse key onto an object. 
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You can find additional information in the "Transitions" section of the "Objects (view 
page 98)" chapter. 
 

Title 
This displays the title settings and the title editor. These presets are sorted into 
different categories and may be loaded by double-clicking or drag & drop. The 3D title 
templates are also located here.  

The text featured by title objects may be changed directly in the program monitor by 
double-clicking. 
 

Effects 
This provides access to the effects that are sorted into the various categories. Read 
more about this in the chapter "Effects" (view page 122). 
 

Video effect templates 
Here you can find pre-configured effect templates that can be dragged-and-dropped 
onto a video or image object. These effect templates consist of a combination of 
various effect settings which you can adjust in the appropriate effect dialogs. 

In the "Video mix effects" subfolder you will find templates for mixing two video or 
image objects. To do so, two video or image objects have to lie on two tracks directly 
above or below the other. To use a mix effect template, drag on the lower object. 
 

Video effects 
Here you can find adjustable effects for video and photo objects. The effects can be 
set only after selecting an object in the respective effects dialog. For more 
information, go to the "Video effects in the Media Pool" (view page 125) section in the 
"Effects" chapter. 
 

Movement effects 
These are movement effects you can use to animate the frame by using zoom or 
camera movements. For more information go to the "Effects" chapter, section 
"Movement effects in Media Pool" (view page 134). 
 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D". (view page 163) 
 

Audio effects 
Here you will find many audio effect templates such as echo, reverb, equalizer, 
compressor, etc. Read the "Audio editing" (view page 179) for more information.  
 

Design elements 
Collages: work similarly to picture-in-picture effects, but employ multiple objects. 
Depending on the collage, arrange the selected objects one after the other and drag 
the collage onto the first object. 

Test images: Professional test images are available to calibrate your system. 
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Backgrounds: The color fields are a collection of various backgrounds that can be 
used to create your own color fades or as backgrounds for text. The special "User" 
template opens a color selection dialg where you can choose the desired color. 

Image objects: Here you will find various image objects such as black bars, arrows 
and symbols for illustrations. 

You can find additional information in "Effects" chapter, in the section "Design 
element in Media Pool". 
 

My Presets 
Here you will find the folder for your own effect templates. For more details, please 
read the "My Presets in Media Pool" section in the "Effects" chapter (view page 142). 
 

Additional Effects 
Here you will find all available effect plug-ins. Please read the "Additional effects in 
the Media Pool" section in the "Effects" chapter. 
 

Various file list view modes 
All supported multimedia files and subfolders of the currently selected folder are 
displayed in the file list. Three different views (list, detail, large symbols) can be set by 
right-clicking on the Media Pool context menu. 

 

List: Only file names are listed. This view mode 
displays the most files simultaneously. 

 

Details: For each media file, its type, size and date 
of last change will be displayed next to its name.  

 

Large symbols  can be quite useful because they show a 
preview frame for each movie and picture file. This allows 
you to sort through the material quicker.  

As soon as you activate this display, the zoom function will 
appear. With it, you can additionally magnify thumbnail 
images. 
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Project folder 

 

The project folder is a type of clipboard for files or objects. The possible applications 
in this case are diverse: 

• Material storage: Interesting files from the Media Pool can be combined in the 
project folder before loading them from there into the project.  

• Cutting: You can cut different sections from longer videos in the project folder in 
order to use them as separate objects in the arrangement.  

• Exchange: You can move finished objects from the arranger into the project folder 
in order to use them in other projects. 

The project folder supports drag & drop in either direction which allows you to move 
elements from the project folder into the arrangement or move objects or object 
groups from the arrangement into the project folder. 

The context menu (view page 328) for project folder elements enables these to be 
saved individually as takes (*.tk2) in order to use them in other projects again; the 
entries may also be renamed. 

 
Opens the import dialog. As an alternative to dragging & dropping from the 
Media Pool, this dialog enables a file to be loaded into the project folder. 

 

 
Save or load the contents of the entire project here in order to use it in 
other projects. 

 

 
This adds a virtual folder to the project folder. No additional subfolders can be 
created inside a folder. 

 

 
This button accesses the next highest folder level. 

 

 
Search field: MAGIX Video Pro X6 searches through all file names 
in the project folder for the text entered and then lists the results. 
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Settings for how detailed the entries in the project folder should be listed can be 
made here. 

 

Program and source monitor 
MAGIX Video Pro X6 features two preview monitors: A program monitor for object 
image output in the project window and a source monitor for previewing files in the 
Media Pool or project folder. 

 
 

Setting up the preview monitor 
Program and source monitors can be set up in various ways: 

• The size of each monitor can be adjusted. This can be done by clicking the screen 
with the right mouse button and selecting the desired size from the context 
menu, either from the presets submenu or user-defined ("Other resolution").  

• Every monitor can be positioned freely. To do this, click on the top bar of the 
monitor window and drag it with the mouse button held down to the position you 
want. This may be a separate monitor, for example, where you can maximize the 
window. 

 

Fullscreen view 
The option "Video monitor fullscreen" in the context menu maximizes the monitors. 
Alternatively, you can simply double-click on one of the monitors or select the desired 
monitor with a mouse click and press Alt + Enter. 

You can also shift the monitors in full screen mode and access the context menu 
(right mouse button). There, you can also hide and display the transport control, apart 
from the regular entries. 

Tip: Using the "Edit video effects" option in the context menu you can display Media 
Pools effect settings and edit effects directly inside the fullscreen display. 

"Esc" returns you to the normal view (or click on "smaller" button to the right in the 
fullscreen mode). 
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Movie overview 
The option "Movie overview" in the "Window" menu enables an overview of the 
entire project. All objects in the project window are displayed in the program monitor. 
The overview display is especially recommended for working on long movies because 
the reduced overview in the program monitor can be combined well with the zoomed 
detailed view in the project window. 

The movie overview can be used for moving around in the movie and editing specific 
parts: 

• When you click on a particular object in the program monitor, the project window 
will zoom into the object. 

• When you drag on a border in the program monitor, the project window will 
zoom into the corresponding area. 

• When you move the playback marker in the program monitor, the playback 
marker in the project window will also move correspondingly. 

Tip: If you use this option very often, try using the corresponding keyboard shortcut 
(Shift + A). 

 

Monitor zoom 
The preview images of both monitors may be zoomed in and out to examine specific 
details in the image more closely (zoom in) or to reduce the image so that black 
edges result for use of animations (view page 151). 

• Click on the preview monitor and zoom out of the video image by holding down 
"Ctrl" and using mouse wheel.  
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Transport control 
Both transport controls enable the video material to be played back. 

 
 

 Range: Change the range between the in and out points by 
clicking above the playback functions. 

 

 
Playback marker: This marker indicates the location of the image 
currently displayed on-screen. 

 
Set in/out points: Defines the start and end of the playback range. 

 
To the start: This button sets the playback marker to the start of the 
current area. 

 
Playback by a frame: This button sets the playback marker just behind 
the current frame and plays it back. 

 
Play/stop (pause): The playback button in the middle starts playback. 
A second click ends playback. 

 

Tip: In the menu "File -> Settings -> Program -> Playback", you can set whether the 
playback marker will go back to the start position (stop) after the second click or 
following the appropriate shortcut (space bar), or if it should stay at the current 
position (pause function). 

 

 
Range playback: This button plays back the current range. 

 
To the end: This button sets the playback marker to the end of the current 
range. 

 

 Jog wheel: Using this wheel, you can move by single 
frames within the video and position the playback 
marker exactly at high zoom levels. 

 Shuttle control: The further the slider control is moved 
to the side, the quicker the arrangement is played in the 
corresponding direction. This way a certain position can 
be reached quickly. 
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Preview quality button 
If performance deteriorates due to hardware limitations, high-res source material or 
project complexity, you can "activate" a smoother preview during editing using this 
function. 

In the selection menu, you can set which functions 
you want to use for the optimized preview when 
this button is activated: reducing resolution, 
reducing frame rate, deactivating plug-ins and/or 
effects. 

"Reduce resolution" and "Reduce frame rate" are preset. 

If you have activated the proxy file function in the start dialog or in Movie settings 
(view page 246), you will additionally see "Use proxy objects".  
 

Adjusting the workspace 
The source and program monitors, the project folder, the project window and the 
Media Pool can be shut off completely or freely repositioned. Your own configurations 
in the "Edit" interface can be saved by going to "Window" > "Workspace" > "Save...".  

The first three user-defined window layouts are automatically assigned the keyboard 
shortcuts F10, F11 and F12. By going to "File" > "Settings" > "Keyboard shortcuts..." you 
can assign keyboard shortcuts (view page 343) to additional layouts. 

Tip: The keyboard shortcut Ctrl + F9 can be used to switch between the current 
interface and the last one you used even if it was not saved.  
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The "Burn" screen 

 

1 Menu preview: Here you can see a selection menu preview. For more 
information, read the "Edit disc menu" (view page 288) chapter. 

2 Switch views: Here you can switch between preview and edit views. 
3 Remote control: Here you can check how your future disc will react when you 

press the buttons of your player's remote control. 
4 Output:Before burning the project, select the desired format. 

5 Play preview: Play the preview menu and test how it works with the remote 
control.  

6 Template category: Select the desired section from various categories with 
different menus. 

7 Menu templates: Switch between different templates for designing your menus. 
8 Use templates: Here you can select whether a template should be assigned to a 

page, the menu or all menus on a disc. 

You will find more information in the "Burning" (view page 227) section. 
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Video recording 

Select the recording method 

 
To start recording, click on the red "Record" button below the preview monitor. 
 

The following selections are possible: 

 

• AVCHD/DVCPRO/AVC-Intra for AVCHD/DVCPRO/AVC-Intra cameras, as 
well as for digital cameras or video DSLR with memory cards or hard drives as 
well as P2 memory cards for XDCAM. This option may also be used to import 
media from removable storage devices, USB devices, or hard drives as a clearly 
laid-out alternative to the Media Pool. 

• HDV camera: For HDV cameras 
• DV cameras: For mini DV cameras and DV video recorders 
• Video for analog video cameras, analog TV, VCR, webcams and  others. 
• Audio for microphones, cassette recorders, MiniDisc players, record players 

and others. 
• Screenshot: Records directly from the computer monitor. 
• Frame for snapshots or image series from analog video cameras, analog TV, 

VCRs, webcams and others. 
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AVCHD/DVCPRO/AVC-Intra 
This option accesses a universal import dialog that is not only suitable for AVCHD, 
DVCPRO, or AVC-Intra cameras, but also for external hard drives, P2 memory cards, 
photo, and movie cameras that contain usable files equally. MAGIX Video Pro X6 
automatically recognizes the file structures and shows only individual takes, making 
import convenient and easy. 

Alternatively, these drives may also be controlled directly via the Media Pool. The 
import dialog also features its own display filters and additional options for 
convenience. 

Note: DVCPRO and AVC-Intra import is optional and must be activated (view page 
344) for a fee. 

 

Connect camera 
Suitable cameras are essentially available in three varieties: 

• Cameras featuring removable data storage: These cameras have a slot for a 
memory card. Your computer should have a card reader for the corresponding 
memory card, which you can then remove from the camera and insert into the 
card reader. Different camera models can also be connected via USB. 

• Cameras which burn DVDs directly (usually 80 mm diameter instead of the 
regular 120 mm): The DVD can simply be taken out of the camera and inserted 
into the computer. For so-called "Slot in DVD" drives, look beforehand in the 
operational manual whether or not 80 mm DVDs (also called 3" DVDs or 
MiniDVDs) are acceptable. 

• Cameras with built-in hard drives: The camera will respond as a drive as soon as 
it is connected via a USB cable to the PC. This additional drive will appear in 
Media Pool. 

Hint: The listed options and procedures reflect our experience with what works. Still, 
we recommend you read the camera's manual for the exact sequence of actions and 
contact the manufacturer in case of problems. 

 

Import 
The option "AVCHD/DVCPRO/AVC-Intra" does not produce a recording as such, 
but rather "only" the transfer of the already created video file and its integration into 
the existing project.  

On older systems, it may be helpful to transfer AVCHD files into the MPEG-2 format 
during import. A corresponding query appears automatically as these files are 
imported. 
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Note: During AVCHD import, it is necessary to activate (view page 344) the MPEG-
4 codec and Surround Sound Stereo/5.1 for copy protection reasons. MAGIX Video 
Pro X6 offers this option as soon as the codec is required. 

After you have selected a recording option, the following dialog opens. 

 

Video source: Navigate to the drive that corresponds to the attached AVCHD camera 
here. 

Save in following folder: Create a target folder for the files to be imported. 

Advanced settings: Adjust various settings for the name and date of the files to be 
created. 

Preview monitor and transport console: Play and rewind the clips in the file list here. 

Medium/General: An info area for the files is provided to the right next to the 
preview monitor. 

File list: The contents of the selected drive are shown here. Use the display filters to 
reduce the types of files shown. You can select every file separately using the little 
check boxes in order to import them later. At the top right of the list you can find 
options for displaying the files. 

Note: The files are color-coded. The colors indicate recording times, so that you can 
quickly recognize which recordings were made at the same time. 

Select: This offers self-explanatory options for file display ("all", "only new", or 
"none"). 
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Display filter: Here you can choose whether to view "Movies" or "Photos". With the 
option "Show only selected", all non-selected elements will be hidden. You should 
only use this option if you've already selected elements. 

Insert into movie: With this option active, media will be inserted directly into the 
MAGIX Video Pro X6 project window as objects. When inactive, they will be simply 
copied into the target folder and can be selected from the Media Pool at any time. 

Delete all media after camera import: This option deletes the selected media after 
importing from the camera. 

Import:  Starts the import process of the selected files into the target directory. 

Cancel: Closes the dialog without import. 

Tip: The AVCHD import dialog is basically a universal import dialog, appropriate for 
external drives, photo or video cameras, containing usable files. If you find the 
display filters useful for your camera as well, nothing stands in the way of 
connecting the camera to the computer and then activating AVCHD recording in 
MAGIX Video Pro X6.   

 

HDV camera 
Use this option to open the HDV camcorder record dialog. To do this, you have to 
connect an HDV camcorder. 
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The options in this dialog can also be found above in DV recording. 
 

DV camera 
Connect a DV or HDV camera 
• Connect the digital output of the switched-off camera with the computer's DV 

interface (also called FireWire or iLink). 
• Insert a DV cassette or the storage device into the camera. 
• Switch your camera’s operating mode to "Video recorder" or "Playback". 

The camera is now ready to transfer video to the computer. 
 

Note: You may also use a HDV camera in DV mode to, for example, transfer 
recordings in the old DV format. We have noted problems with this mode in many 
cameras, and therefore recommend that the Record mode of the camera is also 
switched to DV, switching the camera off and then on again. 

 

Capturing DV recorders or cameras 

 
To start recording, click the "Record" button below the source 
monitor. 

• Select "DV camera" from the recording dialog. Uncompressed DV capture 
requires approx. 220 MB per minute of video. If you would instead like to record 
using the more space-saving MPEG format, then you should first activate the 
"Record DV as MPEG" option. 

 

• This opens the actual recording dialog. Check to see if a DV camera driver has 
been selected. 
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• Name your recording. It's worth choosing a logical name which will allow you to 
find it easily again on the hard drive. 

• You can access the appropriate place on the camcorder tape by using the remote 
control buttons: shuttle forwards, backwards, and start/stop playback. To start 
recording, click on the "Record" button. Keep an eye on the remaining hard drive 
space. 

• Cease capturing with the "Stop" button and exit the record dialog. You can see 
the recording in the film-strip in the lower third of the screen. 

Tip: In the DV recording dialog, you can set clips from the DV video which then will 
be recorded one after the other (batch capturing). Read more on this in the chapter 
"Batch processing" (view page 73). 

 

"DV capturing" dialog 

 

Note: Keep an eye on the available hard drive space before each recording. DV 
capture requires approx. 220 MB per minute of video! 

 

Select DV device driver: The device driver for your DV device should be listed here. If 
"Record audio" is deactivated, then video without sound is recorded only. "Audio 
preview" activates the audio output of the recording. 
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Note: The audio preview is deactivated at first, since DV cameras usually include 
built-in speakers. 

 

Save movie file as/save in folder: Enter the name of the movie to be recorded. You 
can also select the folder where you wish to store your video file. The default 
recording directory is set by default, but you can change the Path settings under menu 
item "File -> Program settings -> Path settings". 
 

Edit after recording: This provides access to the automatic editing options. 
 

Start the DV device automatically: Starts the DV recorder or DV camera 
automatically when the "Record" button is pressed. This does not function with all 
digital cards/video devices. 
 

Video preview: On the preview monitor you can see a preview of your movie. 
 

Original size: This option allows you to preview the video in the original size. To 
return to the dialog use the "Esc" key. 
 

Recording list 
Set the start and end points for the capture here. This allows you to search the entire 
video for all captures to be used and list them for planned batch capture. This is then 
processed in sequence when the recording starts (via the red button). That way, you 
don't need to record each scene individually. Simply specify the recording time points 
and the computer takes care of the rest. To set precise start and end points, click 
"Enter start/end point (view page 74) 

 

Record list: Press this button to view the available list of already 
recorded videos and scheduled recordings. All entries from the 
list may be selected and deleted.  

Every batch recording is automatically logged. Conversely, every 
"manual" DV and HDV recording is transferred into the 
recording list in order to restore lost recordings without much 
effort.  

Batch recording: Here the start and end points can be set for the 
capturing. This allows you to search the entire video for all 
captures to be used and list them for planned batch capture. 
This is then processed in sequence when the recording starts 
(via the red button). That way you don't need to record each 
scene individually. You simply determine recording time points, 
and the computer takes care of the rest. To set the start and end 
points precisely, click "Enter start/end point (view page 74)" 
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Record: Starts the recording process. Also contains the list of scheduled recordings. 
These are processed step-by-step (batch capturing). 
 

Stop: Stops the recording process. 
 

Snapshot! With the Snapshot! button, you can create a frozen image directly from the 
preview monitor. Start the camcorder and watch the preview window. When the 
image you want appears, click "Snapshot". Or you can navigate using the remote 
control to the position you want, and stop there in Pause mode. Stopped playback on 
the DV camera will not deliver an image! The images are saved in the record directory 
as graphics files in the set resolution.  
 

Remote control 
MAGIX Video Pro X6 also supports remote controls for most digital camcorders. This 
does not function with all digital cards/video devices. If your hardware does not 
support the remote control function, the buttons will not be usable. 

The transport controls required for this are featured in the DV or HDV recording 
dialog. 

 
 

Tape title: Enter a name for your tape here. MAGIX Video Pro X6 requires this name 
for the DV logging feature. 
 

Recording information: Displays various information about your recordings. 
 

Set recording start/end point: Enter the exact start and end point or the recording 
length for a scene. 
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Both values can be entered as ATN (absolute track 
number) or as a timecode in 
hours:minutes:seconds:frames. 

 
 

DV as MPEG 
This recording selection dialog option allows you to transfer DV recordings directly 
into the space-saving MPEG format on the harddisk. 

 

From the "DV as MPEG" dialog window you can find 
MPEG encoder settings options under "Advanced". 
You can also burn your DV material direct to disc 
without any intermediate steps. 

 

Recording list 

 

Set the start and end points for the capture here. This allows 
you to search the entire video for all captures to be used and 
list them for planned batch capture. This is then processed in 
sequence when the recording starts (via the red button). 
That way, you don't need to record each scene individually. 
Simply specify the recording time points and the computer 
takes care of the rest. To set precise start and end points, 
click "Enter start/end point (view page 74) 

Record list: Press this button to view the available list of 
already recorded videos and scheduled recordings. All 
entries from the list may be selected and deleted.  

Every batch recording is automatically logged. Conversely, 
every "manual" DV and HDV recording is transferred into 
the recording list in order to restore lost recordings without 
much effort. 
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Logging 
Logging means that MAGIX Video Pro X6 also saves the original save location, 
position and additional information (metadata, e.g. scene, take, rating, comments, 
etc.) about DV video and audio files. 

Everything copied using DV recording, DV to MPEG recording and HDV recording 
appears in the recording lists of the corresponding recording dialog. Recordings for 
which the corresponding video material is no longer on the hard disk will appear as 
"planned recordings". 

If MAGIX Video Pro X6 does not find the corresponding DV and WAV files during 
the loading of a video, it will ask that the corresponding DV tape is inserted into the 
connected camcorder again for automatic scene import. 

You no longer have to save DV AVI and audio files (which can be very large). If at a 
later time you would like to work on a film again, but do not have the space to keep 
the material for it on your hard disk, then you can simply delete the bulky DV AVI and 
audio files. 
 

Video 
This option allows a video recording to be made from analog sources. 
 

Connect analog video source 
Connect the video out of your video camera, DVD player or VCR to the video in (TV, 
video, or video-in graphics card) of your computer, and the audio out to the line in of 
your sound card. 

Due to the variety of device configurations, it is difficult to say which cable will 
function best with your setup. If you’re not sure, check the manual of your VCR or 
your TV-, video- or graphics cards. 

Example: Many VCRs have a SCART output and most DVD players have three RCA 
outputs (two for the stereo track, one for the image). In such cases, you will need a 
SCART to RCA adapter, a cable with 3 RCA plugs at each end. 

   

SCART/RCA adapter Scart/RCA adapter with 3 
RCA jacks 

Stereo RCA/mini phone jack 
adapter 
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Most sound card inputs are mini stereo jacks. To connect the audio out of your VHS 
recorder to the sound card audio in, you will need a stereo RCA/ mini phone plug 
adapter. 

You will have to purchase a cable with three RCA plugs and a stereo RCA/mini phone 
plug adapter. 
 

Record dialog 

 

Video/audio driver: Here you can make settings to you video or sound card before 
recording. In practically every case the driver software supplied with the hardware 
must be installed. 

Input/tuner settings: Supports your video recording card with multiple sources; in 
cases when a TV tuner or multiple inputs (SVHS, composite...) are available, you can 
select the source to be recorded and the correct TV channel. 

Save video file as/save in following folder: Enter the name of the movie to be 
recorded. You can also select the folder where your video file should be saved. The 
standard recording folder is set as default. The location of this folder may be changed 
via "Path settings" under "File -> Program settings -> Folders". 

Edit after recording: This provides access to the automatic editing options. 

Recording quality: You can select among various recording qualities depending on 
intended use of the material and computer performance. These are sorted according 
to picture quality. Use Configuration to fine-tune the quality for the preset. Presets 
you have created yourself appear in this list as long as you use the default folder 
provided as the save location. 
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• Presets displayed with MPEG record directly in MPEG format. 
• The preset "AVI: user-defined" enables AVI videos to be recorded via the codecs 

included with MAGIX Video Pro X6. There are several codecs for various 
applications, e.g. "MSU Screencapture Lossless Codec", which is used for screen 
capturing. Please pay attention to the general advice for AVI videos (view page 
347). 

Tip: Use MPEG presets if you want to burn your recordings immediately after 
recording, because thanks to the so-called "Smart Encoding" additional lengthy 
encoding after recording won't be necessary. 

Advanced...: Opens the video driver settings dialog. 

Recording control: Here you will find the red record button and the stop button. Using 
them, you can start and stop recording. 

Timer recordings active/time limit: Specify the recording start time and length to 
turn your PC into a fully functioning VCR. 

Snapshot!: With Snapshot! you can create a still frame directly from the preview 
monitor. The images are saved in the recordings folder as graphics files in the 
resolution you have set. 

Recording information: Here you will find statistics about recording time, available 
disk space, recorded frames and "dropped frames". Dropped frames are frames that 
have been left out because the computer is too slow for the selected image format 
and recording quality and cannot accept all incoming frames. 

Preview: With some graphics cards, system strain can be reduced by switching video 
preview off. If you hear an "echo", deactivate the audio preview. 
 

Advanced configurations in the video capturing dialog 
Here you can adjust certain settings for the video recording driver. 

These dialog boxes, so-called “property sheets,” come with the video card drivers. 
These driver-specific performance properties may deviate depending on the cards. 
We also have a very limited influence on the behavior of these drivers. If you 
encounter any difficulties, please contact the video card manufacturer for the latest 
driver updates. 

Source: Sets the crossbar of the video card. 

The crossbar determines which video and audio input signal will be recorded. The 
crossbars are connected in series to the video recording chip itself. In the output field, 
the video output (for the crossbars) is the input for the recording chip (video or audio 
decoder-in) of the video card. In the “Input” field, select the signal source that will be 
used by the video card to capture for this input. Many video cards have separate 



 

Video recording 79  

 

crossbars for audio and video. If you have a problem, try out the different 
configurations until the right sound matches the right image. 

Composite-in = the normal video input (typically a cinch jack) 
S-video = S-video input (mini-din jack) 
SVHS-in = SVHS input (special cable) 
Tuner-in = TV signal of the integrated tuner 
 

Display 
Video decoder: If the picture only appears in black & white or it flickers, the video 
standard may be set incorrectly. In mainland Europe, PAL_B is used. 

VideoProcAmp: Fine-adjustment of colors, brightness, contrast etc. We recommend 
against changing any of the manufacturer’s settings. 

Format: Please do not change anything here. The capturing format is set in the 
"Recording quality" option in the video recording dialog. 

Station selection 
This option is only available if a TV tuner is integrated into your video card. 
 

Audio 
Songs, noises, or instruments can be easily recorded in MAGIX Video Pro X6 using 
the audio recording function. A hooked-up microphone or various audio devices 
(especially a stereo system) can be used as recording sources. 
 

Connecting the source for recording 
First of all, the source of the audio material must be connected to the sound card 
input. Again, there are several possibilities which primarily depend on the type of 
equipment you have. 

If you are recording from a microphone, then please connect the microphone to the 
microphone jack on your sound card (usually red). 

If you want to record material from a stereo system, then you can use the line-out or 
AUX out jacks on the back of your amplifier or tape deck. This involves connecting 
them to the sound card input (usually red).  

If your amplifier has no separate output (other than for the speakers), then you can 
use the connection intended for headphones for your recordings. In most cases, you 
will need a cable with two mini-stereo jacks. This type of connection has the 
advantage of being able to set the headphone input signal level with a separate 
volume. As headphone connections generally are not the best, it is advised that you 
use the line outputs if possible. 
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When recording cassettes from a tape deck, you can connect the tape deck's line out 
directly to the sound card input. 

When recording from vinyl records, you should not connect the record player's output 
directly with the sound card because the phono signal needs to be pre-amplified. A 
more suitable method would be to use the headphone connection or an external pre-
amp. 
 

Adjusting the Signal Level 
Adjusting the signal level to the sound card is also recommended to get the best 
sound quality during digital recording. 

Once a recording source is connected to the sound card, the "Record" button opens 
the recording dialog and starts the recording source. 

You can now adjust the recording level with the help of the LED display in the 
recording dialog. For this, you must first check off "Show Levels". 

If the adjustment is set too high, distortion occurs and the incoming signal must be 
reduced. If you have connected the source through either an amplifier or tape deck 
output to the sound card, you can only reduce the signal level in your sound card’s 
software mixer interface. You can access the mixer directly from within the recording 
dialog via the “Recording Level” button. 

If you reduce input sensitivity by using the input fader, the resolution at which the 
analog signal is digitized is also reduced. Try to set these automatic controllers to the 
loudest sound level possible. 

The maximum setting for an optimal level is the loudest part of the material. The 
loudest part should be adjusted to be the maximum. The actual recording begins 
when you press the "Record" button.  At the end of the the recording you will be 
asked if you want to use the recording. Upon confirmation, the newly-recorded 
material will be placed at the next free position of the start maker in the arrangement. 
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Audio record dialog 

 

Audio driver: Selects the sound card for the recording. 

Save audio file as/ Save in folder: Here you can select the title of the audio file you 
wish to record. You can also select the folder where you wish to store the file. 

Recording quality: Sets the sound quality of the recording. In the preset menu you can 
choose between medium wave radio ("AM tuner"), UKW ("FM Radio"), DAT (Digital 
Audio Tape) and CD quality. 

Display Volume control: Using the peakmeter, you can monitor the level of the 
incoming signal. Please read more on this in the chapter "Adjusting levels" (view page 
80) 

Record: This button starts the actual recording. 

Stop: Click this button to stop recording 

Normalize after recording: With this option activated, your material's volume is 
raised to a proper level after recording is completed. In order to achieve good results, 
you should try to record the source as loud as possible without overmodulating it. To 
do so, refer to the peak meter reader in the recording dialog. 

Play while recording: This option is particularly important for spoken commentary, 
etc. If activated, the selected movie (or selected scene if recorded in the "Edit" screen) 
is played while recording. This acts as orientation for the movie. 
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Advanced: Use this button to open a window where you can select from special 
features: 
 

Advanced settings for audio recordings 
• Mono recording: Activate to record in mono. This reduces the required memory 

space in half. Mono recordings are recommended for voice recordings made 
using only one standard mono microphone. 

• Real-time resample to project's current sample rate: Automatically matches the 
sample rate of a new file to be recorded with the sample rate of the current 
movie's sound track (set in the video recording). 

• Automatic volume reduction of other audio tracks ("ducking"): To add narration 
or other sound material to a video that already has sound volume levels set, 
activate the option ”Automatic reduction of sound volume of remaining audio 
tracks”. This automatically reduces the volume of audio objects in the 
arrangement during the recording session (”ducking”). This is achieved using an 
automatically configured volume curve: Before and after the recording, other 
tracks will be faded in or out, resulting in a homogeneous total volume level. 
(Lowering of volume level during spoken comments is also called "Ducking".) 

 

Single frame 
Single frame recording may be used to record snapshots from the connected video 
source. This requires a DirectShow compatible video recording or TV card or a 
corresponding USB device (e.g. a webcam). 

The time control function allows you to automatically take snapshots. This is useful 
for the following applications: 

• to create slideshows using videos 
• for animation films (stop-motion recording) 
• for video surveillance 
• or in time-lapse photography 

The recorded images are added to the current arrangement. 
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Recording dialog 

 

Video source: You may set the video card used to take pictures here. 

Save picture as: Enter the title of the snapshot to be recorded here. Snapshots are 
saved under this name and numbered consecutively. You may also select the file path 
for storage. 

Recording quality: Set the solution for the recording here. This corresponds with the 
resolution options offered on the camera. Use the slider to set the image quality. 
Using higher resolutions results in larger file sizes for each recording. "Reset" resets 
the image quality to the preset value. 

Advanced...: Opens the video driver settings dialog. 

Camera sound during recording: This causes the program to play a clicking sound 
each time a snapshot is taken. 

Record controls: The red record button triggers a snapshot or alternatively a series of 
recordings when using the time control function. 
 

Timer-controlled recording 
Recording interval: When active, starting recording produces a sequence of images. 
Snapshots are saved according to the selected time interval and numbered 
sequentially. For example, if snapshots are taken every two seconds and then inserted 
every five frames into the slideshow, then a ten times accelerated time lapse 
recording will result. 

Photo length in frames: Specifies how long the photos appear in the slideshow. 
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Enhanced single-frame recording dialog settings 
You can adjust certain settings for the video recording driver. 

These dialog boxes, so-called "property sheets", come with the video card drivers. 
The driver-specific features may slightly vary from driver to driver. The MAGIX team 
has little direct influence on the performance of the various drivers. If you encounter 
any difficulties, then please contact the video card manufacturer for the latest driver 
updates. 

Input: Sets the crossbar switch of the video card. This lets you define what video and 
audio signal is used in the recording. The crossbars are connected in series to the 
video recording chip itself. 

Output: In the "Output" field, the video output (for the crossbars) is the input for the 
recording chip (video or audio decoder in) of the video card. In the "Input" field, you 
select the signal source to be used for this input by the video card during recording. 

Composite in = the normal video input (typically a cinch jack) 

S-VHS in = S-VHS input (special cable) 

Tuner in = the TV signal of the built-in tuner 

Video decoder: If the picture only appears in black & white or it flickers, then the 
video standard may be set incorrectly. PAL_B is used in Germany and most European 
countries (France: SECAM; US/CAN: NTSC). 

VideoProcAmp: For fine tuning of colors, brightness, contrast, etc. We recommend 
against changing any of the manufacturer's settings. 

Format: Do not change anything here! The capture format settings can be changed 
under "Resolution" in the "Recording" dialog box. 
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Screen 
Use screen capturing to record everything that moves on your monitor. This process 
is called "screen capturing". 

Use this feature to record your screen content. This process is called "screen 
capturing". 

• Under Recording quality, you will find 
various presets for different 
applications. You can either record the 
entire monitor ("fullscreen"), a frame of 
variable size (e.g. to film the Windows 
Media Player display), or a different 
video player. Click "Configuration" to 
make custom size adjustments. 

Hint: Because many video players work 
with overlay, it is recommended to open 
each player before starting the capture! 
This way switching into "Overlay" mode 
can be prevented. 

Tip: Use the fullscreen preset under "Recording quality". MXV, a video codec 
especially well suited for screen capturing, will be used. 

• Click on the record button in the record dialog. An additional dialog with a red 
record button, a black stop button as well as a frame with dashed bordering 
appears.  

• Activate the option "Record mouse pointer" to record the movements of the 
mouse pointer. 

• If you like, you can deactivate "Animate mouse click", if you don't want to visually 
record it.  
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• Now select the screen area you wish to record, i.e. the screen of the video player 
in which the video is playing. Drag the frame over the area you wish to record and 
adjust its size as required by dragging the edges and corners. 

Note: If you previously selected "Fullscreen", the window will be hidden. 

• To start recording, press the red record button. The recording starts; the record 
symbol appears in the task bar (tray). 

• If you are finished with everything, click on the record button or the stop button 
to stop recording. Recording ends and the recording dialog is visible once again. 

 

Edit after recording 
The "Edit after recording" dialog can be 
opened from the "HDV Camera", "DV 
Camera" and "Video" recording dialogs. 

This dialog offers the these options: 

• Automatic scene recognition: This divides the footage into scenes. Please also 
read the section "Automatic scene recognition" (view page 271). 



 

Video recording 87  

 

• Automatically set chapter markers: Please also read the section "Set chapter 
marker automatically (view page 109)" in the chapter "Edit" in the PDF manual 
(press "F1"). 

Burn project immediately after recording: You can use this option to record and burn 
to a disc in a single step. Simply select the format you would like to burn, insert a 
suitable blank disc into the drive, and press record.  

Note: Make sure that the selected recording quality corresponds with the disc type 
(for DVDs the preset "MPEG DVD"). 

If you use your own settings for MPEG encoding (e.g. half image resolution for long-
play DVDs) make sure that settings for recording and later for burning are the same 
so that no new encoding is necessary (Smart encoding). 

After recording, the program automatically switches to the "Burn" screen, the burn 
window opens and the disc is burned. The last set layout is used for the menu layout 
for the DVD. 

Tip: This function is particularly suitable for handling lengthy projects in one go. You 
can start recording in the evening and have the finished DVD by morning. 

Export for mobile device: The recorded movie is immediately converted into the 
format of the selected mobile device and transferred. The preset in the list field is the 
device which has been selected in the Export video/audio dialog. 

Settings: Opens the Export settings (view page 235) for the selected target device. 
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Objects 
In the MAGIX Video Pro X6 "Timeline" mode you are dealing with objects. The 
general term "object" includes all media types that are present on the arranger tracks. 
The following object types are found in MAGIX Video Pro X6. 

 

Combination objects: Combination objects 
are video objects with an image track and an 
audio track. In the context menu, you can add 
the waveform representation of the audio 
track or add the sound as an independent 
audio object. 

 

Video objects: Video objects include a file 
extension typical for videos (e. g. *.mpg, *.avi, 
*.mxv). Depending on the length of the video 
object, you will see several frames 
representing various positions in your video. 

 

Image objects: Image objects are photos or 
other static images. They have a file extension 
typical for an image (e. g. *.jpg, *.png, *.bmp). 
In contrast to video objects, you'll always see 
only one frame.  
Audio objects: All objects that contain sound 
are considered audio objects. They have an 
extension typical for audio (e. g. *.ogg, *.mp3, 
*.wav). With a right-click you can add a 
waveform display to any audio object. 

 

Title objects: Title objects are created using 
the title editor and contain the text that 
appears in your projects. They have no file 
extensions. 

In the following chapter you can read about what you can do with these objects. The 
workflow for all object types is the same. 
 

Insert object into the project 
Load files 
Files from the Media Pool can be loaded into the project window in various ways: 

• The fastest way: Click on the "Paste" option that appears when you move the 
mouse pointer over the file in the Media Pool. Or you can simply drag and drop 
the file from the Media Pool onto a track. If an object is already present at this 
position, the file is inserted at the desired time position on the next empty track 
below. 
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• Load several files: If you want to load several files, hold down the "Ctrl" key while 
clicking on the entries you want to use. If you want to load a sequence of files, 
hold the "Shift" key and click on the first entry and then on the last. All entries in 
between will be selected. Then you can drag all of the selected files onto the track 
with the mouse button pressed.  

• Use insert modes: You can also use the menu commands of the "Insert modes" 
button. For more about this, read the section "Insert modes (view page 46)" in 
the chapter "Workspaces". 

• Insert through a two, three or four-point edit: These professional insert 
techniques will be dealt with separately later on (view page 101). 

• Project folder: If you want to combine your material separately, using the project 
folder is recommended. It can be used as a sort of clipboard where files that can 
be used in the project are sorted ahead of time. This creates a better overview 
and saves repetitive, time-consuming navigation through folders in the Media 
Pool. 

• Movie as Movie Object (view page 91): All of the movies in the project appear in 
the project temp folder. These movie objects can be loaded into the movie using 
drag & drop. 

 

Files with multiple audio tracks 
MAGIX Video Pro X6 also loads VOB files that contain multiple audio tracks. After 
the VOB file has been loaded, simply click the audio object created and select the 
desired audio track. 

Note: To view and select audio objects in the arrangement, Timeline mode must be 
active. 

 

Scene overview 

 

The “Scene overview” mode is a special view that improves manageability and 
categorization of scenes. All scenes are listed one after the other (in multiple lines, 
like in a text program) and can be copied, cut, moved, deleted and inserted. 
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"Overview" mode does not indicate start, playback, or end markers. The scene which 
is currently being played has a frame around it. 

The zoom slider enables the view 
to be enlarged or reduced. 

This controller also specifies how many scenes are displayed. The smaller the preview 
pictures, the more will fit onto the overview. 

 Maximize: Use this button to maximize the scene overview to fullscreen mode. 

 
 

Load sections from longer video files 
For longer videos, it is recommended to define the areas which should be loaded into 
the project before importing. An in and out point is set to define the area for this 
purpose. This can be done in the following way: 

• Select a file from the Media Pool by double-clicking it. Play it back using the play 
buttons on the source monitor to indicate the section which you want to use in 
the project. 

• You can move the range borders directly by holding down the left mouse button 
or you can set them using the buttons (or the keyboard shortcuts I and O). 
Keyboard shortcuts are particularly useful when setting precise positions with the 
shuttle or jog wheel. 

 

• Click on the monitor image and drag & drop it into the project window. An object 
corresponding to the selected area will appear on the track.  

• You can also drag your selection into the project folder and use it in your project 
later by dragging it from the project folder into the project window. The file in the 
project temp folder in this case has the same name as the original file, extended 
by a running number (001, 002...). 

• You can also drag a file from the Media Pool into the project folder first and then 
cut it from there with the help of the source monitor. The in- and out-points 
created this way will be saved directly when the segment is removed. 

• You can also do the reverse by dragging objects from the project window into the 
project temp folder. If the object should appear both in the project window and in 
the project temp folder, just hold down the Ctrl key. All object-related settings 
(fades, effects, animations) are transferred as well. You can put together different 
edits of one and the same object and store them in the project temp folder for 
later use. 
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Movie objects 

 

  
The movie that forms the basis of a 
movie object 

Movie object within a different movie 

MAGIX Video Pro X6 enables you to use entire movies as single objects in other 
movies. 

Movie objects offer the following advantages: 

• Complete sections are transferred without having to be rendered and imported 
again. 

• Frequently required scenes can be prepared and used as objects multiple times. 
• If changes are made to the corresponding movie, they are immediately applied to 

the movie object. 

Note: If you are using several movie objects that belong to the same movie, any 
changes to this movie will immediately be applied to the corresponding movie 
objects. 

• Movie objects behave the same as video objects. The editing workflow for a 
movie object is also the same as the workflow for a video object. 

Create and import a movie object 

Note: Video files saved separately on the hard drive first have to be opened as a 
normal movie project in order to be used as movie objects. 

1. Create or open new movie to be used as a movie object 
Result: The new movie appears in the project temp folder (see illustration). 
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Tip: Give the movie a distinctive name to make it easier to find in the project temp 
folder. 

 

2. Insert the movie from the project temp folder into the „main movie“ using drag 
& drop (view page 88). 
Result: The movie appears as a Movie Object. The Movie Object can be edited 
in the same way as a Video Object (view page 87). 

 

Select and group objects 
To edit or delete objects using menus, you must first select them. To do so, simply 
click on the object you wish to select. Objects will change color to show that they 
have been selected. 

When the Shift key is pressed, multiple objects are selected. You can open up a 
rectangle positioning the mouse over the object, then holding down the mouse button 
and marking all objects within the rectangle (”elastic band selection”) by left-click-
dragging. 

Any object can be combined with others to make up a group, to avoid the objects 
being unintentionally moved out of relation to each other. Once they are combined, 
clicking on one object of a group will select the entire group. To group or ungroup 
objects, use the buttons in the tool bar or the corresponding commands in the "Edit" 
menu. 
 

Duplicate objects 
Objects may be duplicated very easily. Click on the object to be copied with the 
mouse while holding down the "Ctrl" key. This generates a copy, which you can 
immediately drag to the desired position or cut separately. 
 

Move Objects 
Hold down the mouse button to move selected objects to any tracks and positions via 
drag and drop. It is recommended to place objects that belong together on 
neighboring tracks and to create separate tracks for audio and video objects. For this 
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reason, videos that should overlay each other should usually be placed on the same 
track. 

If the Shift key is pressed, objects can be moved from one track to another, without 
the time position being changed. 
 

Extract sound from videos 
Video with audio material appears in the project window as a combination object 
(audio and video in one object). 

 

In order to edit audio and image material separately, right-click the object and select 
"Audio functions" > "Video/audio on separate tracks" from the context menu. Audio 
and video objects will then be grouped and appear on two tracks. With the "Ungroup" 
(view page 299) function in the "Edit" menu or using the corresponding key, the 
object group can be dissolved.  

Now you can replace the audio or the video track, or process each file separately. Re-
join/regroup the tracks with the "Group" function. 
 

Object handles 
All objects can be re-sized with their lower edge “object handles”. Move the mouse 
over one of the lower corners of the object until the mouse pointer becomes a double 
arrow. Move the mouse over one of the lower corners of the object until the mouse 
pointer becomes a stretch symbol. 
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5 "handles": Length, fade, transparency (volume) 

An object can be faded in or out with the handles to the left and right upper corners of 
the object. Cross-fades between different objects can be created by overlapped 
positioning of objects that are fading in and out. The length of the cross-fade can be 
adjusted with the handles. 

Using the transparency/volume handle located centrally at the top of the object, 
adjusts the transparency of video and Bitmap objects, or the volume of audio and 
image objects.  

If you adjust the middle handle of a video object all the way down, the object will 
become transparent. If a second object is located on a track above it, a black color will 
appear from below it, so that brightness will be reduced. 
 

Object handles for combi objects 
Combi objects have an additional, sixth handle. 

 

• The four outer handles have the same function as with regular objects. 
• The lower middle handle regulates the object's track volume. 
• The top middle handle controls the transparency of the object's image track. 
 

Object borders 
When you place the mouse pointer on a vertical object border, it will turn into a 
double line. 
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If the object doesn't border any other objects, the functionality doesn't differ from 
bottom handles, which means that you can stretch or compress the object. With a 
hard cut or a crossfade, the object transition will be moved, meaning that the object 
start and end of both neighboring objects will remain coupled to each other. 

 
 

Trim Objects 
Trimming provides exact placement of object borders or transitions. MAGIX Video 
Pro X6 has two different trimmers, and these can be opened using the context menu 
for a video or image object. 
 

General advice for operating both trim editors 
Play functions: The trim window contains its own play functions that allow the object 
to be played individually or in relation to the arrangement.  

The right play button plays the arrangement normally. Replays can sometimes appear 
shaky because the processor may be over-worked. Those frames that the processor 
cannot calculate quickly enough are left out.  

The middle play button plays the arrangement “frame by frame”, which means no 
frames are left out. Depending on the processor load, playback may thus be slower, 
but still smooth. 

The left play button renders material before playing, i.e. the current settings are 
calculated first and then exported. This method ensures a smoother playback.  

With the fast forward and rewind functions you can change the range start in the 
timeline. This allows for complete control of transitions between two videos. 

Increments:  A click on the arrow buttons in both trim editors moves the handle or 
the material within an object exactly by one frame. With the Ctrl key you can increase 
the frame rate gradually to 5 frames per mouse-click. 
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Object trimmer 
A schematic display of the selected object and its handles can be found in the center 
of the trimming window.  

 

Fade in/out (4, 5): These buttons adjust the upper fade handles of an object. 

Object content (3): Here you can move the video material to be played without 
changing the object length. 

Position (2): Moves the object on the track. 

First frame/End fade-in (7): Toggles the left monitor between the first frame of the 
object and the end of the transition. 

Start fade-out/Last Frame (8): Toggles the right monitor between the start of the 
transition and the last frame of the object. 

Left/right arrow buttons (1, 6): Here you can adjust the lower object handles. 

Next object/cut (9, 10): The buttons below and to the right skip to the next/previous 
object and/or cut in the arranger. These buttons make it easy to move and trim 
objects in the arrangement without having to leave the trimmer. 

Keyboard Shortcut:  Shift + N 
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Cut trimmer 

 

A schematic display of the selected transition and its handles can be found at the 
center of the trimming window.  

Left arrow buttons (1): These buttons move the last frame of the first object while 
adjusting the second. The length of the transition remains. The display indicates the 
relative change in comparison with the starting situation when the trimmer was 
opened. 

Position (2): Moves the second object. The length of the transition is changed. This 
corresponds with shifting an object in the project window.  

Object content (3): Moves the movie under the second object. The length of the 
object and the object itself are not changed. 

Crossfade (4): Changes the transition’s length between both objects. The objects 
remain of equal length. The length can be numerically entered. 

Middle arrow buttons (5): Shifts the existing transition. Both objects remain in their 
positions, but the transition’s center point moves. 

Transition (6): Displays the type of transition. A mouse click opens a popup window 
from which you can select a transition. 

Right arrow buttons (7): Move the first frame of the second object. The first object 
and the transition remains. Only the length of the second object changes. 

Start fade-out/Last frame (8): Switches the left monitor between the start of the 
transition and the last frame of the object. 

First frame/End fade-in (9): Switches the right monitor between the first frame of the 
following object and the end of the transition. 

Next cut (10)/Next object (11): The buttons below and to the right skip to the 
next/previous object and/or cut in the project window. These buttons make it easy to 
move and trim cuts in the arrangement without having to leave the trimmer. 

Keyboard shortcut: N 
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Transitions (fades) 
When importing video files into the project window, individual objects usually follow 
directly after one another. This is called a "hard cut". However, you can make scenes 
blend or “transition” into each other. 

This means that for the duration of a transition, two objects are shown at once and 
can be mixed "faded" together in different ways. You will find numerous blends in the 
Media Pool’s transition directory. 
 

Simple dissolve 

 

A simple transition can be created in the project window by dragging one object over 
another. A dissolve will be automatically created. During this standard transition, the 
brightness of both objects is increased, i.e. the first clip fades out while the second clip 
fades in. The duration of the dissolve is displayed in the project window by white 
crossing lines. You can adjust the length of the dissolve by dragging the upper handle 
of the second object to the left or to the right. 

  

To select a different fade click on the transition symbol displayed when 
an object is selected. 

The transition menu opens. The transition icon will change, depending on your 
selection. 
 

Transitions from the Media Pool 
• To open the transition folder, click on the "Transitions" button.  
• A click enables a preview of the transition. 
• Simply drag the desired fade onto the border between the two objects. Only 

when the mouse pointer is placed over a scene change will it turn from a lock 
symbol into an object symbol, i.e. you can place the transition at that position. 
The object at the back will be shifted to the front to accommodate the transition.  

The length of a transition is decided by you, if a transition is shortened, it means that 
the resulting effect is speeded up.  

Some transitions can be adjusted even more precisely in the Media Pool (e.g. the 
strength of edge smoothing, or mirroring left or right). The settings that apply for the 
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transitions at the beginning of the selected object are always shown in the Media 
Pool. 

The so-called alpha transitions (in the subfolders "Iris", "Objects", "Random", etc.) are 
actually pre-produced black and white videos that are combined with the alpha keying 
effect to be used as transitions. 

Other transitions use sound effects. Look around at all the contents to form an idea of 
what you can use in future projects. 

Tip: Use transitions sparingly! Most professional movies or TV shows use hard cuts 
as the rule and transitions less frequently. Videos appear unprofessional and too 
ornate if fade effects are added to every change of scene. 

 

Custom transitions with alpha keying 
You can add additional transition effects to MAGIX Video Pro X6 by producing videos 
containing a transition from black to white in any which way. You can create such a 
video from any (including color) video material by exporting it as a transition ("File" > 
"Export movie" > "Export as transition"). 

The loaded movie is then exported as a black and white video in mxv format and 
stored in the transition directory. It will be available in the Media Pool and in the 
transition menu. 
 

3D transitions 
3D effects offer exciting and varied opportunities to create transitions between two 
videos. You can find the 3D effects in the Media Pool under "Transitions" > "3D". 

The following transition settings are available: 

Anti-aliasing: An undesirable step effect is usually created at the borders of 3D 
objects. Anti-aliasing reduces this effect, but also requires more computer power. The 
setting applies globally to all 3D fades, switching on anti-aliasing during 3D fades has 
the effect that all other 3D fades are also affected by this setting. 

Horizontal / Vertical Mirror: Use these options to influence the path of the 3D 
objects within the fades. "Horizontal" mirrors the movement of the object 
horizontally, i.e. along the X-axis. "Vertical" mirrors the movement of the object 
vertically, i.e. along the Y-axis. 
 

3D series 
The 3D series are a further development of 3D transition (view page 99), where the 
transitions are thematically sorted. For instance, you can let photos pop up and 
disappear on a notice board or make it look as if the photos were hung on the walls of 
a gallery.  
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You have the following options to open 3D sequences for photos or scene transitions: 

• In Media Pool, click on "Transitions" > "Spatial Transitions" > "3D Sequences". 
Select the desired 3D series and drag it onto the first scene or image transition 
where the 3D series should start. 

You can select how many of the subsequent transitions should be replaced by the 3D 
series in the dialog. 
 

Search for gaps 
MAGIX Video Pro X6 enables you to locate gaps between objects where no image 
material is located. This hinders unintentional black spots from appearing. This option 
is located under "Edit -> Find gaps". A corresponding dialog opens. 

Optimize view: Zooms to the selected gap. 

Mark gap as range: Spans a section over the selected gap. 

Edit selected gaps: The selected settings are applied but no additional action is taken. 

Keyboard Shortcut:  Ctrl + Shift + C 
 

Simple cut 
All objects can be split. Each object section then becomes an independent object: 

• Select the object to be cut. 
• Position the playback marker at the position where the movie is to be cut. 
• Select "Cut" among the cut functions in the toolbar or press the T key on the 

keyboard. 

 
Cut button: Here you can choose between various Cut modes (view page 45). 

In order to rejoin these split objects at a later stage, simply select the individual parts 
and select the command "Group" to join the selected objects into a group. Orders all 
selected objects into groups. 

Note: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

Tip: You can find detailed step-by-step instructions on how to remove unusable 
scenes from video material in the "Quick start" chapter of the print manual. 
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Two-point edit 
Two-point editing makes it easy to import files at specific positions in complex 
projects. To do this, one point is placed in the project window and another is placed in 
the source monitor and these are used in one of the following variations: 

Variation 1: Source in/Destination in 
The point in the project window specifies the location where the new material should 
be inserted into the project ("destination in") and the point in the source monitor 
where the new material should be inserted ("source in"). 

• Place the playback marker at the position in the project window where the new 
material should be inserted. 

 

• Click in the program monitor on the 
button in the transport control for 
the start of the section (in point). 

• Double-click the desired file in the Media Pool to load it into the source monitor. 
• Find the position in the source monitor where the material should be inserted. 

 
• Click the button in the transport 

control of the source monitor for the 
start of the section (in point). 

Note: To insert the complete material, an in point doesn't need to be inserted into 
the source monitor. Source in will now be the start of the source material. 

 
• Select the insert mode "Overwrite (view page 48)" to overwrite the 

material in the arranger behind the in point. 

  
• Or use one of the two ripple modes (single track ripple or multitrack 

ripple) in order to cut the material at the position of the in point and 
move it to back. 

"Overwrite" mode does not change the total length of the project. The new material is 
only inserted at the position of the in point: 
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The ripple modes move the old material in the range together with the objects behind 
it to the end of the inserted material. This changes the total length according to the 
length of the object: 

 

Variation 2: Source out/Destination out 
This variation functions based on exactly the same principle, only instead of setting in 
points in both monitors, out points are placed. In this way the new material is placed 
in the project window in front of the out point. This variation enables you to work 
from back towards the front to define the scene transition. 
 

Three-point editing 
The three-point edit is an insert process that operates based on three reference 
points. It works in on of three ways: 

Variation 1: Destination in/Destination out/Source in 
This variation defines a range in the project window where the new material will be 
inserted. 

• Initially, the program monitor is used to set an in and out point to stretch out a 
range in the arranger.  

• A third point is then set in the source monitor to define the beginning ("source 
in") of the material to be inserted. 

• Finally, the range in the project window is filled with the new material. The new 
material is cut automatically at the end of the range. 

Variation 2: Destination in/Destination out/Source out 
This variation functions similar to variation 1, with the difference that the point in the 
source monitor is not the beginning, but rather the end of the new scene ("source 
out"). This means that the scene transition at the end is specified and the new 
material moves into the front of the range. The new material is cut automatically at 
the start of the range. 

Variation 3: Source in/Source out/Destination in 
This variation defines a range in the new material that should be inserted at a certain 
position in the project window. 
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• Initially, a range is spanned out in the source material using in and out points in 
the source monitor.  

• A third point is specified in the program monitor which defines the beginning of 
the material to be inserted. 

• Finally, the range from the source monitor is inserted completely at the position 
of the in point.  

We would like to illustrate variation 1 and 2 using step-by-step instructions: 

• In the project, determine an area that corresponds to the time window and 
position of the video to be imported (destination in/out).  

 

Tip: To keep things clear, it is recommended at the start to cut the material within 
the range and then to drag it backwards or to delete it from the range so that a gap 
is present. 

• Load the new material that you want to display inside the range by double-
clicking in the source monitor. 

 

• Position the playback marker in the 
source monitor at the start position 
where the video should be imported 
into the arrangement (source in). 

• If you want to cut at the scene end, 
set the playback marker in the 
source monitor at the position 
where the end of the scene should 
be and click the button for the end of 
the range (source out). 

 

 
• Select the insert mode "Overwrite (view page 48)" to fill the range in 

the project window with the new material, replacing it with the 
existing material. 

   
• Or use one of the two ripple modes (single track ripple or multitrack 

ripple) to cut the material at the start of the range and move it to the 
end of the range. 
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"Overwrite" mode does not change the total length of the project. The new material is 
only inserted at the start of the specified range: 

 

The ripple function moves the material in the range together with the subsequent 
objects. This changes the total length according to the length of the range: 

 
 

Four-point editing 
The four-point edit places new material into the project with the help of a total of four 
marker points.  

A range is set in both the source material as well as in the project, and one of the 
insert modes described above is used. The function is the same for each mode 
(overwrite and ripple): The section from the source material is inserted precisely into 
the range specified in the project window. 

If both ranges are coincidentally the same size (which is normally the exception), the 
new material will be stretched or pinched automatically. The playback speed of the 
video is changed analog to the time stretching applied to the audio track. 

Because timestretching for an audio track is only possible and sensible in certain 
cases, the audio is removed when larger changes are made (above a factor of 2). A 
corresponding confirmation dialog appears first so that the procedure can also be 
canceled, e.g. to carry out a three-point edit instead. 
 

Move the contents of trimmed objects 
You can adjust the contents of a trimmed video object quickly and easily without 
changing the object length.  

1. Select the trimmed video object.  
If the video has not been trimmed, the video object contents cannot be moved, 
because the entire video will be shown. 
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2. Press "Alt + Shift" and hold down the left mouse button while dragging to the 
left or right, in order to move the contents inside the video object.  

 

Zoom preview 

 

• The video image on both monitors can 
be magnified or minimized using the 
zoom buttons. 

Note: This zoom applies only to the 
current view in the preview monitor and 
will not be applied as a video effect. 

 
 



 

106   

http://pro.magix.com 

Markers 
In MAGIX Video Pro X6 you can set various types of markers within your project. 

 

The Lock button (at the very front, next to the time ruler) lets you lock all 
markers (jump markers, chapter markers) against accidental moving or 
deleting. 

 

Playback marker 

 

The playback marker indicates the point from which the material – 
either the arrangement or a selected file from the Media Pool – will 
be played back. There is a playback marker below each preview 
monitor and an additional one above the timeline in the project 
window. 

The playback marker is displayed as a red triangle below the monitors. In the project 
window it is displayed as a red triangle. 

In order to move the playback marker, simply double click on the desired area below 
the monitor. Alternatively, you can click on the playback marker and move it by 
dragging it with the mouse. While being moved, the current image will appear on the 
monitor, letting you see exactly where in the material you are located. 

The playback marker in the video monitor can also be moved by clicking on the lower 
section of the time scale in the project window. The playback marker will also be 
moved on the program monitor, as both markers are coupled to each other. 

The exact position of the playback marker can be seen in the time display at the top 
left, below the corresponding monitor. There, you can change the displayed values 
(Hour:Minute:Second:Frame) per mouse click to reach a certain point in time. Simply 
enter the desired value and the playback marker will jump to the corresponding 
position. 

Tip: In the "Playback" tab under "File -> Settings -> Program", you can set whether 
repeatedly pressing the space bar resets the playback marker to the current position 
or moves it to the original position. 

 

Project markers 
The "Edit" menu or the keyboard shortcut "Shift + numerical keys 1-0 (0 for the tenth 
marker) allow you to set a project marker (view page 301) at the current position of 
the playback marker. They function as a mental marker or indicate certain positions or 
events within the project. 
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After selecting the menu item, a dialog appears to input a name for the marker to be 
created. The first ten project markers may be accessed via Ctrl + number keys 1-0. 
This allows you to jump to a particular position of a longer video immediately, without 
scrolling and searching. 

Project markers may be deleted or renamed via the context menu at any time. This 
does not provide direct influence on the result, but they do make the workflow much 
easier. 
 

Ranges (in and out points) 
Range markers are the "in points" (range start) and "out points" (range end). They 
mark a certain range for playback that can be viewed by pressing the "Range 
Playback" button at the bottom of the corresponding monitor. 

 

To the left, you can see an in point (range start), and an out point is visible (range end) to the 
right 

Hint: The value between both markers shows the length of the selected area 
according to the pattern Hours:Minutes:Seconds:Frames. 

 

There are various options for changing the playback range, and with it the project 
start and end markers. 

• Set the playback marker at the desired position and press "Set start of range (in-
point)" or "Set end of range (out-point)" underneath the monitor to set the in and 
out points of the range. 

• Click on one of the markers below the preview monitor and move it with the held-
down mouse key to the desired position. 

• Click one of the markers in the upper-most bar in the project window and drag it. 
• A right click on the bar moves the range end to the position of the mouse cursor. 

A left click moves the start of the range. The area grows or shrinks in size 
correspondingly. 

• You can adjust the position of the entire range by clicking the blue bar between 
the markers and moving it by dragging while holding down the Crtl button. 

 

Range markers in the source monitor 
You can set the in and out points in the source monitor in the following manner: 

• Set the playback marker at the desired position and press the "Set range start (in 
point)" or "Set range end (out point)" buttons below the monitor to define the 
start and end points of your range. 
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• Click on one of the markers below the monitor and move it to the desired position 
by dragging it. 

• The position of the entire range can be changed by clicking on the blue bar 
between the two markers with the Ctrl button held down and moving the bar. 

For the exact functions of the range markers in the source monitor, please read the 
section "Loading ranges from longer film files (view page 90)". 
 

Chapter markers 

 

The chapter marker defines the start of a new chapter. Chapters serve to 
improve navigation when burning the project to disc (view page 227). 

The following options are provided via "Edit -> Marker" or by right-clicking on the 
playback marker. 
 

Set chapter markers 

 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename". The 
new name will appear in the chapter menu (view page 211). 

Keyboard shortcut:  Shift + Enter 
 



 

Markers 109  

 

Set chapter markers automatically 
This option automatically sets chapter markers in the arrangement according to 
specific rules that will then appear in the film menu of a disc as chapters. This is useful 
if a disc should be burned immediately after recording. 

 

There is a selection of options available for automatic chapter generation: 

At beginning of movie: The movie only contains one chapter in this case. 

At beginning of object in track: Every object in a track creates a chapter; track 1 is 
preset. 

At position of existing title objects: Subtitles, for instance, as faded-in subheadings, 
give the position of the chapter markers. 

Specified interval (minutes)/Specified amount: If the chapters are separated without 
any particular method and are just needed for quicker navigation, chapter markers 
may also be inserted in pre-defined intervals or as a pre-defined number of chapter 
markers. 

Naming of chapter markers: To title the chapter markers, a user-defined name 
featuring consecutive numbers or the object name or text from the text objects may 
be used. 

Optionally, existing chapter markers may be deleted and the automatic chapter 
marker function may be limited to the area between the start and end markers. 
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Keyboard shortcut:  Alt + Shift + Enter 
 

Delete chapter markers/delete all chapter markers 
Delete one or all chapter markers. This removes chapter entries in the disc menu if 
the film is burned to disc. 

Keyboard shortcut:  Ctrl + Alt + Enter 
 

Scene markers 
Scene markers separate a complete video into scenes. You can load any video into 
MAGIX Video Pro X6 and have it divided into scenes. 

Load the desired video into the project window. Then, right-click on the video and 
select "Scene detection". The following dialog appears: 

  

After clicking "Start search", an overview of the detected scenes will be displayed 
underneath the scene control. 

Delete scene markers: Here you can delete individual markers by selecting them from 
the list. 

Delete all markers: Deletes all project markers. 
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Action on OK: You have three options. Either MAGIX Video Pro X6 splits your video 
into individual scenes ("Cut at all markers"), a scene is selected and cut only at this 
position ("Cut at selected marker"), or all scenes are added to the project folder. 

After deciding in favor of one of these options, red scene markers will 
appear on the timeline in the project window. The scenes can then be 
split according to the selected option and edited.  

Note: An important difference between a scene and a chapter marker is that a scene 
marker can be set only within a continuous video, while a chapter marker can 
include several consecutive videos. 

Additional information about scene recognition is provided in the chapter "Edit 
objects (view page 271)". 
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Multicam editing 
Multicam editing enables easy cutting of various recordings of the same scene from 
different camera perspectives. The preview monitor displays image material from up 
to nine sources in sequence, from which the "program" can be cut in real-time using 
your mouse, just like in a real studio. 
 

Preparation 
Multicam editing is a special mode in the project window. The top two tracks serve as 
target tracks; sound and video can copied from up to nine different source tracks. The 
two most upper tracks need to therefore be empty when changing into multicam 
mode, if required the objects will be moved onto another track. 

First you can load various video recordings of the same scene one under the other 
starting on track 3 in the arranger.  

It is important that the individual sources are synchronized to each other exactly. It is 
best to find a noticeable movement, or some kind of audio cue if sound was recorded.  

Note: To localize the sound in the audio track exactly you will have to create a wave 
display of the track. To do this, right-click on the audio track and select "Waveform 
display". 

If you have one, you can use a clapper to signal the start of a scene. If not, simply 
having one of the "actors" clap their hands can have the same effect. Put a snap point 
in each source object at this point (Shortcut Alt + Shift + P). You can now move the 
source objects over each other, so that the grid points are aligned. 

In each case two video sources with audio tracks can be automatically synchronized 
using their audio material. To do this, use the function „Align with other audio 
objects” (view page 115) in the audio object context menu. 

It is also important that, you carry out all output material effect processing (e.g. video 
or audio cleaning) on the objects on the source tracks and master audio track before 
(view page 114) the multicam cut. These object effects are transferred to the object in 
the target track when editing. Otherwise, you will have to apply the effects from every 
single object to the target track. 

You can activate "Multicam" mode with this button or with the "Multicam" 
command in the "Edit" menu. 
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Source tracks and preview images 
The assignment of tracks as source tracks for the multicam cut takes place 
automatically. A maximum of 9 tracks may be used as source at the same time. 
When the multicam mode is activated, the source tracks will be assigned to all tracks 
containing video objects starting from track 3. 

You can also conduct or change the assignment manually. To do so, right click on the 
trackbox of the corresponding track to active or deactivate a track as a source track.  

 

The source tracks are marked using color. This can be accomplished by users if more 
than 9 source tracks are used. 

 

For every assigned track, a preview appears in the source monitor, and the frame's 
color corresponds to the color of the track, letting you assign each preview image to 
the corresponding track. 

If the objects created using multicam cut are located on the target track, a preview 
image of the corresponding source track highlighted with a yellow frame will be 
shown for length of playback. 
 

Multicam edit functions 
You can edit various sources in the the target track during playback in real time or 
during stopped playback. 
 

Real-time Multicam editing 
You can edit various sources together during playback in real time: 

• Start playback. 
• Click on the desired source in the preview monitor. The corresponding video is 

added into the target track starting from this time point. 
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• To switch the source, click in the source monitor on another source. A new object 
will be created using the new source from this point in the target track.  

You can repeat this process as often as you like. 

For precise editing in the target track, use the usual edit functions or the Trimmer. 
Keep in mind that as long as you are in Multicam mode, only the object borders are 
moved, and not the objects themselves. Otherwise, gaps or image jumps could form 
while you use the Multicam edit function again later. 
 

Replacing an object's source 
Replacing an object's video material in the target track with another source: 

• Select the object for which the source is to be replaced in the target track. 
• Click the source you want to replace the video material with in the source 

monitor object. 

The video material will now be replaced by the new source. The project length is not 
changed. 
 

Insert cut 
Insert material from one of the sources between any position on the target track and 
the next object. 

• Place the playback marker at the desired position. 
• Click on the desired source in the preview monitor. 

The material from this source will now be inserted into the target track. The new 
object ends at the next object. The portion below an existing object is overwritten in 
the process. 
 

Overwrite range 
You can overwrite a selected area of the target track with one of the source videos. 

• At the upper edge of the project window, select an area to edit by determining 
the in point by clicking with the left mouse button and the out point by right-
clicking. Or use the corresponding buttons in the transport control. 

• Click on the desired source in the source monitor. 
• The target track will be overwritten with the video material from the selected 

source in the selected area. 
 

Master audio track 
Normally, videos in the source track are edited together with their audio tracks. Since 
the original sound can differentiate from camera to camera due to different camera 
positions, you will probably prefer using either the soundtrack from only one camera 
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for all settings, or to replace the soundtrack completely (for music videos, for 
example, you will use the studio version of the original track). 

Right click on the track box of one of the source audio tracks or a different audio track 
and select "Multicam: Master audio track" from the context menu to assign a master 
audio track for multicam editing. The master audio track will be appear in a dark color. 

Now, during every multicam cut, material from the master audio track will be inserted 
on track 2, independent of the source track used.  
 

Synchronize video objects using the audio track 
Video objects can be synchronized using their audio tracks. This is done by comparing 
the audio tracks for similarities. If videos come from the same recording environment, 
the same acoustic events will be found on their audio tracks (e.g. the sound of the 
clapper board). 

Synchronization of multiple objects on one track is possible.  

• First, on the reference track, select all audio objects that are to act as reference 
positions. 

• Then, on another track, select all audio objects that should be moved. 
• Choose the "Align with other audio objects on this track" function from the audio 

object context menu. 

Note: If the desired audio track is found in a combination object, you will find the 
"Align with other audio objects on this track" option in the "Audio functions" 
submenu. 

MAGIX Video Pro X6 attempts to locate the acoustic events in the reference objects 
of the second track and to move these to the corresponding position. Because the 
audio objects are grouped with their corresponding video objects or comprise a 
common object, videos are synchronized in the process. 
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Title 
Titles can be used for many applications: as a running text (ticker), subtitles, speech 
and thought bubbles, to display date and time, and much more. 
 

Title editor 
In the Title editor you can determine the appearance of your titles. If a title object is 
already present, you can select either the title object or the corresponding video 
object and open the Title editor using the "General" button. 

You can adjust the text properties for multiple selected text objects at once. The 
settings will only be applied to the text objects you have selected. The individual 
properties of each text object remain unchanged. 

 

The following editing options are available for selection: 

Font: Here you can determine the font type and size of the text. If you click on the 
small arrow next to the font size, you can change font size using a smooth slider. 

You can set format properties in the toolbars below. 

 
Bold/Italic/Underlined 

 
Align left/Centered/Align right 
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Font color 

 
Border/Shadow/3D effect/3D title object (view page 117) 

Effects: With "Advanced" you will find additional Title Editor (view page 118) settings. 
"Automatic text break" separates text automatically when the end of the text field is 
reached. "Adjust font size to title field" changes the font size according to the text 
field size. You can activate or deactivate this option temporarily by pressing Shift 
while dragging the text field handles.  

Animation: here you can set four movement directions to move the title on the image. 
You can also set any course of movement. Read more about this in the chapter 
"Animating objects" (view page 145). 

Title object: 

 The left button vertically centers the title object on the monitor; the 
right centers it horizontally. 

 

Here you can enter text for your title instead of editing it directly in the program 
monitor. 

 This deletes selected title objects. 
 

 Use the arrow keys in the title editor to move from one title object to 
the other without having to search in the project window. Captions 
are not included in this. 

 

3D Text 
3D text can be created directly in the title editor.  

 
This button only appears when you have created a title object and it is selected 
in the project window. 

• Open the title editor and then click on the 3D Title button. 

The title object will now be turned into a Xara 3D Maker object. If you have also 
installed Xara 3D Maker, the program will open so you can edit the text. Presets are 
also located in the Media Pool under "Titles -> 3D". You can enter or edit text here. 

Note: For more information about Xara 3D Maker, please refer to the help file. You 
can open it by pressing "F1" from within the program. 
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Advanced settings 

 

Only use visible TV area: The text will be zoomed so that it will always be within the 
TV's limits, which is specified in the Movie effect settings (view page 162). 

Background: Specify here whether the text's background should appear black or 
white. This is only meaningful if no other video or image object is in the background. 

Text effects: Here you can edit different text effects in detail. One color may be set 
for each effect. 

Shadow: The position of the shadow may be set on the horizontal and vertical axes.  

Transparency makes the background "shine through" more or less. 

Soften: Makes the edge of the shadow harder or softer. 

Outline: A border appears around the letters in the text. 

Width: You can enter the width of the frame in points. 

Color: Clicking on this button opens a color selection dialog, where you can set the 
frame color. 

Filled in: The text will be filled with the color selected in the Title Editor. If the option 
is deactivated, only the frame will be visible, and the background will appear instead 
of the color fill. 

3D: The text appears with a 3D-style outline. The width and thickness of the 3D 
contour (H) can be set in points. 
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Creating titles using a template 
The Media Pool includes the tab "Title" with folders filled with additional, thematically 
named title templates. 

• Open one of these entries and select any title template. A simple mouse click 
provides a preview, and double clicking creates a title object using the template. 

Note: Templates may be applied to an existing title object. Settings outside of the 
text will be lost! 

 

Create titles without a template 
Here's how you can create titles without a template: 

• In the Arranger, place the playback marker at the position where the title should 
appear. 

• Click on the "General" entry under "Title" in the Media Pool. 
• Click in the program monitor at the location where the title should be positioned.  

 

• Next, simply enter the text using your keyboard. 
• After the text has been entered, click the check mark in the program monitor to 

confirm it. 
• You can format your title later with the title editor in the Media Pool. 

 
You can open the title editor by pressing "T". A title object will be created 
where you can enter your text directly. 

 

Edit titles retroactively 
• Double click on a title in the program monitor (or the title object while in 

"timeline" mode). 
• Now change the text however you like.  
• Confirm your entry by clicking the check mark next to the positioning frame. 
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Position titles 
• Click in the program monitor once on the title to access the positioning frame. 

Simply move the positioning frame via drag & drop. 

 

• The size of the positioning frame may be adjusted via the corners, and the size of 
the text will also change accordingly. 

 

Click once on the button in the Media Pool under "Title -> General" to 
center the title horizontally or vertically in the monitor. 

 

Fade in date as title 
MAGIX Video Pro X6 is also able to insert the time and date into the image material. 
To do this, select the option "Show date as title" in the video object's context menu. 

If a DV-AVI file is involved (e.g. a digital recording from a camcorder), then the 
recording date for the selected position will be used. If another type of file is involved, 
then the creation date of the file will be used as the timecode. Following this, the title 
editor will appear to adjust the information. 

The context menu of the program monitor also features the option "Show playing 
time". This also creates a timecode. 
 

Timecode 
In the "Timecode" section you will find various presets that you can use for displaying 
the timecode. This function adds a special timecode object to a free track under the 
video object. 

You can adjust the position of the timecode by moving the timecode object in the 
preview monitor. The handles on the borders can be used to adjust the size. 
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Presets can be customized in "Settings".  

 

Timecode source: The type of timecode can be selected here. You can choose from: 

• Movie time: The time position in the MAGIX Video Pro X6 arranger. 
• Object time: The time position within the timecode object independent of the 

movie length and the position in the arrangement. 
• Recording date/time: The date and time when the footage was recorded. This 

timecode information must be saved in the video, otherwise the display will be 
empty. 

• Recording timecode: The timecode for the video that is created by the camera. 
This timecode information must be saved in the video, otherwise the display will 
be empty. 

Note: If the recording date/time and the timecode are not saved in the source 
material, only placeholders in the form of "-" will be displayed.   

Add variable: The date/time format of the selected preset will be displayed as 
variables in the format line (square brackets define a variable). These can be deleted 
or additional ones can be added. You can also add your own text and adjust the 
separators between variables.  

Font: Select a font. 

Fixed character width: For fonts with variable character width (proportional fonts), 
the display will change during playback because, for example,  "1" is narrower than 
"0". Here you can hide these types of fonts from the selection list. 
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Color: You can set the font and background color here. If "transparent" is activated, 
the background will be transparent. 

Adjust to project length: Adjusts the length of the timecode object to match the 
length of the project to ensure that it is displayed at all times. 

Counter start/Progress: If you have inserted a counter as a variable or are using a 
preset, you can regulate how it behaves here. For example , the counter can start with 
10 and continue in intervals of 5. If you would like the counter to count backwards, 
enter a minus sign in front of the number in the "Progress" field. 
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Effects 
MAGIX Video Pro X6 offer a large palette of various video effects. The video effects 
used the most can be found directly in the Media Pool, while others can be found in 
the object context menu or in the "Effects" menu. 
 

Apply effects to objects 
There are various approaches for applying effects: 

• Video and audio effect presets are loaded into the corresponding object from the 
Media Pool using drag & drop. 

• Effects that can be animated (in the Media Pool under "Effects -> Video effects / 
movement effects") will be applied directly to the objects selected beforehand as 
soon as changes are made in Media Pool. 

 
This button resets all of the current effect settings. 

Note: If you animated the effect using keyframes, resetting will affect the entire 
animation. Individual keyframes may be deleted via click + Del (view page 147). 

 

Transfer effects settings 
The items video effects (view page 125), movement effects (view page 134), and 
Stereo 3D (view page 163) on all effects pages provide the option to transfer the 
current effects settings to other objects or to load previously saved settings. Use the 
above right arrow button to open the video effects menu. 

 

Save/load video effects: The current effects settings may be saved for later use in 
other projects or previously saved settings may be loaded. A dialog allows the effects 
to be selected. 
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Reset video effects: Resets the effects settings for the selected object. 

Copy/paste video effects: Copies or inserts the current settings as a new object. Use 
the dialog to select which settings should be copied. 

Apply video effects to all: Copies the current effects settings to all objects in the 
arrangement. Use the dialog to specify which settings should be copied. 

Apply video effects to all the following objects: Copies the current effects settings to 
all of the following objects in the arrangement. Use the dialog to specify which 
settings should be copied. 

Load effects mask (in the Plus version): An effects mask may be loaded for a selected 
object. 
 

Comparison image in the source monitor 
When editing effects in video and image objects, MAGIX Video Pro X6 offers a 
comparison mode which lets you compare the before and after state directly. 

 

Selected object without effects: Outside of effects pages, the object is displayed 
completely without effects; inside effects pages, the object is displayed without 
effects from the current effects page. The "Color" effects page remains open and all of 
the effects except "Color" are applied. This options synchronizes the playback marker 
between the program and the source monitor. 

Selected object: The selected object is displayed with all of the applied effects. The 
playback marker may be moved along the arrangement, for example to compare the 
beginning with the end of an edited object. This option synchronizes the playback 
marker between the program and source monitor. 

Before selected object: Displays the object before the selected object in the same 
track. This enables the edited effects on sequential objects to be compared more 
easily. 

Following the selected object: The object located on the same track after the selected 
object is displayed for comparison in the source monitor. This enables edited effects 
on sequential objects to be compared more easily. 

Select object...: Clicking selects the desired object. An object may therefore be edited 
and then used as a reference for the following effects processes, for example. 

Remove comparison image: The comparison image is removed from the source 
monitor.  



 

Effects 125  

 

Note: Program settings enables you to activate "Comparison image in source 
monitor for editing effects in the Media Pool". If this option is activated, the 
"Selected objects without effects" comparison mode will be automatically activated 
when switching into the Media Pool effects, and will be automatically deactivated 
when the mode is exited. This serves to compare the original and edited image. 
This automation will be suppressed if the option is deactivated. 

 

Video effects in the Media Pool 
Video effects in the Media Pool can always be opened independently from the 
selection of an object. 

The the image at the position of the playback marker is always displayed in the 
program monitor. To see the impact of the effect settings, you must always set the 
playback marker to the position where the selected object is located. The playback 
marker also enables you to jump to a specific position in the video object in order to 
check the results of the effects by starting and stopping playback. 
 

Brightness & Contrast 

 

Auto exposure: With this button you can automatically optimize brightness and 
contrast with a click. Use the fader in the dialog for finer adjustments. 

Brightness/contrast: Use the sliders to increase or reduce the brightness and the 
contrast of the picture. 

Gamma: "Gamma" determines the mean gray value that can be calculated from the 
various color ranges. In the preset list, select various areas to edit only the dark, 
median, or brightest areas of the image. 
Using the fader you can also set the power of the brightness/darkness adjustments. 

HDR Gamma: Unlike "Gamma", very dark areas are selectively lightened. 

HDR blur: This changes the transition between light and dark areas together with 
"HDR Gamma". 
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Color 

 

White point: An incorrect white balance can lead to an unnatural blue or red hue. 
Instructions: To use the white balance, click on on the button to the right of the label 
"White balance" and then select a point which represents white or a neutral gray to 
the "outside world". The color temperature is then corrected automatically. 

Tip: Interesting color effects can be achieved by setting a color other than white. 
There is definitely room for experimentation! 

Red Eye Removal: Using this photo function you can remove unnatural red eyes that 
are the result of using a flash. Click on the eye symbol and then select the red pupils in 
the preview monitor using the mouse.  

Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is applied which makes color changes related to 
other parameters (for example contrast settings) in order to achieve the most natural 
coloration possible. With some experimenting, you can achieve some amazing results 
– such as turning summer images into autumnal pictures, or creating funky pop art... 
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Hue: Select a color for coloring the image from the color chart. 

Red/Green/Blue: Changes the color portion mix using the slide controller. 
 

Color correction 
The "Highs", "Mids" and "Shadows" ranges can be adjusted individually. 

Note: Before using complex color correction, you should first check if 
"Brightness/Contrast" and "Color" functions can help you. 

 

By turning the mouse wheel, the work area of each color wheel can be increased or 
decreased. 

Color angle: Determines the color on the color wheel, which the image should be 
colored with in each brightness area. 

Shortcuts: Shift + mouse wheel above each color wheel 

Correction level: Sets the intensity of the coloration of each brightness range. 

Shortcuts: Ctrl + mouse wheel above each color wheel 

Saturation: This lets you set the color saturation for the corresponding brightness 
range. 
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Edit color ranges individually 
Secondary color correction allows individual colors in video and image objects to be 
adjusted. This includes essentially two layers, the fore and background. The master 
layer may also be used to influence the overall image. 

The foreground layer corresponds with the mask created, and editing in the 
background changes all of the areas outside of this mask. The mask may be assigned 
to a certain color or to multiple colors simultaneously. 
 

To open color correction, click the video or image object and open the entry "Color 
correction" via "Video effects" in the Media Pool. 
 

"Add" allows a color to be 
selected with the pipette tool to 
create a mask. MAGIX Video Pro 
X6 displays the mask in black and 
white stripes to highlight the 
current selection. 

 

Click with the pipette tool on the 
color in the program monitor that 
you would like to add to the current 
layer until your selection is 
complete. 

Unwanted colors can be removed 
from the selection again by selecting 
"Remove" and clicking the 
corresponding color. 

 

 

Select the layers (fore and 
background) to edit. 
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Shadows, mid tones and 
highlights of the selected color 
and level may now be edited 
separately (view page 127) in the 
normal way. 

 

 

A classic example: 
Saturation of all 
brightness areas on the 
background layer is 
reduced, and colors in 
the foreground are 
adjusted as desired. 

 

Chroma key 

 

This section contains the effects for chroma keying used to mix together two videos 
into a foreground and background.  

Note: The background video must be placed in the track above the foreground 
object.   E. G.: Track 1: Background, Track 2: Foreground  

Mode 
Stamp: The currently selected object is "stamped" onto the video on the track above 
the object. This is only possible if the bottom video takes up only a part of the image. 
Otherwise only the bottom (currently selected) video would be visible. Normally, the 
object should be reduced or moved first. This is done with the help of "Position/size" 
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(view page 134) effect or via the submenu "Section" in "Effects -> Video object 
effects". 

Color: In the preview monitor, drag the cursor over the color that should be 
transparent and select a section. The video is made transparent in the sections with 
this color and the video on the top track will show “through”. You can use the 
"Threshold", "Fading range" and "Antispill" controls to fine-tune your results. 

Mix: This button mixes the two videos together based on the brightness. Brighter 
areas accumulate and quickly appear white; darker areas have less of an effect on the 
result. 

Colors to be hidden 
Green/blue/black/white: All green/blue/black/white areas of the video below 
appear transparent. This makes it possible to "place" a person who has been recorded 
in front of a blue background into any type of landscape. 

Water: Only the contours of the upper video are mixed, which results in something 
like a water effect.. 

Alpha: This video effect uses the brightness of a video to control a transition effect 
between two other videos on neighboring tracks. The additional videos should be 
situated directly above and below the alpha-keying object. 
In all black parts of the alpha-keying object, the top video is faded in, while in all white 
passages the bottom video is shown. Grey passages are permeable for both videos 
and create a mixture of the two. In the case of colored passages, the brightness of the 
color is used for control purposes. 

Video Level 
Changes the brightness of the video before additional video effects are applied. This 
can have a serious influence on the effects, in particular on Chroma Keying. The level 
setting may be automated so that two videos can be mixed dynamically with each 
other. Read more about this in the chapter "Animating objects" (view page 145). 
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Art filter 

 

Erosion: The image is broken-up by means of small rectangles and resembles a 
"patchwork". 

Dilate: This works like erosion, but uses light surfaces instead of dark ones to form the 
rectangle. 

Emboss creates a relief of the image edges, in which case strong contrast differences 
are interpreted as edges. 

Substitution: Using the rainbow scale red, green, and blue components are 
exchanged. Quickly create surreal landscapes or a green face! 

Move: The color values are inverted increasingly. Blue colors turn red, and green 
appears purple. 

Quantize: Depending on the setting, colors are either rounded up or down so that the 
overall number of colors is reduced. This creates interesting grids and patterns. 

Colorize: Using this slider, color in the video with red, green, and blue colors (the 
basic TV colors). 

Contour: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is 
possible to select either vertical or horizontal contours. 
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Distortion 

 

Motion: Moving parts of the image are enhanced and warped. 

Echo: The moving images create an optical "echo"; previous images stand still and 
gradually turn paler until they completely disappear. 

Whirlpool: The image is twisted into an "S" shape. 

Fisheye: The perspective is distorted as if the image were viewed through a fisheye 
lens. 

Mosaic: The video is depicted as a mosaic. 

Lens: The image is dynamically distorted at the edges. 

Sand: The image is depicted in a granulated manner. 

Kaleidoscope: The left upper corner is mirrored horizontally and vertically. 

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it 
appears on its side or upside down. 
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Sharpness 

 

Sharpen: The fader allows you to increase the sharpness of the image. 

Blur: The fader allows you to reduce the sharpness of the image. 

Apply to: This allows you to set just how much the sharpness or blur should be 
applied to surfaces or edges. This enables you to effectively reduce ongoing image 
distortions (noise). 

Artificial blur: Here you can apply various soft filters. The achieved effects are much 
stronger compared to simply sliding the controller in "Blur". 

Quality: Adjusts the strength of the artificial blur more accurately. 

Tip: Artificial blur achieves good effects when used for transitions. To do so, you can 
animate (view page 145) the first video so that it is strongly blurred and let the 
second video begin with blur and slowly return to normal focus. 

 

Speed 

 

The playing speed can be adjusted with the slider control. The range between 0 and 1 
plays the video slowly; values above 1 accelerate playback. If the playing speed is 
increased, the object length in the project window is automatically shortened. 
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Frame rate: Here you can set the video's frame rate directly. Changing it directly 
affects the speed factor, while moving the slider conversely results in changing video 
frame rate. 

Algorithm: Here you can determine how the soundtrack should be treated. 
"Timestretching" changes the playback speed, without influencing the pitch: 
"Resampling" changes the playback speed together with the pitch (the faster the 
playback, the higher the pitch). 

Reverse playback: With this button the playback direction will be reversed (with the 
same tempo). 

Interpolate intermediate frames: Activate this option if your video is jerky as a result 
of being slowed down. MAGIX Video Pro X6 then automatically fills in missing 
frames so that your video can be played back more smoothly. 
 

Movement effects in the Media Pool 
Size/Position 

 

Values in: Set whether the values are applied in percent or pixels. 
 

Position 
Left: Enter the start position from the left image border. 

Top: Enter the start position from the top image border. 

Center: Based on the current image size, the image starting points (left and top) will 
be positioned so that they are centered. 
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Note: Negative values can, of course, also be entered. The image borders will then 
be outside of the visible area. 

 

Size 
Width: Enter the width of the image here. 

Height: Enter the height of the image here. 

Maximize: The image is maximized to the resolution of the film. 

Set original size: The image will be scaled to its original size. 

Fix proportions: This option makes sure that the image will not be stretched or 
distorted. The ratio between width and height will always stay the same. 

Note: In the preview monitor you can use the object handles on the sides of the 
decorative element to adjust its size. The additional handles for rotation located at 
the top can be used to tip the element and align it with a background object. 

 

Zoom 
Use the zoom slider to enlarge the complete section proportionately (values greater 
than 100) or to reduce it (values less than 100). 

Note: When zooming, the image will be centered automatically, i.e. anchor point = 
center point. 

 

Section 

 

Sections may be used to display only a portion of the image. 
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Note: In order to move the section with a movement effect across the image, please 
refer to the following section "Camera/zoom". 

The program monitor enables an image section to be specified. Use the eight handles 
to reduce the frame displayed in the monitor and move it to the desired position. 

Preview: With this button you can preview how a segment will look like in 
the movie. Click on this button a second time in order to keep editing this 
segment. 

Keep proportions: In this menu, you can select the format for the section. The format 
of the original picture is used as the default. 

Fill screen: If this check box is selected, the section will be zoomed to fullscreen. If 
this option is deactivated, only the section of the image within the frame will be 
displayed and the edge will remain black or filled with the object behind it. 
 

Camera/zoom 
With this effect, you can move a previously selected frame inside the image, creating 
an impression of camera movement or zoom. 

 
 

Movement in direction 
Determine the direction in which the selected section or image will 
move in the process during the time selected under "time period". In 
addition to horizontal and vertical movements, diagonal movements are 
also possible. 

Preview: Displays a preview of the section at the playback marker location. 
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Zooming 

 

Zoom out: The selected picture section is displayed and is then zoomed 
out to display the entire picture according to the time set in “Length of 
movement”. If no portion is previously set, a central portion of 50% of 
the picture is set. 

 

Zoom in: The entire picture is displayed and then zoomed in to show 
only a smaller picture section according to the time set in “Length of 
movement”. If no portion is previously set, a central portion of 50% of 
the picture is set. 

 

Duration 
The option selected here sets the position where the keyframes of each movement 
effect are set by default. You determine the positions where a movements begins and 
ends. 

Note: Automatically placed keyframes may be edited retroactively, and the option 
will then be set to "Use custom settings". Read the section "Retroactively editing an 
effect's keyframes" (view page 146) in the chapter "Objects". 

 

 
Reset: This option applies a static zoom to show the selected section of the 
picture only. 

 

The size and the position of the image can be roughly entered in the program monitor 
by simply moving the image into it and dragging on the handles. The frame of the 
video monitor with handles can also be moved with the keyboard. 

Keyboard shortcuts for moving the edges of the frame that are visible in the video 
monitor: 

Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 
 

For animated movement effects, it often makes sense to zoom out of the video 
monitor and use the resulting workspace to, for example, let a minimized image or 
text object move through the picture. 

Keyboard shortcuts for the preview picture: 

Thumbnail zoom in/out: Ctrl + mouse wheel 
Move thumbnail: Ctrl + left mouse button + drag 

See the "Animation from outside of the image" (view page 151) section for more 
detail. 
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Rotation/Mirroring 

 
 

Rotation 

 

Rotates the image on the horizontal axis. 

 

Rotates the image on the vertical axis. 

 

Rotates the image around its center point. 

 

Straighten horizon 
The image can be rotated around the axis using the slider. The image is automatically 
zoomed to avoid black edges. 

Show guidelines: Activating this check box displays a grid in the program monitor for 
orientation during horizontal straightening. 

Zoom automatically: This function is preset to active. Unwanted black borders that 
result from horizon straightening are eliminated by zooming in on the image.  

Note: If the image format does not completely conform to the current movie format 
and already has black borders, these cannot be eliminated with the horizon 
straightening function. 
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Mirror/Rotate 

 
Mirrors the image on the vertical axis. 

 
Mirrors the image on the horizontal axis. 

 
Rotates the image 90° clockwise. 

 
Rotates the image 90° counterclockwise. 

 

Rotate image on monitor 
In addition to the settings options in the Media Pool, you can also rotate a video 
object directly on the monitor. 

To do this, move the upper middle handles that are located within the monitor image. 

 
 

3D distortion 
This enables the perspective of images to be distorted and moved. This produces a 
3D impression by causing several components of the image to appear further in front 
of others.  

Enter the individual corner points numerically or move them in the program monitor 
using the mouse here. 
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Note: Compared to Stereo3D, this does not involve genuine 3D positioning. The 
image is only distorted so that it appears three-dimensional on a normal two-
dimensional monitor. 

 
 

Stereo3D in the Media Pool 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo3D". (view page 163) 
 

Audio effects in the Media Pool 
The Media Pool offers various opportunities to add effects to your audio objects. 
Another advantage of this so-called "object-oriented" working method is that 
automations are moved automatically with objects when they are moved, since they 
are attached to the object and not to the track itself. 

See the "Audio effects" (view page 181) section below for more detail. 
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General 

 

Under "Effects -> Audio effects -> General", you will find audio effects that can be 
animated using effects curves (view page 145). This means that certain effect settings 
can be changed during playback. 

Effect curves are always object related, i.e. they only apply to one object and are 
moved or copied together with the object. 

Note: The faders AUX 1 and AUX 2 control the volume at which the object's signal is 
sent to the corresponding FX tracks in the mixer. 

Audio Cleaning (view page 182), Echo/Reverb (view page 186), and 
Timestrech/Resample can also be accessed here. 

Note: Volume and balance curves are also present in the track. The set values in the 
curve are also active, respectively. 

 

Audio effect presets 
In the Media Pool you will find a broad palette of effect settings which you can add to 
audio objects via drag & drop. 
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Design elements in the Media Pool 
You will find a wide selection of decorative elements in this category: Templates for 
collages, color fields for backgrounds and test images and freely positionable image 
objects for animations. 

You should first look through all the options and take stock of what there is.  

• Open the categories one after the other to get a general impression. 

An example of application can be found in pointer objects (Media Pool > Effects > 
Design elements > Image objects > Present). These are various arrow symbols, with 
an added video mix effect. With them, you can select certain sections of the image. 

The design elements create own objects on a different track. You can use the lower 
handles to adjust the size of the borders to fit any length of the video. You can also 
achieve interesting effects by fading in and out. 

Note: Some design elements require track 6 to be empty. When using these, you 
will be notified of this before applying them. 

 

My Presets in the Media Pool 
Your personal effects configurations in the Media Pool can be saved and applied again 
later. You can reach these customized configurations in the Media Pool folder "Effects 
> My Presets". They may be dragged onto objects as usual. 

First, this folder will be empty, of course, because you still have to create your own 
configurations. 
 

Additional Effects 
Video effects plug-ins are additional programs from third-party developers that may 
be used to add additional video effects to video objects. MAGIX Video Pro X6 
supports the plug-in format of the freeware video editing software "VirtualDub", as 
well as the "VitaScene" and "Adorage" programs from "proDAD". A selection of 
tested VirtualDub plug-ins (.vdf files, also called VirtualDub filters) may be 
downloaded as an installer package directly from within MAGIX Video Pro X6.  

Important applications for plug-ins include the application of special effects and 
useful video editing tools. 
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Using video effect plug-ins 
In order to be able to use plug-ins, they must be installed first. MAGIX Video Pro X6 
checks whether plug-ins are already available. If not, it will offer to download them 
from the Internet or to set the plug-in path manually. 

In order to use a video effect plug-in, select the video or image object first, then open 
"Effects -> Extra effects -> Plug-in manager" in the Media Pool menu. This lists all 
available plug-ins on the right side of the dialog. 
 

Video plug-ins manager 

 

Effect templates for plug-ins: MAGIX Video Pro X6 does not include plug-ins due to 
licensing reasons. 

  You can save your settings by pressing the "Save" button and 
remove them by pressing "Delete". 

Available plug-ins: All available plug-ins are listed here. 

Add plug-in: The selected plug-in will be added to the editing chain ( "Plug-ins on the 
current object" list on the right side of the dialog).  You can load as many plug-ins as 
you like simultaneously. They are then edited subsequently according to the list 
sequence. The plug-in order can be changed using drag & drop in the list. 

Plug-in settings: Opens the settings dialog for the selected plug-in. All plug-in 
settings for the entire list can be saved together as a preset (effect templates for plug-
ins). 
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Advanced...: Opens the dialog with advanced settings. 

Navigation buttons: Switch to the previous or next movie via the navigation buttons 
in the lower part of the dialog of a movie.  

Last used: The settings used for the last videos will be applied. This option is active 
only if you edit one image after the next using navigation buttons (see above). 

OK: Settings will be applied to the current video. 

Apply to all: Effects will be applied to all objects included in the movie.  

Cancel: The dialog will close, settings will not be applied. 
 

Advanced... 

 

In the "Advanced" dialog, you can specify the search path for plug-ins. MAGIX Video 
Pro X6 checks these for available plug-in files at program start and adds these to the 
list of available plug-ins. "Add search path" adds new search paths, and "Delete 
searchpath" removes them from the list again. 

Check file extension: Accelerates the search for new plug-ins if a larger number of 
plug-ins are available by not checking if they are valid. 

Scan subfolders: Extends the search to subfolders below the selected paths. 

Local settings 
Recalculate video effect plug-in on bitmaps for each frame dynamically: If you apply 
a plug-in to a bitmap (image), then this option must be activated in case the plug-in 
creates moving effects. 
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Animate objects, effect curves 
The "Effects" tab under "Video effects" and "Movement effects" provide you with the 
effects which can animated using keyframes. 

The following objects can be animated: 

• Combined objects 
• Video objects 
• Image objects (still images) 
• Title objects 
• Audio objects (in the Media Pool under "Effects" > "Audio effects" > "General") 
• MAGIX 3D Maker objects (3D texts) 
 

Preparing animations 
• First, select the object in the project window to animate. For complex animations, 

we recommend placing a marker beforehand for orientation. 
• In the Media Pool, open the "Effects" tab and click on the effect you would like to 

animate under "Video effects" or "Movement effects". 
• If necessary, set up the effect however you would like it for the start of the 

animation. 

 
• Using this button, at the bottom of the Media Pool, a timeline may be 

shown or hidden. You can see here which animated effects are currently 
applied to the selected object. Keyframes may be placed, selected, moved, 
and deleted. 

  

There are two stippled lines in the timeline to 
help you orientate yourself while you edit 
movement. These lines will help you recognize 
the start or end of the transition. 

 

Place keyframe 
Click the timeline to set the playback marker at the locations where a keyframe 
should be added. 

Note: You can also use the timeline in the project window for exact positioning. 
Using project markers (view page 106) is recommended in this case. 
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 • This button places keyframes for all parameters required in the animation. 

• Additional keyframes may be added simply by placing the playback marker at the 
next keyframe location and changing the effects parameters directly. 

The positioned keyframes may also be retroactively moved via drag & drop. 
 

Copy keyframe 

 • Select the keyframes to be copied by clicking them and then press the 
"Copy" button. 

 • Next, set the playback marker at the location for insertion and the press 
the "Insert" button. 

 

Display keyframes of individual parameters 
Multiple keyframes are added simultaneously to effects if they include multiple 
parameters. 

 

Click the small arrow beside the name of the animated effect 
to display all of its parameters. 

 

Now all keyframes of the effects parameter can be individually 
moved, deleted, activated, and deactivated. 

Note: Only those parameters are listed which are used for the animation. As soon as 
another parameter is required for editing the effect, it becomes visible to you here. 

 

Retroactively editing an effect's keyframes 
Previously set keyframes can be retroactively and temporarily moved and their values 
edited. 
 

• Keyframes may be moved via drag & drop. Simply click on the keyframe to be 
moved and drag it to the desired position. 

 

• To change an effects setting for an already positioned keyframe, click the 
keyframe and adjust the effect in the Media Pool. 
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Delete keyframe 

 

Select the keyframe to be deleted by clicking it. 

 

 This button removes the selected keyframe. 
 

Keyframe interpolation 
Keyframe interpolation refers to the process of how the transition is made from one 
keyframe to the next. This can either be constant ("linear") or flattened ("Bezier"). 

The interpolation type for each animated effect can be set using the interpolation 
buttons in front of the keyframe bar. 

 

In addition to the standardized curve progressions you can also create (view page 
148) any kind of curve progression you like. 
 

Linear interpolation 

 Linear interpolation is the default setting.  

This transfers the values evenly as a straight line to the following keyframe. 
 

Soft movement 

 The automatic Bezier interpolation applies an approximation curve at the 
keyframe. 

This makes the movement progression softer and more natural.  
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Manual Bezier interpolation 

 Manual Bezier interpolation enables you to set the value for each keyframe 
separately. 

To do this, right-click on one of the keyframes in the keyframe bar. This will open a 
context menu with four options. 

 

Linear (default setting): Keyframes set to "Linear" are entered and left with a constant 
parameter change. 

Ease In: In this setting the parameter change slows down just before the keyframe. 
The effect curve before the keyframe is slowly flattened. The effect curve after the 
keyframe proceeds in a linear fashion. This setting is not suitable for the first 
keyframe.  

Ease Out: In this setting the parameter change starts after the keyframe and becomes 
slowly more intense. The effect curve after the keyframe starts off flat and becomes 
progressively steeper. The effect curve before the keyframe proceeds in a linear 
fashion. This setting is not suitable for the last keyframe.  

Ease In/Ease Out: This sets the options „Ease In“ and „Ease Out“ in combination. 

Note: Please keep in mind that the settings for two keyframes that follow one 
another are always work together. This means that if you set one keyframe to 
"Linear" and the next one to "Ease In", the effect curve will still be slightly bent. In 
this case, a complete linear change of the parameter can only be achieved by setting 
the second keyframe to "Linear" or "Ease Out". 

Example: 
Left keyframe: Ease Out 
Middle keyframe: Ease In/Ease Out 
Right keyframe: Ease In 

 

Editing an effects curve in the object 
 Activate effects curve: For each of animated effects parameter, a curve is 

created and placed over the object. Click this button to display the effects curve 
on the object. 
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Edit curve points: The curve point can either be edited with 
the individual curve points (in "Standard" mouse mode) or 
by freely drawing the effect curve (in "Curve" mouse 
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and 
clicking; existing ones can be deleted in the same way. Every curve point can be 
moved with the mouse horizontally and vertically. 

Note: The buttons for activating effects curves are first displayed once the first 
keyframe has been placed. 

 

Effects curves - Additional functions 

 

The context menu can also be opened via the small arrow beside the effects indicator. 
 

Delete effects: Removes the selected effect completely. 
 

Delete effects curve: Removes the effects curve to be created again. 
 

Copy effects curve: The effects curve is copied to the clipboard to be used at other 
positions. 
 

Insert effects curve: A previously copied effects curve can be inserted elsewhere with 
this function at any time. This may be in the same object or in another object. 

Note: If you would like to insert the curve into a longer or shorter object, then think 
about setting the option "Connect curve length with object length" correctly before 
copying. 

 

Combine effects curve with object length: If this option is set, then changes to object 
length will affect the effects curve accordingly. 
In practice, this behavior is needed rarely, for example if objects are stretched or 
compressed. The option is deactivated by default for this reason. 
 

Load effects curve: A previously saved effects curve may be loaded via this menu 
item. This is useful, for example, if you have added your own default animations. 

Caution! The current effects curve will be overwritten as another one is loaded. 
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Save effects curve: Effects curves can be saved as a separate file. This is useful, for 
example, if you want to add your own default animations and simply load them again 
at other positions again. 

Tip: Be aware that during saving the setting "Connect curve length with object 
length" is saved as well and applied during loading. 

 

Edit effects curve 
This dialog serves to stretch, compress and move effect curves within an object. The 
info bar of the dialog will display the effect, whose automation curve is currently being 
edited. 

Move position 
Time: With each click on the arrow, you can move the effect curve forward or back by 
the displayed time value. 

Effect: Every click on the arrow up or down moves the effect curve by the entered 
value. Depending on the effect, it is possible to enter exact or percent values. 

Stretch/Compress 
Time: The effect curve will be stretched or compressed by the entered time value. 
Invert reverses the curve on the time axis and reinserts it in "reverse". The entire 
object duration will be considered. 

Effect: The effect curve is stretched or compressed in its values, no time-related 
editing takes place. The selected option (see table) is decisive in editing. 

Mirror: The entire curve is mirrored along the X-axis, whose position is determined by 
the following option (see table). 

... around object center: 
The X-axis lies exactly at 
the center of the object. 

 

...around curve center: The 
X-axis lies between the 
upper and lower 
automation point.  

...around curve minimum: 
The X-axis lies at the level 
of the lowest automation 
point.  
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...around curve maximum: 
The X-axis lies at the level 
of the highest automation 
point.  

 
 

Animations outside of the image area 
Animated effects are useful for making objects or titles appear to "fly" across the 
image. In this case it is recommended that the start and end point of the animation 
are placed outside of the image. 

This will require a video object and a second object to be animated, for example a title 
or a small object to float across the video image. 

Here's how it works: 

• Click on the program monitor and zoom out of the video image (Ctrl + mouse 
wheel). This displays the workspace at the edges of the reduced preview image.  

• Select the effect "Size/Position" (view page 134). 
• Move the object to be animated to the position  on the workspace where the 

animation should start; for example, to the left of the preview image: 

 

• Position the playback marker at the location where the animation should start. 
• Create a keyframe for the animation start. 
• Position the playback marker at the position where the object to be animated 

should disappear from the image. 
• Move the object to be animated to the position on the workspace where the 

animation should end; for example, to the right of the preview image. 
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• A second keyframe for the end of the animation will be placed automatically.  
• Play back the result. 

The object to be animated should now fly from left to right through the video picture. 
 

Create effects masks 
Create effects masks with MAGIX Video Pro X6 
Effects masks help you to apply effects in different areas of one video image with 
varying intensity. A specific image is used as a mask to determine the specific areas 
where the effect should be applied.  

Typical application include: 

• Image optimizations: A typical example are horizontal camera pans of the 
horizon, where the lower or upper image area should be made brighter or color-
adjusted. 

• Eye-catching color gradients, colorations,  etc. 
• Special effects such  as pixelation of a car license plate. 

Effects masks are regular image objects, and as such may be animated or attached to 
a certain image position to use them as moving video images. 

Proceed as follows: 

 

• Select the object in the arrangement to apply the 
effects mask to. 

• Open the desired effects page in the Media Pool. 
• In Media Pool, set the effect parameters which should be applied with the effect 

mask. These must be parameters from the "video effects" area (without "speed" 
and "chroma key"). 

• Click on the button with the arrow pointing 
down on the effects page and select "Load 
effects masks" from the menu. 

 

In the folder that opens you will now find templates for SD and HD material. Double 
click on the mask that you would like to use. The brighter the area in the effects mask, 
the stronger the effect will be. Black indicates no effect, and white indicates full effect. 
If you use your own color images, only the brightness values will be used. 
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• In the effect overview you can also 
make settings that will apply the effect 
mask for all other effects, too. Click on 
the masking button for each effect, for 
which the effect mask should be 
applied. 

• Click on the down arrow button again and select the "Delete effect mask" entry 
from the menu to remove the effect mask. 

To now apply the mask on a certain portion of the video image, you have to edit it 
further. There are many options available for editing effects masks: 

• You can define the size and the position of the effect mask in such a way, that the 
mask fits exactly over the image element to be edited. Please read more on this in 
the section "Position/size" (view page 134). 

• You can attach the mask to the position in the video so that it moves together 
with the image element. To find out more, read "Attach to picture position in the 
video (view page 157)". 

• Or animate the effect mask object directly. To proceed, please read the "Animate 
objects" (view page 145) section. 

 
T 

Tip: You can also use your own effect masks. Any image or photo in JPEG format 
can be used. You can draw a suitable image in a graphics program, save it as a JPEG 
and load it using the "Load effects mask" option in MAGIX Video Pro X6. 

 

Designing effect masks with Xara Designer 
You can also create animated effect masks in Flash format to adjust the effect 
regulation to the moving video images. To do this you will need to have either Xara 
Photo & Graphics Designer 2013 (or newer) or Xara Designer Pro X (or newer) 
installed on your computer. 

Please proceed as follows: 

1. Select the image or video object for which you would like to create an effect mask. 
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2. Open the effects page in the Media Pool that will be used as the effect. Click on the 
down arrow button and select "Create effect mask".  
Here you will also see the option for deleting the effect mask if necessary. 

 

Xara Photo & Graphic Designer or Xara Designer Pro X will start with the animation 
document and the opened frame gallery. The first frame will be added automatically 
and will display the selected image or video object from MAGIX Video Pro X6.  

3. Create effect mask: 

Note: Be aware that the lighter the effect mask, the stronger the effect will be later in 
MAGIX Video Pro X6. Black indicates no effect, and white indicates full effect. The 
best option is to color the object that will be used as the effect mask white and to 
adjust the intensity of the effect yourself in MAGIX Video Pro X6. 

• Use the tools in the editor to create the desired mask form. Add an object that 
marks the area where the effect should later be applied. It will automatically be 
assigned to the first frame.  
With the "Invert mask" function in MAGIX Video Pro X6 you can use an object to 
indirectly select the precise area where the effect should not be applied. 

• Color the object white.  
• Give the object a name by clicking on "Names..." in the context menu. Enter the 

name under "Names" and click on "Add" and then "Close". 
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• Create additional frames by clicking on "Copy" in the Frame Animation Gallery. 
The object that should move will automatically be added to the new frame. 
With each new frame the video moves to the corresponding position making it 
easier for you to adjust the objects directly on the video image by moving them to 
the right position. 

 

Tip: More information about Flash animations is available in the documentation for 
the editor. 

4. Close the document from the external editor. You do not need to save it because it 
is automatically transferred to MAGIX Video Pro X6 when it is closed. It will then 
appear as a linked effect mask object under the image or video object.  
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If you would like to edit the effect mask retroactively, double-click on the effect mask 
object to start the external editor with the opened mask. 

The next thing to do is set up the effect that will be regulated by the effect mask. 

5. Set up effect:  

• Select the source object for which you just created the mask. 
• Set up the effect parameters in the Media Pool that should be regulated by the 

effect mask. These must be parameters from the "Video effects" area (without 
"speed" and "Chroma Key"). 
The effect will be applied to the whole object. 
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6. Activate effect mask: 

In the effect overview click on the mask icon in the bottom edge of the Media Pool for 
every effect the mask will be applied to.  
You can invert the effect mask by clicking on the small arrow on the left of the effect 
mask object. The effects will then be applied to the rest of the image instead of the 
mask. 

 
 

Reverse mask 

 

You can reverse masks: To do so, click on the arrow in the mask 
effect object which appears as soon as you place the mouse 
cursor over it. All dark areas will become light and all light areas 
will become dark. By clicking again, you will remove the reversal 
again. 
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Attach to picture position in the video 
You can attach a video, picture or text object to moved picture content of another 
video. The attached object automatically completes the movement of a picture 
element from the film, making it appear magnetic. For example, you could use this 
method to insert a hat that stays on someone's head throughout, even if the person 
hops through the picture.  

Let's roll: 

• Place an overlay object (e.g. a photo of a hat) on a track below a video with a 
moving image element (e.g. a walking person). 

• Right click the object and select the "Attach to picture position in the video" 
movie point. 

• Then click "Continue" in the dialog that appears. 

Note: If you want to attach two objects, e.g. a title and a speech bubble, an 
additional dialog appears, which lets you select the objects you want to attach to 
your video. 

• The next dialog asks you to draw a frame around the image content to be tracked. 
The content should have high contrast to its background. 

• Movement will be automatically calculated and a series of keyframes that control 
the position and size of the effect according to your wishes will be generated. 

 

Create overlay graphic/animation 
Create vector graphics or animations in an external editor such as Xara Designer Pro 
in order to use them as overlay objects in MAGIX Video Pro X6. A typical use 
scenario would be to draw an object in order to darken certain portions of the video, 
such as a black bar to cover a person's eyes. Overlay objects aren't bound to the 
source material by grouping. They can me moved and edited as you please.  

Note: This menu will appear only when a corresponding graphics program is 
installed on your PC. 

To create an overlay object, proceed as follows: 

1. In the arrangement, select the image or video object, for which an overlay effect 
should be created. 

2. Right-click on this object and in the context menu select "Create overlay 
graphic/animation". 
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The external graphics editor will be launched. Your selected object will be displayed 
to help you get a better idea of how to best design your overlay.  

3. Create the template for the overlay object. You can use all editor functions. 

 

4. Close the editor You don't have to save the project in the editor, as the overlay 
object will automatically be transferred to MAGIX Video Pro X6 and placed below the 
image or video object when the program is closed. 

You can continue to edit it in MAGIX Video Pro X6 as you wish, for example using 
Animated movement effects (view page 134). 
 

Image stabilization 
The motion stabilizer reduces unsteady camera motion and helps to smooth pans. 
This option can be accessed from the context menu of a video object or the "Effects" 
menu > "Open video objects". 

Functionality 
Image stabilization balances undesired picture movements. The motion stabilizer 
equalizes inadvertent movements in the image by moving the image in the opposite 
direction in accordance with the wrong movements. This produces unusable edges in 
the footage that are cut off automatically, and black strips, which are then removed 
using a zoom shot. The result: A clearly more stable, almost imperceptibly larger 
picture. 

Application 
First you have to check the movie material for shaky scenes. To do this click on the 
"Stabilize" button. Based on the preset parameters, a relative shift between the 
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pictures is calculated. After concluding the analysis, take a look at the suggested 
correction, then use the slider for further adjustments. Once you are happy with the 
final correction click OK. If the first scan did not provide a satisfactory result, try 
changing the parameters below and repeat the process. 
 

Image stabilization dialog 

 

Stabilization radius for analysis: To prevent the image stabilizer from recognizing 
every camera movement as unwanted shakiness, you can determine the radius within 
which movement is accepted; the larger the stabilization radius, the more shakiness is 
corrected. Changing this parameter will require re-analysis of the source footage. 

Section of analysis: This area determines the area of the footage that should be 
analyzed. The center of the image is preset. If shaking occurs in one area more than in 
another, then you can move the analysis area (e.g. a foreground element at the edge 
is especially shaky). To do this, use the mouse to “capture” the shaky area. The 
smaller the area, the quicker the analysis will be calculated. Generally, changing this 
parameter will require re-analysis of the source footage. 

Maximum displacement: Correction moves the image accordingly to the shaking 
movements. This means that the edge of the image will be removed. This value 
determines how large the edge area is which may be cut away by the stabilization 
feature; the smaller the value, the less movement correction. Changes to this value 
are immediately applied. 

Temporal smoothing: This value determines the speed of the movements considered 
shaky. This allows you to differentiate between a panning shot and a nervous hand-
held shot. Changes to this value are immediately applied. 

Cancel: Exits the dialog without accepting changes to settings.  
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Reset: Resets the current settings. 
 

Image improvements for the entire movie 
You can open the effects from the the settings via the "Effects" menu. All of the 
settings made here influence the entire movie. Settings are made separately for each 
individual movie in the project. 

On the right, you'll see a preview of the current setting. Use the position slider to jump 
to different positions in the movie or to various scenes in order to see how the 
selected setting affects the image material. 
 

Brightness/Contrast 
Brightness: Use the sliders to reduce or increase the objects' brightness. 

Selective brightness (gamma): “Gamma” determines the mean gray scale that can be 
calculated from the various color ranges. "Selective brightness" is the most important 
function for image improvement. In the preset list, select the various envelope curves 
to edit only the dark, median, or brightest areas of the image. 

Using the fader you can also set the power of the brightness/darkness adjustments. 

Contrast: You can increase or lower the object's contrast. 

Color space correction: This option is effective against powerful colors that violate TV 
standards and can no longer be displayed correctly on-screen. The color saturation of 
the affected material is thereby reduced until the maximum permitted value is 
reached. 
 

Color 
Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is applied which makes color changes related to 
other parameters (e.g. contrast settings) in order to achieve the most natural 
coloration possible. 

Hue: Use the palette to select a hue for coloring in the picture. 

Red/green/blue: Changes the color mix using the slide controller. 
 

Image sharpness 
You can reduce (soften) or increase (sharpen) the object's focus using this slider.  

"Fine adjustment" allows you to set how sharp surfaces or edges should appear. Using 
it, you can effectively decrease persistent image deficits. 
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Anti-flickering filter intensity: The anti-flickering filter affects only still images. It is 
especially intended for zooms in images with many edges and transitions with high 
contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to 
flicker when they are reduced in size. This filter smoothes these edges somewhat. 
You should set the intensity of the anti-flickering filter according to your preferences, 
because smoothing is always a compromise between good contrast and fluid image 
sequence during playback.. 
 

Anti-flickering filter intensity: The anti-flickering filter affects only still images. It is 
especially intended for zooms in images with many edges and transitions with high 
contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to 
flicker when they are reduced in size. This filter smoothes these edges somewhat. 
You should set the intensity of the anti-flickering filter according to your preferences, 
because smoothing is always a compromise between good contrast and fluid image 
sequence during playback. 
 

TV cropping 
This option provides optimal adjustment of the image size for a real television screen 
(anti-cropping). Without this adjustment, the screen could cut off edges of the image 
in some cases. 

Show TV screen area in preview monitor: This option displays the image borders of 
the television as lines in the preview monitor. The four image borders of the TV area 
may be specified via the four input fields. Of course, the real size of the TV image 
must be familiar for this. The following process is available to determine this: 

The four input fields also enable the borders of the four sides to be adjusted freely in 
percent. In this case, the best approach is to determine a balance between reduction, 
bar formation, and the image section: 

• If all four edges feature the same value, then the image will be reduced 
proportionately. In this case no distortions will occur, but there will be bars along 
the edges. 

• If different values are entered for the 4 fields, the image size is reduced 
disproportionately. This will distort the image. 

Apply border range to: With this option, the entered values for the four borders are 
applied as an image reduction. The result may be checked immediately in the preview 
monitor. 

Determining the visible TV frame size 
To determine the picture properties of your television as well as optimal image size 
editor settings, you should perform a test run:  

• Load the project "Visible TV image" from the folder "My Media -> Projects -> 
Visible TV image" in the Media Pool. 

• Play back the film and read the instructions on the video screen. 
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• Burn the project to DVD 
• Place the disc into the player and play the film. Compare the TV picture to the 

picture displayed on your video screen by MAGIX Video Pro X6. 
• Determine the proportional value of the borders cropped by the television with 

the four measurement scales along the edges of the test picture. 
• Enter the values in the "Full TV size" editor. 

The image size is now optimized to your TV picture. Please note: Depending on 
device settings and disc media type, the cropping values may vary slightly. 
 

Image improvements for individual objects 
The context menu or in "Effects -> Video object effects" features various adjustments 
for selected video and image objects. 

Interpolation for interlace material: Select this option to remove interlace artifacts 
from the (video) image. If, for instance, you extract still shots from a video, interlace 
artifacts appear in sequences which feature movement. 

Anti interface filter: Choose this option for still pictures with detailed structures and 
high contrast. This filter reduces line flickering during TV playback. 

Border crop adjustment: Select this option if the edges are cropped during playback 
on your television. Values stored in "Film effect settings (view page 162)" will be 
applied. 
 

Stereo3D 
MAGIX Video Pro X6 enables the editing and creation of "genuine" 3D videos and 
photos. First, let's create an overview of this complex topic by familiarizing ourselves 
with the most important principles and the golden rules that are involved. Next, we'll 
look at the individual steps of the workflow in more detail. 

Note concerning 3D content: Some people experience unpleasantness (e. g. 
headaches, straining, exhaustion of the eyes, or nausea) when viewing 3D videos. 
We recommend taking regular breaks for this reason. In case of problems, the user 
should immediately stop use and refer to a doctor or optometrist. Incorrect 
production of 3D-content may also produce these symptoms. 

Warning for small children: The sight of small children (especially those younger 
than six years old) is still developing. We recommend referring to a doctor or 
optometrist prior to allowing your child to view 3D-videos. 
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3D basics 
Human eyes perceive objects from 2 different angles and our brain "calculates" 
images from this information. This way we can tell the distance and position of an 
object. For this reason, 3D material should be shot according to this principle. 

Viewing 3D 
A regular screen or TV can show images only in 2 dimensions, and various 
technologies have been developed to enable perception of images in 3D. To this day, 
all technologies share the following: You need special glasses to deliver different 
information to the left and right eyes. We will examine these technologies in detail 
later. 

The three golden rules 
• Stay within limits during recording: To make a 3D recording (view page 164) with 

realistic depth information, certain limits must be respected. The most important 
rule is not to go below the point of minimum distance. Minimum point is the 
point in the picture, where the camera is the closest. 

• Frame closest point: In order to place the 3D effect behind the imaginary frame, 
both image components must over lay each other exactly at the closest point. At 
the same time, the same objects must be visible at the edges of both partial 
images, for which, if needed, you can use the Cropping function in the Media Pool 
(view page 135). 

Note: The imaginary window is a type of a plane, behind which the 3D movie plays. 
You select the closest, frontmost point. Not keeping up with this rule can result in 
the object to "jump out" of the imaginary window, which when used too much, can 
cause headaches. 

• Maintain realistic eye angles: Object with a 3D depth effect viewed as a red/cyan 
image (Anaglyph) without glasses will appear displaced. This displacement 
should, if possible, take up less than 1/30 of the entire image. Otherwise, it will 
appear that the eyes are looking in different directions. 

Notice: Displacement may only occur along the horizontal axis. Displacements on 
the vertical axis and rotated portions must be adjusted. 

 

Record 3D 
The distance between eyes in humans is ca. 65 mm, which forms the so-called 
"stereo base width". But because our eyes are dynamic and we can even "cross" our 
eyes, it is possible to focus on objects that are closer. 
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Various techniques exist for 3D recording. Each method has its advantages and 
disadvantages: 

• 3D cameras with two lenses: The advantages are obvious; these cameras produce 
3D material without excessive work involved. The disadvantage is that the stereo 
base width (lens distance) cannot be changed. 

• Two cameras on a special mount: This involves a little more work. Two cameras 
are mounted on a special support to record material for the left and the right side 
of the 3D image simultaneously; microphone booms for stereo recordings may 
also be used for this purpose. 
The disadvantage in this case is that the shutter releases have to be pressed at 
exactly the same time if there are moving objects in the picture. In case of video, 
both movies must be synchronized before being edited. 
Advantages: Stereo base width may be changed by adjusting the distance 
between the cameras; larger selection of camera models. 

• Two photos via the same camera: This technique only allows still images. The 
camera is simply used to record two images from different perspectives, and 
these are used as the right and left images. For best results, use a tripod. 

• Consistently fast camera movement, e. g. along a street: Only a single 
conventional camera is required in this case, but the range of applications is very 
limited. This is the most cost-effective method for creating 3D videos. Material is 
filmed at a speed of circa 6-to 15 km/h. During editing, the edited video object is 
duplicated and one of the videos is played back with a time lapse. The movement 
direction determines which is the right and left image. 3D photos may also be 
created using this method. 

Warning, minimum distance! 
The position of the object closest to the lens is designated as the minimum point. This 
minimum point may not exceed a specific minimum point; this is easy to calculate via 
the following formula: 

Note: Lens focal point (e. g. 25 mm) x stereo base width (e. g. 65 mm) x 1.5* /1 
mm= minimum point (2437.5 mm ~ 2.44 m) 
*1.5 is a factor derived from the cut-off appearing when filming through a lens. 
**1 mm is the so-called "deviation" or "spatial dimension". This only involves a rough 
value in this case. 

Examples for 3D cameras: 
Panasonic HDC-SDT750 ( base width 12 mm): minimum point is approx. 1.5 m. 
Fuji REAL 3D W3 (base width 75 mm): minimum point at approx. 3 m; for long-
distance recordings as much as 8 m. 

This so-called minimum point has an important role in other aspects of 3D editing. 
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Prepare 3D editing 
3D videos are filmed and saved by different cameras, which means: depending on the 
camera model or recording method, the videos or images vary. 

In one file 
Many cameras, especially for photo recordings, create one single file containing the 
left and the right image next to one another. 

• Drag these files from the Media Pool directly into your arrangement.  
• Select the created objects. 
• Select the "Side-by-Side (left images left/right)" entry in the Media Pool under 

"Effects > Stereo3D > Properties > Create stereo". 

In multiple files 
Some 3D cameras create a file for each the left and the right side. This working 
technique works also if you simply take 2 pictures with a regular photo camera. 

• In the Media Pool, open the folder in which the desired file can be found. 
• Sort the files in increasing order according to the date. This way, all files will lie in 

pairs one below the other. 
• Now, select the files and drag them from the Media Pool directly into your 

arrangement. 
• In the Media Pool select "Side-by-side (left image right/left) under "Effects > 

Stereo 3D > Properties > Create stereo" for material with halved width. 

Note: If you have created side-by-side material yourself (e.g. placed two photos next 
to each other in an image file), proceed as described, but at the end select the "side-
by-side (left image left/right)" for material with full width. 

 

Set playback mode for 3D 
There are various techniques available for playback of 3D videos on the computer. 
Depending on the technology used, the corresponding playback mode may be 
activated in MAGIX Video Pro X6. 

Select the 3D mode you want to work with in the upper left corner of 
the video monitor. 

Here is a list of available techniques and the corresponding requirements: 
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3D mode Equipment Requirements 
View partially interlaced Polarizing filter • Polarizing filter glasses 

• Special monitor, typically referred 
to as a 3D monitor or  similar 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Shutter export Shutter mode • nVidia 3D Vision Kit 
• 120 Hz monitor/projector 

Side-by-Side- 
Display 

Side-by-side • 3D TV device 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Note: These three modes should be set only when the preview image is to be 
exported to a separate monitor or TV device. Shutter mode also requires a 3D-
capable graphics card. 

Anaglyph display Color anaglyphs • Red/cyan glasses 
 



 

168   

http://pro.magix.com 

Align videos and images for 3D 
Anaglyph display is recommended for this and can be set in the video monitor (view 
page 166). Precise geometric alignment of images is only possible in this mode. 

Note: If you want to edit 3D-video material, it is recommended to conduct scene 
recognition and split the video into individual scenes. This is necessary because the 
left and right side of each scene must be arranged individually. 

The so-called minimum point is the point in the 3D picture that is closest to the 
lenses. This forms the "center" of the 3D image and must be defined as such in 
MAGIX Video Pro X6. 

To do this, go to the Media Pool and select the option "Effects" -> "Stereo 3D" > 
"Alignment".  

 

Move both images one over the other so that the minimum point of both sides is at 
the same location on the screen. 

You should first see whether automations for spatial adjustment and synchronization 
deliver the desired results. Click on the button "Automatic". 

If you notice that the left and right images are on the wrong sides, click on the "Swap" 
button to reverse this. 

If this does not produce the desired effect, proceed as follows: 

• Find the minimum point in the image. 
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• If the images are offset vertically, they need to be balanced using the lower of the 
two slide controllers under "Spatial alignment". 

• If the images have rotational differences, you have to adjust these with the knob. 
• Try to position the minimum points of both sides precisely one above the other 

using the upper slider. 
• To test the results, put on the cyan/red glasses. In case the image has an 

exaggerated spatial depth, try to position the left and right sides closer to each 
other using the controls under "Spatial alignment". 

 

• Use perspective correction in case the left and right image haven't been recorded 
in quite the right perspective in relation to each other in order to be able to join 
them into a single clear 3D image. Enter values into the dialog or drag on window 
edges in the video monitor. 

 

Turn camera movements into 3D videos 
Camera movements may be transformed into 3D videos by being duplicated and 
converted via time displacement. To do so, you can simply record on the right or the 
left side while, for example, driving along a street. 

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the 
frame rate, the focal point, and the distance of the objects being filmed (among other 
things). At increased speeds, it may occur that the spatial impression is too strong 
and the filmed material seems unnatural and unpleasant. 

• If the video is in the arrangement, the stereo depth for the 2D object may be set 
in the Media Pool via "Effects -> Stereo 3D --> Properties". 

• Depending on the direction of the recordings, you will have to move the control 
either to the right or the left.  
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• Check the results in the anaglyph display with red/cyan glasses 
• Correct any unrealistic effects by adjusting the controller in the opposite 

direction. 
• If the spatial depth is exaggerated, reduce the changed parameters. 

Note: Not only camera movements, but also other 2D materials may be arranged 
spatially. 

3D material may be edited with the same functions as 2D material. 

 

Export and burn 3D videos 
There are no special requirements for export and burning. Only the desired 3D 
technique is specified. 

Anaglyph: This technique is recommended for uncomplicated playback of finished 
videos or playback via conventional TV sets or projectors. Viewers must simply put 
on a pair of red/cyan glasses to be able to enjoy a 3D film. 

Side-by-side: Create 3D movies for a 3D-capable playback device without having to 
compromise the quality. It doesn't matter initially whether your video is viewed in 
"Shutter" mode or via "Polarized filter". 

• Depending on the playback device, you should set double the resolution in order 
to get an image in full resolution for the left and right partial image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output via the anaglyph technique. 

Note: When exporting into Side-by-Side- formats, make sure that the horizontal 
resolution equals the sum of both images, while the aspect ratio (such as   16:9) 
relates to one test image! 

Only left/right side: With these settings, you won't export in 3D, but just one side of 
your 3D -video. 

Flicker image: This way you can view 3D material without 3D glasses. The material 
will be shown in an alternating order, creating an impression of flickering images. 

On top of each other: This export option is similar to the "Side-by-Side" option. The 
images will be exported not next to each other, but one over the other. 

• Depending on the playback device, you should set double resolution to get an 
image in full resolution for the top and bottom partial image. 
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• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output via the anaglyph technique.  

Note: When exporting into the one-over-the-other-formats, make sure that the 
vertical resolution is the sum of both images, but that the aspect ration (e. g. 16:9) 
relates to the partial image! 

Export files/upload movies to the Internet 
All file exports can be found via "File > Export movie" or "File > Online". Depending on 
the export format and destination, the export dialog also allows the 3D technique to 
be used to be selected. 

Burn 
When burning a Blu-ray Disc or DVD, you must first open the encoder settings in the 
burn dialog and set the desired 3D technology. Next, you may proceed to burn the 
disc as usual. 
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Measuring instruments 
In MAGIX Video Pro X6 there are four measuring instruments that can be used in 
various situations. The various application cases are listed in the descriptions of each 
measuring instrument. 

The following measuring instruments are available: 

• Vectorscope 
• Waveform monitor 
• RGB parade 
• Histogram 
 

Operation of measuring instruments 
Requirements 
• The computer is equipped with a graphics card that supports DirectX 11. 
• The source monitor is displayed. 
• There are video or photo objects arranged in the project window. 
• In Program settings > Display options > Preview in arranger > Video mode (view 

page 260) the default setting is „Standard (Hardware acceleration, Direct 3D)“. 

Open measuring instruments 

 

1. Use a simple mouse click to open the source monitor menu. 
2. Select the entry for the desired measuring instrument: 

- Vectorscope 

- Waveform monitor 
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- RGB parade 

- Histogram 

- All meters side by side 
3. Place the playback marker on the desired position in the project window. 

The measuring instrument will display the measured value in realtime. 
 

Description of measuring instruments 
The measuring instruments are displayed in the source monitor and always 
correspond to the content on the video monitor. The measuring instruments are 
either shown individually or all together. 
 

Vectorscope 
• The vectorscope is a color circle 

with a black background. 
• Only the points on the color circle 

that represent the colors in the 
video monitor image are visible. 

• The vectorscope contains 
specified border points: 

- R – Red 

- M – Magenta 

- B – Blue 

- C – Cyan 

- G – Green 

- Y – Yellow 
 

• The color saturation limits run between the border points. 

Note: The positions of the border points depend on the settings of the measuring 
instrument (view page 178). MAGIX Video Pro X6 automatically chooses a default 
setting that is suitable for the material. 

Functionality 
• In the foreground the colors that are available in the image are displayed in the 

corresponding areas of the vectorscope. 
• The more frequently a color appears in the image, the more intensively it will be 

displayed in the vectorscope. 
• When a color is strongly clustered, the respective area in the vectorscope will be 

displayed in white. 
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• If a color is oversaturated, the color saturation limit can be clearly recognized. 
When large areas of the image are oversaturated, the corresponding color 
saturation limit is white. 

 

Cases for using the vectorscope 
Check image material for tinting 
Tinting in the image material can be recognized when the "cloud" tends to a particular 
direction. 

Calibrating cameras with the help of recorded test patterns 

Note: The calibration has to be performed separately for each movie situation. 

1. Record a calibrated test chart. 
2. Transfer recorded video to MAGIX Video Pro X6. 
3. Make any necessary adjustments using the video effects until the color values 

of the test chart are correctly displayed in the vectorscope. 

Detecting color oversaturation 
If the image material on the video monitor is strongly oversaturated, the "cloud" will 
tend to form in the outer area of the color circle. When the oversaturation is strong, 
the color space limits will cut the "cloud" in half. 

If you reduce the color saturation, the result of the effect will be updated in realtime. 

Check compatibility of color values 
To ensure compatibility with industry standards, the color values should not exceed 
the color space limits. Areas in the image with oversaturated colors can be recognized 
in the vectorscope at points that lie on the outside of the color space limits. 
 



 

Measuring instruments 175  

 

Waveform monitor 

The Waveform monitor  displays the 
brightness of the video . The connection to 
the position on the image remains intact. 

• X Axis (horizontal) 
The image position on the horizontal axis of 
the video monitor. 

• Y Axis (vertical) 
The brightness of the video (increasing) at 
the corresponding image position (X-Axis). 

• Brightness 
The brighter an area is displayed in the 
waveform monitor, the more image points 
there will be at this position (X-Axis) in the 
respective brightness area (Y-Axis) 

Image  in connection with the 

Waveform monitor  

The dotted lines on the upper and lower borders of the waveform monitor correspond 
to the values for digital 0 (black) and digital 255 (white). 

The lines 0 and 100 on the left border correspond to the limit values for analog 
transfer of video signals. 

The intensity of the curve is determined in the measuring instrument settings (view 
page 178). 
 

Cases for using the waveform monitor 
Locating areas in the image that are too dark or too light 
Because the horizontal axis of the waveform monitor corresponds to the horizontal 
axis of the image, a connection with the image can easily be made: 

• Lighter sections in the upper third of the waveform monitor: 
Very many image points in the upper brightness area. 

• Lighter sections in the middle third of the waveform monitor: 
Very many image points in the middle brightness area. 

• Lighter sections in the lower third of the waveform monitor: 
Very many image points in the lower brightness area. 

1. Transfer the horizontal position of the too light or too dark areas to the visible 
image in the video monitor. 

2. Locate the corresponding points on this horizontal position in the image. 
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RGB parade 

 

The measuring instrument „RGB Parade“ basically functions like the waveform 
monitor (view page 175) but shows the brightness areas of the colors red, green and 
blue individually. 

The example image (above) is dominated by warm colors meaning that the blue 
portion is lower than the green portion and much less than the red portion. It is also 
clear to see that the image has very few areas with high brightness. 

Each color area is divided up as follows: 

• X Axis (horizontal) 
The image position on the horizontal axis of the video monitor. 

• Y Axis (vertical) 
The brightness of the video (increasing) at the corresponding image position 
(X Axis). 

• Brightness 
The brighter an area is displayed in the waveform monitor, the more image points 
there will be at this position (X Axis) in the respective brightness area (Y Axis) 

The intensity of the curve is determined in the measuring instrument settings (view 
page 178). 
 

Cases for using the RGB parade 
Analyze the brightness distribution of individual colors 
Because the horizontal axis of each color corresponds to the horizontal axis of the 
image, a connection with the image can easily be made: 

• Lighter sections of the color in the upper third of the waveform monitor: 
Very many image points in the upper brightness area. 

• Lighter sections of the color in the middle third of the waveform monitor: 
Very many image points in the middle brightness area. 

• Lighter sections of the color in the lower third of the waveform monitor: 
Very many image points in the lower brightness area. 



 

Measuring instruments 177  

 

Tint detection 
If a vertical movement compared to the other colors is noticed for one of the three 
colors, a tint is present. When you regulate the saturation using the video effects, the 
result is immediately visible in the "RGB Parade" measuring instrument. 
 

Histogram 

 

The histogram shows the brightness distribution on the image. 

• X Axis (horizontal): Brightness increasing to the right 
• Y Axis (vertical): Frequency increasing to the top 
 

Cases for using the histogram 
Detect and correct overexposure / underexposure 
If too many white portions are present, the right border is white (100% and 
digital 255). 
If too many black portions are present, the left border is white (0% and digital 0). 

Analyze and adjust use of brightness space 
When partial areas of the brightness space are not being used, there will be areas on 
the horizontal axis with frequency value 0. No curve can be seen at these positions. 
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Settings 
Norm 

• Automatic: MAGIX Video Pro X6 makes the 
appropriate settings based on the Movie 
settings (view page 246). 

• Standard Definition Video BT.601: This setting 
is used for videos with standard resolution 
(PAL). 
The IBU-R BT.601 deals with a standard for 
the coding of digital interlaced signals. The 
standard defines how an analog TV signal 
with 525 lines/60 Hz and 625 lines/50 Hz is 
digitalized. 

 

• High Definition Video BT.709: This setting is used for videos in HD. 
The IBU-R BT.709(-5) defines all of the parameters required for HDTV. 

Note: This setting affects the measuring instruments "Vectorscope", "Waveform 
Monitor" and "Histogram". 

Intensity: The intensity determines the strength of the contrast in the measuring 
instruments. Lower intensity is suitable for highlighting values that occur very 
frequently. 

Note: This setting affects the measuring instruments "Vectorscope", "Waveform 
Monitor" and "RGB Parade". 

Single color display: The foreground of the vectorscope (i.e. the visual of the analyzed 
image) is displayed in green. This corresponds to the display on analog measuring 
instruments. 

Multicolor display: The foreground of the vectorscope (i.e. the visual of the analyzed 
image) is displayed in various colors. This can make it easier to interpret the results. 

Activate 75% display: The color space limits of the vectorscope are reduced to 75 % 
which corresponds to the values during analog image transfer. 

Display 7.5 IRE black level (NTSC): The borders in the waveform monitor are 
adjusted for the American NTSC standard. Deactivate this option for the NTSC 
standard in Japan. 
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Change measuring instrument settings 

 

Note: Only activate the "Norm" setting for test purposes or if the automatic 
detection fails. 

1. Use a simple mouse click to open the source monitor menu. 
2. Select the option „Meter settings ...“. 
3. Apply the desired settings. 

Result: The changes have an immediate effect on the measuring instrument. 
4. Click on the "X" button. 

Result: The dialog will be closed. 
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Audio editing 
For comprehensive audio track editing that goes beyond volume level adjustment, 
audio must be placed on a separate track.  

1. To place audio on a separate track, right-click on the desired object. The 
context menu will open. 

2. Select "Audio and waveform display" > "Audio on separate track" or use the 
"Ctrl + H" shortcut. The object's audio track will then be placed on its own 
track directly below and can be edited. 

In principle, any track in MAGIX Video Pro X6 can be used as a sound track. There are 
no specific track types. You can also place other audio objects, such as background 
music, on other tracks. But it is easier not to mix object types within one track. 
 

Load and edit audio files 
• All importable audio files can be accessed in the Media Pool. 
• Double-clicking on a file name loads it from the Media Pool into the source 

monitor. You can then preview them using the transport console on the source 
monitor.  

• The files can be moved to the project window or the project folder using drag & 
drop. Tracks from audio CDs can also be integrated using drag & drop. 

• A waveform display can be activated by right-clicking on the audio object. This 
shows the volume progression. 

• Edits, fine positioning, volume settings, and fading in and out can all be adjusted 
directly in the project window using the object handles. 

• Various effect curves (view page 148) can be selected for audio tracks, 
dynamically controlling selectable effects, volume or stereo panorama. 
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Audio effects 
Automatic track damping 
This command from the context menu automatically dampens the volume of other 
audio objects. The volume of the selected object on the track remains unchanged. 

 

Only original sound: Here you can also specify whether you want to dampen the 
original sound of the video or all audio tracks. 

Transition length: In the dialog you can activate and deactivate the value of the 
dampening. You can use this command while recording audio (view page 81) (Audio 
recording, advanced options). 
 

Create mono objects 
Mono recordings can leave noise on the second track, e.g. a mono microphone 
recording. You can deactivate the track with the noise by selecting the function "Use 
only left side" or "Use only right side" (but not with mono videos). 

You can find this function in the audio and video object context menu under "Audio 
functions". 
 

Using audio effects 
Object effects 
Just like with video objects, there are individually adjustable effects and effect 
templates for audio objects. These influence only selected objects. These can be 
found in the Media Pool under "Effects" > "Audio effects" or in the "Effects" menu > 
"Audio object effects" (view page 140). 
 

Track effects 
Track effects always apply to all audio objects of a track. They are set in the mixer 
(view page 182). You can open the mixer by pressing the M key on your keyboard. 

Tip: You can adjust the volume of the entire track in the track header. 
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Audio effects plug-ins 
MAGIX Video Pro X6 supports VST as well as DirectX audio plug-ins. These are 
usually effects modules such as reverb, equalizer, dynamics compression, etc. 

Installation 

Before using audio effect plug-ins, they first have to be installed – this process may be 
different depending on the plug-in. VST plug-ins are typically saved in a certain 
directory, which must be entered in the MAGIX Video Pro X6 path settings. After the 
path has been indicated, MAGIX Video Pro X6 scans it for working plug-ins and offers 
them to be used. You can also indicated multiple locations where VST plug-ins are 
installed. 

Using plug-ins 

 

Two so-called slots for track effects are located in the channel strip of 
the mixer for the corresponding track as well as in the FX tracks. 

Clicking on the small triangle will let you select an effect from the list. 
Select "No effect" to remove a plug-in from the slot.  

 

Master effects 
Master effects influence the mixed sum of all audio tracks. For this purpose a Master 
Audio Effects Rack and further plug-ins are installed in the Mixer window. The 
MAGIX Mastering Suite (view page 190) is also available to help produce perfect 
sound. 
 

Sound optimization 
This option opens an editor for correcting audio material discrepancies. 

Select the cleaning function you desire from the upper part of the dialog: 

• The equalizer (on page 184) allows you to manipulate the frequency spectrum – 
perfect for cleaning up muffled dialog.  

• The compressor is a dynamic volume control that lends the overall sound a 
deeper, richer quality. 

• The stereo FX processor justifies the position of the sound in the stereo 
panorama. 

• DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do 
exactly what their titles say they do. 

Presets: You can try out the suitability of a number of presets in the preset menu. 

Temporarily deactivate all effects: Switches all the effects off. 
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Apply to all scenes: Applies the selected cleaning settings of all effects to every scene 
of the movie. 
 

Declipper 
Should the input level of an audio recording be too high, overmodulation may result at 
the louder parts (the signal peaks). This digital distortion is also called "clipping": At 
the overmodulated area, the values that are too high are simply cut off, and typical, 
quite unpleasant-sounding crackling and distortion appear. 

MAGIX Video Pro X6 contains a special function for dealing with digital clipping and 
analog distortions. Of course, this only works to a certain degree. 

Using the fader you can set at what level the Declipper should register a signal as 
being overmodulated and, if required, correct it (Clip level). This is important, as 
different sound cards show different clipping methods. The more the fader is turned 
up, the lower the level recognized by the program as overmodulated. If the clip level is 
set too high, unwanted sound modification may occur. 

Get clip level: The clip level is gaged automatically. 
 

Denoiser 
The Denoiser removes persistent background noise like computer hum, hissing, 
noises from sound charts, disturbance from ground circuits, interference from audio 
equipment with high-impedance outputs (such as record players), impact noise, or 
the turntable rumble. 

The Denoiser requires a noise sample. Some typical noise sounds are included in the 
"Preset" selection menu.  

Set the degree to which the noise should be reduced with the fader. It is often better 
to reduce interference signals by 3-6 dB rather than as much as is possible in order to 
keep the sound "natural". 

A different option consists of creating a noise sample yourself. All that's needed is a 
short section from the audio track in which the distortion can be found. To get it, 
switch to the DeNoiser dialog by pressing  "Advanced". 
 

DeNoiser – Advanced settings 
Step 1: Choose a noise sample 
First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-
called "noise sample".  

You have two options to choose from: 

Pick out typical background noise: You can select and use a number of typical 
background noises from the flip menu. Select one and listen to it by pressing the 



 

184   

http://pro.magix.com 

"Play" button. If it is similar to the background noise in your sound track, go ahead and 
use it (see "Step 2: Removing background noise"). 

Extract a new noise sample from an audio track: You can also pick out a short 
passage (from the existing sound track) in which you can hear the background noise. 

Automatic search: Searches especially quiet passages in which background noise is 
most noticeable. 

Previous / Play / Next: These buttons allow you to play all of the passages found for 
easy comparison. 

Save as: Once found, you can save noise samples to the hard drive. They then appear 
as entries in the "Typical background noises" flip menu to be used in other projects. 

If you only wish to use the noise sample in the current project, you don't have to save. 
Instead just go to the "Remove noise" category. 

Step 2: Removing background noise 
Noise level: The level of the noise reduction function should be set as precisely as 
possible. Values that are too low are expressed at a low distortion dampening level 
and in artifacts, like noises or "twittering" (see below). High settings produce dull 
results – useful signals that sound similar to hissing noises are also filtered away. Try 
to find the best setting for the project at hand. 

Reducer: This sets the balance between the original signal and the signal with the 
applied noise reduction. It's often better to reduce interference signals by 3-6 dB 
rather than as much as is possible, so as to keep the sound "natural". In case of 
buzzing, it’s best to apply complete removal. 
 

Dehisser 
The Dehisser eliminates regular "white" noise typically produced by analog tape 
recordings, microphone pre-amplifiers, A/D converters, or transformers. 

Noise reduction can be regulated in decibels with the fader. It is often better to reduce 
interference signals by 3-6 dB rather than as much as possible in order to keep the 
sound "natural". 

Noise level: You can choose between different noise levels. The level of the noise 
reduction function should be set as precisely as possible. Low settings result in 
incomplete deletion of the hissing. Incomplete deleting of hissing produces artifacts 
and should be avoided, since high settings will produce dull results and some useful 
signals (i.e. woodwinds) which are similar to hissing are also filtered away. 
 

Equalizer 
The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and 
supplies them with separate volume controls to allow you to achieve many impressive 
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effects, from the simple rising of the bass to total sound transformation. If you raise 
the low frequencies too much throughout the whole level, it might cause distortions.  

Fader: The volume of each of the 10 frequency bands can be set separately with the 
10 volume controls. 

Link frequency bands: The frequency fields can be bundled together flexibly in order 
to avoid artificial-sounding exaggeration in individual frequency fields. 
 

Compressor 
The compressor is an automated, dynamic volume controller. Loud passages become 
quieter and the total value is raised. This makes the volume more consistent and 
speech easier to understand. A compressor is mainly useful in case background noise 
or music interferes with speech and simply increasing the volume of the individual 
objects or tracks does not result in any significant improvement. 

Level: Regulates the level of compression applied (the "ratio"). 

Function: Defines the compressor depending upon the sound material. 
 

Stereo FX 
The stereo FX processor provides adjustment of the alignment of the audio material in 
the stereo balance. If the stereo recordings sound weak and undifferentiated, an 
extension of the stereo base width can often provide better transparency. 

Bandwidth control: Adjust the bandwidth between mono (on the extreme left), 
unchanged base width (center) and maximum bandwidth ("wide" on the extreme 
right). 

Reducing the bandwidth can raise the overall level. In extreme cases, when the left 
and the right channels include identical material and the bandwidth control is pushed 
to the extreme left on "mono", the result can be a level increase of 3 decibels. 

Raising the bandwidth (values of 100) diminishes the mono compatibility. 
 

Effect devices controls 
Some effect options open a graphic window, which has the appearance of the studio 
effect device that it simulates (such as the "Echo/reverb" or "Timestretching" effect 
menus).  

These virtual effect devices are controlled either with common sliders, knobs and 
buttons or alternatively with graphic sensor fields. 

 

Sensor fields: Sensor fields can be controlled intuitively with mouse 
movements, with the graphic and the corresponding effect setting 
changing in relation to each other. 
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Power switch: Every effect device in the rack may be switched on or off 
separately. This button allows you to directly compare the neutral, unedited 
sound of the audio object with the effect setting you have chosen. 

 
Reset: Every effect has a reset button that restores the effect device’s initial 
default. In this state, the effect is not calculated into the sound, and the 
effect is not rendered. 

 

 
Preset selection list: Each effect device has a selection of 
proven presets which can be selected from a drop-down 
menu. 

 

 A/B: The A/B button compares two settings with each other. If you have 
selected a preset for the effect and make manual changes to it later, you can 
compare the original preset sound with the new settings by using the A/B 
button. 

Note: The displayed graphics serve only examples and can differ from device to 
device. 

 

Audio effect dialogs 
Some of the following effects can be opened individually (via the context menu), or as 
part of the track or master effects rack. However, the functionality remains the same. 
 

Echo/Reverb 

 

The echo/reverb effect device offers newly developed and very realistic reverb 
algorithms to add more spatial depth to your recording. 
 

Reverb 
Reverb is probably the most important but also the most difficult effect to generate. 

Parameters 
The reverb effect has the following parameters: 

Size: defines the size of the room (or the system for the plate and spring). The larger a 
room, the longer the sound travels between walls or objects. With some low "size" 
settings you can also reduce the distance between the individual reflections. This 
allows resonance to develop (accentuated frequency ranges), which can sound 
oppressive if the reverb sustain is too long. 
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Time: With this knob you can adjust the echo time and determine how much of it will 
be absorbed and, simultaneously, the reverb's decay. 

Color: You may influence the sound characteristics of the effect within certain limits. 
The effect of this controller depends on the used preset. In rooms, "Color" controls 
the dampening of the highs in the reverb (from dark to bright) as well as pre-filtering 
of the signal. With plate and spring presets, this fader determines the dampening of 
the basses as well. 

Mix: This controller sets the mix ratio between the original and the edited signal. For 
rooms, you can therefore move a signal further into the room by increasing the effect 
share. The last four presets are intended for use in an AUX channel of the mixer and 
are set to 100%. 

Presets 
The presets represent the basic settings for the various room algorithms, which can 
still be varied along with the other parameters. Hence, they are more than just simply 
parameter sets. 
 

Delay 
This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). Application of this effect in an AUX bus requires 
the controller to be set to 100% (all the way to the right). 
 

Timestretch/resample 

 

This option opens an effect device with which you can change the speed and/or pitch 
of the object. 

Pitch: This control changes the pitch independently from the object's speed 
("pitchshifting"). 
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Tempo: This control changes the speed independently from the pitch 
("timestretching"). The object acts as if it were compressed or stretched on the track. 

Tones/BPM: These fields serve for numerical alteration of pitch and speed. Only 
MAGIX soundpool files are suitable for numeric entries because they are equipped 
with information regarding pitch and speed. 

Setup: This button opens a setup dialog, where you can choose between various 
pitchshifting and timestretching processes. 

• Standard: Timestretching and pitchshifting in standard quality. The method is 
suitable for audio material without a pronounced beat. Existing beat markers are 
evaluated to improve audio quality. 

• Smoothed: Timestretching and pitchshifting for audio material without impulse-
like components. The method is suitable for several voice orchestra instruments, 
surfaces, speech and singing. Beat markers will not be evaluated.  
A complicated algorithm is used here, which results in a higher processor load. 
Material can also be edited using very large factors (0.2...50), without large 
artifacts. For this, material will be somewhat "smoothed", which will be 
manifested in a softer sound and an altered phase length. This smoothing is 
hardly audible, e.g. with speech, singing, or solo instrumentation. For complex 
spectra, such as mixes of different instruments and finished mixes, this can lead 
to problems. 

• Beat marker slicing: Beat-synchronous timestretching and pitchshifting via 
splitting and temporal repositioning. Exactly set beat markers are required at the 
beats or transients. Markers can be generated in realtime (automatically) or read 
out from the source file, as long as they are available (patched). A patch tool is 
available in MAGIX Music Editor which lets the user set own markers. The 
algorithm is suitable for rhythmic material that can be divided into individual 
beats or notes. For this, the levels before and after the individual notes or beats 
should be low. 

• Beat marker stretching: Beat-synchronized timestretching and pitchshifting in 
high audio quality. The material is stretched between beat markers positions so 
that the impacts or attacks at the beat markers positions are not impaired by 
stretching. The markers can be generated in real time from the audio material 
(automatically), provided they are present (patched). The method is suitable for 
rhythmic material which is not separated into individual beats or notes because 
the beats or notes overlap. 

• Beat marker stretching (smoothed): Beat-synchronous timestretching and 
pitchshifting in high audio quality, even with extreme timestretching. Beat 
markers are used at the beats or transients. The markers can be generated in real 
time from the audio material (automatically), or read out from the wave file, 
provided they are present (patched). The method is suitable for rhythmic 
material which is not separated into individual beats or notes because the beats 
or notes overlap. This method results in relatively high CPU loads, and should be 
used carefully on less powerful systems. 
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• Universal HQ: Universal method timestretching and pitchshifting in very high 
audio quality. Suitable for all types of audio material. Existing beat markers are 
evaluated to improve audio quality. This method requires so much processing 
time, that a realtime application is recommended only in exceptional situations. 
For this reason, we recommend to use the apply function. 

• Monophonic voice: Time-stretching and pitch-shifting for vocal solos, speech or 
solo instruments. The material may contain no background noise, and even 
strong reverb can reduce the usefulness of this method. With suitable material 
the audio quality is very high. Additionally, formats are kept after pitchshifting. 
Beat markers are not evaluated.  

• Resampling: Pitch shift and tempo can not be changed individually. This method 
requires comparably little CPU time.  

 

Audio effects in the mixer 

 

You can open audio effect devices in the mixer using the "FX" 
button found in each track or in the right master area.  
Under "Mastering" you will also find MAGIX Mastering Suite (view 
page 190). 
"Reset" resets all effect settings to original values. 

 

Equalizer 

 

The 10-band equalizer subdivides the frequency spectrum into ten areas ('bands') and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete elimination of a 
certain range of frequencies. Note: If low frequencies are boosted too much, the 
overall sound level is heavily increased which may lead to distortion. In this event, 
adjust the overall volume downward by using the 'master volume' control situated at 
the bottom center of the effect rack. 

Slider control: Each of the ten frequency ranges can be separately boosted or turned 
down with the ten volume controls. 

Link bands: Using this button randomly combines the frequency ranges with each 
other in to avoid artificial-sounding overemphasis of an individual frequency range. 

Touch screen (right EQ section): This is the 'sensor field' of the EQ. Here you can 
draw any type of curve with the mouse. This will be immediately translated into a 
corresponding control setting on the left side of the EQ. 
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Compressor 

 

The compressor is an automated, dynamic volume adjustment controller: louder 
passages become quieter and quiet passages become louder. A compressor is useful 
to make spoken passages more audible against background noise or music in case a 
simple increase of the overall volume is insufficient. Several useful presets are 
included for this purpose, however compression may also be set manually. 

Ratio: This parameter controls the compression level. 

Threshold: This sets the volume threshold below and above which compression is 
applied. 

Attack: Sets the algorithm's reaction time to increasing sound levels. 

Release: Sets the algorithm's reaction time to falling sound levels. 

Gain: The gain controller amplifies the compressed signal. 
 

MAGIX Mastering Suite 
MAGIX Mastering Suite is a special effect rack for use with the mixer master channel. 
Its effects serve the so-called "Mastering" with which the finished mixed music file is 
given its last "cut". 

The On/Off switches can switch the effects on and off individually. Each effect offers 
a number of presets, which can be selected from a list on the bottom edge of the 
effect. 

 

The settings of all effects can also be saved 
together as one preset so that you can use your 
ideal mastering setting again for other 
arrangements. 

 

 
Each effect can be reset by pressing the "Reset" button. 

 

Note: 5.1 Surround mode only provides the compressor (view page 190) and 
parametric equalizer devices in this case. 

 

6 Band Equalizer 
The parametric equalizer has six filter bands that you can use to shape the sound of 
the music track. Each band is a filter with a typical "bell shape". Within a certain 
frequency range around an adjustable middle frequency you can increase or reduce 
the signal level gain. The width of this frequency range is called bandwidth. The 
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bandwidth is defined by the Q value. The higher the Q value, the narrower and 
steeper the filter curve.  

You can influence the basic sound of the mix by increasing and decreasing the 
broadband so as to give it more "depth" (lower center 200-600 Hz) or more "air" 
(Highs 10Khz). You can also decrease the narrowband width (high Q-value) in the 
frequency response to remove disruptive frequencies. 

 

 

Sensor field: The sensor field displays the resulting 
frequency response of the equalizer´. The frequency 
is displayed horizontally and the increase or decrease 
of the respective frequency is displayed vertically.  

The blue bullets 1-6  symbolize the six frequency bands. You can move them around 
with the mouse until you find the frequency response you want. 

 

You can control the output level of the equalizer with the Peak Meter . With the 
Master Gain Controller beside it you can offset the level changes resulting from the 
EQ adjustments. 
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You can access additional settings for each frequency band by clicking on the bullets. 

 

You can use the knobs to set the values for each band. There is also a numeric field 
for each parameter where values can be entered. 

Gain: This controller allows you to raise or lower the filter. Setting the controller to 0 
deactivates the filter so it does not use any CPU power. 

Freq: The center frequency of the individual filters can be set between 10 Hz and 24 
kHz with the frequency controller. Freely choosing the frequency enables multiple 
filters to be set to the same frequency in order to have a greater effect. 

Q (Bandwidth): Here you can set the bandwidth of the individual filters to between 10 
Hz and 10 kHz. 

Bands 1 and 6 are special: Their Filter Curves can be edited in three different modes. 
The four editing points in the graphic have different functions in each mode. 

 Peaking: Here the effect curve is brought closer to the working point (which 
represents the peak of the curve) from both sides simultaneously. 

 Shelving (Basic setting): Here the working point displays the beginning of the 
filter curve. From this point on there is a gentle increase or decrease in the 
frequency. 

 High or Low Pass:In Band 1 the working point displays the frequency which is 
filtered out of particularly high or low frequencies.  

 

MultiMax 

 

MultiMax is a compressor with three independent frequency bands. The dynamics 
are edited separately for each band. 
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The advantage of a multi-band compressor versus a "normal" compressor is that the 
"pumping" tendency and other unwanted side effects are dramatically reduced while 
editing the dynamics. For instance, it can prevent a bass top peak from "reducing" the 
entire signal. 

Multiband technology also lets you specifically edit individual frequency ranges. 

Link: When this function is activated and one controller is adjusted, all controllers are 
changed at the same ratio. However, the way the dynamics are edited is not affected. 

Setting the frequency bands: The settings of the frequency bands are changed 
directly in the graphic. Simply click on the separator lines and move them. 

Lo/Mid/Hi: These knobs define the level of compression for each frequency band. 

Presets: MultiMax has a selection of presets for various applications. 
 

Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 

Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 
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Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 
 

Digital Audio Meter 

 

On the lower border of the MAGIX Mastering Suite there is a digital audio meter 
which provides separate control method displays for 10 wave bands on each channel. 
This device is used for orientation purposes, e.g. selective equalizer editing. 
 

Limiter 
The limiter prevents clipping by automatically 
lowering the level if it is too high. Quiet parts remain 
unaffected. In contrast to the compressor it tries to 
leave the basic sound as unaffected as possible.  
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Audio CDs 
Loading an audio CD works just like loading of any other files into the arrangement. 

• Place an audio CD into the drive. 
• Find the drive in your Media Pool The individual CD titles appear in the file list. 
• Double click on the song to preview. 
• Drag & Drop the CD title into a track of the current arrangement, and it will be 

digitally scanned and copied to the hard-drive. The files will be saved in the 
import folder (this can be indicated in "File" > "Settings" > "Program" > "Folder").  

The audio object appears in the track and can be played back or edited immediately. 
 

Import audio CD tracks 
There is also a custom option for audio CDs in "File" > "Import audio-CD track(s)", 
which allows simple import with additional options. 

This option opens the CD Manager where you can select tracks from Audio CDs and 
partially or fully import them into the arrangement. Audio tracks are imported in 
WAV format, saved in a selectable directory and imported into the arrangement.  
 

The tracklist dialog 

 

Tracks can be selected from the list with a mouse click or with the key combination 
Shift + arrow or Ctrl + mouse click. 

Transport control in the dialog activates the preview function. The playback arrow 
starts audio playback of the first selected track. 

Select all tracks: This option selects all audio tracks in order to copy the complete CD.  
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Save selected tracks: This button opens dialog to save selected tracks. You can either 
place all files into a single WAV file or create a separate WAV file for each track. A 
new object will be created in the arrangement for each track in either case. 

Options CD drive: With this option you can access the "CD-/DVD drive list". 
 

CD/DVD drive list 

 

Configuration: This button opens the configuration dialog, where various special 
settings can be made. 

Reset: sets drive settings back to default. 

Add: Creates a new drive in the list, which first requires special settings. 

Delete: Deletes selected drive from the list. 

Load setup: Loads the current drive list and all configuration data from a *.cfg file. 

Save setup: Saves the current drive list and all configuration files in a *.cfg file. 
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CD/DVD-ROM configuration 

 

Drive Name: Lets you edit the name of the drive in the list. This is useful if you create 
more than one entry accessing the same physical drive.  

Host Adapter Number: Lets you specify the number of your SCSI adapter - normally 
0. 

Bus ID: Here you can enter the ID of your CD-ROM drive. Be sure to set the correct 
ID, there is no error checking! 

Bus LUN: sets the LUN parameter, normally 0. 

Alias: Lets you select the manufacturer type of your CD ROM drive. 

Normal copy mode: copies audio files without any software correction. 

Copy mode sector synchronization: copies audio files with a special correction 
algorithm. This is especially useful, since many CD drives have problems finding an 
exact position again and gaps can occur.  

Burst copy mode: optimizes the speed of the copy process, no software correction is 
used.  

Sectors per cycle: defines the audio sector count that should be read from the audio 
CD in one cycle. The higher the number of sectors, the faster the copying process. 
Numerous SCSI systems have problems with more than 27 sectors. 

Sync sectors: sets the count of audio sectors, which should be used for software 
correction. A higher number results in a better synchronization but also in a slower 
copying process. 
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Mixer 

 

The Mixer can be opened by pressing the "M" key or via the button bar in the main 
window (also: "View" > "Mixer").  
 

Mixer channels 
Each track of the project window is represented with a corresponding mixer channel 
in the mixer. The mixer channel offers a range of options to regulate objects' audio 
signals together in the track. 
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FX: Opens (view page 189) the audio effect rack . 

Auto: activates the volume and panautomation (view page 200). 

 
Plug-ins: You can access the audio plug-ins (view page 182) installed on 
the PC using the triangle-shaped button. 

 

Volume: You can adjust the track volume using the large slider. 

 

Stereo panorama: You can set the stereo -position for each track using 
the knob.  
 

Note: Double-clicking on the volume or panorama slider sets it back to 
its passive default position, in which no CPU is used. 

 

Solo/mute: The "Solo" switches a track into solo mode, which means 
that all tracks not switched to "solo" will be muted. "Mute" makes  the 
track silent. 

 
 

Effect channels 
In addition to normal mixer channels that correspond to the tracks in the 
arrangement, you can create two separate effect channels. The principle behind them: 
You can take a partial signal from a normal channel into an effect channel, where the 
partial signal is then processed with additional effects. This is a common process used 
in professional audio production. 

 

In each mixer channel there are two FX-Send knobs (FX 1 and FX2 ) 
under plug-in slots.  

Here you can determine the strength of the signal from the track that is routed into 
both available effect channels.  

The FX tracks are usually hidden in the mixer. When an FX-Send is used, they will 
appear to the left next to the master section. 
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An effect channel is a complete additional mixer channel with 
volume and panorama controls, an effect rack and two plug-in 
slots. 

Reverb is activated in the first effect channel by default because 
this is the most important application of send effects. 

The volume control regulates the strength of the effect channel and 
corresponds to an AUX return control. The"Mute" button is used to 
switch the FX function on and off. By activating "solo", you can 
listen to the effect channel separately. Track peakmeters that send 
to the FX track appear greyed out. 

 
 

Master channel 
The master channel is to the right of the individual channels. It controls the overall 
sound and offers all editing options: volume, panorama, plug-ins and effects. 

The FX buttons and the plug-in slots work just like in the other channels. The FX 
button opens the master audio effect rack. With "Reset" you can rest all mixer 
settings, including effect channels. 

Mastering: Here you can open the MAGIX Mastering Suite (view page 190). 

5.1 Surround: This button switches the mixer into Surround mode (view page 204). 

Both faders control the total volume. 

Link buttons: If the link button is deactivated, the 
volume of the right and left channels may be set 
individually. 

 

Volume and panorama automation 
You can automate volume and panorama for a track. This means that during playback 
you can record the movements of the sliders on the track. This way, for instance, you 
can simulate the movement of a sound source from left to right and make volume 
adjustment instantly during playback. 
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As long as the autobutton for a track is activated, all movements of the 
volume and panorama sliders will be recorded. 

The automation is displayed as a curve in the project window and can be edited later 
with the mouse. 

Note: The mixer's automation curves relate to a track, which means that they are 
independent of the objects contained on it. 

 

5.1 Surround 
MAGIX Video Pro X6 supports playback and export in genuine 5.1 Surround sound. 
 

Requirements 
You will require a sound card or a sound chip which is integrated into the computer's 
motherboard with six individual outputs to playback the individual channels: 

• front left (L) / right (R) 
• centre (C) / subwoofer (LFE) 
• back left (Ls) / right (Rs) 

Surround playback is possible with all audio driver models (see Playback settings), 
(Wave, DirectSound). 

DirectSound is supported by most of the standard sound cards.  

Wave drivers are similarly supported by many standard sound cards; however, 
individual sound cards (for example, Soundblaster) require access to DirectSound.  

Output of the six output signals is achieved in all driver models in the output channels 
in the same (standardized) order: 

Channels 1/2: L-R 
Channels 3/4: C-LFE 
Channels 5/6: Ls-Rs 

When using WAV drivers, the loudspeaker settings normally have to be changed to 
5.1 playback in the control panel. On most systems the program does this 
automatically while using DirectSound. 
 

Importing and exporting surround audio files 
Import 
When importing MPEG-2 files with Surround Sound Stereo/5.1 (e.g. VOB files from 
DVDs or DVB-TV recordings), you can choose from two different applications: 



 

202   

http://pro.magix.com 

• Mixdown: Surround Sound is displayed as an audio object under the video object, 
playback of the surround track is reduced and recalculated to stereo playback. 
Use this option if you want to export the Surround Sound without editing You can 
also use it if you think that a stereo export is enough to meet your requirements 

• Surround mix: The individual Surround channel pairs (L-R, C LFE, Ls-Rs) are split 
into three audio tracks as separate objects and the mixer is then set to Surround 
Mode. This mode allows you to change the Surround mix. 

In MAGIX Video Pro X6 the import of Surround Sound Stereo/5.1 is always executed 
as a mixdown. MAGIX Video Pro X6 can also import interleaved wave files (multi-
channel wave files), multi-channel Windows Media Audio and MP3Surround files; a 
Surround mix is always created. 
 

Export 
Surround mix exports can occur in any one of the following formats: 

• 6-channel PCM files (interleaved wave) 
• Windows Media files (as a Surround soundtrack of a Windows Media Video or 

WMV-HD disc) 
• MPEG-2 files with Surround Sound Stereo/5.1 audio track 

The files created are fully compatible with the normal file formats. This means that 
they can also be played on computers incapable of playing Surround (in normal 
stereo). 

The export is performed using the same menu commands (e.g. "File -> Export movie -
> Audio as wave") like the normal stereo export. You will then be asked if the export 
should be in stereo or Surround format. 
 

Export Surround Sound using Smart Copy 
You can also burn original material with Surround Sound to DVD again without the 
need for the codec or you can export the corresponding MPEG files while keeping 5.1 
Surround Sound. To do this, use the "Smart Rendering" option which transfers the 
unprocessed parts of the original material to the destination file without renewed 
encoding. Read more on this in the MPEG encoder settings section General settings 
(view page 365). 

Note: The import has to be executed as a mixdown; the audio material cannot be 
changed (no fades, no audio cleaning, no volume adjustment). Hard cuts, e.g. to 
remove commercials, are allowed but in some cases they may only occur at the 
borders of the GOP and not frame-precise. 
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The mixer in surround mode 

 

To activate surround playback, open the mixer (M key) and click on "5.1 surround" 
button in the master. 

In the master, six peak meters for the individual channels are provided. The normal 
panorama button turns into a representative display of the surround editor (see 
below), which can be opened by clicking on the display.  

The surround sound editor is also available to the effects tracks. For example, you can 
send the original track to the front L/R speakers, the FX track however will remain at 
the rear L/R speakers.  

The master volume is applied to all channels, here the left controller influences 
channels L and Ls, the right controller; channels R and Rs and the middle value of both 
controller; the channels C and LFE. 

The master plug-ins are only applied to the front channels. 

The full effects palette of the mastering effects rack in MAGIX Mastering Suite is not 
available in 5.1 surround mode, but rather only the compressor and the parametric 
equalizer (from the Mastering Suite) are provided. The settings of these effects have 
the same effect on all six channels.  
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5.1 Surround editor 

 

The selected mixer track's 5.1 surround editor allows you to arrange the audio signal 
of a track (displayed as two red sound sources) in stereo space. The signal is 
dispersed to the 5 (blue) loudspeakers which represent the individual surround 
channels.  

There are 6 channels: 

L: front left 
R: front right 

C: center 

Ls: back left/left surround 

Rs: back right / right surround 

LFE subbass (Low Frequency Effect) channel 

Dispersing the signal to the 5 loudspeakers occurs after the sound source emits a 
sound field of a certain level (displayed as red circles). The further away a 
loudspeaker's source is, the lesser its share of the corresponding loudspeaker channel. 
The position of the loudspeaker can be moved with the mouse. 

The subbass share (LFE) is set directly from the corresponding value table. It can also 
be changed by dragging the mouse. 

There are various modes in which you can use the source signal: 
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• Mono: The (stereo) source signal is seen as mono material, the left and right 
channels are mixed together and arranged together. The original stereo 
information is lost here. 

• Stereo 1: Similar to mono mode insofar as the left and right channels are moved 
together, but only a portion of the left source is audible in the loudspeakers L and 
Ls and only a portion of the right source in the right channels R and Rs. The stereo 
information remains as intact as possible. 

• Stereo 2: The left and right channels can be moved individually. The distance 
between the left and right source is retained when you move the left source. You 
can move an individual source by holding down the "Alt" key. 

• Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn 
solely from the right channel. This mode is only important for importing Surround 
material. 

Width determines the level of the sound field of an individual source. 

Automation: 

Panning of the sound source on the loudspeaker can be automated to simulate 
movements in the room.   

For this to happen "Automation" must be activated. There are two methods to create 
automations: record and draw. 

To record (when automation is on), the sound source is moved between the 
loudspeakers during playback. When recording the automation, the "Record" check 
box lights up red. 

The draw function is an alternative to drawing out complex movements. When 
drawing in active mode, all panning movements are transmitted to the time interval 
between the start and end marker (when the mouse button is held). You can thus 
draw the entire movement curve for the selected time range. 

"Reset" deletes surround automation from the track. 

There is no automation of the parameters for width and LFE, of the distance 
between the left and right source in "Stereo 2" mode, or of the loudspeaker 
positions. 

 

Transfer surround tracks from Samplitude/Sequoia to MAGIX Video Pro X6 

Note: In order to be able to use Samplitude/Sequoia parallel to MAGIX Video Pro 
X6, the programs will have to be synchronized with each other. Read more about the 
topic "Synchronizing Samplitude/Sequoia with MAGIX Video Pro X6".  
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Existing surround tracks are transferred directly to MAGIX Video Pro X6 from 
Samplitude/Sequoia. Set a playback marker first in MAGIX Video Pro X6 at the 
starting position of the movie – the wave file will be added at the position of this 
marker. 

Note: In MAGIX Video Pro X6, the last six tracks must be free to ensure that correct 
transfer can take place. Set the number of tracks to a higher number in the Movie 
settings as required. 

• Switch to Samplitude/Sequoia 
• To transfer, open the menu item "Export to MAGIX Video Pro X6" in the "File" 

menu under "Export". 
• Please note that when exporting, a sampling rate of 48 kHz should be set, since 

this is the sampling rate used in DVD audio streams. 
• Click "OK" and enter the save location and a logical name for the surround sound 

in the dialog that opens. 
• After export, the six surround channels will be loaded directly into MAGIX Video 

Pro X6. 5.1 surround mode will be activated and the channels will feature the 
corresponding track settings. 

 

Set multiple sound tracks 
Multiple sound tracks are provided for adding multiple audio tracks to the video for 
selection via the disc's menu. This has primarily two main uses: 

• Creating audio tracks for different languages 
• Mixing stereo and Surround audio separately 

These two applications can be combined, since MAGIX Video Pro X6 features up to 8 
separate multi-sound tracks. 
 

Workflow 
In the context menu of the track header, each track can be defined as a "DVD audio 
track".  

• Right-click on the the track header. 
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• Select the option "DVD Audio track" > "DVD Audio track: unused". A dialog will 
appear where the track can be renamed. 

 

• Give the track a descriptive name. The name entered here will later appear in the 
menu of the burned disc. 

 

Now you can assign this DVD audio track to other tracks in the project window. To do 
this, check the box in the context menu of the track header. The default setting is 
"Apply to all audio tracks". This ensures that the audio material on the track can be 
heard on all tracks. 

Normally several DVD audio tracks should not be played back together. For this 
reason you can use the loudspeaker button to select the DVD audio track that should 
be played back in the project window. 
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Tip: The multi-audio track concept is very useful for offering a selection of 
languages. First define a corresponding multi-audio track for each language and 
assign all of the tracks that should belong to the respective language tracks. 

 

Combine Surround and stereo tracks 

Note: The method described here is only recommended if the stereo track requires a 
separate mix, since it normally isn't necessary to add an extra stereo track. Playback 
devices automatically apply a downmix to stereo sound in place of 5.1 Surround 
when it is required. 

If you still wish to create a disc that contains a 5.1 Surround track as well as a regular 
stereo track, proceed as follows: 

• Select the "Stereo" DVD audio track. 
• Open the mixer and proceed with normal stereo mixdown.  
• Close the mixer. 
• Select the "Surround" DVD audio track. 
• Open the mixer and activate 5.1 Surround mode. Conduct the Surround mixdown. 
 

Set formats of individual multi-sound tracks 
Next, make the necessary changes to the formats of the multi-sound tracks. This 
takes place in the MPEG encoder settings, which can be opened form the burn dialog. 

The simplified settings dialog displays an additional section for the multi-sound 
tracks. From the flip menu, select the DVD audio track to be set. Now, you can assign 
each track to the desired format. 

Click "Edit" to open the advanced audio settings dialog for the MPEG encoder. Now 
you can define which format the selected DVD audio track should have. For more 
information, read the "Audio settings" (view page 368) section in the "MPEG encoder 
settings" (view page 364) chapter. 

Note: Even if you create all multi-audio tracks in 5.1 Surround, you must make this 
setting for each separately. 
Sound tracks which feature the setting "Apply to all multi-sound tracks" will always 
be mixed with the other multi-sound tracks, although these will be created using the 
format set for them. 
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Scrubbing 
The term "scrubbing" originates from the age of cassette players and provides quicker 
monitoring of passages of a film or a piece of music. The function plays short samples 
at the original speed. 

Note: In order to preview individual audio objects completely, use "Preview (view 
page 45)" mouse mode. 

 

Activate scrubbing 

 

Scrubbing can be activated using the small arrow 
next to the speaker button. 

 

Scrubbing: Modes 
No scrubbing: Scrubbing is inactive. If the playback marker is set or moved, then 
sound will not be played. 

Scrubbing (1 frame): Scrubbing is active and samples are only 1 (video) frame in 
length. The speed is 25 fps, i.e. 1/25 second. This mode is suitable for positioning the 
playback marker exactly. 

Scrubbing (long): Scrubbing is active, the sample length amounts to approx. 0.5 
seconds. In this mode, locating specific events is particularly easy. 

Play 1x with scrubbing: If this option is active, the current position will be played one 
time. If it is inactive, then it will be repeated. 
 

Using "Scrubbing" 
If scrubbing mode is selected, set the playback marker to a certain location in the 
timeline using the mouse. Hold the mouse key and move the playback marker to 
various locations in the arrangement. 

 

Scrubbing may be used also by employing the jog and shuttle wheel on the video 
monitor, as well as through various hardware controllers, which gives the software the 
feel of an analog video editing system! 
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Edit disc menu 

 

Switch to the "Burn" screen first by pressing the button displayed. 

Here you can adjust the disc menu before burning and burn your movies with a menu 
to a CD, DVD or Blu-ray disc. 

All movies loaded into the project will be included. If you want to remove some of the 
loaded films, then switch to the "Edit" screen again and delete the unwanted movies 
from the project there. To do so, switch to the corresponding movie, open the "File" 
menu and select "Manage movies -> Remove movie" (view page 290). 

Note: For screen resolutions 1280 x 1024 pixels or higher, the program display will 
be different. This makes the program more manageable and easier to use. The work 
steps remain the same in spite of the different display. 

 

Preview and editing 
MAGIX Video Pro X6 provides two different modes for designing and previewing the 
disc menu. 

 
"Preview" mode simulates the behavior of a playback device, e.g. 
DVD player or Blu-ray player.  
You can select a template for the menu and burn the disc. 

 
In "Editing" mode, you may adjust many features of the disc menu. 
Templates are also available here that may be flexibly adjusted to 
suit your needs. 

 

Remote control 
The virtual remote control is an important helper when it comes to checking how the 
disc will perform later. 

When the disc featuring the project is inserted into the player, this remote control will 
control the preview picture just like a "real" remote control controls the picture on a 
monitor or TV. The menu navigation may be activated via the arrow keys or the "OK" 
button. Activated buttons are highlighted. 
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The number keys select the corresponding entry on the menu 
page. All menu entries are marked with a corresponding number. 
Within a chapter menu, playback is started from the particular 
scene. In the movie menu, the corresponding chapter menu (if 
available) is changed or movie playback is started.  

Navigation button: Use these buttons to navigate in the menu of 
the disc being burned. The individual entries may be changed and 
confirmed by pressing "OK". The remote control reacts exactly 
like a genuine DVD/Blu-ray player's remote control. 

Skip/move forward/back: This allows you to skip to the next or 
previous scene while playing back your movie. In the menu, you 
can skip forward or back from one menu page to another. 

Play: Starts the first entry in the menu. In case chapter menus are 
available (view page 214), the chapter menu will be displayed 
first. Press the play button again to start playback at the 
beginning of the first scene of the first chapter. 

Stop: Pressing stop halts playback. 

Disc: Switches to the first page of the film menu. 

Sub: Switches to the chapter menu (if available) for the currently selected film. 
 

Menu 
The selection menu is also burned to disc and appears when inserted into your player. 
Just like with a store-bought DVD or Blu-ray Disc, you may easily select your movies 
with the help of preview pictures, or access particular chapters within a movie. 
 

Templates 
You will find the menu templates below. 
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To the left, you will see a tree structure for selecting various menu templates. At the 
top, you should first select whether you would like to use templates in ratio "16"9" or 
"4:3".  

• Animated  (DVD): These templates contain background and introductory videos 
as well as music. The control elements are displayed in various modes. The 
templates can be used only for mini DVDs, DVDs and AVCHD discs.  

• Static (4:3 only, DVD): Here you will find templates made up of regular 
background pictures and control elements. 

• Custom: These templates adjust to your disc project; the movies and scenes you 
use are integrated directly into the menu. 

• HD  static (16:9 only, DVD, Blu-ray, AVCHD, WMV HD): These templates contain 
super-sharp, high-res background images that are particularly noticeable on HD 
TV devices. 

• Movie templates (only 16:9): Here you will find menu templates that are specially 
made for movie templates (view page 286) found in the Media Pool. 

Note: These menus require "Film menu" and "Chapter menu" to be activated in the 
"Edit" screen under "Disc options". 

If you've selected one of the menu templates, you can use the horizontal scroll bar to 
view all the others available. There are lots of options when using the templates: 

• To apply a template to all menu pages, double-click the desired template. The 
complete template will then be applied. 

• You can also combine various elements from different templates with each other. 
To do so, you must first switch into Editing mode. If, for example, you wish to 
combine the text format of a template with the background of another one, 
double-click on the template containing the background first. Then click on the 
"Font" tab and select a template for the font. 

• You can load the layout (or individual layout elements) for the current menu 
(movie or scenes) as well as for all menus. 

 

Note: Some menu templates include intro videos with a smooth transition to the 
menu page! 

 



 

Edit disc menu 213  

 

Edit disc menu 

 

To edit individual menu elements and the menu structure, 
activate the "Edit" button. 

 
 

Edit menu elements 
Hold down the left mouse button and drag text boxes or graphical elements to the 
desired position. You can adjust the size by dragging out the corners and edges of the 
frame. 

 
Undo: This command allows you to undo the last changes made.  

 
Redo: This function undoes the previous "Undo" function. 

 

 
Lock aspect ratio: To avoid distortion, use this button to lock the aspect 
ratio for the menu elements.  

 
Group: Menu elements are moved or resized simultaneously as a group, 
including the description text and number. 

 
Fade in TV display area in the preview monitor: This option displays the 
image borders of the television (view page 162) as lines in the preview 
monitor.  

 
Grid: This button shows a grid to help position frames exactly next to 
each other as required. Using the small arrow next to the button you can 
open a dialog to fine tune the grid settings. 

 

Export import PSD 

 
Import PSD: With this option you can import a menu template created in PSD 
format (for example, in Xara Designer Pro, Photoshop,…) 

 
Export PSD: With this option, you can export your menu as a PSD file ( for 
example for Xara Designer Pro, Photoshop,…) 

Note: With the help of these two options, you can quickly adjust your menu to your 
individual wishes. Simply export the menu, edit it in a graphics program, save it and 
import the same file back into the program. To find out more, read the Edit DVD 
menus in Xara Designer Pro or Photoshop (view page 219) section in the PDF 
manual! 

 

Navigation 
Using navigation links above you can reach the structure of the menu entries. 
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• All movies are listed as first entries. The 
corresponding menu level is the film menu. 

• All scenes are listed as second entries next to it to the 
right. The corresponding menu level is the chapter 
menu. 

Removing the red check deactivates the corresponding 
entry in the chapter menu. The scenes are still displayed 
of course, but you can no longer select them directly from 
the menu. 

• You can open the movie menu for further editing by 
clicking on the movie above it.  

• If you click on one of the chapters, the chapter menu 
in the preview will be opened for editing. 

 

Disc options 
Here you can activate or deactivate certain elements or even complete menus. 

Intro video: Press this button to load videos to be used as introductions to your discs. 
The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is 
played immediately after the DVD has been inserted into the player. The DVD menu 
will then appear. A check mark "Do not skip" ensures that the intro video must be 
played completely each time the disc is inserted and that it may not be skipped with 
the remote control or otherwise. 
 

Film menu, chapter menu, and audio menu 
The disc menu essentially consists of two layers: 

Film menu: The upper layer includes the film menu, which is only used if a project 
contains multiple movies.  

Chapter menu: This is the lowest layer of the disc menu, which utilizes the chapter 
markers in a movie as menu entries. More information about this is available in 
"Chapter markers (view page 108)". 

Note: A chapter menu cannot contain more than 99 entries. If your movie has more 
chapters, then you can either burn it without a chapter menu or split it into multiple 
parts. 
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Audio menu: If your project features multiple DVD audio tracks, then a menu will be 
added to the disc for the user to select an audio track. 
 

Preview pictures: Shows/hides the preview pictures in the disc menu. 

Numbering: The numbers beside the menu entries may be selected directly using the 
remote control, but they might be unwanted at times. Use this option to show/hide 
them. 

Frame: A frame borders the preview pictures. If this is unwanted, it may be removed 
easily using this option. 
 

Create your own menu background 
You can edit the existing menu background or create a new one from scratch.  

 
A click on this button switches to the "Edit" interface and 
loads the selected menu background as video.  

Here you can change and design the background as you please. The background 
movie will be set as the menu background automatically after pressing "Save". 

Tip: If you would like to design a new menu background, simply delete all existing 
objects from the menu project and load new ones. 

 

Design page 
Edit: This provides three options for setting the background of a menu page. You may 
either set a certain "color value" for the background or you can select an image file 
from your hard drive. You may also select a certain frame from a video in your project. 

In external editor: A PSD file (view page 213) is sent directly to the program that has 
been selected in the program settings as the menu editor (view page 258). 
 

New menu pages may also be added or irrelevant pages may be removed. 

 
Adds a new menu page. 

 
Removes the selected menu page. 

 

Animated selection menus 
Audio-visual animations may also be added to the DVD menus. As required, 
background videos are played as endless loops while the menu is shown on the 
screen. Add background music in various formats or use any background picture for 
each menu. 

Sound/music: Load an audio file into the preview monitor and use it as an animation 
in the menu background. 
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Video: Load a video or graphics file into the preview monitor and use it as an 
animation in the menu background. In addition to the options for the background 
graphic (see above), you may also use a sequence from a loaded slideshow or from a 
different video file. 

Background video options: 
• Create animated menu buttons: The preview images for individual movies in the 

movie menu are shown as small movie samples. Set the start point and length of 
the animation using the sequence options faders. 

• Use video's audio track: The audio track of the background video is used with the 
menu. 

• Play menu animation as a loop: The background video (audio and/or video) is 
played back as a loop. 

• Length of the menu view is set by: Audio/video or whichever medium is longer. 
You can specify how long the background video should be here. The other 
medium will be played as a loop. 

 

Create a button design 
MAGIX Video Pro X6 enables easy editing of all buttons together with their menu 
entries. 

 
You can edit menu entries that you created using this 
button or with a double click on the menu. The dialog with 
the properties of the menu entries (view page 217) will 
open. 

 
Edit in MAGIX Photo Designer: You can open MAGIX 
Photo Designer for additional editing of elected menu 
elements. 

 
Apply to all objects: Applies the properties of the selected 
button to all remaining buttons. 

 

New menu entries may also be added or irrelevant pages may be removed. 

 
Adds a new menu entry. 

 
Removes the selected menu entry. 

Tip: If you would simply like to deactivate unused menu entries, this may be done 
via the navigation. 

 

Note: The chapter menu is formed via chapter markers (view page 108) and can be 
influenced in detail with these. 
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Pressing this button or double-clicking the menu entries allows menu 
entries you have created to be edited. The dialog with the properties 
of the menu entries (view page 217) will open. 

 

 
These buttons open MAGIX Photo Designer for further 
editing of your background pictures or the selected menu 
elements. 

 

Jump to linked page 

 
To test the targets of menu entries, select the desired 
menu entry and click the button. 

 

Menu entry/menu page properties 
Double clicking the preview picture or a menu entry opens an editor for you to adjust 
the preview picture or menu entry.  

 
 

Menu text 
In the text input field, you can enter any text to match the chosen menu entry. 

 

Set the vertical direction of the text (upwards, centered or downward). 

 

Set the horizontal direction of the text (left, centered or right). 

Font size: Set the height of the text in pixels. 
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Font color: Define the foreground color of the text. 

Font: Set which font and which style (bold, italic, etc.) should be used. 

Shadow: Set the color and size of the shadow that will appear underneath the text. 

3D effect: If you would like to make your text appear three-dimensional, you can set 
the width, height, and color of the 3D effect. 

Apply to all: Except for the text, all settings are applied to all entries in the current 
menu. 
 

Menu image 
Use frame from movie: Use the fader to set which frame should be used in the video 
as a preview picture. The numerical input fields are sorted as follows: 
Hours:Minutes:Seconds:Frames. 

Use different graphic: You can also load your own bitmap images to be used as menu 
pictures. 

Hint: It may be the case that there are no menu pictures in some menu templates, 
so changing the menu picture won't have any noticeable effect. 

 

Actions at the end of the movie (preview images in film menu only) 
Enter which action should be carried out once the film has finished playing here. 
Select from: 

• Stop playback: This option depends on the DVD player being used. Most DVD 
players show the DVD player's own menu (or background picture) after 
playback. 

• Jump to movie menu/chapter menu: Jumps back to the previously displayed 
menu. 

Tip: If one of these two options is not available, please check which menu mode is 
set. 

• Jump to next movie: The next movie will be played without any additional action. 
• Play movie as endless loop: Any movie may be burned onto a disc as a loop. This 

means that the movie will be played as a endless loop until the next menu entry is 
accessed using the remote control or playback is stopped. This way, you can 
transform your TV into an aquarium, a train journey, a fireplace or anything that 
you could watch over and over again. 

Note: This option only functions for DVDs, Mini DVDs, or Blu-ray Discs. 
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Edit your own menu entries 

Note: This function is available only in the deluxe version. 

There is another view in this dialog to edit menu entries you have created. Menu links 
can be edited here. This makes it possible to link a menu entry with a certain action, 
menu page, or a certain position in the movie. 

No link: The menu element cannot be selected and has no function other than to 
display menu text. 

Link to page in current menu: Jumps to a menu page in the current movie or chapter 
menu in the current film. 

Link to another menu: Opens another movie or chapter menu. 

Link to chapter in a movie: If this option is selected, enter a film and chapter marker 
where playback should start. 

Note: For DVDs, only chapters within the current movie may be jumped to. 

Link to film start: The movie will play back from the start. 
 

Edit DVD menus with Xara Designer Pro or 
Photoshop 
Besides the option of editing the menu template directly in the preview (view page 
213), menu templates may also be exported as a Photoshop file (*.psd) and edited in 
an external graphics program. There you have complete control of menu appearance, 
including complex text effects and highlighted state management. 
 

Export menu 
The transfer of the menu templates to the graphics program takes place in one of two 
ways: 

 

If a complex, longer edit is required or if you have created a menu without a 
template, then use the PSD import/export (view page 213) function in the 
menu editing functions. 

Next, open the PSD file in the graphics program of your choice. 
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For smaller changes, you can also shorten this process: click the button "In external 
editor" in the "Disc options" on "Design page".  

 

A temporary PSD file will be added and opened in the program that has been selected 
in the program settings as the menu editor (view page 258). After editing has been 
completed and saved in this external program, the temporary PSD file will be 
imported again and the menu page will be updated immediately. 
 

Menu text with external menu editing 
Menu elements are transferred as a bitmap during PSD export as well as during 
import of the edited PSD. This also applies to the text displayed in the menu. This text 
may also normally be changed in the "Menu entry properties" dialog. The menu text 
are adjusted if movies or chapters are added or removed.  

The PSD contains these texts as a bitmap and cannot be changed. During importing, 
the bitmaps replace the original text entries. By the way, this is maintained, and the 
font will only be set to a size of 0 so that texts are not displayed in duplicate; the 
menu will therefore look identical after external editing. 

It is important that no more movies or chapters are added to the menu. Otherwise the 
preview images, that have also changed along with the menu structure will no longer 
match the bitmap text, since the bitmap text will not match the changed references in 
the menu structure! 

An example 

A chapter with two entries is present. Entry 1 is named "travel preparations". Entry 2 
is named "arrival". A chapter named "the trip" is going to be added between chapter 
1 and chapter 2. The second chapter now becomes chapter 3 and moves to the next 
menu page. 

Normal text behavior: The second entry (now with preview image for the newly 
inserted chapter) receives the new title "the trip". The next menu page features 
chapter 3 as the first entry with the name "the trip". 

Text after external menu editing: The second entry will feature the title "arrival" (as 
a bitmap, as a component of the button), but the preview image will feature the new 
chapter "the trip"! The next menu page now features the preview image for chapter 
3 (formerly chapter 2, "arrival"), this is now called "travel preparations"! The name is 
a component of the button as a bitmap for the first menu entry on the page, and this 
is "travel preparations" on the first menu page. Completely out of order! 
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If the number of menu entries displayed is increased, this results from copying the 
layer groups in the PSD (see below). Of course, the rendered text layers are also 
copied into the layer groups, which results in incorrect text again.  

The best way to proceed is to edit the text entries at the very end, since changes 
normally will not follow at this point. If changes are required nevertheless, then 
proceed as follows: 

1. Restore the "correct" chapters or movie names by resetting the font size in the 
dialog "Menu entry properties" to the default value. Two texts will be 
displayed; the incorrect bitmap and the correct one. 

2. Export the menu template as a PSD. 
3. Delete the incorrect bitmap object in the corresponding layer and re-import 

the PSD. 

Of course, the menu text may also be added from the start via an external graphics 
editing program only (in order to take advantage of the additional options provided in 
this case). Delete the corresponding bitmap objects in the PSD immediately after 
export and replace these with your own text objects. 
 

Structure of a PSD file 
MAGIX Video Pro X6 produces a PSD file during export that contains a layer for each 
object of the menu entry. This uses a naming scheme that enables assignment of the 
objects in the file to their contents. Individual layers feature mathematical signs that 
indicate their function. This naming scheme is similar to that featured in Adobe 
Premiere and which is only expanded occasionally in MAGIX Video Pro X6 to 
describe additional mechanisms.) 

This is how these mathematical characters are used: 

Characters for layer groups 

(+-) or (+) Play button/start film 
(++) Chapter menu button 
(+>) Next page 
(+<) Previous page 
(+^) Root menu button (jump back from chapter menu) 
(+*) Menu title: 
(^^) Layer group is ignored 

Characters fro individual layers 

(-) Layer contains text 
(=1) Layer contains a bitmap with a highlight of the menu element. 
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(%) Preview image/thumbnail from the movie to be referenced 
Bitmap information will be ignored during import and only the size and 
position will be exported. 

 
 

Edit menu templates 
The resulting PSD file will now be loaded into the external application. The following 
steps may differ slightly depending on the application that is used. The following 
steps, for example, describe the workflow in Photoshop CS, Photoshop Elements 8, 
and the download version of Xara Designer Pro. 
 

Editing a menu from 3 to 5 movies. 
Photoshop Elements: 

In Photoshop Elements, it is enough to touch an object with a held-down Alt key on 
the video monitor and drag a copy of it to a new location. A movie button and a 
chapter menu button should be duplicated each two times.  
Assigning the movie takes place later via the index in the layer group hierarchy. Make 
sure that the "x" chapter menu button ends up next to the "x" movie button in the 
optical hierarchy. Otherwise, the screen will cause confusion for its users. 
Save the results. 

Photoshop CS1: 

In the context menu of the layer group to be duplicated in Photoshop CS1, select 
"duplicate layer set". This must be done twice for the movie button and the chapter 
menu button.  Drag the created layer sets to the required positions. To do so, the layer 
must be selected and the Ctrl button be held down during the click. 
Save the results. 

Xara Designer Pro: 

In Xara Designer Pro you must first open the object gallery after loading the PSD file. 
There, for each layer of the PSD file, corresponding Xara layers will be created with 
contained objects. The layer groups are represented with the names of individual Xara 
layers, with PSD layer names separated by backslashes.  

Find the layers of the group, which you would like to duplicate. In the example, this 
refers to the 4 layers on the movie button ad two l ayers of the chapter menu button. 
To ensure visual assignment of the objects to the work area, you have to invest some 
effort since the Designer does not select the corresponding objects when a layer is 
selected, and conversely it doesn't select the layer when the work area with objects is 
selected. You have to open a layer in the object gallery and select the contained 
object. Now you will see the selection on the work space. 

Now, the 6 layers will be copied along with the corresponding objects in the object 
gallery by clicking on "duplicate". The newly created layers will always be placed at 



 

Edit disc menu 223  

 

the top position, so it makes most sense to copy the existing layers from the 
lowermost to the topmost. Otherwise, you will have to restore the correct order of the 
new layers using drag & drop. 

Now, select all objects of the button while holding the Shift key and move them to a 
new position. Usually, you also have to select the frame and chapter meny objects 
behind the highlight layers and move those, too. Mutliselection in the object gallery is 
not possible because the objects are in various layers, and the program will prevent 
you from selecting them together. 

These steps must be repeated for the second additional button. 

Finally, the changes must be saved as a PSD file. To do so, select "Export" in the File 
menu ("Save as..." wouldn't work). 
 

Change text font 
Photoshop Elements: 

In Photoshop Elements it is recommended that you export the template after 
changing the font size of the text to be edited to 0. This way, no text will be visible in 
the PSD to be exported. This step is necessary because in Elements you cannot 
change anything in the created layer groups and nothing in the existing font layer can 
be removed. 

Create the desired font objects using the text tool. A separate layer will be created for 
each font object. Name the layers clearly by selecting "Rename layer" from the 
context menu. Change layer names so that they begin with "(-)". If additional layers 
are needed for the text (for example background picture/frame, etc), their names will 
also have to start with an "(-)". 

Add the created layer to the proper layer set using drag & drop (for example, the new 
label for the movie button to the "(+) menu entry" layer set or the new header to the 
"(+) title" layer set. To do so, you select the layers with the mouse inside the layer 
container and drop them into the proper layer group. 
Save the results. 

Photoshop CS1: 

In Photoshop CS1 you can access layer groups and can first delete text layers in order 
to add your own text objects. Replace labels on movie buttons, by opening all "(+) 
menu entry" layer sets and deleting text layers ("(-) ..."). Using the text tool, create 
new text objects, one next to each movie button. Use all of the program's functions in 
order to realize your ideas.  

Drag the text layer using drag & drop into the layer container into the respective layer 
sets. Adjust the layer names. Add an "(+)" to each text layer. You can generate 
additional layers that may be necessary for the text, such as shadows, background 
frames or bitmaps, etc. During reimport, all layers of a group with a (-) in front will be 



 

224   

http://pro.magix.com 

pooled into one text object. 
Save the results. 

Xara Designer Pro: 

In Xara Designer Pro, activate the text tool after loading the PSD file and write the 
desired text next to the movie button. 

Now, you have to localize the existing movie buttons (object gallery technology, see 
above). You can drag and drop the text object from the background into the found 
layer and delete the text object there (Del or "Delete" in the object gallery). Because 
naming takes place in the surrounding layer and the objects in Designer  themselves 
don't have names, you don't have to rename anything. 

Repeat this for every movie button and "Export" the result. 
 

Adjust background and butttons 
Photoshop Elements:  

In Photoshop Elements you can only add something to existing button graphics and 
highlights since individual layers in layer sets cannot be deleted an no new layer sets 
can be created. The general method is similar to text editing: create new layers and 
add these to existing layer sets using drag & drop. Finally, adjust the layer names: All 
layers, containing the highlight to be displayed, must again recieve a name that begins 
with a "(=1)". 

You can create graphics for your new menu for "Prev" and "Next" buttons by dragging 
them into the open PSD file. They are, for example, 4 layers, two button graphics and 
twop highlights. The highlight layers must be renamed and scaled and placed on the 
screen using the mouse. Move the layers using drag & drop into the "(+>) next 
button" or "(+<) prev button" layerset. 
Save the results. 

Photoshop CS1: 

In Photoshop CS1 everything works similarly to Photoshop Elements. In contrast to 
MAGIX Video Pro X6, generated layers can also be deleted, so that button graphics 
can really be replaced. 

Xara Designer Pro: 

In Xara Designer Pro, the workflow is similar to creating new texts. When the menu 
template is open, you can drag and drop, for example, 2 graphics  for navigation 
buttons into the ready PSD. Two new layers will appear in the menu template with 
two new graphics objects. Drag these into the layer with the Bitmaps to be replaced. 
Renaming is unnecessary, since the surrounding layers do this, too. Localization, 
scaling and moving on the screen is analogous to Photoshop programs. 
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Import menu back into MAGIX Video Pro X6 
After editing, a PSD file is created, which is imported into MAGIX Video Pro X6 again 
and must then be assigned to a menu page as a template. 

 
If access takes place through "Edit externally" see "Export menu" (view page 
219), this is done automatically during saving and closing of the graphics 
program. Otherwise, use the button "Import PSD" to do this. 

This imports and converts the PSD (saved to an automatically generated folder in the 
folder Content\DVD\Layouts, with TPL files and the generated bitmap files). 
 

Create DVD menus without a template 
It is recommended that an existing menu template is adjusted first with a graphics 
program. This exercise will help you learn about the functions and structure of a DVD 
menu as a PSD file to create menus without using any templates. 

You can create PSD files without templates if the following is observed.  

• MAGIX Video Pro X6 can only use bitmap layers from the menu PSD file. Text 
layers are read as a bitmap (graphic) so that MAGIX Video Pro X6 cannot make 
any changes to the text. Layer effects, etc. cannot be read by MAGIX Video Pro 
X6. For this reason, all layers featuring additional features in the graphics 
program need to be reduced/combined to bitmap level. 

• The correct naming of layers is very important! MAGIX Video Pro X6 assigns the 
layers and layer groups to the menu items via their names, which makes their 
correctness important. The characters added in front (view page 219) of the layer 
names should therefore be observed. 

A correct menu PSD contains the following elements: 
• background 
• menu title 
• x movie buttons with preview image, frame bitmap, text for menu, text for 

numbering, highlight 
• one chapter menu button per movie button with bitmap and highlight 
• 3 navigation buttons: in front, in the back, and the root menu 

Background: The background utilizes all layers from the PSD file from the very back to 
the foremost "usable" layer groups. All of the layers up until this are combined via 
alpha layering. If the appearance of the background in the graphics and in MAGIX 
Video Pro X6 is different, then this step may also be made in the graphics program. In 
Photoshop, all associated layers would be combined with the background layer. 

Menu titles: In the next step, the layers of the menu title are added and combined into 
a single layer group. This must feature a name that begins with "(+*)". Besides the 
text layer, additional layers such as text background, shadows, etc. may be present. 
All layers are unified as a single layer via alpha layering. 
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Film buttons: Layers for film buttons are each combined as a layer group that features 
the prefix "(+-)" or "(+)" at the beginning of its name. The layers themselves have 
different functions that are kept together via this naming prefix. 

Preview image: The name of the layer for the preview image begins with "(%)". In this 
case, MAGIX Video Pro X6 only reads the position and size of the layer and uses this 
range to generate the preview image. In case multiple preview images are present, 
their right corners will be combined during importing.  

Text layer: This includes text layers beginning with "(-)". "(-) index text" serves as an 
identifier for the naming, all other text layers will bear the name of the button label. 

Highlight layer: The highlight layer is the top of the layer groups. Its name begins with 
"(=1)". This should contain a highlight version (e.g. altered color) of the frame bitmap. 

All other layers will be combined into a frame bitmap. 

Chapter menu buttons: The last portion features the layer groups for the chapter 
menus and navigation buttons. These are named variously ("(++)" or "(+>)","(+>)", 
and "(+^)"), by they feature the same principle the structure. All highlight layers 
(beginning with "(=1)") become the highlight bitmap; all other layers become the 
buttons bitmap via alpha layering. 

The sequence of the layer groups from the PSD file is basically not considered by 
MAGIX Video Pro X6. Characterization in the program takes place in the order 
outlined here, even if the associated layer groups in are saved in a different order in 
the PSD file. 

An exception is formed by movie and chapter menu buttons: arrangement in MAGIX 
Video Pro X6 takes place in the sequence featured by the PSD file. The first chapter 
menu button detected belongs to the detected movie button, the second to the 
second movie button, and so on. 
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Burn a disc 
Switch to the "Burn" screen first by pressing the button displayed. 

Here you can burn your movies to CD, DVD, or Blu-ray Disc including selection 
menus. 

All movies loaded into the project will be included. If you want to remove some of the 
loaded films, switch to the "Edit" screen again and delete the unwanted movies from 
the project there. To do this, switch to the movie, open the "File" menu and select 
"Manage movies -> Remove movie" (view page 290). 

Notes 

When you try to burn your first Blu-ray disc a notice will appear to inform you that a 
free audio expansion package must first be downloaded and installed. Click on OK to 
proceed and wait until the audio encoder for Blu-ray discs is installed. 

At a screen resolution of 1280 x 1024, the program display changes. This makes the 
program more manageable and easier to use. The work steps remain the same 
despite the different display. 

If the current project contains data in the BDMV/MVC (Stereo 3D) format, the burn 
process cannot proceed. Due to licensing stipulations of the Blu-ray Disc 
Association, files in BDMV/MVC (Stereo 3D) format cannot be burned to blank 
optical media. 
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Burning wizard 

 

Click "Burn" to open the dialog for creating DVDs, Blu-ray discs, 
AVCHD and other video media including a menu. 

 

Select what kind of disc you would like to create. 
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The burn dialog 
Here you can select your burner, the type of disc, the encoder settings. MPEG-2 is 
used for DVDs. Blu-ray discs also use MPEG-2, and higher bitrates are employed in 
order to reach the higher HD resolutions. AVCHD discs use a much more complex 
MPEG-4/H.264 codec, which is documented in detail in the "MPEG-4 encoder 
settings (view page 354) section of the PDF manual and in Help (F1 key). 

 
 

Proceed as follows to burn a disc: 

• Set up burner and burn speed: If multiple burners are installed, you may select 
which device you wish to use in this menu. 

• Encoder settings: Use the "Encoder" button to access the selection dialog to 
specify settings for the MPEG encoder (memory requirements, quality, and 
duration of the MPEG conversion). "Advanced settings" accesses a dialog 
featuring additional options. You can adjust all the fine settings for the MPEG 
encoder here. 

• Burning disc/starting video encoding: The button "Burn disc" starts the disc 
burning process. Every time you burn and every time a simulation is carried out, 
the disc project is encoded. Please note that the MPEG file is not deleted from the 
hard disk after the burn process has finished. Depending on the length of the 
project, encoding and burning may take some time. The time required can be 
seen in the dialog. 

 

Creating an ISO image 
The simplest way to create an ISO image is to select "Image recorder" under "Burner". 
When starting the "Burning process", you have to specify a name for the image file 
you wish to create. 
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Options 
Simulate first: If you are not sure about the write speed or memory requirements of 
the selected disc, you can simulate the write process before burning.  

Activate buffer underrun protection: Many burners support techniques that prevent 
the much-feared "buffer underrun". Use this option to activate this protective feature 
and burn your files at higher speeds without risking making a coaster out of your blank 
disc. 

Completely format DVD/CD-RW media: This option reformats the RW media and 
deletes all existing file material. 

Shut down computer after burning: Activate this option to automatically turn off the 
computer after encoding and burning has been completed. You could, for instance, 
start the encoding and burning process in the evening, and you don't have to wait for 
the process to finish to switch off your computer. 

Burn standard video DVD onto same disc: You can use this option with a WMV HD 
disc to burn an additional normal DVD video. This ensures that your discs can also be 
played back on standalone DVD players. See Multi disc. 

Activate the burner's defect management option: If a certain section of the disc is 
defective, then this will be recognized by the burner and labeled as such. No content 
will be saved there as a result. 

Check data after burning disc: The finished disc will be checked for any mistakes after 
burning. 

CD/DVD title: This is the title of the DVD as it will appear on the PC. The disc project 
name is displayed here by default. 
 

Memory 
Disc type Storage media Menu Quality: Length (optimal quality) 

DVD DVD Yes  *** 98 min. 
Blu-Ray disc 
(view page 350) 

Blu-Ray disc Yes ***** 110 min. 

AVCHD (view 
page 350) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 
160 min./Blu-ray Disc 

*  The display time for some DVD players can be determined in this menu. The 
amount of image material that can be put onto a CD or DVD depends on the sizes of 
the picture files. 
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It is difficult to acquire reliable information regarding required memory, especially 
with the MPEG-2 encoder. If the “Variable bit rate” of the MPEG-2 encoder is 
activated, encoding will occur according to the movements in the picture. The 
required memory depends on the film material; an action film would need more 
memory than a drama, for instance. 

In the MAGIX Video Pro X6 burn dialog there is a display of remaining capacity, 
which estimates directly how much space remains on the selected disc type with 
current settings. As soon as you change Encoder settings, the capacity display will be 
updated. 

Tip: The capacity display is only an estimate. For this reason, always make sure that 
you never completely fill the disc space. Instead, leave a buffer in case the files end 
up being larger than the provided estimate. 

If you cannot save your disc project on a single blank CD, you will have to divide it up 
into various parts. 

Note: Further information on MPEG compression and formats can be found in the 
chapter PDF manual in the chapter "Video and data formats" (view page 347). 

 

Separate project onto multiple discs 
Automatically: If the disc project requires more memory than is available on the disc, 
a dialog will appear before burning asking whether the disc project should be 
automatically segmented for multiple discs. Confirm this by clicking “Yes”. The disc 
project will then be automatically divided into individual disc projects and burned 
sequentially onto multiple discs. This is the easiest method as everything is automatic 
and all you have to do is insert a new blank CD when required. 

Manual 

Case 1: If several movies do not fit on a single disc: 

In this case, switch back to the “Edit” interface and delete as many movies as 
necessary until the remaining movies fit onto the disc. You can create a new disc 
project and load and burn the other movies afterwards. 

Case 2: If a long movie doesn’t fit on a disc... 

In this case, the movie has to be split into two or more parts that will be burned 
separately onto disc. 

• Switch back to the "Edit" view and place the playback marker to the position 
where you want to divide the movie. In the "Edit" menu, select "Cut -> Separate 
movie". 
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• All passages behind the playback marker will be removed from the overly long 
movie and made into a separate movie. Both movies can be controlled in the 
movie tab in the Project window. Save both of them separately to your hard disk 
(“File > Manage movies > Export movie file” menu option, for example, as “Part 1” 
and “Part 2”). 

• Remove one of the two movies (for example, "Part 2") from the disc project 
("File" > "Manage movies" -> "Remove from project (view page 290)" menu 
option). 

• Switch to the "Burn" interface and burn the first film ("Part 1") to CD or DVD. 
• Create a new disc project (“New” button), switch to the “Edit” view and load it 

into the second film (“Part 2”). 
• Switch to the "Burn" interface and burn the second movie to ("Part 2") CD or 

DVD. 
 

Encoder settings 
Use the “Encoder settings...” button to access the selection dialog to specify the 
properties of the MPEG encoder (memory requirements, quality, and duration of the 
MPEG conversion) 

Preset: Here you will find useful presets for the selected disc type. Here are some of 
the presets for a DVD: 

Longplay DVD Video DVD with extra-long playing time. The bit rate is reduced, 
which compromises image quality. 

Longplay music DVD DVD with extra-long playing time for music. The bit rate for 
the soundtrack remains at the highest quality level. 

Standard DVD Normal DVD 
Widescreen DVD Normal DVD in 16:9 format 

Note: For all settings, you can choose between NTSC (USA and Japan) (Europe). 

Bitrate: Bitrate determines the size on the disk that the finished video will take up. The 
greater the bit rate, the larger the file, and the shorter the maximum playing time of 
the movie that fits on a disc. 

Adjust bit rate: The expected file size of the finished video is estimated, depending on 
the set bit rate. If the movie does not fit onto the disc, the bit rate is corrected 
accordingly. 

Quality: Specifies the quality of the encoding process. The higher the quality, the 
better the finished video will look; however, encoding will take considerably longer. 

Smart Rendering: With Smart Rendering you can significantly reduce the encoding 
effort for MPEG files. During the production of MPEG files, only those parts of the 
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movie that were changed in the program are re-encoded. Please note: The MPEG files 
contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

Anti-interlace filter: Activate this option only for playback on a TV screen, where it 
reduces horizontal flickering around fine details. 

Calculate video effects on GPU: To accelerate exporting, you can let video effects be 
calculated on the graphics card. At this time this applies to brightness, gamma, 
contrast, color, saturation, image size, cropping and position effects as well as various 
fades and mixes. Please note that external effect plugins and elaborate artistic effects 
must be processed on the CPU and for this reason using this function will not yield 
any speed advantage. 

Note: This function is specifically optimized for NVIDIA graphics cards. You can, 
however, experience acceleration with other types of graphics cards, too. 

3D mode: If you have 3D material in your project which has been edited with 
Stereo3D, you can select here in which mode it should be burned to disc here. 3D is 
switched off by default. 

To return to the standard settings, press the Reset button. 

Via "Advanced" you can reach the "Advanced settings" dialog. Here you can make 
changes to all MPEG encoder settings. Read the \ "MPEG-1/2 encoder-settings" 
appendix (view page 364) and "MPEG-4 encoder settings" (view page 354) in the 
PDF manual or program help. 
 

Apply hardware acceleration for rendering 
MAGIX Video Pro X6 supports hardware acceleration for AVCHD exports as well as 
AVCHD and Blu-ray discs. This can noticeably speed up the encoding process. 

The hardware acceleration that is applied depends on the encoder being used and the 
hardware built into the system. 

• Quick Sync Video: Intel processors starting with „Sandy Bridge“ when using a 
standard MPEG-4 encoder (view page 354) or a Main Concept MPEG-4 encoder 
(view page 354). 

• CUDA: NVidia graphic cards when using a Main Concept-MPEG-4 encoder (view 
page 354). 

• OpenCL: AMD graphic cards when using a Main Concept MPEG-4 encoders 
(view page 354). 
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Note: Ask your graphics card manufacturer whether your graphics card supports 
hardware acceleration.  Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it in the "Encoder 
Settings" dialog under "Advanced..." > "Hardware acceleration". 
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Export movie 
A movie may be exported in different video formats via "File -> Export movie". The 
options available vary according to the selected format. 

Presets: These are typical settings for the selected format for the most important 
applications.  

  Click "Save" to save your own settings and "Delete" to remove them 
from the list. 

Export settings: Specify general export parameters like resolution, aspect ratio, and 
frame rate here. Select the most frequently used values from the list fields; to set your 
own values click on the "..." button. The "Advanced" button opens the specific 
settings for the selected video format. "File" enables you to export your file to another 
folder than the preset one. The option "Overwrite file without confirmation" option 
allows you to execute multiple exports in the same file.  

Other: "Other" also provides the option to switch off your computer automatically 
after long encoding processes and to limit export to the selected area (between the in 
and out point).  

Other 

• Export selected range only 
• Apply anti-interlace filter (suppresses flickering) 
• Shut down PC after successful export 
• Calculate video effects on GPU 

Output after export: Some formats allow special playback options (e.g. DV-AVI on 
the camera or WMV export with output via Bluetooth to your mobile phone). 

Note: Burning a disc takes place on the "Burn (view page 66)" screen. Read more on 
this in the chapter "Burning a disc (view page 227)". 

 

Video as AVI 
When exporting to AVI video, you may set and configure the size and frame rate of 
the AVI video and the compression codec for audio (audio compression) and video. 
Please see the general information about AVI video formats (view page 347) as well. 

Keyboard shortcut:  Ctrl + Alt + A 
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Video as DV-AVI 
This option exports the video as a DV encoded AVI. The arrangement can be easily 
transferred to a connected camera using a FireWire interface. 

The dialog will provide further information on all available options. You can access it 
via "Advanced" in the export dialog. You will also be asked for which video standard 
you want to export the DV data - PAL (Europe) or NTSC (USA). 

Shortcut:  Ctrl + Alt + D 
 

Video as MPEG video 
MPEG stands for "Motion Picture Experts Group" and is a high-performance 
compression format for audio and video files. 

We recommend finding a fitting preset from the list first, since there are many various 
devices and applications for this format. You will also find, for example, intra-frame 
presets (starting with "Intra422") for video playback in professional studio 
environments. 

Details about settings for the MPEG encoder are provided in the program's "Help" file 
in the "MPEG encoder settings (view page 364)" appendix. 

Keyboard shortcut:  Ctrl + Alt + P 
 

Video as MAGIX video 
Exports the project in MAGIX video format. 

This format is used for video recording by MAGIX Video Pro X6 video software and is 
optimized for digitally editing high quality video material. 

Keyboard shortcut:  Ctrl + Alt + M 
 

Video as QuickTime movie 
Exports the project in QuickTime Movie format. This format enables streaming 
playback of audio or video files via the Internet. 

Note: The Apple QuickTime Library must be installed for QuickTime files (*.mov). 

Keyboard shortcut:  "Ctrl + Alt + Q" 
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Uncompressed movie 
When exporting an uncompressed AVI video file you can adjust the size and frame 
rate of the AVI video you wish to create. The video material will not be compressed 
by a codec. 

Note: This will create very large files! 

Keyboard shortcut:  Ctrl + Alt + U 
 

Video as MotionJPEG AVI 
Opens the export dialog for AVI video in MotionJPEG format. This format is 
supported by digital picture frames, for example. 

Keyboard shortcut:  Ctrl + Alt + O 
 

Movie as a series of individual frames 
This option exports the video as a sequence of single frames in bitmap format. This 
means a graphic file will be created for every frame of the video. The image count may 
be determined in the export dialog under "Frame rate". 

Keyboard shortcut:  Ctrl + Alt + E 
 

Windows Media Export 
Exports the arrangement in the Windows Media format. This is a universal 
audio/video format from Microsoft. Accordingly, the settings options in the 
"Advanced" dialog are very complex. 

Manual configuration 
Audio/video codec: Various codecs corresponding to the various Windows Media 
versions (7, 8, 9) are possible. Should compatibility problems arise on playback, try an 
older codec with a lower version number. 

Bit rate mode: Constant and variable bit rates are possible, most devices and 
streaming applications require constant bit rates. For VBR two pass modes the movie 
is compressed in two passes in order to optimally use the bandwidth for highly-
compressed movies for the Internet. 

Bit rate/quality/audio format: The bit rate is decisive in defining the display/audio 
quality. The higher this is set, the better the videos will look and the larger the files 
and the required encoding time will be. For variable bit rates, the bit rate is adapted 
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dynamically to the requirements of the corresponding picture or sound material. 
Either the quality value may be set between 1-100 or, for two-pass encoding, an 
average or maximum bit rate. For audio, the bit rate is set additionally by the audio 
format. 

Import: For the most common applications (other than for playback on mobile 
devices, for which you should use the supplied presets) like Internet streaming, 
Microsoft provides diverse system profiles to choose from. If you have the Windows 
Media Encoder 9 installed, which is available from Microsoft as a free download, you 
can edit the profiles or create your own. These may be loaded by pressing the 
"Import" button. 

"Clip info" enables the title and artist names, copyright details, and descriptions to be 
entered. 

Keyboard shortcut:  "Ctrl + Alt + V" 
 

Video as MPEG-4 video 
MPEG-4 is actually a collection of highly efficient codecs for video and audio based on 
the MPEG standard. Compared to MPEG-2, the same quality can be achieved with 
smaller file size. 

Recommendation: Check the presets that the program offers to find the right preset 
for each application and the right playback device. These presets are optimized for 
typical applications. 

The advanced settings in "Advanced" are divided into "Video", "Audio", and 
"Multiplexer".   

Under "Video“ there is a choice between "MPEG-4 Simple" (MPEG-4 Visual/MPEG-
4 Part 2)  (view page 359)and "MPEG-4 H.264" (AVC/MPEG-4 Part 10) (view page 
354).  

Depending on the purpose of application of the material to be exported, either one of 
these encoder settings can be selected for compressing the video material. Refer to 
the manual for the playback device to find out which encoder is supported. 

Under "Audio", "AAC" (view page 362) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available.  

Under "Multiplexer" you can adjust certain presets, e.g. container format and 
streaming properties. This is only recommended for experts. 

The option "Export as website" also creates an HTML page in an integrated Flash 
player that can play back the video created. Read the topic "Embed Flash videos into 
your own web site (view page 334)". 
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Tip: First, check if there is a suitable preset in the export dialog for your purposes. 
Advanced users can make specific adjustments to these three areas using the 
advanced settings. 

For more information about the MPEG-4 encoder read the "MPEG-4 encoder settings 
(view page 354)" chapter. 

In the presets there are also various 4K presets for exporting very high resolution 
material. 

Keyboard shortcut: Ctrl + Alt + G 
 

Export as media player 

Note: This option is available in the export dialog of the basic mode. In the standard 
mode it is found in "File" > "Video as MPEG 4" > "Presets" as "FlashPlayer" options. 

You can export your movie as an HTML-enabled media player if you want to play it in 
an Internet browser or embed it on a web page. 

• Select the desired quality. 
• Click on "Save video". 

In target folder, an HTML and an MP4 file will be created for further use. 
 

Audio as MP3 

Note: MP3 export requires Windows Media Player version 10 and up. 

The MP3 encoder cannot be used as a codec for the AVI audio file audio tracks. 

Options 
The "Options" section allows the format and the compression level for the audio file 
to be set. 

Bit rate: "Bit rate" selection specifies the compression level: the higher the bit rate, the 
higher the quality of the exported audio file will be. On the other hand, the bit rate also 
determines the final file size: the smaller the bit rate, the smaller the files will be. 

Mono/stereo/5.1 Surround: Most mobile devices have only one loudspeaker. To save 
on memory, you may export in mono for these devices. In "5.1 Surround" mode, you 
can also export in MP3 Surround. Read "Mixer in Surround mode" for more about this. 
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Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet. 

Transfer format: 
Specify here whether the created file should be transferred via device connected via 
Bluetooth or via email. 
 

Audio as wave 
The movie's audio track is exported in the wave (*.wav) audio format. 

Keyboard shortcut:  Ctrl + Alt + W 
 

Export as transition... 
The movie is exported as an alpha transition in the MXV format. The brightness value 
of the movie depends on how the transition functions. The option "Export the selected 
range only" also specifies that only a small part specified beforehand via the in and 
out points will be exported. 

If you do not change the save location, you will locate the saved transition in the 
Media Pool under "Transitions -> Standard". 

Keyboard shortcut:  Ctrl + Alt + T 
 

Single frame as BMP file 
Exports the image located at the playback marker and displayed in the video monitor 
as a bitmap (*.BMP) file. 

Keyboard shortcut:  Ctrl + Alt + B 
 

Single frame as JPG 
Exports the image located at the playback marker and displayed in the video monitor 
as a JPEG (*.JPG) file. 

Keyboard shortcut:   Ctrl + Alt + J 
 

Export movie information as EDL 
Exports the current movie in a Samplitude-compatible EDL format. This export is 
mainly intended for transferring audio files to Samplitude/Sequoia, since the program 
cannot process all of the video formats MAGIX Video Pro X6 can manage. Only 
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object cuts, tracks, pans, and volume (with curves) are transferred, since the EDL 
format only saves this information in a limited manner.  

Items that are not transferred: All effects, Surround positions, video transitions, 
markers (chapter markers, scene markers). 

The basic audio and video files will not be exported. They will either be loaded by the 
EDL-importing program automatically (if they are available in the same folder of the 
EDL file) or requested during importing. 

The following is a recommended approach for using an editing list in EDL format: 

• Save the media you use beforehand in a folder (e.g. via "File -> Backup copy -> 
Copy film and media to folder". 

• Export your film as an EDL editing list and add the EDL file in the same folder as 
the media. 

• Load the EDL file into the importing program (e.g. Sequoia). The EDL file provides 
the correct positioning of the individual media. After editing, you can export the 
audio track as a WAV file, e.g. to import it again into MAGIX Video Pro X6 to 
replace existing audio objects. 

Note: Cut lists may also be imported from external programs. Select the menu item 
"File -> Import cut list (EDL)" to do this. 

Keyboard shortcut:  Alt + D 
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Upload to the Internet (YouTube and Vimeo) 
You can upload your movie to various online sites such as YouTube or Vimeo by 
going to "File" > "Online". YouTube is a hosting site for self-made clips of all kinds. 
Vimeo is a growing service that is popular with more experienced videographers and 
budding filmmakers. Before uploading your video to YouTube or Vimeo you first have 
to add some additional information. This can be done in the program dialog. 

 

Community: Here you can select the platform. 

Title: Enter the name of your movie here. 

Description: Create a short description of your movie to describe it to other members 
of the community. 

Category: Select the category for your movie here. 

Send: Select whether the film should be private, accessible only to you and authorized 
persons, or public, meaning freely accessible. 

Export settings: Set various quality settings. 
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Upload to Internet (MAGIX Online Album and 
showfy) 
Go to "File" > "Online" > MAGIX Online Album and showfy> "Upload current movie 
as video" to access the login dialog. In MAGIX Online Album you can present your 
videos along with photos and music in custom designed online albums. With showfy 
you can organize your photos and videos into "Streams" and share them with 
privately only with the people you select. 

 
 

Export to device 
The menu "File -> Export to device" allows you to transfer your video to the 
connected playback device.  

 

Besides the Camcorder options for digital camcorders (DV/HDV) and VHS recorder 
for playing analog video for recording onto digital camcorders and analog VCRs 
includes many options for further players such as mobile video players, Smartphones, 
PDAs, or games consoles. 
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Output as media player 
You can export your movie as an HTML-enabled media player if you want to play it in 
an Internet browser or embed it on a web page. 

• Select the desired quality. 
• Click on "Save video". 

In target folder, an HTML and an MP4 file will be created for further use. 
 

Output as video file 
With this option you can recalculate a movie including all objects, effects settings, 
transitions, text, etc. into a video file and save it to a computer. 

 

Select a certain quality (e.g. DVD quality) and a file format (e.g. MPEG -4). The dialog 
provides further information about the properties of your selection. Please note that 
MAGIX Video Pro X6 also adjusts the quality when you change file format, if this 
wasn't optimally selected for your chosen format. 
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Settings  for and management of video 
projectors 

Movie and project settings 
When you create a new video project, you can make settings for the new project 
already in the start dialog. You can change these later. 

In the following chapter, we'll discuss the various settings included in MAGIX Video 
Pro X6 for your movies and projects.  

All settings dialogs may be accessed via "File -> Settings". 
 

Movie settings 
Open the movie settings via "File -> Settings -> Movie..." or by pressing "E". The 
following dialog opens: 

 

The buttons at the top are for the four tabs in the dialogs: "Movie settings -> 
Synchronization ->Movie information" and "Project settings". 
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Movie settings 
Play movie in loop mode: The movie will be played back endlessly. Playback starts at 
the playback marker and after reaching the end of the project will restart at its 
beginning. 

Use current settings as presets for new movies: If this option is activated, all new 
movies will receive the settings that you have chosen in this dialog. 

Crop new images to fit the screen automatically: Fits all images and videos inserted 
into the project automatically so that they fit the screen. 

Number of tracks: Here you can change the number of tracks. 

Audio sample rate: The preset sample rate is 48 kHz. This sample rate is used for all 
recordings and is also the standard setting for DVD audio tracks. This setting 
guarantees optimal sound quality. Audio material at different sample rates (e.g. CD 
audio with 44 kHz) is automatically converted when loaded (resampling). Only 
change this value if you want to use audio with a different sample rate or if your 
sound card does not support this sample rate. 

Note: The audio sample rate can only be changed in empty projects. When an object 
is added to the project, this setting is locked. 

Video settings: You can select the standard settings for the picture format and frame 
rate for PAL or NTSC images or for your own format. Make sure that the entries for 
aspect ratio and frame rate correspond to your target format so that your finished 
movie will play smoothly on the intended screen, no undesired black strips are seen, 
and all video/image objects are in their correct positions. You'll also find various 
settings for 4K videos ("Ultra HDTV"). 

Note: MPEG encoding requires a width/height ratio that is divisible by 8. 
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Synchronization 
Synchronization dialog 

 

Note: You will find descriptions of all synchronization dialog elements here. You can 
find a description of how the synchronization settings are made in the 
"Synchronization settings" (view page 248) chapter. 

Input synchronization: Here you must select the driver which the MAGIX Video Pro 
X6 will receive the MIDI timecode. This setting will also be used for SMPTE. With 
synchronization via SMPTE, please make sure that the device corresponds to the 
SMPTE input of your MIDI interface. 

Frame rate: Here you can determine the fitting SMPTE frame rate, for example 24 for 
cinema film, 25 for PAL video and audio synchronization, 29.97 drop/non drop or 30 
for NTSC video. 

Preroll: Here you can enter a frame number which MAGIX Video Pro X6 will ignore 
before it starts synchronization. This accommodates the fact that analog devices need 
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time to reach their correct speed. To make sure that MAGIX Video Pro X6 
synchronizes to a valid time, this segment can be skipped using pre-roll frames. 

Output synchronization: Here you must select the driver, which MAGIX Video Pro 
X6 will use to send MIDI timecode. When synchronizing via SMPTE, please make 
sure that the device corresponds to the SMPTE output of your MIDI interface. 

Start offset (ms/SMPTE): Here you can enter a time value in milliseconds or in 
SMPTE frames to be subtracted from the SMPTE time before the time is used for 
synchronization. With an offset of 60:00:00 (1 hour), a tape whose SMPTE code 
starts at 1 hour may be synchronized by MAGIX Video Pro X6 as starting at 0. 
 

Specify synchronization 
MAGIX Video Pro X6 is capable of being synchronized by external sources or 
synchronizing external sources. 

Synchronizing MAGIX Video Pro X6 with Samplitude or Sequoia is also possible via a 
virtual MIDI cable (e.g. "MIDI Yoke" or Hubi's MIDI Loopback Device"). The 
requirement in this case is simply that the virtual MIDI cable has been installed 
successfully. 
 

MAGIX Video Pro X6 as master 
If MAGIX Video Pro X6 should synchronize external programs or sources, then 
proceed as follows: 

• Open the Synchronization dialog (view page 247). 
• Under "Output synchronization", set the MIDI device that is connected to the 

device that MAGIX Video Pro X6 is supposed to sync with. 
• In case you want to synchronize another program (e.g. Samplitude/Sequoia) via 

a virtual MIDI cable with MAGIX Video Pro X6, please make sure that the 
corresponding MIDI device is set in both programs. The program to be 
synchronized must support MTC and be configured as the "slave". 

• For example, if you use "MIDI Yoke NT1" under "Output synchronization", then 
the device "MIDI Yoke NT 1" must also be set in the MTC input of the program to 
be synchronized. 

 

MAGIX Video Pro X6 as slave 
MAGIX Video Pro X6 set as the slave causes the program to follow an external 
source or another program during playback. 

• Open the Synchronization dialog (view page 247). 
• Under "Input synchronization", set the MIDI device that is connected to the 

device that MAGIX Video Pro X6 is supposed to sync with. 
• In case you want to synchronize another program (e.g. Samplitude/Sequoia) via 

a virtual MIDI cable with MAGIX Video Pro X6, please make sure that the 
corresponding MIDI device is set in both programs. The program that is set to be 
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the synchronization source must support MTC and be configured as the 
"master". 

• For example, if you use "MIDI Yoke NT1" under "Input synchronization", then the 
device "MIDI Yoke NT 1" must also be set in the MTC output in the master. 

 

Synchronizing Samplitude/Sequoia with MAGIX Video Pro X6 
This section should help you synchronize MAGIX Video Pro X6 with 
Samplitude/Sequoia for Surround productions. 

The introduction featured here provides a single example. In this case, MAGIX Video 
Pro X6 is the master: Samplitude/Sequoia follows the time information from MAGIX 
Video Pro X6 but sends information from the transport control to MAGIX Video Pro 
X6. This method allows playback from both programs to be started while they run 
synchronously. 

The chapter "Transferring a Surround project to MAGIX Video Pro X6 (view page 
205)" explains how completed Surround projects are transferred from 
Samplitude/Sequoia to MAGIX Video Pro X6 and how they are processed. 
 

Requirements 
Since synchronization occurs via MTC (MIDI time code), a virtual MIDI driver must 
be installed. Examples are "MIDI Yoke" or "Hubi's MIDI Loopback Device". Configure 
the driver as required so that at least two virtual MIDI devices are available. 

If a Surround project is to be created, then you require a Surround-capable sound card 
with at least 6 channels.  
 

Setting up MAGIX Video Pro X6 
• Open the synchronization dialog 
• Activate the box "Input synchronization active". 
• Under "Device", set the first free virtual MIDI device (e.g. "MIDI Yoke NT 1"). 

Now set the transport controls via MMC (MIDI machine control): 

• Click the "MMC button" to open the "MIDI machine control". 
• Activate the box "Receive MMC commands (slave)". 
• Under "Device", set the second free virtual MIDI device (e.g. "MIDI Yoke NT 2"). 
• Close both dialogs by pressing the "OK" button. 
 

Setting up Samplitude/Sequoia 
• Start Samplitude/Sequoia; MAGIX Video Pro X6 can remain open. 
• Open the Samplitude/Sequoia synchronization dialog. Right-click the "Sync" 

button on the transport console, or select the entry "Synchronization settings" in 
the "Options" menu. 
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• Activate the box "Output synchronization active". 
• Under "Device", set the first free virtual MIDI device (e.g. "MIDI Yoke NT 1"). 

Now set the transport controls via MMC (MIDI machine control): 

• Click "MMC settings" to open the "MIDI machine control" dialog. 
• Activate the box "Send MMC commands (master)", "Transport window as 

remote control for external device", and "Space bar for remote control". 
• Under "Device", set the second free virtual MIDI device (e.g. "MIDI Yoke NT 2"). 
• Close both dialogs by pressing the "OK" button. 
 

Now you can conveniently dub your movie in Samplitude/Sequoia while you edit and 
cut your work in MAGIX Video Pro X6. Playback can be started from both programs 
and always runs synchronously. 
 

MIDI Machine Control (MMC) 

MMC modes 
The synchronization window provides settings for remote control via MIDI Machine 
Control. MAGIX Video Pro X6 supports the control of external devices or through 
external devices through MMC. 

Send/receive MMC fullframe: With activated output synchronization (MAGIX Video 
Pro X6 is master), MMC commands are sent additionally. If the input synchronization 
option (MAGIX Video Pro X6 is slave) is activated, MAGIX Video Pro X6 receives 
MMC commands. 

While playing a range in MAGIX Video Pro X6, the MMC device stops once the end 
of the range is reached. If this option is activated, the start and stop commands sent 
by the space bar only control the MMC device. 
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Movie information 

 

This option opens an information window: 

Name: Here you can enter the name of the current movie. 

Date of creation: Displays the time the movie was created. 

Last changed: Displays the time of the last save. 

Number of objects used: Displays the number of all objects in the movie. 

Used files: All files used in the movie are listed here. 
 

Project settings 
You can change project settings here. A project can consist of multiple movies and is 
saved as an MVP file. 
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Name and path: Displays the name of the movie and the location where it is stored on 
the computer. 

Description:  Here you can give your project a description - perhaps a few statements 
about the state of the editing progress, e tc.  This is something like a notepad function. 

Date: Here you can assign your project a specific date. You can choose between a 
date - e. g. "Dec. 25, 2010" - or a written description - e. g. "Christmas 2010".  

Preview: This is the preview in a file manager such as Windows Explorer. You can use 
the automatic selection for the preview image or choose an image from your hard 
drive. You can also use a preview image from movie project. 
 

Select preview image automatically: MAGIX Video Pro X6 uses an automatically-
selected preview image. 
 

Use image file 
Clicking the folder button opens a dialog to load image files. In this dialog, you can 
navigate to the directory where the image file is found and select it by double clicking. 
 

Use preview image from movie 
Use the controller to select a frame from the corresponding directory. 
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Start dialog 
A start dialog will open when the program is started or a new project is loaded.  Here 
you can make important presets for the project. You can change these settings at any 
time by going to "File" > "Settings". 

 

Load existing project: Here you can select and load a previously saved project. 

View introductory video: Here you can start the introductory video with information 
about workflows in MAGIX Video Pro X6. 

Create new project: Here you can assign a name to your new project. 

Create proxy file automatically: The original material is already converted to a 
suitable target format in advance, which can (view page 267) save a lot of time when 
editing and exporting when finished. 

Project folder: Here you can set the path for the project folder where all project files 
should be saved. 

Movie settings: Here you can set the movie's target format (display norm, resolution, 
frame rate). This setting has no effect on the internal processing quality and can be 
changed at any time by going to "File > Settings > Movie". 
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Audio sample rate: Here you can set the audio track's audio sample rate. 

Use movie template: Here you can choose an included movie template for a new 
project. Read the "Using movie templates" (view page 286) section for more details. 

Editing mode: You can use Standard Mode and Basic Mode (view page 35) to edit 
your movies. 
 

Open 

 With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. MAGIX 
Video Pro X6 will search for all used sounds and video files in the folders in 
which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Save project 

 
The current disc project is saved with the name displayed in the project window. 
If you have not specified a name for your project yet, a dialog will open for you to 
do so. 

Keyboard shortcut:  Ctrl + S 
 

Save project as... 
A dialog opens where you can specify the path and name of the video for saving. 

Keyboard shortcut:  Shift + S 
 

Program settings 
All basic settings for MAGIX Video Pro X6 are made in program settings. 

Open program settings from the menu tab "File > Settings > Program" or use the 
shortcut by pressing "Y". 
 

Playback 
Audio playback 
Driver selectionHere you can specify whether the Windows Wave driver or the 
DirectSound driver will be used for audio playback.  

• DirectSound is a component of DirectX and, if necessary, is installed together 
with MAGIX Video Pro X6. DirectSound has the advantage that the sound output 
(for all modern sound cards or onboard soundchips) can also be used by other 
programs open simultaneously.  

• WAV drivers are recommended if the CPU load is higher, as the larger buffers 
allow better handling of the load peaks (otherwise this would cause crackling). 
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Output device: Use this option to specify which sound card plays the wave audio 
objects. This is especially important if you have multiple sound cards installed on your 
computer, e.g. "onboard sound" as well as an additional sound card.  

Audio buffer: In order to allow smooth playback of a complex project, MAGIX Video 
Pro X6 creates a RAM data buffer into which the current data is loaded.  This allows 
for step-by-step preprocessing instead of preprocessing for the entire project. 

• Number of buffers: Here you can specify how many buffers should be used. More 
buffers increase reliability and improve playback performance, but they also 
increase the memory requirements. When playback goes through DirectSound, 
only one buffer is used automatically. 

Note: As a rule, if response and loading times are too slow, reduce the number and 
size of the buffers. Otherwise, increase the buffer size if you are still having problems 
with playback performance. Since error-free playback is usually more important than 
fast reaction times, the buffer size should be raised to 16384 or 32768 to avoid 
drop-outs. The possible number of used buffer updates is between 2 and 10. 

• Multitrack size/Preview size: Specify the buffer size used to play the entire 
project or for previewing waves in the file manager. 

Video playback 
Overload prevention for realtime playback: Here you can activate or deactivate 
overload prevention during realtime playback of the project. This feature is 
particularly suitable for lower performance PCs. 

Instant cache refresh in Multicam Mode: Activate this mode to empty the cache in 
short intervals which will make the preview for multicam editing immediately visible 
in the preview monitor. This may result in juddering during playback. 

Number of tracks for parallel track optimization: It makes sense to limit the number 
of tracks when the program is running low on disk space and the project has multiple 
videos in parallel. 

Project window  
Autoscroll during playback: If autoscroll is activated, the screen view automatically 
shifts when the playback marker reaches the right edge of the screen, which is useful 
for longer arrangements. You can select the size of the scrolling steps from either 
"Fast" (whole pages) or "Slow" (half pages).  

Attention:  Scrolling requires constant recalculation of the screen view which may 
lead to interrupted playback if system RAM is too low. If this happens, simply 
deactivate the autoscroll feature.  
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Update in background: The update of the object display after move and zoom 
operations in the project window is performed in the background in order to let you 
work smoothly.  

Spacebar function: You can set whether the playback marker returns to its original 
position or stays at its current place when playback is stopped with the spacebar. 

Image playback 
Resizing high-quality image material: Use this feature to improve the quality during 
resizing, particularly when downsizing to less than half of the original size (e.g. for 
picture-in-picture effects). Keep in mind that this function requires more processing 
power. 

Load images in background: Images will be loaded in the background to save 
computing power. 
 

Folders 

 

Set the path where 

• projects are saved (Projects) here, 
• where files are exported (Export) or imported (Import), and recordings 

(Recordings) are saved, 
• where disc images are saved, 
• where EXE files for the external audio and picture editor are located so that they 

are able to be launched via the context or effects menu. 
• and where the VST-plugins were installed. 
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Video/Audio 
In the "Video/Audio" tab you will find all settings options concerning video and audio 
files.  

Video standards 
PAL is used in Europe; the United States, Canada, and Japan use NTSC. 

Movie display 
The resolutions that can be set here concern only the picture display in the arranger. If 
playback becomes jerky, we recommend entering a lower value. This does not 
influence the quality of exported videos. 

Automatic interlace processing: MAGIX Video Pro X6 usually automatically detects 
whether the loaded video files were recorded using interlace or progressive method; 
for interlace videos, the half-frame sequence is also recognized. In case automatic 
detection fails, you can deactivate it here and set the object properties (view page 
316) of video objects to the correct process. 

Options 
Automatic preview of exported clips: This option plays the clip directly after export to 
check the result. 

Extract sound from video: If a video file contains video as well as audio files, you can 
also import the audio file of the video if this option is selected. It will be displayed as 
an audio object in the arrangement below the video object. Both are automatically 
grouped together. If the audio track has to be edited or replaced later, you first have to 
ungroup it ("Ungroup" button in the tool bar or via the "Edit" menu). 

Allow user-defined names for sound extracted from VOBs: This determines whether 
a dialog will appear for each imported file during VOB import (VTS_01_1.vob) where 
you can give your film a name (box checked) or whether an automatically generated 
name should be assigned (box unchecked). 

Adjust small deviations from 4:3 aspect ratio during bitmap import: This option 
automatically adjusts photos that have nearly a 4:3 aspect ratio to the 4:3 TV format. 
The pictures are therefore easily stretched or compressed. This inevitably brings 
about distortions in the picture. If this option is deactivated, black bars appear along 
the sides. 

Load effects from JPX file automatically for images: If the images were edited with 
other MAGIX programs (e. g. MAGIX Photo Manager), description files with jpx 
extensions have ben created for each, containing certain effects and image titles.. This 
option adds that information into your editing process. 

Apply image effects during export to MAGIX Online Services: If this option has been 
activated, all image effects will be calculated into the sent file. 



 

258   

http://pro.magix.com 

GPU acceleration for standard transitions: Here you can (de)activate hardware 
acceleration of your graphics card for 3D effects. More information can be found in 
the 3D transitions (view page 99) chapter.  

Automatically create frame table during import: Sometimes, rebuilding a frame table 
can get rid of problems in certain MPEG files. For example, such problems can be 
present if the navigation (positioning of the playback marker, transport) is bumpy or 
doesn't function at all. 
Normally, when loading MPEG video, a frame table is not created in order to speed up 
the loading process. If you do create one anyway, MPEG files are normally noticeably 
faster and easier to edit. 

Reduce bitmap resolution for preview: Resolution fro image files will be reduced 
during playback to conserve resources. This requires less computing power than 
playback in full resolution; full resolution is always calculated during export. 

Outsource memory for bitmaps in other process: If this option is activated, your 
bitmaps become easier to handle because they are edited in a different process. 
 

System 
Warning dialogs:  In its newly installed state, MAGIX Video Pro X6 displays a number 
of security queries at various parts of the program. Each of them can be switched off 
by clicking the small box at the bottom that says "Don't show this message again". To 
display these warning messages, select the "Reactivate dialogs" option. "Hide news" 
enables current messages concerning MAGIX Video Pro X6 to be deactivated, and 
the screen can also be set to darken when dialogs are displayed. 

Text size and for touch: The default text size is "Smaller". The option also determines 
the sizes text used for buttons, menus etc. Change text size to "Medium" or "Large" if 
you find it easier to read. 

Start online configuration: Configure the various services for MAGIX Online World 
here. 

Undo/Redo: Here you can set the maximum number of steps the "Undo" function can 
have. Please note that memory requirement increases with the number of steps the 
program must save. 

Automatic save: Here you can set up an automatic backup function, which saves the 
project as a backup file with an "MV_" (instead of the normal project file "MVD") in 
the project folder. You can choose whether or not your project should be backed up 
and at what intervals this will take place. 

Other 
Automatic preview when changing transitions: When this option is activated, a short 
preview of the transition effect will be quickly played between the two objects you 
selected. 
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High-quality output for dynamic zoom and combination effects: This improves the 
display quality of zooms and effects, but results in longer loading times. 

Move playback marker when selecting objects: This option automatically moves the 
playback marker to the beginning of the selected object. 

Preferred codec for import and export of H.264: Selection of the codec during import 
and export of H.264 video files. If "MainConcept" is selected, this codec must be 
activated for a fee (view page 346). 

Import formats 
File formats that you never use can be de-selected here. Once de-selected they won't 
be imported anymore. Please keep in mind that several import modules exist for some 
file types (AVI, WMA); MAGIX Video Pro X6 uses the fastest one in each case. If you 
experience problems when importing certain files, you can experiment with 
deactivation of certain import modules which forces MAGIX Video Pro X6 to use the 
slower but more compatible import module. 
 

Display options 

 
 

Activate video output 
With this option, you can display your project windown on an additionally connected 
monitor. Without additional hardware, you can play a preview in any mode in order to 
see how the final material looks. 
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Preview in the project window/preview window and playback in video 
recorder/analog recording 
You can set the playback mode separately for the project window (including all 
preview windows and effects dialogs) and the preview monitors during recording and 
in the video recorder. 

Always use DirectX9: Normally DirectX11 is activated for the preview in the project 
window. DirectX9 can be activated for Windows XP and graphics cards that don't 
support DirectX11. You can also activate it if you are having general problems. 
 

Video mode 
The default setting is "Hardware accelerations (Direct3D)", which you shouldn't 
change because it delivers the best results. If you are running into problems, such as if 
the image remains black, you can see if the other modes work better. "Compatibility 
mode (VideoForWindows)" switches hardware acceleration completely off, and thus 
this setting should work best. It is also the slowest mode, in which the project 
probably won't play smoothly. These options are irrelevant for file export and disc 
burning. 

Tip: Change video modes only in case of problems with presets, such as jerks or 
persistent image artifacts. 

Preview in project window 
Compatibility mode (Video for Windows): This is the (tried-and-true) standard 
mode, which works on all systems. 

Hardware acceleration (Direct 3D): This mode offers extreme speed advantages, 
processing effects, mixing and various transitions directly on the graphics card. 
Depending on the graphics card, performance can increase by 300%. The graphics 
card will not be used during export. 

Warning: To be able to use this mode, the graphics card must have at least 128 MB 
disk space of its own. Direct 3D 9 or higher must be installed and the graphic card 
driver must support "High Level Pixel Shader Language 2.0". MAGIX Video Pro X6 
checks the corresponding properties when this mode is selected, and switches it off 
if necessary. 

Preview and playback on VCR/Analog recording 
Alternative mode 1 (Overlay Mixer): In this mode you can use hardware deinterlacing 
for export to PC monitor or progressive scan-enabled projector, which noticeably 
improves reproduction quality of analog video recorded with interlacing. 

Alternative mode 2 (Video Mixing Renderer 9): This mode uses hardware 
deinterlacing of modern graphics cards together with DirectX9. Make sure that you've 
installed the latest graphics card drivers and the card is compatible with DirectX9. 
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This mode works better than the standard mode (Overlay Mixer) only for a few 
graphics card models. 

Standard renderer: The DirectShow standard renderer is used for viewing. 
 

Image formation in Vertical Blank Intervals (VBI) 
The image formation takes place in the vertical blank intervals of the monitor signal 
(or the connected TV signal). This helps avoid image interruptions. Warning: Because 
of the necessary waiting time on the next VBI, this process adds significant 
computation time! 

You can deactivate this option for digital displays such as TFT monitors. In "Overlay" 
mode, image formation occurs exclusively via VBI. 
 

Acceleration for high-resolution MPEG2 files 
This option can be selected only in the "Hardware acceleration (Direct 3D)" video 
mode and indicates that videos in MPEG-2 format will be processed directly from the 
graphics card GPU. Depending on the graphics card performance, an improvement of 
up to 300% can be achieved! 
 

De-interlacing 
The DirectShow modes "Overlay mixer" and "Video mixing renderer 9" enable 
activation of hardware de-interlacing for the graphics card. For general information 
about de-interlacing and the options "Top/bottom field first", please read the 
corresponding article "De-interlacing (view page 373)" in the manual. 
 

Comparison image in source monitor for editing effects in the Media Pool 
If this option is activated, the "Selected objects without effects" comparison mode will 
be automatically activated when switching into the Media Pool effects, and will be 
automatically deactivated when the mode is exited. This serves to compare the 
original and edited image. 
This automation will be suppressed if the option is deactivated. 
 

Proxy and preview rendering 
The proxy/preview rendering settings affect the way in which MAGIX Video Pro X6 
renders selected ranges in the project window. This dialog can be accessed through 
"File" -> "Settings" -> "Proxy and preview rendering". 

Keyboard shortcut:  Alt + R 



 

262   

http://pro.magix.com 

Info: The proxy and preview rendering function enables smooth preview playback by 
rendering complicated passages in the project in advance. You can start this 
function in the context menu of the marker bar. More details are available in the 
"Preview rendering" section.  

 

Presets: Choose a preset that is suitable for your project. The rendered files will have 
a correspondingly higher or lower quality, and the quality of the preview will be 
determined. 

• Playback: The lowest quality. Preview rendering should only be used for improved 
performance during playback in the program and not during export or burning. 
This is the default setting. 

• DVD export: Playback in the program will be smoother and writing standard 
video DVDs will be faster. 

• HD export: Playback in the program will be smoother and writing Blu-
ray/AVCHD will be faster.  
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• Manual setting: The dialog is extended: 

 

Format settings: Specify here which format should be used to render a set range. 
"Advanced settings" enables you to adjust the selected format to suit your own 
particular requirements. Your own custom presets can be saved for future projects. 

Options 
• Use files created during rendering for export and burning: If the resolution of the 

rendered files is sufficient for the finished movie, you can use them for the final 
export. This shortens the time required for creating the movie. 
This function is set as default when you select presets for DVD or HD export, 
since quality is also optimized for export.  
You cannot select this setting if you have activated the option "Best Performance 
during Playback". 

• Extract audio when creating proxy files: In addition to the proxy files for videos, 
separate audio files (*.wav) are created in order to improve playback 
performance. 

• Create Stereo3D files for preview rendering: You can also view the preview in 3D. 

Note: Rendering may take longer depending on the selected format and size of the 
set range. 

 

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 
 

Copy movie and media to folder/copy disc project and media to folder 
This menu option allows you to put a complete MAGIX Video Pro X6 arrangement, 
including all applied multimedia files, into one folder. This is especially useful if you 
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want to archive an arrangement for later use or in case the files are on multiple data 
carriers (CDs, DVDs, etc) so that on loading you continually have to change them. 
Effects files used are also saved in a folder together with the other files. 

If the option "Copy disc project, movies, and media in folder" is activated, all movies 
in the current disc project, including all of the related media, are combined and copied 
into the selected folder. 

Note: MAGIX Video Pro X6 also features DV logging. Large DV-AVI and audio files 
no longer need to be backed up, since MAGIX Video Pro X6 saves the position of 
this material on the DV tape and imports missing files automatically when reloading 
the DV tape. 

A dialog opens to specify the path and name of the video. 

Shortcut: 

Copy movie and media into folder "Shift + R" 
Copy project and media into folder "Alt + S" 
 

Burn project and media onto CD/DVD/burn data to CD/DVD 
Use this option to burn the film as well as all associated files to disc. To do so, you 
must have a burner installed on your computer and a blank CD must be inserted. 

If you choose the option "Burn project and media", the current project and all of the 
associated media files are grouped together and burned onto disc. 

Even larger projects can be burned straight to disc. The project, if necessary, will be 
split up and burned automatically to multiple discs. A restore program which is 
burned to the first disc of this type of backup guarantees that the backup can be 
restored without any problems. 
 

Restore project from video disc 
This command restores a project backup that has been saved on a disc. The disc must 
have been burned with the option "Add project backup" (see "Burn disc" dialog 
options). 

Choose which of the movies contained on the disc should be restored by selecting it 
from the list and highlighting and selecting the corresponding directory. You must 
also indicate the directory where the project should be saved. A subfolder 
"Backupxxx" will be created in this folder where all project files from the disc will be 
saved. All of the restored movies will be loaded into MAGIX Video Pro X6 for editing. 

Select the option "Restore image files only" and only the original image files 
contained on the disc will be restored. 
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Importing & exporting EDL files 
Import EDL (edit list) 
The menu "File -> Import edit list (EDL)..." allows you to import edit lists in the 
Samplitude EDL format into MAGIX Video Pro X6. It is important in this case that the 
folder structure remains unchanged. During importing into MAGIX Video Pro X6, the 
file locations must match the place where they were when the cut list was created 
using Samplitude/Sequoia. 

• If an empty project is opened, the complete EDL file will be imported. 
• If the tracks are muted before importing the EDL file, then they will not be 

removed. 
• If there are already objects in the project, then you will be asked the files should 

imported into the project or if a new project should be created for them. 
 

Export EDL 
The menu item "File -> Export movie" enables EDL files to be created using the 
"Export movie information as EDL..." for additional editing in other programs, e.g. 
Samplitude or Sequoia. 

This section features a completely new input mask. Use the check boxes to select 
whether video and/or audio should be exported. As required, a selection may be 
made whether individual tracks should be rendered or referenced as original files via 
EDL. Video rendering takes place in the DV-AVI format, and audio rendering as WAV 
stereo. For Surround projects, 6 mono files will be rendered. 

An export folder may be specified via the selection dialog. The EDL file and the 
rendered files will be stored there as required. 

Check boxes may be used to select whether the EDL file should be loaded directly into 
Sequoia (if present). The program will either be launched automatically, or the files 
will be added into a running instance of the program. The user may enter the path to 
Sequoia in the input mask. 
 

Clean-up wizard 
The clean-up wizard helps delete projects from the hard drive, including all of the 
media files used. Use this function to free up disk space for future projects. 

Caution: If the files you used in the movie have also been used in other movies (like 
trailers, opening music, etc.), then you should make backup copies of these files 
beforehand. 

Keyboard shortcut:  Ctrl + Shift + Y 
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Delete specific files 
Choose this option if you would like to select certain files for deletion. In the file 
selection dialog, you can select the desired files. In the next step, the clean-up wizard 
searches for other files which belong to your selection. Using this method, you can 
delete an entire movie with all of its accompanying media, help, project, and backup 
files. Before they are deleted, you will receive relevant information in a dialog and a 
confirmation request.  
 

Search and delete superfluous files 
Choose this option if you would like to find unnecessary files or free up some space 
on your hard drive. The clean-up wizard automatically looks for extraneous files 
created during use of MAGIX Video Pro X6. Before they are deleted, you receive 
relevant information in a dialog and a confirmation request.  
 

Advanced 
"Advanced" lets you set which files and folders should be included in the cleaning 
process. 
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Special functions and wizards 
In this chapter, we will introduce you to some of the especially useful special 
functions.  
 

Proxy editing 
If performance deteriorates and playback becomes shaky due to hardware limitations, 
hi-res source material or very complex projects, it is recommended to use proxy files 
for editing. Lower resolution copies of the original file in a format that is better for 
playback are created and used for the editing process. The original files in a higher 
resolution are then used for the export process by default. 

You can activate the "Create proxy files automatically" function directly in the start 
dialog or at a later time in "File" > "Settings" > "Movie..." > "General movie settings". 
By default this option is not selected. 

When this option is activated, proxy files will automatically be created for all video 
files imported to the arranger or the project folder.  

Note: Make sure there is sufficient memory available if proxy files are going to be 
created. 

You can set the quality of the proxy files in the dialog (view page 261) "Configure 
proxy and preview rendering" > "Presets".  (Shortcut: Alt + R). The rendering process 
can be cancelled by pressing the "ESC" key. Proxy files will not be created if the 
quality settings for them are higher than the quality of the source material. 

• It is not possible to create proxy files on an FAT file system (such as on an SD 
card) so the source material for proxy files should be saved on an NTFS drive 
(Windows standard). 

Proxy files are not created for the preview on the source monitor. The conversion only 
takes place when the material is moved from the source monitor to the project folder. 
Now editing can be done more smoothly on the source monitor. 

Tip: You can activate or deactivate proxy files using the Quick function (view page 
65) for a smoother playback. This is useful during proxy editing if you want to 
quickly check how an effect will look on the original material. 

Use proxy files during rendering: If you want to burn your HD material to DVD, you 
can reduce the rendering time. Activate the settings „Best performance for DVD“ in 
the dialog (view page 261) „Configure proxy and preview rendering“ before the proxy 
files are created. This will ensure that the quality of the proxy files is sufficient for 
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output on DVD. You should also activate the option "Use files created during 
rendering for export and burning" to use the proxy files during export. 
 

Preview rendering 
With MAGIX Video Pro X6 you can pre-render specific sections of your movie. This is 
especially useful if smooth playback is not possible due to the applied effects and 
transitions. The advantage versus the option "Combine audio and video" in the "Edit" 
menu is that all of the objects will be maintained in the arrangement. The rendered 
material will only be played in the background when the playback marker reaches the 
corresponding position. 

 

Preview rendering is available in timeline mode and multicam mode.  

Note about multicam mode: Only the source tracks will be rendered, not the 
target tracks. 

MAGIX Video Pro X6 offers two options: 

• It can automatically indicate all sections that can be rendered. 
• Or, alternatively, you can indicate the section that should be pre-rendered 

manually. 

Note: The format that is used to render can be set via "File" > "Settings" > "Proxy 
and preview renderings" (view page 261). 

 

Automatic preview rendering 
When using automatic preview rendering, you don't have to think about which 
sections could be affected. MAGIX Video Pro X6 analyzes your computer's 
performance and determines which sections can be considered for preview rendering. 

To perform automatic preview rendering, proceed as follows: 

♠Step 1: Click on preview rendering button above the track header next to the 
timeline. 
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<MAGIX Video Pro X6 will then analyze which sections should be pre-rendered. A 
dialog will appear, indicating how many areas have been located. 

 

 
These sections will be additionally marked in the MAGIX Video Pro 
X6 timeline using red bars. 

Step 2: Select "Yes" in the dialog to start preview rendering. If you choose "No" 
instead, you can still conduct preview rendering later. 

The red bars will appear green after preview rendering is over. If you make changes in 
the pre-rendered section, it will appear red again and will have to be updated (view 
page 270). 
 

Manual preview rendering 
In manual preview rendering you first have to identify the problem-prone section. 

 

Step 1: First, place an in and out point 
above the range to be rendered. 

Step 2: Click on the preview rendering button and select "Start preview rendering..." in 
the context menu.  

A preview rendering dialog will appear. 

 

Step 3: Select "Range". 

The preselected range will now be rendered. 
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After rendering, a green line appears in 
the timeline to symbolize that this range 
has been rendered. 

As with automatic rendering, the section will remain green as long as no further 
changes are made to it. The green line will then turn red and can be updated again. 
 

Update preview rendering 
Preview rendering is effective only as long as no changes are made to the pre-
rendered area. You can recognize a pre-rendered area from the green bars appearing 
above it on the timeline. As soon as an object in the section has been edited, the 
green bar will turn red. You can update this section at any time.  

1. To do so, place the playback marker inside the section to be updated. 
2. Click on the "Preview rendering" button. 
3. In the preview rendering dialog, select "Range" in order to update just the 

section selected by the playback  marker.  If you select "All", all non-rendered 
(red) sections will be rendered. 

 

Load backup project... 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, for example, if you unintentionally saved your change and wish to 
return to the previous version of the movie. 

Keyboard shortcut:  Ctrl + Shift  + O 

Tip: Under "File -> Settings -> Program...", you can determine how often an 
automatic backup will be created in the "System" tab under "Automatic backup". 
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Automatic scene detection 

 

In the "Effects" menu automatic scene recognition can be opened. The scene 
recognition function analyzes the film for scene transitions and scans for drastic 
changes in the brightness and color distribution within the picture. 

Digital Video “time stamps” (points in time at which the device was switched on and 
off) are also recognized as separate scenes. 

1. First select "Start" from the "Search scene change" box. The search for 
possible scene transitions will then start. If you have a large amount of 
material, this can take a while, but the image analysis has to be done just once 
for each recording. The results are saved together with the video file.  
If the scene recognition is performed again with the same source material, the 
scene transitions found are immediately displayed. If you are still not happy 
with the resulting scene partitioning, simply repeat and correct where 
necessary. 

2. All found scene transitions in the list can be checked in the dialog. Every scene 
marker can be selected or deleted. Select a scene transition from the list of 
found scene transitions and use the preview images to check whether the 
found transition is really a scene change or not.  

Tip: This option is helpful, for example, if a camera flash was captured in the source 
footage. The flash from the camera would cause a sudden brightness modification 
even though there was no actual scene change. 

The preview always displays the end of the previous scene and the beginning of the 
new scene. If the images do not differ except for the brightness, the scene may have 
been falsly recognized. In this cases select "Delete scene marker". 
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Via the zoom +/- buttons you can enlarge the part of the arranger where the selected 
scene begins or previous scene ended. 

You can use the "Sensitivity" controller to change the sensitivity of the scene 
recognition, so that different scene changes can be found depending on the setting. 

With "Action on OK" you can specify whether the movie should be cut at the selected 
scene transition or at all scene transitions and whether the found scenes should be 
saved in the project folder.  
 

Import a Movie Edit Touch project 
You can import projects from the Windows 8 app MAGIX Movie Edit Touch into 
MAGIX Video Pro X6 for further detailed editing. 

Note: Exporting the project back into MAGIX Movie Edit Touch is not possible. 

Step 1: Save your project in MAGIX Movie Edit Touch using the „Save project“ 
function. This function can be accessed in the app bar. If you are using MAGIX Movie 
Edit Touch on a different system than MAGIX Video Pro X6 (e.g. on a tablet PC), you 
can save the project on an external data storage device, e.g. a USB flash drive. 

In this case a dialog appears where you are asked if the individual media files should 
be saved together with the project. Confirm this option by selecting "Yes". 

Step 2: If necessary, connect the external storage device to computer that has 
MAGIX Video Pro X6 installed. Now select the option "File" > "Open..." in MAGIX 
Video Pro X6. Navigate to the project file from MAGIX Movie Edit Touch. This will be 
in the format "*.mxpl". Double-click on the project file. 

If a movie is already open in MAGIX Video Pro X6, you will be asked if it should be 
closed. 

 

Clicking on "Close" closes the current movie so that only the Movie Edit Touch 
project is open. 
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„Don't close“ creates a new movie that can be selected in the the Movie tab (view 
page 19). 
 

Musical cut adjustment 
Behind the "Adjust cuts to music" function in the "Edit" menu hides the option to 
adjust the rhythm of an existing arrangement with cut scenes to a song in order to 
transform the movie into a music video. Requisite is that the song contains 
information about rhythm and beat.  

• Place the arrangement with video sequences on the top track (track 1), which 
should be used for the musical edit adjustment. If possible, the arrangement 
should have the same length as the song and contain many cuts. 

• Load the song, on which the cuts should be based, onto the track below. 
• Select "Edit" > "Musical cut adjustment". 

Normally, an info dialog will appear, stating that no beat information exists for the 
selected audio object.  

 

• Select the "Open assistants" option in the dialog. 
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This opens the "MAGIX Remix Agent" beat recognition assistant. This tool can 
analyze the song's rhythm. 

 

After the song's BPM value (= beats per minute) has been found, the music will be 
separated into short, similar passages (remix objects). The individual objects that 
result in  (However, nothing prevents you from doing just that. To do so, click on 
"Ungroup".) 

The resulting object borders are important for editing. Because all objects always 
"snap to grid" on their edges, videos can be arranged in such a way so that they are 
cut exactly to the rhythm of the music: the positions on the track where the videos 
will snap lie on the positions of the beat. 
 

Checking the automatic tempo recognition 
A song must have the following properties in order to be analyzed: 

• It must be longer than 15 seconds. 
• It must contain "rhythmic" (danceable) music. 
• It must be in stereo. 

The analysis takes place in four steps: 
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Step 1: Checking the start marker 
Step 2: Tempo recognition 
Step 3: Specifying beat starts 
Step 4: Application of BPM and beat recognition 

Step 1: Checking the start marker 
Before you start the analysis you should set the start marker at the position where the 
rhythmic music begins. This means that if the song has a long ambient intro, the start 
marker should be set after the intro. If the wizard can't detect any rhythm it will ask if 
the start marker has been set after the intro. If not, you can move it to a better 
position in the dialog. 

If the beginning of the song does not have a definite rhythm, you will be asked if you 
want to move the start marker. 

Step 2: Checking the automatic tempo recognition 
The Remix Agent will analyze the audio material and try to determine the tempo. The 
object is played back while a metronome click can be heard and numbered green beat 
lines appear in the waveform. 

Under the waveform on the left side the established tempo is displayed in BPM. There 
is a small transport console in the middle to make navigating easier. The slider serves 
as a position controller. To set the metronome volume, an additional fader and mute 
button are provided on the right-hand side. 

The automatic tempo recognition doesn't always work right away. If you don't hear 
the metronome clicking in time with the music, click the "No" button in the upper 
section of the dialog in order to access the manual tempo input dialog. 

To correct the metronome speed and any timeshift that may occur between the 
metronome clicks you can use the tempo correction as  well as the "Tap tempo" 
button: 

Tempo correction: The Remix Agent offers various speed settings. The most probable 
tempo detected by the Remix Agent is preset. If this tempo isn't correct, you can 
choose another one from the list. The next time you play back the song it should be in 
sync with the metronome. 

On/Off beat correction: Now it may happen that the tempo is right, but the beats 
have been displaced. "On/off beat correction" provides a number of alternatives for 
moving the beats according to the complexity of the rhythm. Try out various 
alternatives until the metronome clicks are in sync with the beat. 

Tap tempo: Alternatively, click rhythmically on the "Tap tempo" button or press the 
"T" key.  Additional blue lines are displayed in the wave display. After at least four 
taps, the Remix Agent attempts to select the correct tempo from the list in "Tempo 
correction". The display next to the "Tap tempo" button displays the current status. 
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Keep tapping until the red display showing "Unlocked" changes to the green "Locked" 
setting. 

Use the "0" key to manually set the quarter beats while the music plays. Surrounding 
markers will automatically be removed to ensure that the set tempo remains intact.  

You can move the markers with the mouse. If you hold down the "Ctrl" key 
simultaneously, the subsequent markers are also moved. 

If the metronome clicks now correspond with the music, you can continue to the next 
step. 

Step 3: Determining the start of a bar: 
Next you can set the time signature. The default setting is 4/4 but you can adjust this 
if necessary. The beat at the start of the bar should coincide with the high sound of 
the metronome, or the red line in the waveform display. 

It can now be corrected in one step: If the start of the bar can be heard, click on "Tap 
One" once using the mouse or press the"T" key on the keyboard. 

Alternatively, select how many quarter notes the "One" is to be moved back. 

Use the "0" key to manually tap the position of the beginnings of the bars during 
playback. This allows you to correct the beginnings of the bars in longer sections. 

Continue to the last step if the starts of the bars are now correct. 

Step 4: Apply 
The final step is to apply the musical information to the audio material.  

The images on track 1 will be repositioned according to this information. 
 

MAGIX Soundtrack Maker 
MAGIX Soundtrack Maker automatically generates music tracks that correspond to 
the indicated mood. Even mood changes are possible. 

You can open MAGIX Soundtrack Maker by going to "Edit" > "Assistants (view page 
300)". 
 



 

Special functions and wizards 277  

 

Select music style 
Choose a musical style first. The option "Apply only between start and end marker" 
limits the length of the background music you want to create. Start and end markers 
(view page 107) may be set with the left and right mouse button if MAGIX 
Soundtrack Maker is open. 

 
 

Set mood change: 
You can select a mood from the list. 

 

Preview audio: Preview the selected mood here. 

Position: Use the position slider to skip to a certain position in order to set the mood 
for a certain position. The start marker may be moved instead with the left mouse 
button. The preview will be displayed in the video monitor simultaneously. 

Add emotion: This button inserts the selected mood at the current position. MAGIX 
Soundtrack Maker will then suggest a new position for the next emotion by 
repositioning the position slider. Of course, you may also position this elsewhere to 
insert further moods. 

Delete emotion: Removes the currently set. 
 

Generate background music 
Clicking "Create soundtrack" creates a new soundtrack. "Progress" shows the current 
status. 
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Variations 
If the background music that has been created is not suitable, a variation may be 
created. This process may be repeated for the entire background music as well as for 
individual emotions: 

• If you want to vary the entire background music, then simply click on "Create 
variations". 

• If you only want this to apply to a certain emotion, then move to it with the 
position slider first in the dialog (or the play marker on the main screen). Activate 
the option "Vary only selected emotions". Now click "Create variation". 

Automatic cut adjustment: This option re-arranges the video and photo objects in 
your project to match the music. Make sure this option is deactivated in case this 
function is unwanted. 
 

Slideshow Maker 
Slideshow Maker is ideal for converting still images into moving pictures, adding 
background music, and effects. 

• Open Slideshow Maker via "Edit -> Wizards". 

 
 

Style templates 
Select a template that best matches your needs.  

 

This button plays a sample slideshow with the selected style template.  
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Intensity 
Controls the portion of video and image objects that feature effects. With "Normal" 
you will see a balanced amount, whereas with "Weak" or "Strong", correspondingly 
fewer or more effects.  
 

Transitions 

 

Transitions can be individually activated or deactivated using this button.  

The slider in the transitions dialog can be used to adjust the amount of each type of 
transition.  

Transition duration: Set the length of the transitions in seconds.  

3D transitions use Stereo 3D mode: If this option is activated, 3D transitions use 
Stereo 3D mode. 

Random transitions: The transitions are set to random values. 

The "play" button below the preview monitor plays a preview. 
 

Effects 

 

Various effects can be individually activated or deactivated using this button.  

The slider in the dialog controls the amount of each effect type.  

Random effects: The faders that control the amount of effects are set randomly. 
 

Treat special image formats intelligently 
Treat special image formats intelligently: Panoramas and portrait photos can be 
treated "intelligently". If this option is activated, then panoramas and portraits will be 
treated with special effects adjusted to the format. These effects can also be selected 
and unselected in the detail view. 
If this option is not selected, then these images will use the same effects as all other 
images. 
 

You can turn effects and transitions belonging to each category on or off using the list 
symbol. The arrow below the preview monitor plays a preview. 
 

Properties & titles 
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Film length 
Resulting film length: This is an estimation of how long the film will be after applying 
Slideshow Maker. 

Available music: This is the complete length of the music that is currently selected. 
Background music (view page 281) enables detailed settings for the pieces of music 
to be used. 

Adjust film length to the music: An attempt is made to adjust the length of photo 
objects to the background music. If the film is too short the music will be cut off. If the 
film is too long, the music will repeat. 

Adjust music length to the film: Photo objects have a set length, and the resulting film 
is filled with music. The music at the end of the movie is simply faded out. 
 

Including video objects 
Process videos: If this option is set, then videos will be automatically processed with 
effects and transitions. 

Length: Settings may be made here about whether the original length of the video 
should be maintained or if it should be shortened. 
 

Opening and closing credits 
Set the text for opening and closing credits here. 

Text: Enter the corresponding text for opening and closing credits that should be 
added by Slideshow Maker. 

File: A title template, a video, or an image file may also be used. 

Note: Titles created using Slideshow Maker may also be edited at any time. 

 

Group associated images together 
If this option is active, an attempt is made to detect associated events via their date 
information and to separate them from each other optically. Detection of individual 
events is based on the time span of these events to achieve a sensible separation. 

Begin group with black fade:A black fade is added between the different events. 

Begin group with date/time below thru black:A black fade is added between the 
different events.A title is also faded in with a suitable duration, e.g. 1st/2nd/3rd day, 
provided the events take place over multiple days. 

Begin group with date/time below picture:A black fade is added between the 
different events.A title is also faded in with a suitable duration after the black fade, e.g. 
1st/2nd/3rd day, provided the events take place over multiple days. 
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Background music 
Specify if and which music should be used for the background here. 

Use background music: Adds background music. 

Load file(s): A file selection dialog will open to choose a folder featuring music; select 
one or multiple files. 

Remove: The selected pieces of music are removed from the list and will not be used. 

Insert random: MAGIX Video Pro X6 selects random pieces of music from the folder 
"Import -> My Media -> Slideshow music" in the Media Pool. 

Preview: This button previews the selected piece of music. 

Volume ratio: This slider controls the volume ratio between the original sound and 
the background music. 
 

Tip: Music objects, located on the 5th track will be listed and used together with 
audio objects for background music.  

 

Produce panorama pictures 
This special function may be selected for highlighted photos under "Effects > Video 
object effects > Create panorama". Using it, you can combine several photos into a 
wide panorama photo. You don't need to create exclusively "proper" panoramas; Let 
your imagination run wild and put together anything you want to. 

Tip: Optimize you photos beforehand, so that the transitions are not to be seen in 
the finished panorama. 
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Select pictures for panorama 
Load all necessary images into the film project as usual. The images that should make 
up the panorama should be selected one after the other while holding down the 
"Shift" key. Select the entry "Create panorama" from the context menu "Effects" (view 
page 304) > "Video object effects". 

 
 

Invert image sequence for panorama image 
Sometimes photos are accidentally loaded in the wrong sequence.  To sort the photos 
properly, click on the "Invert sequence" button. 
 

Calculating the panorama image 
If you click on "Create" the panorama image will be processed. Depending on the 
resolution and number of original images this may take some time. The original 
photos are replaced in your slideshow with the panorama image in the movie. The 
original files on your hard disk are not affected. 

Note: You can use up to six images to create a panorama image. Click on "More 
options", to find out more about the upgrade. 
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Finished panorama (2 images) 

 

Finished panorama from 2 images 
 

Batch conversion 
Batch conversion makes it is possible to convert multiple video files, movies, objects, 
or whole projects into another format in just one step. 
 

Open batch conversion 
Batch conversion can be opened using different presets. A pre-selection appears only 
if you have loaded a film or a project. 

The following scenarios exist: 

• Batch conversion has been opened from the context menu in the Media Pool: The 
file selected in the Media Pool beforehand will be transferred to the task list and 
can be converted to the available formats. In case of projects which contain 
multiple movies, all movies will appear as individual tasks. 

• Only one empty movie is open: A dialog opens additionally for batch conversion, 
in which video files that have to be converted to other formats can be selected 
and loaded. 

• A movie with video material and more than one object in the first track is opened. 
A dialog opens, in which you can select which tasks should be created for batch 
conversion. 

- All scenes in the movie: All objects present in the 1st track will be used as 
starting points for the video files to be exported. An application for this could 
be that all scene beginnings of a movie should be exported as bitmap files or 
a backup for a movie is to be created as individual scenes. 

- Multiple movies: The opened movie will be exported as a whole video. 
Additional movies can be added to the list in the dialog. 

• Multiple movies with video material are open: The opened movie will be exported 
as a complete video. This is especially useful for large projects with a lot of 
individual movies, eliminating the need to export each one individually. 
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Batch conversion dialog 

 

Presets: Save and load your settings here. These include the list of files to be exported 
and the export settings and names of all entries. 

Caution!  Batch conversion references the projects, movies, and the objects contained 
therein directly. Keep in mind that when converting entire movies, the source material 
must also be available. During conversion of individual objects from movies, you have 
to make sure that the movie file has not been changed between loading and saving. 

 This is the list of all objects that have to be converted into the indicated format. Each 
task can have its own export settings. 

Add files (not during conversion of individual objects from movies): Manually add 
files, including video files and projects. 

Remove selected: The marked tasks will be removed from the list. 

Duplicate selected: If you would like to export tasks in multiple formats, you can 
simply mark and duplicate them and assign individual export settings to them. 

Format settings: These are settings for the currently selected tasks, and multiple 
tasks can be given a setting simultaneously. Select one or more tasks from the task 
list. 
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Note on format setting for multiple tasks: If one of the marked tasks already has an 
individual setting, its will be lost after another format is selected. To prevent this, 
remove the selection for each task using Ctrl + mouse-click. 

Set the target format in the flip menu. Windows Media Video format (*.wmv) is the 
default.  

Advanced settings: This opens the dialog for the advanced format settings. This 
corresponds to the dialog for normal video export of a movie. 

Tip: If you give several tasks the same file name, the files created will be documented 
intelligently. For example, you can easily convert and simultaneously line up multiple 
movies that belong together thematically. 

Shut down computer after successful export: This option is especially useful when 
you export long movies and are using an especially high-quality and resource-
demanding export format. You can leave the computer to work on the individual tasks 
and after finishing them it will turn itself off. 

Start batch conversion: Click on "Start conversion" to start the process. After ending 
conversion processes, a list of all export processes with a message informing of its 
success will appear. 

Hint: During batch conversion, messages that appear during normal file import will be 
for the most part suppressed. This is to enable the smoothest conversion of all tasks. 
Therefore, please make sure that all files to be converted or the project can be easily 
loaded before starting a batch conversion. 
 

Blackmagic Design video cards 
MAGIX Video Pro X6 supports the display and recording of screens and monitors 
that are connected through certain Blackmagic Design video cards such as DeckLink 
and Intensity. 

Fullscreen preview monitor 
The image from the video monitor will be displayed on an external monitor, which is 
connected to the card output. Activate this in the "Program settings > Display options 
> Video output to external device > Activate video output" and select the connected 
device. 

The display on the external monitor is dependent on the settings of the current movie 
(resolution / frame rate / interlace properties). This makes a very precise preview of 
the movie possible during editing. 
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Recording 
These cards can also be used to record various signals, such as HDMI. Some DSLR 
cameras output preview images through an HDMI. These images can be recorded 
directly into a high-quality and editing-friendly format if the camera's internal image 
compression is bypassed.  

HDMI capture can also be useful for creating presentations with applications 
requiring high computing power. An image from a PC with an HDMI out can be 
recorded by a second PC with an HDMI in. 
 

Use movie templates 
Use movie templates in order to tell a whole story using just a few mouse clicks.  

You can open movie templates either in the start dialog or in an already open program 
in the import tab of the Media Pool under "Movie templates". Double-clicking on a 
menu template will open it in Storyboard Mode.  
 

Insert own material 
You can add your own content everywhere you see a placeholder (indicated with an 
arrow in the illustration). Drag the desired video from the Media Pool in front of the 
placeholder, which it should replace. The placeholders' names indicated which type of 
material should be inserted here (e.g. "Group recording"). 

 

If your video is too long for a placeholder, you will see a green bar in the mini timeline 
below the video monitor. You can grab it using your mouse and move it in such a way 
that just the right section of the video appears in the placeholder. If your inserted 
video is too short, it will be rejected by MAGIX Video Pro X6. 
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Audio tracks of inserted material 

 

Menu templates contain audio material. For this reason, the 
audio track of the inserted audio material will be muted. 
You can, however, switch it on again by clicking on the 
speaker symbol in the preview image. 

A speaker slide controller appears which lets you control 
the volume of the original audio track of the inserted video 
clip. 

 

Design title 

 

Click on the T symbol in the preview image to edit the title 
included with the movie template. 

You can enter your own text in the title editor (view page 
119). 
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Menus 
Certain menu items are not available on the "Record" and "Burn" screens. The menu 
reference describes the full menu as found on the "Edit" screen. 
 

File Menu 
New project 

 
A new MAGIX Video Pro X6 project is created. The Start dialog opens in this 
case 

A start dialog will open when the program is started or a new project is loaded.  Here 
you can make important presets for the project. You can change these settings at any 
time by going to "File" > "Settings". 

 

Load existing project: Here you can select and load a previously saved project. 

View introductory video: Here you can start the introductory video with information 
about workflows in MAGIX Video Pro X6. 
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Create new project: Here you can assign a name to your new project. 

Create proxy file automatically: The original material is already converted to a 
suitable target format in advance, which can (view page 267) save a lot of time when 
editing and exporting when finished. 

Project folder: Here you can set the path for the project folder where all project files 
should be saved. 

Movie settings: Here you can set the movie's target format (display norm, resolution, 
frame rate). This setting has no effect on the internal processing quality and can be 
changed at any time by going to "File > Settings > Movie". 

Audio sample rate: Here you can set the audio track's audio sample rate. 

Use movie template: Here you can choose an included movie template for a new 
project. Read the "Using movie templates" (view page 286) section for more details. 

Editing mode: You can use Standard Mode and Basic Mode (view page 35) to edit 
your movies. 

Shortcut:  Ctrl + N 
 

Open 

 With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. MAGIX 
Video Pro X6 will search for all used sounds and video files in the folders in 
which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Recently opened projects 
Project that you have recently opened in MAGIX Video Pro X6 are listed and can 
quickly be opened with a click. 
 

Save project 

 
The current disc project is saved with the name displayed in the project window. 
If you have not specified a name for your project yet, a dialog will open for you to 
do so. 

Keyboard shortcut:  Ctrl + S 
 

Save project as... 
A dialog opens where you can specify the path and name of the video for saving. 

Keyboard shortcut:  Shift + S 
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Manage movies 
New movie 
Use this option to create a new movie for your recordings and imported files. Since a 
film is normally already opened, you will have to decide whether the movie should be 
inserted into the existing project or if a new project should be created. 

Keyboard shortcut:  Ctrl + Alt + N 
 

Delete movie 
This option lets you remove the current movie from the project. However, it is still 
available on the hard drive and can be loaded again at any time. 

Keyboard shortcut:  Ctrl + F4 
 

Attach movie 
Using this function you can attach a movie to an opened one. This is then attached to 
the end of the movie and automatically takes on the original movie's settings. 
 

Import 
Use this option to load a movie into your disc project. Please note that all media files 
associated with it must be accessible. MAGIX Video Pro X6 will search for all used 
sounds and video files in the folders in which they were located when the movie was 
saved. 

 

You can use the tabs to switch from one movie to another. 
 

Export movie file 
A dialog will open to enter a file name for the movie to be exported. The movie may 
then be imported into other projects again. 

Note: The movie file (*.mvd) includes all information about the media files used, 
cuts, effects, and titles, but not about the image and sound material itself. This is 
always contained in the recorded or imported media files, which remains unchanged 
during editing with MAGIX Video Pro X6. In order to save a movie in its own folder, 
e.g. for use on another PC, use the function "Copy film and media to folder (view 
page 263)". 

Keyboard shortcut:  Ctrl + Alt + L 
 

Export movie 
This provides all export formats supported by MAGIX Video Pro X6 that aren't 
covered by burning. Refer to "Exporting (view page 235)" for more information. 
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Project folder 
Import media files into project folder 
The files selected in the Media Pool will be imported into the project folder (view page 
61). 
 

Clean up project folder 
Unused media files will be removed from the project file. 

Note: This function applies to the entire project. 

 

Record audio / images / video 

 

A selection window will open to choose the desired recording type. This may also be 
accessed via the "Audio or video recording" button in the transport controls. 

Keyboard shortcut:  R 
 

Import Audio CD track(s) 
A CD track may be imported via drag & drop from the Media Pool just like a normal 
file. If this convenient method fails for some reason, then this menu command may be 
accessed via the CD manager to insert tracks from audio CDs directly into the 
arrangement. More about this is available in the section "Import audio CD". 
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Scan image 
Select scanner 
The twain interface connects MAGIX Video Pro X6 with almost all current scanners 
or digital cameras. Here's how to proceed the first time you scan via the twain 
interface:  

1. Install the twain software for the device.  
2. Restart your computer.  
3. Start MAGIX Video Pro X6.  
4. Click on "File -> Twain scanner -> Select source", if the scanner works with 32-

bit software.  
5. Click the device that you want to use in the dialog. This step will no longer be 

necessary as long as the same device is used. 
 

Start the scanning process 
The scan window of your scan software will appear. Specify the resolution and color 
depth in this window. Once the scan process is finished, the twain software will 
normally switch off by itself – the scanned image file will be added to MAGIX Video 
Pro X6 automatically. If the twain dialog remains open, you will be able to scan 
multiple images in succession.  
 

Import edit list (EDL) 
Import cut lists in EDL format (view page 265) may be opened via this menu. 

Keyboard shortcut:  Ctrl + D 
 

Output to device 
This command opens the dialog for exporting finished video or its soundtrack to 
analog or digital VCR/camcorder or various mobile devices such as smartphones and 
tablets.  

Please read the chapter "Output audio/video". 

Shortcut: H 
 

Batch conversion 
This menu item accesses the batch processing (view page 283) function. This quickly 
and efficiently converts multiple files, movies, or projects into various video formats. 

Keyboard shortcut:  S 
 

Burn CD/DVD 
Manually compile files 
Opens MAGIX Speed burnR to burn videos or other files onto CD/DVD. File selection 
is done via drag & drop from MAGIX Speed burnR's Explorer. 
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Keyboard shortcut:  Ctrl + B 
 

Copy CD/DVD direct 
The dialog provides several options for creating a copy: 

• Copy: Here you can directly copy a non copy-protected CD or DVD.  
• Shrink: Compresses a DVD to the size of a regular single layer DVD+/-R/RW. All 

files of the original DVD have to be on the hard drive. 
• Analog copy: Copies your video onto a disc via analog recording. 

Read more about this in the chapter "Record (view page 66)". 
 

Burn copy of an already created video disc 
All necessary files, menus, and encoded video files needed to burn a disc will be 
temporarily stored on your hard drive as an image. After your disc is burned, these are 
not automatically deleted. You can use these images to burn as many discs as you 
would like without having to encode the files again. 

In the dialog, choose the image you want. All necessary files are then transferred to 
the MAGIX MAGIX Speed burnR burning software. 

Tip: For more information on using MAGIX Speed burnR, read the program's help 
file. 

 

Online 
This is a list of menu entries regarding all of the services that are available directly 
from within MAGIX Video Pro X6. 
 

MAGIX Online Album/Catooh 
MAGIX Online Album allows you to publish photos and videos in your own online 
album. You can share this with your friends and acquaintances or with the whole 
world. 

Catooh offers you with the option of finding and purchasing more media and 
templates. Via the "media backup" option, you can import already purchased media 
that are saved on your computer to MAGIX Video Pro X6. 

Note: For more information about MAGIX Online World select the menu item "File" 
> "Online" > "Find out more about MAGIX Online World...". 
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Export to magix.info 
This command allows you to export your movie to magix.info. 

First, export your project in one of the following formats: asf, mov, mpg, mpeg, mp4, 
wmv, 3gp, or avi. Next, access "File -> Internet -> magix.info -> Present videos on 
magix.info" to reach a page where you can upload your video. You may need to 
register with magix.info. 
 

Manage your login details 
In this dialog you can enter and manage your login details (email address and 
password) for all services accessible from MAGIX Video Pro X6. You therefore do not 
have to login every time, for example, when exporting to Facebook (view page 294) 
or in the MAGIX Online Album (view page 293). 
 

YouTube / Vimeo / showfy 
This is a direct connection between MAGIX and various online communities. 
 

Youtube / Facebook 
Uploads the current film to the selected portal or to the selected community. Enter 
the data for video into the fields provided, so that the search function for this portal 
can also find this video. 

MAGIX Video Pro X6 partially uses the H.264 format for this, which is a component 
of the MPEG-4 codec. Since Flash supports this format directly and most 
communities and portals use the format, the film does not need to be re-rendered on 
the corresponding server. This avoids loss of quality. 

When HD material is uploaded, a resolution of 720p is used for the HD format. 
 

Upload all selected media in Media Pool 
Uploads the media selected in the Media Pool to the corresponding portal or the 
selective community. 
 

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 

For detailed information, read the "Backup" (view page 263) section in the "Wizards 
and special functions" (view page 266) chapter. 
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Load backup project 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, for example, if you unintentionally saved your change and wish to 
return to the previous version of the movie. 

Keyboard shortcut:  Ctrl + Shift  + O 
 

Cleaning Wizard 
The clean-up wizard helps delete projects from the hard drive, including all of the 
media files used. Use this function to free up disk space for future projects. 

Caution: If the files you used in the movie have also been used in other movies (like 
trailers, opening music, etc.), then you should make backup copies of these files 
beforehand. 

Keyboard shortcut:  Ctrl + Shift + Y 

For detailed information, read the "Cleaning Wizard" (view page 265) section in the 
Wizards and special functions" (view page 266) chapter. 
 

Settings 
Movie settings 
Opens the movie settings of the currently selected movie. 

 
 

Program... 
Opens program settings. 

Shortcut:  Y 
 

Keyboard shortcuts... 
This menu entry opens a dialog for editing keyboard shortcuts (view page 343); this 
enables you to adjust MAGIX Video Pro X6 however you like. 

Keyboard shortcut:  Ctrl + Shift + U 
 

Preview rendering 
This menu opens the dialog for the preview rendering (view page 261) settings 

Keyboard shortcut:  Alt + R 
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Reset Program Settings to Default... 
Use this function to reset all program settings you made in MAGIX Video Pro X6 to 
their original settings. 
 

Exit 
Closes MAGIX Video Pro X6. 

Keyboard shortcut: Alt + F4 
 

Edit Menu 
Undo 

 
With this command you can undo the last changes you made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
then you can always revert to the previous state by using "Undo". 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings. In 
general: The longer the list, the more RAM is used. 

Keyboard shortcut:  Ctrl + Z 
 

Redo 

 
This function undoes the previous "Undo" function. 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings. In 
general: The longer the list, the more RAM is used. 

Keyboard shortcut:   Shift + Y 
 

Empty undo and cache memory 
Using this function, you can empty undo and cache memory in order to be better able 
to conduct memory-intense processes such as exporting 
 

Cut objects 

 

This function extracts the marked scene and copies it to the clipboard. You 
can then use the "Paste" command to copy it into any movie. 
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Copy objects 

 

This function copies the selected scene (or the selected object in the Timeline 
mode) to the clipboard. You can then use the "Paste" command to place it into 
any movie. 

 

Paste objects 

 
This command inserts the clipboard material (photo or object) at the current 
position of the start marker.  

Keyboard shortcut: Ctrl + V 
 

Duplicate objects 
This command duplicates all selected objects. The copies appear beside the original 
and can be placed in the correct position using drag & drop. 

Keyboard shortcut:  D 
 

Delete items 

 
This function deletes the selected scene (or the selected object in the Timeline 
mode). 

Keyboard shortcut:  Del 
 

Select all objects 
All objects in the arrangement will be selected. 

Keyboard shortcut: Ctrl + A 
 

Cut 
Editing functions are also accessible using the toolbar. The last selected function will 
appear in the toolbar as a button. 
 

Split scene 

 
This command cuts a scene at the point where the playback marker is 
positioned. This way, two free-standing objects are created. 

Keyboard shortcut:   T 
 

Remove scene start 

 
This command cuts a scene at the point where the start marker is positioned, 
and deletes all material that precedes the start position simultaneously. 

Keyboard shortcut:  Z 
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Remove scene end 

  

This command cuts a scene at the point where the start marker is positioned, 
and deletes all material behind the start position simultaneously. 

Keyboard shortcut:  U 
 

Remove scene 

 
If you want to cut a scene out of a movie retroactively, this option 
automatically moves all objects, titles, and transitions on all tracks forwards 
so that no gaps result. 

Objects on other tracks which project into the area of the selected scene will not be 
moved automatically; they will remain at the current position. 

Keyboard shortcut:  Ctrl + Del 
 

Split movie 

 
This command divides the movie into two individual movies at the position of 
the playback marker. 

The current project window retains the portion that is located in front of the playback 
marker. The latter part will be removed from the current project window and placed 
as a new film. You can find this movie by going to the "Window" menu. 

Shortcut: Alt + Y 
 

Musical cut adjustment 
If you have edited your background music with the beat detection wizard and a 
musical tempo was provided, then you can adjust the cuts to change automatically in 
time with the beat using this command. All of the cuts (even transitions) will be 
moved to correspond with quarter note positions. 

Keyboard shortcut:  Ctrl + Shift + H 
 

Range 
MAGIX Video Pro X6 provides object-based functions as well as "band-oriented" 
editing functions. These always refer to the whole arrangement from the first to the 
last track as well as to the area between the start and end marker. 
 

Cut  
The section between the in and out points is cut from the current arrangement and 
placed on the clipboard. It can, for example, be pasted in again at a different position. 

Shortcut: Alt + X, Shift + Del 
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Copy 
The section between the in and out points is copied from the current arrangement to 
the clipboard. If can be pasted back at another location.  

Keyboard shortcut:  Alt + C 
 

Delete 
The section between the in and out points is deleted from the current arrangement 
and not copied to the clipboard. 

Keyboard shortcut:   Alt + Del 
 

Insert 
The contents of the clipboard are inserted at the current arrangement's position of the 
in point.  

Keyboard shortcut:  Alt + V 
 

Extract 
The section between the in and out points is preserved, and all of the material in front 
and behind it are deleted. Use this option to isolate a specific part of an arrangement 
for further individual editing. 

Shortcut: Shift + X 
 

Insert blank space 
An empty section the length of the period between the in and out point will be added 
to the first track. The objects following this will be moved. 

Keyboard shortcut:  C 
 

Group objects 

 
All selected objects are assigned to a group which may then be selected and 
edited jointly by clicking the mouse. 

Shortcut:  G 
 

Ungroup objects 

 
This command splits an object group into separate objects. 

Shortcut:  Shift + G 
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Wizards 
Slideshow Maker 
Opens the Slideshow Maker (view page 278) 

Keyboard shortcut:  Ctrl + M 
 

Soundtrack Maker 
This command opens MAGIX Soundtrack Maker (view page 276). 

Keyboard shortcut:   Ctrl + Shift + S 
 

Travel route animation 
This menu entry opens the separate Travel route animation program. This enables 
simple creation of animated travel routes with the help of online maps. 

Note: In order to be able to use current map data, maps are fetched by Travel route 
animation directly from the Internet. This requires an active Internet connection. 

 

Audio mixdown 
This option joins all audio objects in one audio file. Afterwards, the audio material will 
only occupy one track and take up hardly any RAM (does however take up space on 
the hard drive [ca. 10 MB/min in stereo]). This way you get a clear overview of 
further objects and space for them. 

MAGIX Video Pro X6 automatically normalizes the audio file, i.e. the loudest part of 
the wave audio object is identical with the highest figure of the 16-bit resolution 
ceiling. This guarantees the same sound quality, even if you repeat the mix down 
procedure or you combine the mix down file with other wave audio objects again and 
again. The mix down function is very helpful if you want to go on using the mix down 
object.  

Tip: Instead of using the mixdown function, use the various options found in the 
"Export movie" submenu of the "File" to create the final *.avi or *.wav (or another 
multimedia) file. 

Keyboard shortcut:  Shift + D 
 

Audio and video mixdown 
In addition to the "Combine audio" function (see above), all video objects including 
effects, transitions, and edits are combined in a single MAGIX video file (view page 
236). If your computer starts to approach its limits, this enables you to free resources 
for further editing. 

Keyboard shortcut:  Shift + M 
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Start preview rendering 
You can render a pre-defined area for the preview or automatically search the 
material for critical areas. See "Preview rendering". 

Shortcut: Ctrl + R 
 

Remove areas for preview rendering 
All rendered previews will be discarded; the video material will be rendered again via 
the arrangement in real time and played back. 

 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Marker 
Set project marker 
This option places a project marker at the current playback position. More 
information about project markers is available in the chapter "Markers" under "Set 
project marker (view page 106)". 

Keyboard shortcut:  Ctrl + Enter 
 

Delete project marker 
Deletes the selected project marker (view page 106). Project markers can be deleted 
and renamed via the context menu. 
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Set chapter markers 

 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename". The 
new name will appear in the chapter menu (view page 211). 

Keyboard shortcut:  Shift + Enter 
 

Set chapter markers automatically 
This option automatically sets chapter markers in the arrangement according to 
specific rules that will then appear in the film menu of a disc as chapters. This is useful 
if a disc should be burned immediately after recording. 

 

There is a selection of options available for automatic chapter generation: 

At beginning of movie: The movie only contains one chapter in this case. 

At beginning of object in track: Every object in a track creates a chapter; track 1 is 
preset. 

At position of existing title objects: Subtitles, for instance, as faded-in subheadings, 
give the position of the chapter markers. 

Specified interval (minutes)/Specified amount: If the chapters are separated without 
any particular method and are just needed for quicker navigation, chapter markers 
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may also be inserted in pre-defined intervals or as a pre-defined number of chapter 
markers. 

Naming of chapter markers: To title the chapter markers, a user-defined name 
featuring consecutive numbers or the object name or text from the text objects may 
be used. 

Optionally, existing chapter markers may be deleted and the automatic chapter 
marker function may be limited to the area between the start and end markers. 

Keyboard shortcut:  Alt + Shift + Enter 
 

Delete chapter markers/delete all chapter markers 
Delete one or all chapter markers. This removes chapter entries in the disc menu if 
the film is burned to disc. 

Keyboard shortcut:  Ctrl + Alt + Enter 
 

Marker -> Set range start/end 
Sets a range start/end marker at the position of the playback marker. 

Keyboard shortcut:  I/O 
 

Marker -> Jump to range start/end 
Sets the playback marker at the position of the range start/end. 

Keyboard shortcut:   Shift + I/O 
 

Range above blank space 
The start and end of the range in the film will be set to the respective borders of the 
empty space that is clicked on. 

Keyboard shortcut:  X 
 

Marker -> Reset selected range 
Deletes the range start and the range end. 
 

Move screen view 
Using these commands, a viewable portion together with the start marker will be 
moved in the timeline. You can quickly skip between different markers (skip, chapter, 
scene, ad-marker) and object edges. 

Keyboard shortcut: See "Keyboard shortcuts", "Project window". (view page 
338)  
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Search for gaps 
MAGIX Video Pro X6 enables you to locate gaps between objects where no image 
material is located. This hinders unintentional black spots from appearing. This option 
is located under "Edit -> Find gaps". A corresponding dialog opens. 

Optimize view: Zooms to the selected gap. 

Mark gap as range: Spans a section over the selected gap. 

Edit selected gaps: The selected settings are applied but no additional action is taken. 

Keyboard Shortcut:  Ctrl + Shift + C 
 

Multicam 
This command switches to Multicam mode. 
 

Mute audio tracks (Multicam) 
As soon as you switch into multicam mode, all audio files in the source tracks will be 
muted. You will hear only the audio track of the final movie. 

If you would like to deactivate this function, uncheck the box. You can now mute 
audio tracks one by one in the track boxes. 
 

Effects Menu 
Master effects 
This menu item accesses the movie's effect settings (view page 161). The settings 
affected here apply to the entire movie. 

Keyboard shortcut:  Ctrl + Shift + H 
 

Video object effects 
Scene recognition 
Calls up the automatic scene recognition, which "cuts up" longer videos into scenes 
for storage in the "Takes" directory.  

Keyboard shortcut:  Shift + Z 
 

Image stabilization 
Opens the image stabilization dialog to correct "wobbly" recordings. Read more about 
this in the chapter "Image stabilization (view page 159)". 

Keyboard shortcut:  Ctrl + L 
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Edit in external editor 
Graphics files (BMPs or JPEGs) can be edited retroactively with an external graphics 
program within the project window. The selected image file will be loaded 
automatically and used in MAGIX Video Pro X6 in place of the original material 
automatically. MAGIX Video Pro X6 includes the high-performance image editing 
program "MAGIX Photo Designer" for this purpose. 

Shortcut:  Alt + Shift + D 
 

Save photos with effects 
This allows you to save photos used in the movie and add the object effects used in 
MAGIX Video Pro X6 (e.g. StoryMaker) to the photo. 
 

Create panorama... 
Opens the dialog for setting a panorama. Place as many photos in the correct order as 
you like, and align brightness and color settings to get the best results. You should 
make sure that the photos harmonize at the transitions. 
 

Video effects 
Here you can find adjustable effects for video and photo objects. The effects can be 
set only after selecting an object in the respective effects dialog. For more 
information, go to the "Video effects in the Media Pool" (view page 125) section in the 
"Effects" chapter. 
 

Movement effects 
These are movement effects you can use to animate the frame by using zoom or 
camera movements. For more information go to the "Effects" chapter, section 
"Movement effects in Media Pool" (view page 134). 
 

Movement effect templates 
These are templates for movement effects. These can be added from the Media Pool 
into the arrangement by double-clicking or via drag & drop. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D" (view page 163). 
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Background design 
Select a color, a picture, or any video on your hard disk which you would like to serve 
as the background for the photo displayed. This function is especially useful when 
photos have black bars around them, or if they are reduced in size. 
 

Reset background 
Resets the background design (view page 306) settings to default settings. 
 

Set as background 
Uses the selected photo or video as the background. 
 

Load video effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

Shortcut:   Alt + Shift + O 
 

Save video effects 
This command saves the current effects combination for each object separately. 

Shortcut:   Alt + Shift + S 
 

Reset video effects 
This option allows you to deactivate all currently used effects. The material will be 
reset to the state it was in before you applied the effect.  

Shortcut:   Alt + Shift + H 
 

Copy video effects 
Effects settings for an object may be copied to the clipboard to add (view page 306) 
them to other objects. 

Keyboard shortcut:  - 
 

Insert video effects 
Video effects may be inserted into the selected object from other objects. The 
settings must be copied (view page 306) beforehand into the clipboard. 

Keyboard shortcut:  Shift + - 
 

Apply video effects to all 
The current effects settings will be applied to all scenes and photos in your movie. 
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Apply video effects to all of the following 
The current effects settings will be applied to all scenes and photos in your movie 
which lie behind the selected object. 
 

Audio object effects 
Normalize 
The function "Normalize" raises the level of an audio object to the maximum possible 
level without clipping the material. This searches for the largest signal peak in the 
audio material and raises the level of the object so that this position matches exactly 
0 dB (maximum overdrive). 

Shortcut:  Alt + N 
 

Automatic track damping 
Please see Reduce volume (view page 181) in the audio effects chapter. 

Keyboard shortcut:  Alt + L 
 

Set volume 
This function, located in both the effects menu and the context menu, controls the 
sound volume for individual objects, just like the object handles in the project window. 
 

Audio cleaning 
Opens the "Audio Cleaning (More information can be found in the section "Sound 
optimization" on page 182)" dialog. 

Keyboard shortcut:  Alt + A 
 

Echo/Hall 
Please see "Reverb/Echo" in the chapter "Audio effects". 

Keyboard shortcut: Shift + H 
 

Timestretch/resample 
Read more about this in Timestretch/resample. 

Keyboard shortcut:  Ctrl + Q 
 

Load audio effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

Keyboard shortcut:  Ctrl + + 
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Save audio effects 
This command saves the current effects combination for each object separately. 

Keyboard shortcut:  Shift + + 
 

Reset audio effects 
This option allows you to deactivate all currently used effects entirely if you want to 
undo the changes. 

Keyboard shortcut:  Ctrl + Alt + + 
 

BPM Wizard 
Read the section concerning the Tempo and beat recognition in the chapter "Audio" 
for more about this. 

Keyboard shortcut:  Alt + Shift + K 
 

Edit wave files externally 
This opens the audio track or audio object in the included audio editor MAGIX Music 
Editor. 
 

Volume curve 
The most important effect, the volume, is available here directly. The volume is also 
available via the Media Pool under "Effects -> Audio effects -> General (view page 
140)", where it may also be animated. 

Keyboard shortcut:  Ctrl + Shift + V 
 

Title Effects 
Title Editor 

 
Opens the Title editor for the selected photo, video, or title object. 

Keyboard shortcut:  Ctrl + T 
 

Load title template 
Use this command to load previously saved title effects for the current object.  

Shortcut:   Alt + Shift + T 
 

Save title template 
You can save the current effect combination for each title object separately and apply 
it to other title objects later. 

Shortcut: Alt + T 
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Design elements 
Picture-in-picture: Here you will find various presets for picture nestling. 

Collages: work similarly to regular picture-in-picture effects, but employ multiple 
objects. Depending on the collage, arrange the selected objects one after the other 
and drag the collage onto the first object. 

Test images: Professional test images for calibrating your system are included. 

Backgrounds: Here you can find static and animated photo and video backgrounds. 
Video backgrounds are capable of being looped, meaning that their length can be 
extended by duplication. The special "User" template opens a color selection dialog 
where you can choose the desired color. 

Image objects: Here you will find various image objects such as black bars, thought 
bubbles for cartoons and  others. 

You can find additional information in "Effects" chapter, in the section "Design 
element in Media Pool". 
 

Effects library 
Using these menu choices, you can control the corresponding directories in the Media 
Pool. 
 

Windows Menu 
Window arrangement 
Switch between the classic Movie Edit Pro screen with a single monitor or the normal 
MAGIX Video Pro X6 view. More information can be found in the chapter "Notes for 
MAGIX Movie Edit Pro users (view page 17)". 

Movie Edit Pro and Video Pro X each have default window arrangements. However, 
you can save any other arrangement and combination of visible windows. You can 
then easily switch between them using menus. Us the "Save..." menu.. 
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At the top you can select a 
name for the window 
arrangement. 
In "Media Pool" you can 
additionally determine whether 
selected tabs (main 
navigation) and sections 
(subnavigation) should also be 
saved. 

Keyboard shortcuts F10, F11 and F12 are automatically assigned to the first three 
window arrangements; by going to "File" > "Settings" > "Shortcuts..." every other 
arrangement can be assigned  a keyboard shortcut (view page 343). 

Each user-defined window arrangement can also be deleted. You can select the 
arrangement to be deleted in the dialog found under "Window arrangement" . 
"Delete" and then press the "Delete" button. 
 

Edit mode 
In MAGIX Video Pro X6 you have a choice of 2 Editing modes (view page 33): the 
simplified Basic mode (view page 35) and the Standard mode (view page 34). 
 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming")" chapter for more details.  

Keyboard shortcut: N 
 

Object trimmer 
Shows or hides the trim window. This enables the position of the selected video or 
image object and its handles to be adjusted more finely. Read the chapter "Adjusting 
videos precisely" ("Trimming"). 

Keyboard shortcut:  Shift + N 
 

Mixer 
With this option you can open and close the real-time mixer. Further information can 
be found in the Mixer (view page 198) chapter. 

Shortcut:  M 
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Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 
 

Mastering Suite 
This opens the Mastering Suite (view page 190). 
 

Program monitor 
Hides or shows the program monitor. 

Keyboard shortcut:  Shift + V 
 

Source monitor 
The source monitor provides an opportunity to preview and edit files in the Media 
Pool, and these can in turn be dragged into the project folder or the arrangement from 
the source monitor. 

For the exact options for cutting in the source monitor, please see the chapter 
"Section markers in the source monitor (view page 107)". 
 

Media Pool 
With this option you can hide the Media Pool or make it visible again. 

Shortcut:  F 
 

Project 
Shows/Hides the project window 
 

Project folder 
Hides or shows the project folder. 

Keyboard shortcut:  Shift + B 
 

Activate next window 
You can switch between the various program windows (screen areas) back and forth. 
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Show movie overview 
With this option, you can display an overview of the entire arrangement on the video 
screen. It is particularly suitable for long and complex arrangements to prevent you 
from losing track. You can view the whole movie and you are, despite this, able to 
access the object you're looking for in a split second – you can zoom in directly on the 
video monitor or move around the clip displayed in the project window. 

Keyboard shortcut:   Shift + A 
 

Optimize movie view 

  The zoom level is set to 100% so that you can see every object and the entire 
film.   

The start and end markers are set to the beginning or end, so that the entire movie 
can be played. 

Keyboard shortcut:  Ctrl + F 
 

Zoom horizontal 
Here you will find a range of functions for altering the visible time axis section. 
 

Zoom vertical 
The number of simultaneously visible tracks can be changed here. The more tracks 
are visible, the smaller they will appear. 
 

Remove all movies from project 
All movies are removed from the open project.  

If you want to use these movies with the current changes such as effects and titles 
again, export these movies first via "File > Manage movie > Export". This saves the 
movie's editing state, but not the original material. If you were to delete the source 
material, the editing state won't be restored. 
 

Help Menu 
Help 
This command is available for almost every feature of the program, and it opens the 
"Help" file for the corresponding topic. Use this command to get help on any of 
MAGIX Video Pro X6's functions. 

Keyboard shortcut: F1 
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Context help 
The mouse cursor will turn into an arrow with a question mark.  

Click on any button of the main screen, to open program help which will describe the 
control element in question. 

Shortcut:  Alt + F1 
 

PDF manual 
Opens the manual in PDF format. Similar to the Help feature that can be accessed by 
pressing F1, this manual contains all of the important information about the program. 
 

Display tooltips 
Tooltips are small information windows that open up automatically if the mouse 
pointer stops briefly on a button or some other area. They provide information about 
the function of the button. These information boxes can be switched on or off with 
this option. 
 

Open magix.info 
Directly from within the program you'll be able to access magix.info, the Multimedia 
Community from MAGIX. You'll find answers to all the most frequently asked 
questions about MAGIX products and multimedia in general. Were you unable to find 
a solution to your particular problem? No problem, just ask the question yourself. 
 

Online tutorials 
Interesting tutorials and useful tips for working with MAGIX Video Pro X6 can be 
found on the MAGIX website.  
An online connection is required. 
 

Register online 
This option opens the MAGIX homepage for online registration where you can 
register as a MAGIX user. 

Registration grants you access to the MAGIX support website where various program 
updates and help programs can be downloaded. 
 

Online Update 
Connects directly to the online update page where you can get the latest version of 
your program. 
 

Download video effects plug-ins 
This command lets you download new video effects plug-ins. 
 

About MAGIX Video Pro X6 
Displays copyright info and version number of MAGIX Video Pro X6. 
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Context menu (right click) 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 
 

Video objects 
Audio functions 
Create wave form 
In most cases, the waveform display of an audio file will not be required. However, if 
you require this, e.g. to navigate while cutting video, a waveform display can be 
produced manually via this function. 
 

Video/audio on one track 
Video material and the corresponding audio material (original sound) will be 
displayed as one object on one track. Using the top object handle you can adjust the 
video's opacity. The lower object handle adjusts the object's volume. 
 

Video/audio in separate tracks 
Audio material will be displayed on a separate track below the corresponding video 
material. This makes it easier to make advanced adjustments to audio material that 
go beyond changing the soundtrack's volume. 
 

Remove audio object 
When you no longer need the audio object, remove it.  

If you decide that you need the original sound after all, you can "Restore audio object".  
 

Create frame table (new) 
Sometimes, rebuilding a frame table can get rid of problems in certain MPEG files. For 
example, such problems can be present if the navigation (positioning of the playback 
marker, transport) is bumpy or doesn't function at all. 
Normally, when loading MPEG video, a frame table is not created in order to speed up 
the loading process. If you do create one anyway, MPEG files are normally noticeably 
faster and easier to edit. 
 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming")" chapter for more details.  

Keyboard shortcut: N 
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Object trimmer 
Shows or hides the trim window. This enables the position of the selected video or 
image object and its handles to be adjusted more finely. Read the chapter "Adjusting 
videos precisely" ("Trimming"). 

Keyboard shortcut:  Shift + N 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Create still frame 
MAGIX Video Pro X6 can create a still frame of an object at the position of the start 
marker. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 157)". 
 

Interpolation for interlace material 
Choose this option to remove interlace artifacts from your video image. If, for 
instance, you extract freeze frames from a video, ridge structures appear in sequences 
which feature movement. 
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Anti-flicker filter 
Choose this option for still pictures with detailed structures and high contrast. This 
filter reduces line flickering during TV playback. 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 162)" ("Effects" menu) will be applied. 
 

Video effects 
The entries for this submenu are directly available in the Media Pool. 

 
 

Insert objects into the project folder 
Every single object can be added to the project folder and used again later. All of the 
object's properties will be maintained. This is useful, for example, if the video material 
should be edited beforehand and then arranged in the next step. 
 

Fade in date as title 
MAGIX Video Pro X6 is also able to insert the time and date into the image material. 
To do this, select the option "Show date as title" in the video object's context menu. 

If a DV-AVI file is involved (e.g. a digital recording from a camcorder), then the 
recording date for the selected position will be used. If another type of file is involved, 
then the creation date of the file will be used as the timecode. Following this, the title 
editor will appear to adjust the information. 

The context menu of the program monitor also features the option "Show playing 
time". This also creates a timecode. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 
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General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Video Pro X6 automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Video Pro X6 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 373). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

Image objects 
Change photo length 
This dialog gives exact values regarding the display duration for the selected photo. 
You may select multiple photos beforehand to change their display duration at once. 
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Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 157)". 
 

Cut automatically to fit screen 
This function ensures that images don't have black edges (in case they don't fit into 
the given format). 
 

Anti-flicker filter 
Choose this option for still pictures with detailed structures and high contrast. This 
filter reduces line flickering during TV playback. 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 162)" ("Effects" menu) will be applied. 
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Export to MAGIX Online Album 
Log in to the MAGIX Online Album service and load images and music into the album 
to share them with your friends and acquaintances in the Internet. The assistant will 
lead you step-by-step through the uploading process. After the process is finished, 
you can access your updated MAGIX Online Album. 
 

Export to MAGIX Online Print Service 
Use MAGIX Online Print Service to order high-quality photo prints or fantastic printed 
photo gifts of your valuable digital photos simply with one click. 
 

Video effects 
The entries for this submenu are directly available in the Media Pool. 

 
 

Insert objects into the project folder 
Every single object can be added to the project folder and used again later. All of the 
object's properties will be maintained. This is useful, for example, if the video material 
should be edited beforehand and then arranged in the next step. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Video Pro X6 automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 
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Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Video Pro X6 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 373). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

Transitions 
 The context menu for transitions can be accessed via the A/B button on each 
background object. Along with the various transitions you will find the following 
options: 

 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming")" chapter for more details.  

Keyboard shortcut: N 
 

Audio objects 
The options in the context menu for audio objects correspond to the menu options 
"Effects" > "Audio effects" and the "Edit" menu with the following exceptions: 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 
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• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

BPM Wizard 
Read the section concerning the Tempo and beat recognition in the chapter "Audio" 
for more about this. 

Keyboard shortcut:  Alt + Shift + K 
 

Insert objects into the project folder 
Every single object can be added to the project folder and used again later. All of the 
object's properties will be maintained. This is useful, for example, if the video material 
should be edited beforehand and then arranged in the next step. 
 

Edit wave externally 
Audio files in the project window can also be edited in an external wave editor. The 
selected audio file is loaded automatically and, once editing has been completed, is 
used in the MAGIX Video Pro X6 instead of the original material. For this purpose, 
MAGIX Video Pro X6 comes with a powerful audio editing tool: <music editor>. 

Keyboard shortcut: Alt + Z 
 

Volume curve 
The most important effect, the volume, is available here directly. The volume is also 
available via the Media Pool under "Effects -> Audio effects -> General (view page 
140)", where it may also be animated. 

Keyboard shortcut:  Ctrl + Shift + V 
 

Audio effects curves 
This feature provides direct access to diverse object effects, and these can be 
automated using a curve. All of the audio effects listed here are found in the Media 
Pool under "Effects -> Audio effects -> General". 
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Align other audio objects with this track 
Video objects grouped with audio objects may be used to synchronize recordings 
from different camera perspectives. 

For more information, please see the topic "Synchronize video objects using the audio 
track (view page 115)". 
 

Split stereo objects into mono objects 
An audio object in stereo format can be split into two mono objects very easily using 
this function. The original track will then feature the audio object with the left channel, 
and an automatically added track will feature the object with the right channel. 

This is useful if the channels were switched by accident during recording, i.e. due to 
incorrect cabling. In this case, simply open the mixer and set the pan setting to the 
correct position for each channel. 
 

Display track curves 
The most recently selected track curve is displayed on the object for editing. Use of a 
curve causes the parameters set in the mixer to be disregarded. 

Note: The track curves of audio objects can be animated in the same way as video 
effects. Read more about this in the chapter "Animating objects (view page 145)". 

 

Reset track curves 
All track curves can be reset with this function. The settings made in the mixer will be 
applied to the track again. 

Caution! Before applying this function, make sure none of the track curves will be 
need in the future.  

 

Export to MAGIX Online Album 
Log in to the MAGIX Online Album service and load images and music into the album 
to share them with your friends and acquaintances in the Internet. The assistant will 
lead you step-by-step through the uploading process. After the process is finished, 
you can access your updated MAGIX Online Album. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 
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General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Video Pro X6 automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Video Pro X6 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 373). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

Text objects 
Title Editor 

 
Opens the Title editor for the selected photo, video, or title object. 

Keyboard shortcut:  Ctrl + T 
 

Disable effects 
All effects applied to the text will be deactivated. 
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Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Load title template 
A dialog for loading a title template will open. 
 

Save as title template 
This allows you to create your own templates using your title creations. The function 
"Load title template" enables these templates to be used again quickly. 
 

Save as special effect 
This function saves the title with all objects that have been grouped (view page 299) 
with the title object. This enables you to create title templates that contain all 
required overlay objects. 
 

Convert to 3D title 
The title object will now be turned into a MAGIX 3D Maker object, and a limited 
version of MAGIX 3D Maker will open. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 157)". 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 162)" ("Effects" menu) will be applied. 
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Insert objects into the project folder 
Every single object can be added to the project folder and used again later. All of the 
object's properties will be maintained. This is useful, for example, if the video material 
should be edited beforehand and then arranged in the next step. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Video Pro X6 automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Video Pro X6 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 373). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
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MAGIX 3D Maker objects 
Edit settings... 
A limited MAGIX 3D Maker version is opened to edit the selected object. 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Create still frame 
MAGIX Video Pro X6 can create a still frame of an object at the position of the start 
marker. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 157)". 
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Video effects 
The entries for this submenu are directly available in the Media Pool. 

 
 

Insert objects into the project folder 
Every single object can be added to the project folder and used again later. All of the 
object's properties will be maintained. This is useful, for example, if the video material 
should be edited beforehand and then arranged in the next step. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 

General information 
The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images (only for video objects) 
Interlace properties:  Normally, MAGIX Video Pro X6 automatically makes suitable 
settings for this. Adjustments still need to be made to faulty video footage. If playback 
of the exported movie is very jittery, if flickering occurs, or if some effects do not look 
how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting Automatic interlace processing does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Video Pro X6 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 373). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 
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Tempo/Pitch (audio objects only) 
If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the BPM Wizard. 

Metadata (only when metadata is found in the object) 
Metadata from images or AVCHD videos will appear hear - if available. In this way 
you can find additional information about the object. 
 

Project folder 
Rename 
This command allows you to rename an object in the project folder. The name is also 
used as a file name if you save the object as a take (*.tk2). 
 

Save 
This command enables an entry in the project folder (object or object group) to be 
saved as a take file (*.tk2). More about this is available in the chapter "Objects" under 
the section "Saving objects separately". 
 

Delete 
Removes the object from the project folder. The associated source file (photo, video, 
audio, etc.) will not be deleted. 
 

Properties 
Displays the properties of the object (view page 316) in the project folder.  
 

Insert movie 
Inserts the selected object into the movie. 
 

Open in video monitor. 
Displays the selected object in the source monitor. 
 

Select associated objects in movie 
An object from the project temp folder is selected in the movie. If the object is being 
used in more than one place in the movie, all of them will be selected. 
 

Select associated source material in movie 
All objects in the movie that correspond to this source material are selected. 
 

Track 
This menu opens by right clicking on an empty range in the track. 
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Paste objects 
Inserts the contents of the clipboard at the click position. 
 

Range above blank space 
The start and end of the range in the film will be set to the respective borders of the 
empty space that is clicked on. 

Keyboard shortcut:  X 
 

Display track curves 
This option hides or shows track curves for the corresponding track. Track curves are 
only available fro the volume and panorama of an audio track. These result if these are 
automated via the mixer. Read more about this in the chapter "Audio tracks (view 
page 200)". 

Shortcut:  Alt + - 
 

Reset track curves 
The volume and balance track curves are reset; the automation for the corresponding 
mixer settings (view page 200) is removed. 
 



 

330   

http://pro.magix.com 

Problems and solutions 

File will not load 
If files cannot be loaded, this means that the format is either not supported by MAGIX 
Video Pro X6, or the corresponding codec must be activated first. Read the section 
"Import formats (view page 15)" for more information. 

In case of AVI files, it is possible that the necessary codec in not installed. For more, 
please refer to "General tips for AVI videos (view page 347)" in the appendix "Digital 
video and storage devices". 
 

Choppy or uneven playback 
Don't panic if the picture on your screen is choppy or uneven. The finished product 
will look perfect and play smoothly. Don't forget that MAGIX Video Pro X6 calculates 
all effects in real time. This lets you see for yourself what sort of influence each of the 
effects will have on your video footage. Some effects make even today's high-
performance PCs work quite hard, and often, a steady, continuous video stream is 
simply not possible on your PC. The final product, free from previous choppiness, is 
only available after rendering it to DVD or exporting it. For that reason, you should 
first edit the movie in its raw version without effects. The preview generally delivers a 
steady picture, allowing you to work quickly and quietly. Towards the end, you can 
add effects to your movies to give them a special touch of Hollywood! 
 

Problems and Remedies regarding the Auto 
Remix Assistant 
Problem: The playback stutters, the metronome is suspended, the computer is 
overloaded... (on older computers.)  

Remedy: We recommend changing to wave drivers ("P" key, "Playback parameter" 
dialog) instead of DirectSound.  

Problem: The metronome does not work and there are no lines on the the wave-
shaped display.  

Probable cause: The material does not contain beats or the song contains a passage 
without beats.  

Remedy: The song should be limited in such a way that only rhythmic passages are 
contained.  

Possible 2nd reason: Inaccurate tapping or a false BPM value has been entered.  
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Remedy: Try the tempo correction buttons or tap until the "locked" condition is 
attained.  

Problem: The metronome sounds inaccurately or is jerky, the lines in the wave-
shaped display are irregular and thinly drawn.  
 

Activation problems 
Problem: The entered code is incorrect (telephone activation) 

Make sure your entry is correct; in most cases a typo is to blame. 
If the code is entered correctly, dial the number of our Call Center. Our support staff 
will help you personally. 

The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

• Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

• Check that your inbox isn't full. 
• Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. Please 
have the following information at hand so that we can assist you as quickly and as 
specifically as possible. 

• Complete product name 
• Exact version number (to be found in the about box in the "About" menu item of 

the "Help" menu) 
• Encoder/Decoder name 
• Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed MAGIX Video Pro X6 on a new computer, installed a new 
hard drive in my old computer (sound card, memory...), or installed it multiple times 
on the same computer. My activation code is no longer accepted! 

If the program cannot be activated again after it has been activated multiple times, 
please contact the MAGIX customer service (view page 11). 
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Online functions 

Integrated browser 
The integrated browser offers many useful functions that help you collect material for 
using in your project. All kinds of media can be collected – images, videos, sound or 
simply text can be all integrated using the built-in browser with great results. 

Tip: You must have an Internet connection to use the full range of options offered by 
the integrated browser. 

 

Open browser 

 

The integrated browser is opened by clicking on the 
"Internet media" button in the Media Pool ("Import" tab). 

 

Navigation in the browser 

 
One page back: Switches to the previous page. 

 
One page forward: Switches back to the page before the "One page back" 
button was pressed. 

 
Stop: Stops loading the selected page. 

 
Reload: The current page will be reloaded. 

 
Home: Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an 
Internet address like http://http://pro.magix.com. Press the enter button and the 
corresponding page will be loaded. 
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Loading Internet media 
The buttons described here are used to collect and load media directly from the 
Internet into the current film. The corresponding functions can be found in the context 
menu of the browser. 

 
Save selected text: The selected text will be saved. It can then be edited using 
the title editor. 

 
Start screen capture: Opens the capture dialog for starting screen capture. 

 
Download selected images: The selected images will be saved to your 
computer. 

 
Import screen capture of the opened Internet page: The loaded Internet page 
will be saved as an image file. 

 
Start audio recording: A dialog for audio recording opens. 

Hint: For recording from the Internet, it is important that the sound card is 
selected as the sound source. 

 

Accept media after download 
This option makes sure that the downloaded media are loaded into the current movie 
right away. 
 

Define the path for saving Internet media. 
To define the path for saving Internet media, simply click on the folder symbol and 
navigate to the desired folder. Confirm your selection with OK. 

 
 

MAGIX News Center 
The MAGIX News Center features links to current online tutorials and tips & tricks on 
the software application examples. The "News" is indicated by color according to 
content:  

• Green indicates practical tips & tricks for the software 
• Yellow reports the availability of new patches and updates 
• Red for special offers, contests and questionnaires 
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If no new messages are present, the button will appear gray. When the MAGIX News 
Center is clicked, all of the available information will be displayed. Click the messages 
to reach the corresponding website. 
 

Embed Flash videos into your own web page 
To do this, you will need a basic knowledge of HTML pages and all technical 
requirements for uploading your files to your web page. 

Tip: If you do not have HTML skills, we recommend using MAGIX Online Album. 
Without any previous knowledge, you can present videos, photos and music on your 
own web page – all completely for free. Videos from MAGIX Online Album can also 
be embedded in other websites as well. 

Please note that a Flash video cannot be directly embedded into an HTML page like a 
picture in JPEG format. For a Flash video, you will need a Flash player embedded in 
the website to play back your video. 
 
MAGIX offers you a download package with some Flash player goodies. It can be 
downloaded here http://support.magix.net/dl/flvplayer.php. 

The package contains the following files: 

• standalone_omk.swf - the Flash player 
• demo.html - a sample website, which demonstrated how the player can be used 
• demo.flv - a demo video, which will be played by the Flash player on the demo 

website 

To reach your target quickly, simply adjust the demo website to your own 
requirements and replace the demo video with your own. At the end, upload all three 
files to your website. 

If you need more information about the website's HTML code, we recommend that 
you read an explanation of HTML documentation to better understand the structure 
and functions of HTML. 

If you understand HTML code, you will find another explanation of various 
parameters using which you can influence the appearance and function of the Flash 
player.  

url The path to the video which is to be played back. 

preview The path to an image in JPEG format. It is displayed as a 
preview in stopped state before the video is played back. 

http://support.magix.net/dl/flvplayer.php�
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sound The sound contained in the video will be played back if this 
parameter is "true". 

loop The video will be automatically played back from the start 
after reaching the end if this parameter is "true". 

tooltip Changing the position of the position cursor will display a 
tooltip with position information if this parameter is "true". 

swfborder A limiting line will be drawn around the player if this 
parameter is true. 

autoplay The video will be played back automatically when the page 
or the player are loaded. 

 



 

336   

http://pro.magix.com 

Keyboard shortcuts 

Tip: In Windows, keyboard settings are changed using the Alt + Shift key 
combination. Those who often use keyboard shortcuts can accidentally change their 
keyboard settings, so that they keys don't correspond to the pictured symbols. To 
prevent this, you can remove the check mark found by going to "Control panel" > 
"Regional and language options" > "Languages" tab > "Details" > "Keyboard" > 
"Change keyboard combination" under "Change input layout". 

 

Playback functions 
Start / Stop Spacebar 
Increase playback speed in stages L 

Shift + L 
Stop playback (playback marker is stopped at 
the current position) 

K 

Reverse playback or rewind in stages  J 
Shift + J 

Speed up fast forward Shift + Right arrow  
(Hold keys down) 

Speed up rewind Shift + Left arrow  
(Hold keys down) 

Restart beginning at playback marker Backspace 
Playback marker back to the beginning Home 
Playback marker to end End 
1 frame back Left arrow 
1 frame forwards Right arrow 
5 frames back Ctrl + Left arrow key 
5 frames forward Ctrl + Right arrow key 
Set project marker  Ctrl + Enter key 
Play from range start to range end # 
Playback at current frame + 

Activate smooth playback for preview P 
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Scroll and zoom 
To scroll and zoom in the project window it is recommended to work with keyboard 
shortcuts + the mouse wheel. The following keyboard shortcuts are available: 

• Mouse wheel: Horizontal scrolling 
• Alt + Mouse wheel: Vertical scrolling 
• Ctrl + Mouse wheel: Horizontal zoom 
• Shift + Mouse wheel: Vertical zoom (all tracks are magnified) 
• Ctrl + Alt + Mouse wheel: Move section 
 

Monitors 
Program monitor  
Other resolution Alt + G 
Adjust video monitor to movie settings Ctrl + G 
Adjust video monitor to selected video Ctrl + Shift + G 
Time background transparent Ctrl + Alt + I 
Anaglyph view      Ctrl + . 
View partially interlaced Alt + . 
Standard (2D) . 
Side-by-side display Shift + . 

Source monitor  
Display source image only Shift + , 
Comparison image: selected object without 
effects 

Alt + Shift + , 

Comparison image: selected object Alt + , 
Comparison image: in front of selected object , 
Comparison image: behind selected object Ctrl + Shift + , 
Comparison image: select object Ctrl + , 
 

Arranger view 
Zoom in Ctrl + up arrow / Ctrl + mousewheel up 
Reduce section Ctrl + down arrow / Ctrl + mousewheel 

down 
Play movie fullscreen Alt + Enter 
Show/hide movie overview in the video 
monitor 

Shift + A 

Optimize movie view Ctrl + F 
Zoom 1 frame / 5 frames Alt + 1/2 
Zoom 1s / 10s / 1min Alt + 3/4/5 
Zoom 10 min Ctrl + Alt + 6 
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Zoom to selected range Alt + F 
Zoom to complete movie length F 
Preview rendering Ctrl + R 
 

Move view 
To next object edge Alt + W 
To previous object edge Alt + Q 
To movie start Home 
To movie end End 
To beginning of range Ctrl + Home 
To end of range Ctrl + End 
Page to right/left Page up/Page down 
Grid unit to right/left Ctrl + Page up/Page down 
To next/ 
previous project marker 

Ctrl + Shift + Page up/Page down 

To next/ 
previous scene marker   

Shift + Page up/Page down 

To next/ 
previous chapter marker   

Alt + Page up/Page down 

Go to previous/next marker Q/W 
To next empty range < 
To previous empty range Shift + < 

To next/previously selected object Shift + W 
Shift + Q 

Select previous/next object Ctrl + W 
Ctrl + Q 

 

Mouse Modes 
Mouse mode for individual objects 6 
All tracks mouse mode 7 
Single track mouse mode 8 
Curve mode 9 
Object stretch mode 0 
Preview audio objects Alt + 6 
Context Help Alt + F1 

Move contents of trimmed object Alt + Shift + hold mouse and drag to 
the right/left 
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Context Menu 
Here you find some more functions among other functions of the menus: 

Set Audio-Video-Offset Alt + O  
Object properties Ctrl + E 

Audio and waveform display  
Create waveform display Shift + E 
Video/audio on one track Ctrl + U 
Video/audio on separate tracks Ctrl + H 
 

File menu 
New project Ctrl + N 
Open project Ctrl + O 
Save project   Ctrl + S 
Save project as... Shift + S 
Project folder -> Clean up project folder Alt + Shift + X 
Record audio/images/video... R 
Import edit list (EDL)... Ctrl + D 
Export to device... H 
Batch conversion... S 
Burn CD/DVD -> Manually compile files... Ctrl + B 
Clean-up wizard Ctrl + Shift + Y 
Export to device H 
Load backup project Ctrl + Shift + O 
Exit  Alt + F4 

 
 

Manage movies 
New Ctrl + Alt + N 
Remove from project Ctrl + F4 
Export Ctrl + Alt + L 
 

Export movie 
Export as AVI Ctrl + Alt + A 
Export as DV AVI Ctrl + Alt+ D 
Export movie as an MPEG Ctrl + Alt + P 
Video as MAGIX video Ctrl + Alt + M 
Video as QuickTime movie Ctrl + Alt + Q 
Uncompressed movie Ctrl + Alt + U 
Video as MotionJPEG-AVI Ctrl + Alt + O 
Movie as a series of individual frames Ctrl + Alt + E 
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Windows Media Export Ctrl + Alt + V 
Video as MPEG 4 video Ctrl + Alt + G 
Audio as wave Ctrl + Alt + W 
Export as transition Ctrl + Alt + T 
Single frame as BMP file Ctrl + Alt + B 
Single frame as JPEG Ctrl + Alt + J 
Export movie information as EDL Alt + D 
 

Backup copy 
Copy project and media into folder Alt + S 
Copy movie and media into folder Shift + R 
 

Settings 
Movie E 
Program Y 
Keyboard shortcuts Ctrl + Shift + U 
Preview rendering Alt + R 
 

Edit menu 
Undo Ctrl + Z 
Restore Ctrl + Y 
Cut objects Ctrl + X  
Copy objects Ctrl + C 
Insert objects Ctrl + V 
Duplicate objects D 
Delete objects  Del 
Select all objects Ctrl + A 

Edit  
Split scene T 
Remove scene start Z 
Remove scene end U 
Remove scene Ctrl + Del 
Split movie Alt + Y 

Musical editing adjustment Ctrl + Shift + M 

Edit range  
Cut range Shift + Del; Alt + X 
Copy range Alt + C 
Delete range  Alt + Del 
Insert range Alt + V 
Extract range Shift + X 
Insert empty space into selected range C 
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Group objects G 
Ungroup objects  Shift + G 

Wizards  
Slideshow Maker Ctrl + M 
Soundtrack Maker Ctrl + Shift + S 

Mixdown audio Shift + D 
Merge audio and video Shift + M 
Start preview rendering Ctrl + R 
Set snap point Ctrl + P 

Marker  
Set project marker Ctrl + Enter key 
Set chapter markers Shift + Enter key 
Set chapter markers automatically Alt + Shift + Enter key 
Delete chapter markers Ctrl + Shift + Enter key 
Delete all chapter markers Ctrl + Alt + Enter key 
Set range start I 
Set range end O 
Jump to range start Shift + I 
Jump to range end Shift + O 
Select range above blank space X 

Move view see "Move view" (view page 338) 

Mute audio tracks (Multicam) Alt + Shift + M 
 
 

Effects menu 
Movie effects settings Ctrl + Shift + H 
 

Video object effects 
Scene recognition Shift + Z 
Image stabilization Ctrl + L 
Edit with MAGIX Photo Designer Alt + Shift + D 
 

Video effects 
Brightness/contrast Alt + Shift + H 
Color Alt + Shift + F 
Color correction Alt + Shift + C 
Sharpness Ctrl + Alt + S 
Video effects plug-ins Ctrl + Shift + P 
Video mix effects Ctrl + Alt + X 
 

Movement effects 
Position/size Alt + Shift + I 
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Section Alt + Shift + P 
Camera/zoom Ctrl + Alt + Z 
Rotation/mirror Alt + Shift + R 
 

Audio object effects 
Normalize Alt + N 
Volume reduction Alt + L 
Audio cleaning Alt + A 
Echo/reverb Shift + H 
Timestretch/resample Ctrl + Shift + Q 
Load audio effects Ctrl + + 
Save audio effects Shift + +  
Reset audio effects Ctrl + Alt + + 
BPM wizard Alt + Shift + K 
Edit wave files externally Alt + Z 
Volume curve Ctrl + Shift + V 
 

Title effects 
Title editor Ctrl + T 
Load title effects Alt + T 
Save title effects Ctrl + Shift + T 
 

Effects libraries 
Audio and video effects Ctrl + Shift + E 
Transition effects Ctrl + Shift + B 
Title effects Alt + Shift + L 
 

Window menu 
Edit trimmer N 
Object trimmer Shift + N 
Mixer M 
Master audio effect rack B 
Program monitor Shift + V 
Media Pool Shift + P 
Project folder Shift + B 
Activate next window Ctrl + Tab 
Reset window arrangement F9 
Movie overview Shift + A 
Optimize movie view Ctrl + F 
Zoom horizontally/vertically See project window view (view 

page 337) 
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Help menu 
Help F1 
Context help Alt + F1 
Display tooltips Ctrl + Shift + F1 
About MAGIX Video Pro X6 Alt + Shift + F1 
 

Edit keyboard shortcut 
In this dialog you can specify keyboard shortcuts for all menu function of MAGIX 
Video Pro X6. This allows you to adapt existing shortcuts to your requirements or to 
add new ones. 

The settings are automatically saved in a file upon closing the program, i.e. they will 
be available the next time the program is used. 

The display of the entire menu tree is the key function of MAGIX Video Pro X6. 
 

Add keyboard shortcut 
To add a keyboard shortcut, proceed as follows: 

• Look for the required menu point and select it with a simple mouse click. Under 
"Current menu point" the currently selected menu point will be displayed. 

• Then, click on the "New keyboard shortcut" field. 
• Type in the keyboard shortcut. You can also use combinations of any key with 

"Shift", "Alt", and "Ctrl". 
• Then click on "Assign shortcut". If the shortcut should already have been 

assigned a corresponding warning will be displayed. 

Note!  Please do not use the space bar, "Esc", or "Insert" key ("0" in the number 
block), since the functions of these keys are permanently assigned in MAGIX Video 
Pro X6 and can not be changed. 
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Keyboard shortcut list 
Reset: Activates all preset shortcuts again. 

Load: Previously saved shortcuts are loaded and activated again. 

Tip: MAGIX Video Pro X6 offers additional presets for those switching from other 
programs. These settings make it considerably easier to switch to MAGIX Video Pro 
X6. 

If you have used MAGIX Video Pro X3 and want to use its keyboard shortcuts, load 
Video_Pro_X3.ssc. 

Warning:  The current settings will be overwritten during loading! Save your current 
keyboard shortcuts in advance if you would like to keep them. 

Save: The current keyboard shortcuts can be saved after naming the file appropriately. 

List: This button opens a window where a complete list of current keyboard shortcuts 
appears. The included Copy button can be used to copy this list to the Windows 
clipboard and then edit and print it using a text editor. 
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Activate codecs 
You may activate encoders/decoders for various file formats as required. The 
corresponding activation dialog will appear automatically when the codec is used for 
the first time, e.g. when a DVD is burned and the MPEG-2 codec is used. 

Why does it have to be "activated"? 

To import (decode) or export (encode) certain video and audio formats, you will 
require a specific codec to be able to read in and export these formats. As soon as the 
corresponding decoder or encoder is required, MAGIX Video Pro X3 will notify you 
and ask you if you would like to activate it. Activation is only possible for a valid 
registered version of MAGIX Video Pro X3. This is a copy protection mechanism 
which ensures that only legal owners of the software may use it completely. 
 

To be able to use the codecs MPEG-2, MPEG-4, Basic V2 (Intel) and Surround Sound 
Stereo/5.1 or to burn Blu-ray or AVCHD discs, you first have to activate the codecs 
for free. 

Note: Various codecs require a restart of MAGIX Video Pro X6 before they can be 
used. 

Activation can be done online via telephone or via post/fax. The quickest and easiest 
way to order an activation code is via the Internet. 

Order activation code online 
Click on "Order online..." (Field 1). MAGIX Video Pro X6 will automatically contact the 
MAGIX server and load the corresponding codec. 

Note: Activation of the codec checks the registration data as required. Activation of 
the codec only functions if your version of the program has already been registered 
in your name. If you haven't registered MAGIX Video Pro X6, then you can do this at 
any time.  

If your computer has no Internet access, you have the following options for activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has Internet 
access. 

Enter activation code 
After receiving your personal activation code, use the export or burn function to 
reopen the activation dialog for the corresponding file format. Type or copy the 
activation code into the input field in the dialog and click on "Activate...". 
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Fee-based codec activation 
In order to use the professional video codecs DVCPRO and AVC Intra in MAGIX 
Video Pro X6 they must first be activated. This involves a fee-based activation 
process. 

The codec MPEG-4 Full from MainConcept can also be activated for a fee. 

Order activation code online 
Click on "Order online..." (Field 1). The web browser will open for you to register 
MAGIX Video Pro X6 first (if you have not already done so). You will then be 
forwarded to a website where you can request the corresponding activation. 

If your computer has no Internet access, then you have the following options for 
activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has Internet 
access. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2) your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on "Continue to 
order form" to transfer your user code automatically to the post/fax form. Now send 
the completed form as a printout to the address/fax no. mentioned.  Once payment 
has been processed successfully, your activation code will be sent to you in the 
post/via fax in just a few days. Optionally, it can also be sent by email if an email 
address is stated. 

Enter activation code 
After receiving your personal activation code use the export or burn function to 
reopen the activation dialog for the corresponding file format. Type or copy the 
activation code into the input field in the dialog and click on "Activate...". 

 



 

Annex: Digital Video and Data Storage 347  

 

Annex: Digital Video and Data Storage 

MPEG Compression 
MPEG means "Moving Picture Experts Group" and defines a workgroup which 
cooperates with the International Standards Organization (ISO) as well as the 
international Electro Technical Commission (ETC) to develop standards for video and 
audio coding.  

Generally, the graphic data rate of the digital video standard is 167 megabits per 
second, which, when not compressed, requires a far higher storage capacity than a 
DVD can offer. A one-sided DVD 5 with 4.7 GB storage capacity is enough for 4 
Minutes. For this reason, the available pictorial material must be effectively 
compressed – a function which is achieved with the MPEG procedure. 

This procedure is based on the simple fact that up to 96% of digital video data 
consists of repetition and can be compressed without visible degradation of the 
pictorial quality.  

Each MPEG compression is, however, a data reduction and as such connected with 
information loss. If the video consists of very extensive details, or if the content 
changes very fast, then the picture may blur (dependent on the strength of the 
compression and the quality of the encoder). 

Errors can also result from so-called compression artifacts such as small color defects 
or images that are too dark.  

At average compression rates under 3 megabits per second it is probable that you will 
notice reduced quality. At rates around 6 megabit per second the degradation in 
quality becomes almost invisible.  
 

General notes on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container", where the conventions for transferring audio and 
video files to the program are only loosely defined. The codec (coder/decoder) 
actually defines what storage format is used. A codec compresses audio/video data 
into its own unique format which can only be read by the codec itself and is decoded 
when the film is played.  

In concrete terms, a computer-generated AVI file can only be loaded by and played 
on a different computer if the same codec is installed on it. 

Many codecs (e.g. Intel Indeo® video) have now become standard components of the 
Windows installation. Others are not standard. If you are generating an AVI file for 
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future play on another computer using one of these codecs, you should first install 
this codec on the other PC. The best method available is to copy the codec installer to 
your export directory and burn it every time you create a video disc (slideshow disc) 
for play on computers. 

You may encounter some problems when using older video editing cards with codecs 
which only function with the card’s hardware. Such AVIs can only be used on the 
computer which was used to create them. Try to avoid using this kind of codec. 
 

Overview of the different disc types 
MAGIX Video Pro X6 supports numerous disc types, and these depend on whether 
you want to burn a movie or slideshow and which disc type you are using (CD, DVD, 
or Blu-ray DiscTM), or the type of playback device or quality required.  

The table below will explain which disc types are best for different cases, the 
differences in quality, and how much storage space each format requires. 

More detailed information, consult the chapters concerning the individual disc types. 
 

Disc type Storage media Menu Quality: Length (optimal quality) 

DVD DVD Yes  *** 98 min. 
Blu-Ray disc 
(view page 350) 

Blu-Ray disc Yes ***** 110 min. 

AVCHD (view 
page 350) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 
160 min./Blu-ray Disc 

*  The display time for some DVD players can be determined in this menu. The 
amount of image material that can be put onto a CD or DVD depends on the sizes of 
the picture files. 
 

Digital Versatile Disc (DVD) 
Quality 
Featuring a resolution of 720 x 576 (PAL) and encoded with MPEG-2, 25 frames per 
second provides very good results. 

Writable data storage formats 
The recordable DVD market is currently split into three types: "DVD-RAM", 
"DVD+RW", and "DVD-RW". 

DVD-R/+R: This medium may only be written to once. The DVD-R may be specified 
with file structures for DVD video, DVD audio, or DVD-ROM. 
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DVD +RW: +RW drives allow re-writable DVDs to be created which may be read by 
almost any commercial DVD-ROM or DVD player. The companies involved are 
mainly Philips, Sony, HEWLETT PACKARD (as well as Ricoh, Yamaha and 
Mitsubishi). 

DVD-RW: This is a write/erase DVD technology promoted by Pioneer and Sharp. 
This format was developed by the Pioneer company and should be compatible with 
existing DVD players. 

DVD-RAM: DVD-RAM technology is based on either Phase Change, MOs, or hard 
disks, etc. and is now almost 100% incompatible with all available players. 

Due to the small storage capacity and incompatibility with DVD players, setting on 
this standard is not recommended. 

Note: MAGIX Video Pro X6 supports DVD±R and DVD±RW, but not DVD-RAM. 

Blank discs: Single-sided recordable blank discs featuring a capacity of 4.7 GB and a 
duration of approx. 2 hours. 
 

Copy Protection 
Macrovision (APS): The movie industry claims that even DVD-ROM drives and 
decoders or diagram cards with composite outputs or s-video outputs must support 
the Macrovision analog copy protection (APS). Only some older DVD players do not 
possess APS.  

APS adds additional signals to a DVD’s stored graphical data. The data is almost 
unchanged. These supplementary signals disturb the synchronization and the 
automatic recording regulation of most video recorders to prevent recording of the 
video. They are not noticeable on the television or the monitor, however. 

Content Scrambling System (CSS): CSS prevents saving and duplication of DVD 
video tracks to hard disk. The VOB streams of DVDs without CSS can otherwise (like 
other video files) be loaded via the Import Video button 

There are further types of copy protection besides APS and CSS which ensure that 
retail DVDs cannot be copied without distortion 

 

miniDVD 
The miniDVD is nothing more than the DVD data format burned onto a CD-ROM. 
Thus the MPEG-2 encoder and all other specifications of the DVD data format are 
used, and only the data carriers are different. Because the CD-ROM can only save 
about a sixth of the quantity of data a DVD can hold, the capacity of a miniDVD is 
accordingly limited to approx. 20 minutes of movie.  
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MiniDVDs are particularly suitable for playing on the computer. For stand-alone 
devices they must be tested on an individual basis as to whether the device can 
handle the DVD format on a CD-ROM. 
 

AVCHD disc 
Use this format to create a high-resolution video. You can burn Blu-ray (BD-R/RE) 
blanks as well as conventional DVD±R/RWs. In contrast to Blu-ray Discs (view page 
350), MPEG-4/AVC codec (view page 354) is applied as the video format, which 
requires less memory at a comparable image quality. 

Compatibility 
AVCHD disc on Blu-ray blank: Since this is a BD-conformant format, the disc created 
can be played back in any conventional Blu-ray player. Playback problems can almost 
always be traced to incompatibilities between Blu-ray blanks and Blu-ray players. In 
this case, consult the instructions for your Blu-ray player or ask the manufacturer 
which blanks are compatible with the device. 

AVCHD disc on DVD blank: The DVDs created with AVCHD video are not supported 
by all Blu-ray players. The behavior of the devices is quite different. Normal DVD 
players cannot replay AVCHD discs, since the AVC format is not supported. 
 

Blu-ray Disc 
Since early 2008, Blu-ray Discs are viewed as successors to DVDs and offer 
especially high storage capacity of up to 27 GB in a single layer (double-layer up to 54 
GB) with very few write errors. 

The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot 
be registered as a trademark, the letter "e" was removed from the word "blue". 

The high storage capacity of the Blu-ray Disc suits high definition videos and 
slideshows in high quality perfectly, since these are characterized by large file sizes 
(depending on material approximately 40 MB/sec) and very high memory use. The 
MPEG-2 codec is used to create video. 

Companies that were involved in developing Blu-ray technology have united 
themselves into the Blu-ray Disc Association (BDA). 

Blu-ray Discs come in three varieties: 
• Only readable BD ROM (comparable to DVD video), 
• rewritable BD-RE (comparable to DVD±RW or DVD-RAM),  
• and as a disc that can be written to only once BD-R (comparable to DVD±R). 
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MPEG-4 encoder settings (Intel) 
In the „Advanced Settings“ you can make detailed adjustments to the MPEG 4-data 
flow. 

 

The advanced settings are divided into "Video", "Audio", and "Multiplexer".  
 

Video (H.264) 
Bit Rate Mode: The bit rate indicates how much data is saved in the video per second 
(at playback speed). This makes the bit rate the deciding parameter with regard to the 
file size and quality of the video to be encoded. A higher bit rate means more quality 
but also a larger file size. 

• Constant: The exact value entered in "Average bit rate" is applied which enables 
precise calculation of the video size.  

• Variable: The value entered in "Average bit rate" is used as an approximate 
guideline for the value applied to the video. This means that the size of the video 
can only be estimated. 

• Constant quantization parameter: This parameter ensures that the video quality 
remains the same throughout. Entering a value sets the quality level: 

- Low values lead to large video files with good image quality. 

- High values lead to small videos files with poor image quality. 
 

Average bit rate (kbps): The bit rate entered here is used as the average rate applied 
to the video. The size of the video to be exported can only be approximated. 
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Maximum bit rate (kbps): This is the maximum bit rate for the video stream, i.e. the 
maximum number of bits the decoder is allowed to transfer per second. This 
parameter only takes effect in the "Variable" bit rate mode. 

Hardware acceleration: MAGIX Video Pro X6 supports the hardware acceleration 
"Quick Sync Video" for AVCHD exports, AVCHD and Blu-ray discs. This can 
noticeably speed up the encoding process. 

Smart Copy: If this option is activated, unedited AVCHD material with hard cuts is 
transferred without changes. This drastically accelerates the encoding process. The 
transfer always takes place on the GOP borders is not frame-precise. 

Maximum GOP length: The maximum GOP (view page 372) length is determined 
here. High values mean improved compression. Lower values create stronger security 
protection and enable improved access to individual frames for processing the video. 

B-Frame interval: Here you can specify after how many frames a B-Frame (view page 
374) will be created. Several applications, e.g. video conferences, require a setting of 
"0" for this, i.e. no B-Frames, in order to enable the shortest possible reaction times 
for transfer. 

B-frames save the differences between the current picture and the I or P frame 
preceding and following. You only save the information that was not in the 
preceding frame and not "left" in the next frame. Both directions are analyzed, hence 
the "B" in the name which means "bidirectional-predicted". 

Number of P-Frames: Here the number of P-frames per second is specified. 

P-frames save only the difference between the current picture and the preceding I 
frame (Intra Frames).  The "P" comes from "prediction", which describes this 
process. 

HRD (Hypothetical Reference Decoder): When this option is activated, a virtual 
decoder checks the data stream for compatibility with the video standard during the 
encoding process. This ensures that the generated video is compatible with various 
playback devices, but it also slows down the encoding process. 

CPB (Coded Picture Buffer): This field is only unlocked when the parameter „HRD“ 
(Hypothetical Reference Decoder) is activated. The entered value determines the 
buffer size for the HRD (Hypothetical Reference Decoder).  
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Profile: Profiles define the encoder properties that are supported. 

Note: You should only change this setting when there are problems playing back the 
generated video. 

• Auto: The encoder automatically selects the appropriate setting. 
• Main: This profile was originally intended for the broadcast industry and for 

backup purposes. It became less popular when "High Profile" was developed for 
exactly these applications. 

• High: This profile is used for broadcast and backup applications and is also 
sometimes used in the HDTV industry (High Definition Television). This profile is 
used for HD-DVD and Blu-ray Discs, for example. 

Level:  H.264 defines different levels. The level determines which bit rate and 
resolution are possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 
 

Audio (AAC) 
Sample rate: Here you can set the sample rate for audio encoding. For DVDs the 
standard is set to 48 kHz. If you change the settings here, it may result in not being 
able to play back the sound or the entire video. 

Channels: Determines the number of audio channels. 

• Mono: 1 channel, mono sound 
• Stereo: 2 channels, one for left and one for right. 
• Surround: 6 channels (5.1) 

Average bit rate (kbps): The desired bit rate is entered here. 

Variable bit rate (VBR): If this option is activated, high bit rates will only be used 
when required. The achieved values in "Average bit rate (kbps)" may vary so the 
predicted file size is only an estimate. 
 

Multiplexer 
Streamable: The generated video is suitable for live playback on websites. 

HTML Start file: MAGIX Video Pro X6 generates an HTML file with a video player 
that opens the HTML file and plays it back. 
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MPEG-4 encoder settings (main concept) 
MPEG-4 is actually a collection of highly efficient codecs for video and audio based on 
the MPEG standard. Compared to MPEG-2, the same quality can be achieved with 
smaller file size. 

Recommendation: Check the presets that the program offers to find the right preset 
for each application and the right playback device. These presets are optimized for 
typical applications. 

The advanced settings in "Advanced" are divided into "Video", "Audio", and 
"Multiplexer".   

Under "Video“ there is a choice between "MPEG-4 Simple" (MPEG-4 Visual/MPEG-
4 Part 2)  (view page 359)and "MPEG-4 H.264" (AVC/MPEG-4 Part 10) (view page 
354).  

Depending on the purpose of application of the material to be exported, either one of 
these encoder settings can be selected for compressing the video material. Refer to 
the manual for the playback device to find out which encoder is supported. 

Under "Audio", "AAC" (view page 362) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available.  

Under "Multiplexer" you can adjust certain presets, e.g. container format and 
streaming properties. This is only recommended for experts. 

The option "Export as website" also creates an HTML page in an integrated Flash 
player that can play back the video created. Read the topic "Embed Flash videos into 
your own web site (view page 334)". 

Tip: First, check if there is a suitable preset in the export dialog for your purposes. 
Advanced users can make specific adjustments to these three areas using the 
advanced settings. 

 

Video codec 
MPEG-4 H.264 
The MPEG-4 H.264/AVC codec is suitable for all types of material; however, it 
requires relatively higher CPU power for later decoding. 

In the advanced encoder settings of the AVC encoder the "Generic" options in "Main 
Settings" are mainly interesting. 
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The AVC preset and video format can be adjusted here. For instance, if DVD quality is 
desired you should select "DVD". The video format should be selected specific to the 
country so that the material can be played on the devices most commonly available in 
these countries. For instance, you should select PAL for Germany, SECAM for France 
and NTSC for the US. 
 

MVC 
MVC: Multiview Video Coding (MVC) is an expansion for stereoscopic applications. 
Activate this to export MVC files.  

Note: MVC is only available in the Video deluxe Pro versions. 

 

2-pass 
The video to be exported will be encoded twice. The first run-through serves to 
calculate the streaming rate for each section (for video this is per frame). The second 
run-through is when the actual video is created with the streaming rates that were 
calculated in the first run-through. The result is an improved image quality, but 
encoding takes place approximately twice as long. 
 

Smart Render and Smart Copy 
Smart Render lowers the demand on the encoder for AVCHD material. In the 
production of AVCHD files, only those parts of the movie that were changed in the 
program (e.g. by video cleaning or effects) are re-encoded. Please note: The AVCHD 
files contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

The Smart Rendering special mode „Smart Copy“ enables AVCHD material to be 
transferred without having to encode it for the target medium which greatly increases 
the encoding speed. The video material cannot appear to have been altered in any 
way, only hard cuts (without fades) are permitted. These won't be executed precisely 
to the frame, but rather take place at the next GOP borders. For this reason, cuts 
should be set somewhat more generously. 
 

Hardware acceleration - CUDA, Quick Sync Video, OpenCL 
The MPEG-4 encoder from MainConcept supports the use of hardware acceleration 
for AVCHD export as well as AVCHD and Blu-ray (H.264) encoding (burning). This 
can noticeably speed up the encoding process. 

The following hardware acceleration technology is supported:  

• Quick Sync Video (Intel)  
• OpenCL (AMD)  
• CUDA (NVIDIA). 
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Note: Ask your graphics card manufacturer whether your graphics card supports 
hardware acceleration.  Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it in the "Encoder 
Settings" dialog under "Advanced..." > "Hardware acceleration". The program will 
make the adjustments according to the available technology. 
 

Advanced video settings 
Generic 

AVC preset 
This is where the actual video stream that will be exported is selected. 

• Baseline: According to ISO/ICE 11172-1/2 standard 
• Main: Corresponds with ISO/ICE 13818-1/2 standard 
• High: High Profile 

• SVCD: Corresponds with MPEG-2 Super VideoCD 
• D1: Corresponds with MPEG-2 DVD 
• DVD: DVD video 
• Blu-ray: Blu-ray-Disc 
• Blu-ray HD: Blu-ray-Disc in High Definition 
• Sony PSP: Sony PSP-compatible format 
• HD 1280x720p: High Profile with a resolution of 1280x720p (progressive) 
• HD 1440 x 1080i: High profile with a resolution of 1440 x 1080i (interlaced) 
• Apple iPod: Apple iPod-compatible stream. 
 

Profiles 
Profiles 

Profiles define the encoder properties that are supported. 

• Baseline profile: The basis of applications with limited computing performance, 
especially for video conferences or videos on mobile telephones. 

• Main profile: This profile was originally intended for the broadcast industry and 
for backup purposes. It has become less popular since the development of the 
"High Profile" for this purpose. 

• High profile: This profile is used for broadcast and backup applications, and it is 
also used sometimes in the HDTV industry (High Definition Television). This 
profile is used for HD-DVD and Blu-ray Discs, for example. 

Level 
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H.264 defines different levels. The level determines which bit rate and resolution are 
possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 
 

Frame type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Progressive Frame: A single image from a video sequence, also called a fullscreen. 
• Interlaced Field:  This is half an image. Two of these are combined to produce a 

frame. Read more about this explanation regarding "Interlace (view page 373)". 
• Interlace Frame: The encoder creates a „Frame field“ which is the basis for the 

encoding. 
 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 373)". 
 

Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
 

Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 
 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Constant quantizer: In this mode, a fixed colour quantization is used for the 

macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 373), P-Frame, or B-
Frame (view page 374)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 
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• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 
rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

 

Pass 
Here you can choose whether you want to manually perform one-pass or multi-pass 
encodings (2-pass, multi-pass) 

Note: The 2-pass option in the main dialog of the MPEG-4 export is recommended. 
This automatically performs two encoder passes. 

If you want to perform 2-pass encoding manually, you must select "Multi-pass 
analysis" in the first pass and "Multi-pass encode" in the second pass. 

• Single pass: The encoder process takes place without prior analysis. This requires 
the least amount of time.  

• Multi-pass analysis: Analysis data is calculated during encoding and used for 
multi-pass encoding. 

• Multi-pass encode: Assumes that an analysis has already been performed The 
analysis data is used during encoding to optimize the results. 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

 

HSS rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. "Use HRD" must also 
be activated. 

 

Aspect ratio 
In the film industry, this is an indication of the ratio between width and height of a 
rectangle, monitor, or screen.  

There are 3 different sizes available: 

• Picture Aspect Ratio (also Display Aspect Ratio, DAR): This indicates the desired 
aspect ratio of the video to be exported. Here are some examples of typical 
aspect ratios: at home 4:3, 16:9 (typical for TV sets) or 16:10 (widescreen-
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flatscreens, widescreen notebooks), 3:2 for 35mm films and photos. In cinemas 
you mostly find 1.85:1. 

• Pixel Aspect Ratio (PAR, pixel aspect ratio: Indicates the aspect ratio of individual 
pixels. The majority of computer monitors have quadratic pixels (PAR=1:1), for 
analog television monitors (PAL at 4:3) 128:117. 

• Sample Aspect Ratio (SAR, also Storage Aspect Ratio): Aspect ratio of the saved 
resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture 
aspect ratio and pixel aspect ratio: SAR = DAR / PAR. 

Note: In the standard case, the "Aspect ratio" remains set the way it is. You should 
only change the settings if the resulting video is exported distorted or stretched or if 
you need to correct the video because it is in the wrong aspect ratio. 

 

GOP structure 

Max GOP length 
Determines the maximum GOP (view page 372) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 
 

Max b-frames count 
The maximum number of b-frames (view page 374). Several cases of application, e.g. 
video conferences require "no b-frames" in order to achieve the shortest possible 
reaction times during transfer. 
 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 373) after a scene change.  
 

MPEG-4 simple 
If MPEG-4 H.264 cannot be played back on your device, use MPEG-4 Simple. 

Note: We recommend that only advanced users make adjustments to the advanced 
settings. You can use the technical specifications of your playback device to help 
with this. 
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Advanced video settings 
Generic 

MPEG-4 preset 
Different presets located within the encoder. 

(A)SP@L0-L5: (Advanced) Simple Profile in Level 0-5 

(Q)CIF (Common Intermediate Format): CIF is a video format produced as soon as 
1990 with the video compression format H.261. At that time, the format was used for 
video telephone conferences. 
The "Q" in QCIF stands for "Quarter", and since resolution is halved in terms of height 
and width compared to CIF, the entire size is only a quarter of CIF. 
QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 
144 pixels was sensible for the first affordable SmartPhones (144 x 176). 

(Half)D1: D1 corresponds with MPEG-2 DVD. HalfD1 has exactly half of the entire 
number of pixels, meaning that the pixel number of the height and weight is 2/3 of D1. 

720p: Video stream with a resolution of 1280 x 720p (progressive). 

Apple iPod: Apple iPod-compatible stream. 

Sony PSP: Sony PSP-compatibler stream. 
 

Profile/Level 
Profiles: Profiles define the encoder properties that are supported. 

Level: The level determines which bit rate and resolution are possible for the video.  
 

Picture type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Frame: A frame is a single image from a video sequence, also called a full image. 
• Field: A half-image, two of which combine to produce a frame. Read more about 

this explanation regarding "Interlace (view page 373)". 
 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 373)". 
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Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
 

Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 
 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 

rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

• Constant quality: Similar to the "Variable bit rate" mode, the bit rate varies 
according to the video material. The quality depends on the selected profile and 
can be changed. 

• Constant quantizer: In this mode, a fixed colour quantization is used for the 
macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 373), P-Frame, or B-
Frame (view page 374)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

 

Max. rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. 
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Pixel aspect ratio 
Specifies the page ratio of the individual image points (pixels). 

Meaning: Different television norms and the standard pixel ratio. Select a setting and 
the results are displayed as "X" and "Y". 

X/Y: The actual pixel ratio. If under "Meaning" the setting "Custom" is selected, then 
a custom ratio can be set. 
 

GOP structure 

Max key interval 
Determines the maximum GOP (view page 372) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 
 

B-frames count 
The number of B-Frames (view page 374). Several applications, e.g. video 
conferences, require a setting of "0" for this, i.e. no B-Frames, in order to enable the 
shortest possible reaction times for transfer. 
 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 373) after a scene change.  
 

Audio codec: 
Under "Audio", "AAC" (view page 362) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AVCHD audio track" will be available. 
 

AAC 
AAC was developed by MPEG, the Moving Picture Experts Group, as an audio data 
compression process that was specified as a further development of MPEG-2 
Multichannel in the MPEG-2 standard.  

AAC is equally suitable for encoding general audio information and not especially 
optimized for certain types of audio material.  

AAC audio can be encoded with a sample rate of 8000, 16000, 24000, 32000 or 
48000 Hz in either mono or stereo. By default, the sound is set to 48000 Hz stereo. 
The higher the sample rate is, the larger the resulting file and higher the audio quality. 
You can use the technical specifications of your playback device to help with this. 
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Advanced audio settings: 

• The bit rate can be set between 6 and 512 kbit/s. 160 kbits/s is active by default. 
The higher the value is, the larger the resulting file and higher the audio quality. 
After a certain limit, additional improvements to audio quality will not be 
perceived. Bit rates under 64 kb/s are not recommended. 

• As an MPEG version, set MPEG-4 or the older, proven MPEG-2 format. 
• For the File Header Type, choose either RAW or ADTS. The "Header" indicates 

an explanatory head for the beginning of the file segment, which in fact takes up 
extra space, but is required for decoding under circumstances. 

- RAW indicates material which does not include a file header in audio format. 
The audio material is therefore transferred directly without any special 
additional information (raw). 
This requires that decoding routines are able to process the material without 
the explanatory file header. Especially in case "exotic" sample rates are set, 
this can lead to problems during RAW encoding. 

- ADTS indicates a file header type which contains information for encoded 
audio material. In case of doubt, select this file header type, since fewer 
problems can be expected in this case. 

 
Profiles:  

• Low complexity: Data is present in a form that hinders different decoding 
algorithms (noise replacement), but enables others (temporal adjustment noise 
formation). 

Note: For example, Apple iPod requires "low complexity encoding". However, you 
don't need to worry if you select the right preset for Apple iPod in the export dialog. 

 

AVCHD audio track 
If you have chosen an AVCHD, AVCHD transport stream, or Blu-ray (H.264) from 
the presets, "AVCHD audio track" will be available. 

Note: 5.1 surround is only available in MAGIX Video Pro X6. 
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Multiplexer 
The Multiplexer combines audio and video streams so they can be played back 
together on playback devices. 
 

Output format 
MPEG-4 file: This is an MPEG standard (ISO/IEC-14496) with the original goal of 
supporting devices with less computing performance. Currently, MPEG-4 has reached 
a wide bandwidth of application, from HD video to support for mobile telephones. 

JPEG2000 file: DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 
format for encoding movies. The current distribution and presentation of films has 
been taken over by digital projectors that play back high-resolution Mj2 streams in 
outstanding image and sound quality. 

3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP 
is very similar to the MPEG-4 standard, but also supports formats that are not 
permitted by MPEG-4. 
 

Streamable format 
Activate this option if you would like to create files that can be integrated into and 
played back on websites. This way the file can be played back without having to be 
completely preloaded. 

Note: This setting is recommended if you choose the option "Export as website". 

 

For Sony PSP 
Switch on this option if the video should be played back with the Sony PSP. 
 

For iPod 
Switch on this option, if the video should be played back with the Apple iPod. 
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Appendix: MPEG Encoder Settings 

General settings 
MPEG type: Here you can set the output type of the created MPEG file. You can 
either adjust the encoder settings freely, for instance, to export your video in the 
corresponding format, for further use in other programs or on your own website. 

Video format: Automatically specifies the video format, aspect ratio and frame rate 
(see video settings (view page 366)). You can choose between PAL or NTSC. 

Interlace mode: The movie is encoded interlaced (i.e. in two half-screens, so-called 
fields). This is essential for later playback on TV screens. If you want to view the 
exported movie on your PC only and like a "cinemascope" view, you can also encode 
by frame (progressively). Some video projectors also support playback of 
progressively encoded image material. See Interlace (view page 373). 

Bit rate: The bit rate determines the memory requirements of the completed video. 
The amount of data available can be used differently for different display modes. 
20 MB can be 4 seconds of DVD Video or 5 minutes of Internet streaming at the 
thumbnail size. The quality of an MPEG video is measured by the "width" of the 
created "data stream", the bit rate. This is the amount of the transmitted data per 
time unit; it is stated in kBit/s or bit per second.  

Quality: Determines the quality of the encoding process, to be more precise, the 
quality of the motion estimation (view page 370). The higher the quality, the better 
the finished video will look; however, encoding will take considerably longer. The 
preset value of 10 is a good compromise between speed and quality. 

Smart Rendering: With Smart Rendering you can considerably reduce the encoding 
processing strain for MPEG files. With the production of MPEG files, only those parts 
of the movie that were changed in the program (e.g. by video cleaning or effects) are 
re-encoded. Please note: The MPEG files contained in the movie must have the same 
format, i.e. the bit rates (variable or constant), image resolutions and video formats 
must match. 

Smart copy (quick, GOP-precise copying): This special mode of Smart Rendering 
enables MPEG material to be transferred without having to encode it for the target 
medium, thereby increasing the encoding speed manifold. The video material cannot 
appear to have been altered in any way, only hard cuts (without fades) are permitted. 
These won't be executed precisely to the frame, but rather take place at the next GOP 
borders. For this reason, cuts should be set somewhat more generously. 

To burn DVDs in original 5.1 surround sound without having to re-encode, this option 
must be activated. 
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Conclusion: Displays an overview of all settings of the encoder. 

From file: Allows you to rip the necessary settings from an existing MPEG file. This 
can be useful, for instance, if you want to merge MPEG files together without re-
rendering via Smart Rendering. 
 

Video settings 
Frame rate: PAL requires 25 frames/sec, NTSC 29.97 frames/sec. Please note: 
encoding NTSC material as PAL or vice versa may be possible; however, it will result 
in jittery images. 

Aspect ratio: Lets you set the image side or pixel ratio. With MPEG-2 the image 
format is displayed as image ratio; correspondingly there is 1:1 (square screen, not 
recommended), 4:3 (regular video), 16:9 (widescreen) and 2.21:1 (cinemascope). This 
applies irrespectively of the selected video format. 

For MPEG-1 the pixel format is set; the options here are 1:1, CCIR601 (represents 
normal 4:3 video) for 625 lines = PAL and 525 lines = NTSC and the same for 16:9.  

The option Auto is set as default. Here you can adjust the Movie settings (view page 
300) accordingly.  

Resolution: Width and height of the video corresponds with the settings in the export 
dialog. 

GOP structure: Here you can change the settings of the GOP (view page 372) 
sequence, i.e. the number of P frames and B frames per I frame within a GOP. Please 
note that the total length of the GOP must not exceed 15 frames, which corresponds 
to the default setting (1 I frame + 4 P frames + 5*2 B frames = 15 frames).  

However, you can reduce the length of the GOP sequence (while compromising the 
image quality at the same bit rate). This speeds up the encoding process considerably 
as the motion estimation while encoding P and B frames requires high CPU 
performance. The speed of decoding, i.e. playback, is also increased. 

If I frame is set to 1, each frame is an I frame. If the value is set higher, the setting 
describes the total length of the GOP. 

Auto GOP: Closed GOPs do not contain relations to frames from subsequent GOPs. 
MPEGs where all GOPs are closed, make MPEG editing easier as the I frames only can 
be edited alone if the GOP is closed. Auto GOP closes GOPs at scene changes, 
whereby two different and complex procedures ("fast" and "VCSD") are used. 
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Bit rate mode 

In "constant bit rate" mode a bit rate that constantly remains the same is used. With a 
constant bit rate the full power of MPEG compression can not be used properly as 
bandwidth for non-moving scenes is lost. 

"Variable bit rate" mode attempts to adjust the available storage space to the 
requirements of the video you want to encode. The actual bit rate fluctuates around a 
mean value. During calm sections of the video it may drop to a minimum value, if 
there are movements in the scene it may rise to the maximum value. There are two 
different regulation processes (mode 1 and mode 128). 
 

Advanced video settings 
MPEG profile and level: The MPEG-2 standard defines various "profiles" and "levels". 
For creating DVDs you can use the "Main profile & Main level". The high profile adds 
additional properties to the data stream, such as the option of displaying an image at 
a reduced resolution for restricted transmission quality (SNR scalable profile) or 
locally scaled, for instance an HDTV data stream on a standard TV set). The 4:2:2 
profile is used if the image data is to be encoded for alternative chroma scanning 
(view page 371). However, these profiles are only supported by very few encoders, 
mainly for professional use.  

The different levels define the restrictions to the image resolution and the maximum 
data rate. Low level can only reach a reduced resolution (352 x 2888 = CIF), high 
level or High -1440 enables encoding in HDTV format.  

Estimate movement: These parameters are controlled by the quality controller (see 
General Settings). 

Other 

Noise sensitivity: This factor defines how sensitive the encoder will react to noise in 
the source material. If your source material only contains little noise (digital 
recordings, computer animations or already de-noised by video cleaning), you don't 
have to change the default value 4, or you can even reduce it in order to increase the 
quality further.  

However, if you want to encode noisy material, a factor that is too low will 
considerably increase the encoding time without producing higher quality. For an 
unedited analog video you can increase the factor to 8-14. 

Noise reduction (click on noise sensitivity): A noise filter is used which has adjustable 
settings from 1-31.  
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Advanced parameters 

Additional expert settings are available in the tree to the right of the window. These 
should only be changed by experienced users. They have been optimized for general 
applications to such an extent that adjustment is only necessary in exceptional cases.  
 

Audio settings 
Audio type: You can use MPEG Layer 1/2 audio or "AVCHD audio track". Select "No 
audio" in the export dialog. 

Sample rate: You can set a sample rate of 32, 44.1 or 48 kHz for the audio track. 
VCDs and SVCDs require 44.1 kHz, DVDs require 48 kHz. To reduce the size of audio 
data it is recommended to lower the bit rate instead of the sample rate. 

Mode: You can use Mono, Stereo, Joint Stereo or Dual Channel. If the audio type 
"AVCHD audio track" is used, "5.1 surround" mode may also be selected. 

• Dual Channel enables encoding of two mono tracks (e.g. different language 
sound tracks) that can be switched during playback.  

• Joint Stereo is an optimized stereo encoder which takes advantage of the fact 
that the signal of both stereo channels is largely identical. Use Joint Stereo if you 
can only use small audio bit rates but still require a stereo signal. 

• 5.1 Surround is available only for surround projects for burning DVDs. During this 
process, all 6 surround channels in the audio stream are encoded. 

ATTENTION! For surround projects, "AVCHD audio track" should be selected in 
"Audio type" and "5.1 surround sound" in "Mode". 

Bit rate: Here you can set the bitrate of the audio signal. The higher the bitrate, the 
better the playback quality. VCD requires 224 kBit/s, and for SVCDs and DVDs you 
can select a value between 384 kBit/s and 448 kBit/s. 
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AVCHD audio track details 

Note: These functions are available only in the "5.1 Surround" mode. 

Dialog normalization: Here you can set the level of spoken dialogs in dB. This value 
will be used to adjust the total volume of DVD movies and different programs that 
can be received by the DVB. To do this, you must first measure the volume of spoken 
dialogs in your movies. The values 1 to 31 correspond to volume levels of -1 to -31 dB. 

Note: Use the mixer's peakmeter to set the volume level. This process produces only 
approximate results because the exact measurement requires a mean value, which 
cannot be easily measured with MAGIX Video Pro X6. 

The displayed value serves also as a reference value for "Dynamic Range Control". 
Areas that are softer than speech will be made louder, and louder areas will be made 
softer to avoid overmodulations. 

Calculation example for "Normalization dialog" 

Let's assume you have created a movie in MAGIX Video Pro X6 and dubbed it in 
Samplitude/Sequoia. After the transfer of the surround tracks from 
Samplitude/Sequoia (view page 205) you measure the volume of the spoken dialog. 

The maximum modulation level for Dolby® Digital audio is 31 dB over the set 
reference value for surround stereo systems. For this reason the normalization dialog 
has a value range of 1-31, describing the volume of the spoken dialog in dB. 

If you have spoken dialogs with a volume level of, for example, -21 dB, you should 
enter value "21" into the normalization dialog, so that the total volume can be lowered 
to the reference level set in the surround decoder or amplifier. This is usually -31 dB 
below the digital uppermost level. 

Measured volume 
level in spoken dialogs 

Value set in "Normalization 
dialog" 

Damping in Dolby® 
Digital audio 
stream 

-25 dB 25 -6 dB 
-30 dB 30 -1 dB 
-31 dB 31 0 dB 
-5 dB 5 -26 dB 

Note: The set value does not directly alter the created audio material, but simply 
delivers information about the ideal damping to the surround decoder, making sure 
that the dynamic range is not restricted. 
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Background: Action-filled movies have larger volume differences between spoken 
dialogs and loud scenes (for example during explosions), and because of this, their 
dialogs are softer than in quieter films, which can be modulated higher. 

Surround mix level/Center mix level: These settings lead to an additional damping of 
the surround channels and the central channel. Both settings are preset to -3 dB. 

LFE channel: Here you can switch off the LFE channel (Low Frequency Effect), for 
example if you want to eliminate undesirable rumbling sounds in the low frequency 
range. Normally you should leave this option activated. 

LFE filter: The LFE filter is a low pass filter, which lets through only the lowest 
frequencies. If you are dubbing a project in Samplitude/Sequoia, and have applied the 
LFE filter, you can switch off this function here, since this filtering has already been 
accomplished. 
 

MPEG glossary 

Motion estimation 
Motion estimation is a further element for reducing data used in MPEG encoding.  

Motion estimation also occurs in the B and P frames. The image difference that still 
exist after prediction (view page 374) are examined. Complex algorithms are used to 
search for an original occurrence of the macro block in the reference frame of each 
macro block of the P or B frame (these are units of 2x2 blocks specially combined for 
this purpose), which have been moved either by movement or by camera pan. They 
can then be left out in the P and B frame. Only the information by how far and to 
where the macro block has been moved is saved instead. This vector is called the 
motion detector. 

In the General encoder settings (view page 365), you can specify the quality of the 
final MPEG video. This factor also influences the time required for encoding. The 
longer it takes, the better the quality. 
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Bit rate 
MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you 
could predict that 20 seconds of movie would result in 20 MB of data. The file size is 
this a direct measurement of quality.  

This is different for MPEG: The amount of data available can be used differently for 
different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet 
streaming in thumbnail format. The quality of an MPEG video is measured by the 
width of the created data stream, the bit rate. This is the amount of the transmitted 
data per time unit; it is stated in kBit/s or bit per second. 

Bits, not bytes are used, since the data word width has to address the transmission 
restrictions. 

The file size can be calculated from the average bit rate, if its length is known: 

F = (BRV + BRA) * t 

F=File size BRV= 
Video bit rate 

BRA= 
Audio bit rate 

t=Length in s 

 

Block 
For almost all image file editing techniques the image is subdivided into 8 x 8 pixel 
blocks (image points). This should be noted if you would like to used user-defined 
image resolutions (width/height), and they should always be a multiple of 8. 
 

Chroma format 
The color value of each image point consists of the color values for the primary colors 
red, green, and blue (RGB), and for traditional and technical reasons it is transformed 
into one brightness value (Y = 0.299*R = 0.587*G + 0.114*B) and two color 
difference values (U = R - Y, V = G -Y). 

The Y value alone produces the black and white picture. These signal components 
allow brightness and color information to be handled separately. The first data 
reduction occurs  when single rows comprising a picture are read. Because the human 
eye has a lower color resolution than a brightness resolution, the color components 
are recorded only for every other point of a row (4:2:2) for each four pixels grouped 
(4:1:0), i.e. color signal under-reading. 

4:2:2 This corresponds to the established TV standard. One piece of color information 
is transmitted per row for two pixels which corresponds to a 2/3 compression of the 
output data. 
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4:1:0  This is the color coding used for DVDs and most other consumer video 
applications. For each 4 pixels grouped together on two rows, one unit of color 
information is saved. This corresponds to a output data compression of 1/2. 
 

Field 
A half-image, i.e. two halves which combine to produce a frame (see de-interlacing 
(view page 373)).  
 

Frame 
A frame is a single image from a video sequence which also called a full image. PAL 
video, for example, contains 25 frames per second, NTSC 29.97 frames.  

Video recordings, with the exception of computer animations and still frames, don't 
contain full images. Instead, they have double numbers of half-images (fields) which 
are transmitted in an interlaced state. However, we still refer to frames, since many 
predecessors of MPEG compression are based on such frames. Video editing 
literature usually refers to frames. 
 

GOP 
Group of Pictures: The sequence of I frames and the P and B frames that belong to 
them. 

e.g. I B B P B B P B B I ... 

(This GOP has a length of 9, with 2 P frames and 2 B frames) 

I frames contain the entire image information of a frame, while P and B have part of 
the information. So-called prediction (view page 374) and movement approximation 
are methods used for reduction. 

The combination P B B is called a subgroup. 

I frames must appear in regular intervals in the data stream for image and sound to be 
synchronized. Between the I frames only a limited count of P and B frames is allowed. 
This explains a few things: Since P and B frames contain only differential information, 
these differences will be larger with time, since more and more changes takes place 
from frame to frame. A large count does not make much sense, since GOP has a 
maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B 
frames between P frames is not allowed). 
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In a closed GOP, B frames of the last subgroup may contain only backward 
predictions or references to the preceding P frame, but no references to the following I 
frame, since it belongs to the next GOP. 
 

I frames 
Intra-frames: In these pictures, the entire image information of a frame is saved and 
only information from this frame is used ("intra-frame encoded"). In contrast to the I 
frame, P and B frames save only the differences between the current frame, and 
preceding and/or following frame are also found in MPEG video (P frame = "predicted 
frame", B frame = "bidirectional frame", see Prediction (view page 374)). 

 
 

Interlace 
For historical reasons, pictures in a movie are always recorded and transmitted in the 
form of two fields, first the lines with even numbers and then those with odd 
numbers. These fields are alternatively displayed with a double-frame rate. The (lazy) 
eye of the viewer or the processing of the TV tube puts the two frames together to 
form one. 

   

The output image First field Second field 

You normally don’t have to worry about field processing. The video material goes 
through the entire processing chain as fields and is exported again as fields or burned 
onto DVD or shown on TV when played back on a DVD as a full picture. Only in 
certain rare conditions is it necessary to delve deeper into this process. Two problems 
can occur: 

Interlace artifacts 
To be displayed on a computer monitor the two fields must be combined to form a 
full screen.  

These two fields are not the same, since two fields are created during the recording 
(between which a 1/50 of a second gap is evident). Moving objects can therefore 
produce artifacts at the vertical edges. 
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Typical interlacing errors 

You can use so-called "de-interlacing" to avoid these artifacts. A picture in between 
the two fields is created (interpolated). So if you want to create stationary pictures 
from movies, then you should definitely use a de-interlace filter. 

In the system settings (File menu-> Program settings) you can set the preview 
monitor display to use hardware de-interlacing during video recordings, for the video 
recorder, and for display in the arranger. 

Incorrect field rate 
If you move around the series of fields in a movie data stream you can see strong jitter 
and flicker effects. Picture objects move in a backward movement - two steps 
forwards, one back - since a delayed field is shown before the previous one. This can 
happen in the processing chain if you export video material improperly with the wrong 
field order and then import it into different material.  

We use MXV or MPEG "Top field first" format for all analog recordings ("odd" in 
other programs). DV-AVI on the other hand is saved with “Bottom Field First”.  

You can correct the field series for each video object in its object settings. See: Menu 
-> Effects -> Object properties 
 

P frames and B frames 
P frames save only the difference between the current picture and the preceding I 
frame. The "P" comes from the term "prediction" which describes this process. 

B frames save the differences between the current picture and the I or P frame 
preceding and following. This includes the information that was the same before and 
remained the same after the current frame. Both directions are analyzed (indicates 
the "B" in the name, i.e. "bidirectional-predicted"). You can read more under 
prediction (view page 374). 
 

Prediction 
Prediction is a method of data reduction used by the MPEG format. The image 
elements already known from the previous or following frames are removed from the 
data stream. 
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How does it work? 
The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is 
transmitted together with the encoder, which always knows exactly which kind of 
frame comes next. I, P, and B frames are differentiated. 

Hint: When we talk about pictures, we mean frames of the video output, and I, P an 
dB frames are the frames of the encoded video. Just as in movement approximation, 
blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction. 

The first frame is always the I frame. It is completely encoded from the first picture. 
Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As 
already said, the encoder, and later the decoder, will know that two B frames belong 
between them.) This image will also be completely encoded, and afterwards all 
macroblocks that haven't changed in comparison to the I frame will be deleted. They 
will be replaced by corresponding references for the decoder that tell it "you already 
know what should be shown here, and you can get it from the last I frame". 

Now, the 2nd will be completely encoded, and all macroblocks identical to the first I 
frame and the following P frame will be removed. References to previous frames  are 
called backward predictions, and references to following frames are called forward 
predictions. The third picture will be edited in exactly the same fashion. 

The fourth picture we have already explained, and now we need the next P frame, or 
picture number 7. Pictures 5 and 6 are B frames again, which are compared to P 
frames to both sides of them (picture 4 and 7); these are followed by the last two B 
frames. These have a special place, since in closed GOPs, they may contain only 
backward predictions, and no references to the next I frame, because it belongs to 
the next GOP. 

Something else: Since the decoder is no prophet, the P frames are always transmitted 
before the B frames! The GOP explained above will be encoded and transmitted in the 
order it is written. 

Original 
GOP 

I0 B01 B02 P01 B11 B12 P02 B21 B22 I1  

Data stream I0 P01 B01 B02 P02 B11 B12 B21 B22 I1 ...  for closed GOPs 

 I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11...  For open GOPs 

Due to this nested structure, it is easy to see that during direct editing of MPEG 
material, complicated computations have to take place! These are made easier using 
a frame table. A frame table contains a list, where the information of every frame in 
the data stream is found, identifying the type of frame it is.  

Using Movement prediction (view page 370) P and B frames are likewise reduced. 
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Quantization scaling 
The single pictures in MPEG are saved using a compression method comparable to 
JPEG with bitmaps and associated with quality loss. For this single images are divided 
into 8 x 8 blocks (view page 371). 

Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows 
and columns) using a DCT (discreet cosinus transformation) mathematical method. 
Each of these values is produced using all 64 individual pixels of the block, but the 
values in the matrix are ordered in such a way that the image information is ordered 
according to its importance. 

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. 
Exactly how and why this matrix must be created is the biggest secret of encoder 
programmers, since this determines the quality of the whole encoding process. What 
is known is that the result should contain as many zeros as possible! These zeros 
correspond to the "unimportant" image elements mentioned and will not be 
transmitted in the data stream. 

Depending on the encoder parameters regarding the target bit rate, fewer or more 
values of the matrix will be declared unimportant by dividing the quantization matrix 
by the quantization scaling factor. Since only whole numbers are used, a division can 
produce a zero is the remainder is discarded. 

This factor is also a direct measure of the sought image quality of the MPEG data 
stream, since the "Q" in "Q" factor stands for quantization and quality. 
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Glossary 

Symbols & Numeric 
1080i/1080p 
1080i or 1080p are the so-called Full HD resolutions. These have a resolution of 1920 
x 1080 pixels. The "i" stands for "interlaced" (view page 383) and means that each 
field is stored, as with interlaced scanning. The "p" stands for "progressive" and 
means that entire images are stored. 
 

720p 
This is the "small" HD resolution, which is sized at 1280 pixels x 720 pixels. The "p" 
stands for "progressive", i.e. full images are always displayed. 
 

A 
Aliasing 
Aliasing, or alias effects, are mistakes that appear during digital scanning of sounds, 
videos or images when the sample frequency (in audio editing) or resolution (in video 
editing) used are too low. 
 

ATN: 
This abbreviation stands for "Absolute Track Number". Which is the actual time code 
of DV and HDV recordings recorded using the helical scan method.   
 

Audio 
This is then referred to as "audio" when the sound signal is saved directly as such on 
the PC. The actual sound is recorded or played back here. 
 

audioid 
audioid is a process used to determine the title and artist name base on musical 
properties. An Internet connection is required to access the audioid database. 
 

AVCHD 
Stands for "Advanced Video Codec Definition". It is an HD format for video cameras, 
which has been developed by Panasonic and Sony. In comparison to the "HDV" 
format, a clear improvement in quality can be seen here. 

MPEG-4 AVC/H.264 is used for video encoding and AAC or AC3 for audio encoding. 
The maximum bitrate is 25 Megabits/sec. 
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AVI 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container" for which the conventions for transferring audio 
and video files to the program are only loosely defined. More in this topic can be 
found in General notes on AVI videos. (view page 347) 
 

B 
Backup disc 
Copying of files to a different file storage medium to secure these files is called 
backing up, or creating a backup. 
 

Browser 
A browser (also known as web browser, or Internet browser) is a computer program 
that displays websites. The best-known browsers are Internet Explorer, Firefox, Safari, 
and Opera. 
 

Button 
Refers to an element of the graphic user interface of a program. The button initiates 
an action in the program via left mouse click. 
 

Button 
Refers to an element of the graphic user interface of a program. The button initiates 
an action in the program via left mouse click. 
 

C 
Cache 
Simply stated, this is a temporary folder where frequently accessed files are saved so 
that they can be quickly launched while you are working. 
 

CC 
CC stands for "Connectivity Co-ordination" and describes how the change of a 
domain name from one provider to another occurs (domain transfer). 
 

Clip level 
Signifies the volume level at which the recorded signal is overmodulated, or "clipped". 
 

Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 
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Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 
 

Compatible 
Different devices are compatible with each other if they operate together without any 
errors occurring. 
 

Context menu 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 
 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 
 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 
 

CPU 
Central processing unit: The name for the main processor of the computer (CPU). 
Modern computers have even two or more processors, or one processor with several 
cores.  
 

D 
Dialog 
A dialog opens in a new window and lets the user interact with the program. This 
means that the dialog can present information to the user and/or expects to receive 
input from the user. 

A dialog can contain various user elements which can be manipulated by a simple 
mouse click. Keyboard entries are also possible. 
 

Disc project 
A "Disc project" includes everything that you want to put on your CD and DVD.  

This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 
 

Disc types 
The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to 
which the current project will be burned. 
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Dissolve 
Transitions, Dissolve. Can be used to fade between objects. 
 

DNS 
The abbreviation DNS stands for Domain Name Service and refers to a provider of 
Internet services that registers domain names for customers. 
 

Domain 
A domain is the website's Internet address. It consists of the name of the Internet 
protocol (usually http://), the computer or network name (such as www), the 
second-level domain (such as magix), and the top level domain (like .com, .net). 

Altogether we have: protocol://networkname.second-level-domain.top-level-domain 
(such as "http://www.magix.com"). 

Domains are allocated by a country's so-called NIC (Network Information Center). In 
Germany the DENIC is responsible for the release of domains. 
 

Domain transfer 
See CC. If you already have a domain, you can move it from your previous provider to 
another provider. 
 

Downmix 
A method developed for audio technology to turn a Surround Sound recording into a 
version with fewer channels. Most often (as is the case with MAGIX Video Pro X6) 
this will be a stereo version. 
 

Drag & drop 
Enables files and objects to be moved freely between various applications (or within 
an application) by dragging the object and letting it drop using the mouse cursor. 
 

F 
Fader 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is 
the zoom slider that lets you see a picture in more detail. 
 

Field 
A half-image, two of which combine to produce a frame (see interlace). 
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Flip menu 
Drop down menus create menus consisting of lists of selectable choices. They look 
very similar to text input fields, but have a button with a downward-pointing symbol 
on the right-hand side. 
 

Frame 
A frame is a single image from a video sequence which also called a full image. 

A PAL video contains 25 frames per second; NTSC contains 29.97 frames. 
 

H 
Handles 
Handles are the five little rectangles at the edges of selected objects. All curve points 
can be moved by holding down the left mouse button. 

Length handles: Bottom right and bottom left. You can use them to change the length 
of an object. 

Transition/Fade handles: Top right and top left. These can be used to softly fade an 
object in or out. 

Volume/Brightness handle: Above-center. You can use it to adjust the volume or the 
brightness. 
 

Hard disk 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

Hard disk drive 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

Hardware 
The all-encompassing name for all internal components of a computer. For example 
hard disk, graphics card, mainboard, etc. External peripheral devices are also 
considered hardware, i.e. printer, scanner, monitor, etc. The synchronization of single 
hardware components is coordinated by the software. 
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HDD 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

HDTV 
This acronym stands for "High Definition Television. 
 

HTTP 
Stands for Hyper Text Transfer Protocol and is used for transferring websites onto the 
Internet (from web server to the browser). For this reason, the abbreviation http:// 
always comes before the Internet address. This is automatically inserted and does not 
have to be entered when entering the Internet address. 
 

Hyperlink 
Hyperlinks (or in short "links") are references to other websites/online documents (or 
other computer networks). They build the base of the World Wide Web (WWW) as 
it is only via these hyperlinks that networking or interlinking between the billions of 
website out there is actually possible. 
 

I 
ID3 tags 
ID3 tags contain title information that can be added to a music title. This includes the 
title, artist, album, as well as the genre, year of release, and other criteria that can help 
searching through a database. The database is created using this information. 

Info: Title information will only be saved for MP3s in the so-called ID3 tags (Identify 
an MP3), but other formats offer similar possibilities, like "Vorbis comment" for the 
OGG Vorbis format, for example. 

 

Image 
An image is a representation of a CD, DVD, hard drive, or another storage medium 
that is saved as a file. 

The difference from a copy or backup is that an image contains information about the 
structure of the original storage medium, and not just individual files. This enables 
01:01 copies of complete storage media to be created. 

Caution! Copyright laws forbid copying of commercial CDs/DVDs, and for this 
reason, this process can be prohibited by copy protection. 
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IMAP 
Stands for Internet Message Access Protocol and is an advanced process of receiving 
emails. 
 

Interlace 
Describes the creation of a full image from 2 half-images (fields). 

In this process, even and odd lines are alternately assigned to one of the two fields. 

The human eye perceives both of the projected half-images as a single full image, so 
that despite the slow image repetition rate (25 Hz for PAL, 29.97 for NTSC) a 
subjectively fluid image is seen. 
 

Intro 
"Intro" means the introduction or opening credits of a movie. 
 

J 
jpx 
A format developed by MAGIX which is used for photo editing. It enables free 
experimentation with effects without altering the original file. The effects settings are 
also displayed when the photos are opened using a different MAGIX program. 
 

M 
Menu 
Menus contain practically all the program functions. They can be opened using a 
simple mouse click on the corresponding menu. Keyboard shortcuts, if available, are 
also found at the end of menu entries. 

The graphical surface of a CD/DVD will also be represented as a menu. 
 

Menu bar 
Almost every program has a menu bar. It can normally be found underneath the title 
line of the program. A simple mouse click opens a corresponding menu. 
 

MIDI 
MIDI files do not contain the actual sounds like audio files, but only the note control 
information which can be interpreted during playback by the synthesizer chip on the 
sound card or an external synthesizer. 
 

MMC 
MMC stands for MIDI Machine Control and is part of the MIDI protocol. Transport 
control and position data is conveyed using MMC. 
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Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

MOV 
MOV is a video and audio format developed by Apple, which has since become 
widely used with Windows. QuickTime supports lots of compression technology, 
which make it possible to optimize audio and video and even graphics for the Internet 
and multimedia/video applications. Conventional (hardware) DVD players are not 
able to play this format. 
 

Movie 
In MAGIX Video Pro X6, an arrangement of various objects (videos, photos, text, 
sound, etc.) is called a movie. A movie file has an "mvm" extension. 
 

MP3 
MP3 (actually MPEG-1 layer 3) is currently the most important standard for 
compressing audio files. 
 

MPEG 
MPEG is short for "Moving Picture Experts Group" and refers to a committee 
concerned with the standardization of video and audio data compression as well as 
container formats. 
 

MS audio 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 
 

MTC 
MTC stands for MIDI Time Code and it transmits the exact playback position via 
MIDI. In this way, programs and devices can be synchronized with each other. 
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MXV 
This is the MAGIX video format for quicker processing with MAGIX products. It 
offers very low loss of quality, but it cannot be played via conventional DVD players. 
 

N 
Noise Sample 
Sample of a noise that is to be removed 
 

NTSC (USA, Japan) 
NTSC stands for "National Television Systems Committee". This is a US institution 
that defined the first color carrier system for TV which is now used in most of 
America and some East Asian countries. 

The image repetition rate for NTSC is 29.97 Hz. 
 

Numeric keypad 
Also known as the numpad, or the number block. 
 

O 
Offset 
With an offset of 60:00:00 (1 hour) you can, for example synchronize a tape whose 
time code that starts at 1 hour, MAGIX Video Pro X6 however, still starts the tape 
beginning at 0.  
 

OGG VORBIS 
This is a new, royalty-free format with similar properties to MP3. 
 

P 
PAL (Europe) 
Phase Alternating Line, or PAL, is a process for color transmission for analog TV that 
is primarily used in Europe, but also in Australia, South America, and many African 
and Asian countries.  

The image repetition rate for PAL  is 25 Hz. 
 

Play marker 
The play marker is a red vertical line which moves from left to right during playback. It 
indicates the current play position.  
 

Playlist 
Arrange your songs in playlists from various sources in different formats and in 
whatever way you like, sometimes updated daily. 
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Important: Playlists are only links to songs on your hard drive or in your CD drive.  

When you add a song to your playlist whose real source is a CD in your computer's 
drive, the song will no longer be playable when the CD is removed from the drive. 

Similarly, when you move a folder on your hard drive, the playlist will no longer be 
able to play the song, since the link is no longer valid.  

For the latter, however, there is a simple solution: If you know where the song has 
been saved, then you can redefine the path. A corresponding dialog window is 
provided for this purpose. You can reset the path by navigating through the Explorer 
folders. The playlist is now correct once again.  
 

Plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 
 

POP3 
Stands for Post Office Protocol (version 3) and is used in standard email programs for 
receiving email (for example, Outlook Express). POP3 enables email to be collected 
by the provider's email server and loaded into your email program. 
 

Project 
A "Disc project" includes everything that you want to put on your CD and DVD.   

This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 
 

Provider 
A provider or ISP (Internet Service Provider) offers Internet services like webhosting 
or domains (DNS). In relation to the MAGIX Website Service, MAGIX is the provider. 
 

R 
RAM (Random Access Memory) 
This is a hardware component of a computer. RAM is needed to temporarily save 
files. This type of storage is erased when the computer is shut down or reset. The 
larger this storage is, the faster you can work with programs to change and save files. 
 

Ratio 
The aspect ratio is the ratio between the height and width of a rectangle. In practice 
these are photos, screens or projection screens. This method can also be used to 
describe the aspect ratio of pixels. 
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Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV 
sets), or 16:10 (widescreen flat screens, widescreen notebooks), 3:2 for 35 mm films 
and photos. In cinemas you mostly find 1.85:1 
 

Red Book 
Specific standards have been established for the different CD types in order to unify 
their data structure and to make them compatible with the different CD drives. Their 
names refer to the color of the books where these standards were written.   

The term "Red Book" is common language for the Compact Disc Audio Standard. The 
requirements listed here have to be observed for industrial CP production. Audio CD 
players only read CDs created according to the Red Book format. It is therefore 
necessary to first convert PC files into this format before writing them onto an audio 
disc compatible with any audio CD player. 
 

Restore 
Restoration of files originating from a backup is called "Restoring". 
 

RM 
RealMedia includes all of the media formats from software developer RealNetworks. 
RealMedia especially refers to the "RealVideo" video format and the "RealAudio" 
sound format. The quality of RealVideo files is comparably good at high compression 
rates, but does have some loss of quality. These formats cannot be played back by 
(hardware) DVD players. 
 

S 
Scene 
Freely definable section of a movie in MAGIX Video Pro X6. 

In general, a scene is a segment of a film that is a product of various settings and 
conveys a certain action. 
 

Screenshot 
A screenshot is an image composed of all visible screen elements (messages, open 
dialogs, etc.) at a certain time. By pressing the "Print screen" key on the keyboard, this 
image is saved into the clipboard. Next, open a program which can edit images and 
select "Insert" (shortcut "Ctrl+V") in a new document to add the screenshot for 
editing and saving. 

Note: Press "Alt + Print screen" on the keyboard to capture the active window only. 

 



 

388   

http://pro.magix.com 

Slider 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is 
the zoom slider that lets you see a picture in more detail. 
 

SMTP 
Stands for Simple Mail Transfer Protocol and enables the exchange of emails across 
computer networks. 
 

Software 
The name for all non-physical functional components of a computer. This primarily 
includes computer programs and files that are meant to be used by computer 
programs. 
 

Submenu 
Besides normal entries, a menu can contain submenus that offer additional functions. 
This makes menus more comprehensive. 
 

T 
Toolbar 
Here you will find small buttons that provide a function when clicked. For example, 
you can cut out a selected object by clicking on the scissors. 
 

Toolbar 
All basic functions of the corresponding program can be found here. The 
corresponding functions can be called up via mouse click. 
 

Top-level domain 
Top-level domains (TLD) are always those separated by a dot at the end of an 
Internet address (for example, "http://www.magix.com" < here, .com is the top-level 
domain). Among these are also country top-level domains, such as .co.uk, .us, .de as 
well as so-called generic top-level domains like .net, .org, .biz, and so on. 
 

Traffic 
Traffic (data transmission) occurs within your MAGIX Website Service as soon as 
data is transferred across the Internet: for example, when uploading or downloading 
files to your website or when someone else opens your website. 
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U 
Universal Plug & Play; UPnP 
Universal Plug ‘n’ Play (UPnP) is a network protocol which enables data exchange 
between different devices (PCs, hi-fi systems, video cameras, PDAs, and webservers). 
UPnP allows various devices to participate in network-wide communication, i.e. the 
initialization of functions and other device functions. Long-winded configuring or 
installing of drivers is not required as the devices can handle their own functions and 
data sources by themselves. Find out more at www.upnp.org. 

Hint: To work with UPnP you have to activate it first. This can be found under 
"Options" ("Y" -> UPnP).  

 

URL 
URL stands for Uniform Resource Locator and describes where a source can be found 
online (for example, a website). The address or the path to the storage location of a 
file on your computer is known as a URL. Often the term URL is used as a term for the 
domain. The URL for the MAGIX website is: http://www.magix.co.uk 
 

V 
VirtualDub plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

VirtualDub plug-ins are also referred to "VirtualDub filters" and have the "VDF" file 
extension. You can use them to apply additional video effects to video objects. 
 

VST and DirectX plug-ins 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST 
has asserted itself stronger in the current market.  
 

W 
WAV 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Wave 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Wave file 
Wave (*.WAV) is a standard uncompressed audio format. 
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Webhosting 
This means that an Internet Service Provider makes domains and webspace available 
to its customers. With the MAGIX Website Service, MAGIX provides webhosting to 
its customers. 
 

Webmail 
Webmail enables the customer to view and receive the contents of their email inbox 
without having to install email software on their computer. Customers of the MAGIX 
Website Service can use MAGIX Webmail for this. 
 

Webmaster 
A webmaster is responsible for the administration and maintenance of a website. 
Often, the webmaster is also the owner of the website as well as the domain that 
belongs to it. Once you have registered a domain in the MAGIX Website Service, an 
email account will automatically be set up, for example: 
"mailto:webmaster@domainname.co.uk". 
 

Webserver 
Webserver refers to the computer on which your host saves your website's pages and 
which makes your pages accessible on the Internet 24-hours a day. 
 

WMA 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 
 

WMV 
Windows Media Video (WMV) is a trademark video codec from Microsoft. If you 
have Windows installed on your PC, then playing WMV files shouldn't be a problem. 
Only a few (hardware) DVD players are able to play this format. Read more about this 
in your DVD player's manual. 

This video format is very good for web videos as it allows relatively high compression 
rates. 
 

World Wide Web (WWW) 
WWW stands for "World Wide Web" and is the most used service of the Internet. 
On the WWW, web browsers (for example, Internet Explorer) are used to display 
information via websites. The process is colloquially called "Surfing the Internet". 
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Tips for program help 
The "Help" file features hints on how to use the program and additional information. 
Many important terms are indicated in the text in italics and clicking on them displays 
an explanation. 

Context help: Press the "F1" key at any point in the opened program and the help file 
will open with the matching topic (context help). 

Search function: Use the search function to find out information about specific words. 
Enter either the individual word or use logical operators (OR, AND, NEAR) to refine 
your search if you have several search words. 

• "OR" (between two words): All topics which contain both words or one of the 
words will be listed. 

• "AND" (between two words): Only those topics will be listed which contain both 
words. 

• "NEAR" (between two words): Only those topics will be listed which contain both 
words. A maximum of six other words may be added between the search terms. 

• "NOT" (before a word): Topics which contain this word will not be listed. 

Print: Use the help program's print function to make a printout of individual topics or 
entire sections. The print button is located at the top of the help window in the 
toolbar. 
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